
MATLAB®

Desktop Tools and Development Environment

R2023a



How to Contact MathWorks

Latest news: www.mathworks.com

Sales and services: www.mathworks.com/sales_and_services

User community: www.mathworks.com/matlabcentral

Technical support: www.mathworks.com/support/contact_us

Phone: 508-647-7000

The MathWorks, Inc.
1 Apple Hill Drive
Natick, MA 01760-2098

MATLAB® Desktop Tools and Development Environment
© COPYRIGHT 1984–2023 by The MathWorks, Inc.
The software described in this document is furnished under a license agreement. The software may be used or copied
only under the terms of the license agreement. No part of this manual may be photocopied or reproduced in any form
without prior written consent from The MathWorks, Inc.
FEDERAL ACQUISITION: This provision applies to all acquisitions of the Program and Documentation by, for, or through
the federal government of the United States. By accepting delivery of the Program or Documentation, the government
hereby agrees that this software or documentation qualifies as commercial computer software or commercial computer
software documentation as such terms are used or defined in FAR 12.212, DFARS Part 227.72, and DFARS 252.227-7014.
Accordingly, the terms and conditions of this Agreement and only those rights specified in this Agreement, shall pertain
to and govern the use, modification, reproduction, release, performance, display, and disclosure of the Program and
Documentation by the federal government (or other entity acquiring for or through the federal government) and shall
supersede any conflicting contractual terms or conditions. If this License fails to meet the government's needs or is
inconsistent in any respect with federal procurement law, the government agrees to return the Program and
Documentation, unused, to The MathWorks, Inc.

Trademarks
MATLAB and Simulink are registered trademarks of The MathWorks, Inc. See
www.mathworks.com/trademarks for a list of additional trademarks. Other product or brand names may be
trademarks or registered trademarks of their respective holders.
Patents
MathWorks products are protected by one or more U.S. patents. Please see www.mathworks.com/patents for
more information.

https://www.mathworks.com
https://www.mathworks.com/sales_and_services
https://www.mathworks.com/matlabcentral
https://www.mathworks.com/support/contact_us
https://www.mathworks.com/trademarks
https://www.mathworks.com/patents


Revision History
June 2004 First printing New for MATLAB 7.0 (Release 14). Formerly part of

Using MATLAB.
October 2004 Online only Revised for MATLAB 7.0.1 (Release 14SP1)
March 2005 Online only Revised for MATLAB 7.0.4 (Release 14SP2)
March 2005 Second printing Revised for MATLAB 7.0.4 (Release 14SP2)
June 2005 Third printing Minor revision for MATLAB 7.0.4 (Release 14SP2)
September 2005 Online only Revised for MATLAB 7.1 (Release 14SP3)
March 2006 Online only Revised for MATLAB 7.2 (Release 2006a)
September 2006 Online only Revised for MATLAB 7.3 (Release 2006b)
March 2007 Online only Revised for MATLAB 7.4 (Release 2007a)
September 2007 Online only Revised for MATLAB 7.5 (Release 2007b)
March 2008 Online only Revised for MATLAB 7.6 (Release 2008a)
October 2008 Online only Revised for MATLAB 7.7 (Release 2008b)
March 2009 Online only Revised for MATLAB 7.8 (Release 2009a)
September 2009 Online only Revised for MATLAB 7.9 (Release 2009b)
March 2010 Online only Revised for MATLAB 7.10 (Release 2010a)
September 2010 Online only Revised for MATLAB 7.11 (Release 2010b)
April 2011 Online only Revised for MATLAB 7.12 (Release 2011a)
September 2011 Online only Revised for MATLAB 7.13 (Release 2011b)
March 2012 Online only Revised for MATLAB 7.14 (Release 2012a)
September 2012 Online only Revised for MATLAB 8.0 (Release 2012b)
March 2013 Online only Revised for MATLAB 8.1 (Release 2013a)
September 2013 Online only Revised for MATLAB 8.2 (Release 2013b)
March 2014 Online only Revised for MATLAB 8.3 (Release 2014a)
October 2014 Online only Revised for MATLAB 8.4 (Release 2014b)
March 2015 Online only Revised for MATLAB 8.5 (Release 2015a)
September 2015 Online only Revised for MATLAB 8.6 (Release 2015b)
October 2015 Online only Rereleased for MATLAB 8.5.1 (Release 2015aSP1)
March 2016 Online only Revised for MATLAB 9.0 (Release 2016a)
September 2016 Online only Revised for MATLAB 9.1 (Release 2016b)
March 2017 Online only Revised for MATLAB 9.2 (Release 2017a)
September 2017 Online only Revised for MATLAB 9.3 (Release 2017b)
March 2018 Online only Revised for MATLAB 9.4 (Release 2018a)
September 2018 Online only Revised for MATLAB 9.5 (Release 2018b)
March 2019 Online only Revised for MATLAB 9.6 (Release 2019a)
September 2019 Online only Revised for MATLAB 9.7 (Release 2019b)
March 2020 Online only Revised for MATLAB 9.8 (Release 2020a)
September 2020 Online Only Revised for MATLAB 9.9 (Release 2020b)
March 2021 Online Only Revised for MATLAB 9.10 (Release 2021a)
September 2021 Online Only Revised for MATLAB 9.11 (Release 2021b)
March 2022 Online Only Revised for MATLAB 9.12 (Release 2022a)
September 2022 Online Only Revised for MATLAB 9.13 (Release 2022b)
March 2023 Online Only Revised for MATLAB 9.14 (Release 2023a)





Startup and Shutdown
1

Start MATLAB on Windows Platforms . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-2
Select MATLAB Icon . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-2
Call matlab from Windows System Command Line . . . . . . . . . . . . . . . . . . 1-2
Call matlab from MATLAB Command Prompt . . . . . . . . . . . . . . . . . . . . . . 1-2
Open File Associated with MATLAB . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-3
Select MATLAB Executable from Windows Explorer Tool . . . . . . . . . . . . . 1-3

Associate .mat Files with MATLAB . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-4

Start MATLAB on Linux Platforms . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-5
Startup Folder . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-5
Execute MATLAB Script from Remote ssh Login . . . . . . . . . . . . . . . . . . . . 1-5

Start MATLAB on macOS Platforms . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-6
Start from Applications Folder . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-6
Start from Terminal Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-6

Exit MATLAB . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-8
Ways to Quit or Exit . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-8
Confirm Exiting . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-8
Run Script When Exiting . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-9

Recovering Data After Abnormal Termination . . . . . . . . . . . . . . . . . . . . . 1-10

Crash Reporting . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-11
Locating Crash Logs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-11

When MATLAB Terminates Unexpectedly . . . . . . . . . . . . . . . . . . . . . . . . . 1-12
MathWorks Crash Reporter . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-12
MathWorks Crash Analyzer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-12

Specifying Java Startup Options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-13

MATLAB Startup Folder . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-14
Default Startup Folder . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-14
Change Startup Folder . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-15
userpath as Initial Working Folder . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-15

Commonly Used Startup Options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-17

Specify Startup Options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-18
Startup Options from Operating System Prompt . . . . . . . . . . . . . . . . . . . 1-18
Startup Options in Shortcut on Windows Systems . . . . . . . . . . . . . . . . . . 1-18
Startup Options in MATLAB Startup File . . . . . . . . . . . . . . . . . . . . . . . . . 1-19

v

Contents



Passing Perl Variables on Startup . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-19
Startup and Calling Java Software from MATLAB . . . . . . . . . . . . . . . . . . 1-19

Toolbox Path Caching in MATLAB . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-21
About Toolbox Path Caching in MATLAB . . . . . . . . . . . . . . . . . . . . . . . . . 1-21
Using the Cache File Upon Startup . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-21
Updating the Cache and Cache File . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-21

Remove canberra-gtk-module and pk-gtk-module Messages . . . . . . . . . 1-23
Red Hat Distributions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-23
Debian-Based Distributions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-23

Desktop
2

Zoom and Change Desktop Fonts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-2
Zoom . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-2
Change Font Size . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-2
Change Font Name and Style . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-3
Advanced Customization . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-4
Add New Font . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-5

Change Desktop Colors . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-7
Change Text and Background Colors . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-7
Change Syntax Highlighting Colors . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-8
Change Output Colors . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-8
Change Programming Tools Colors . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-9
Select Theme in MATLAB Online . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-10

Customize MATLAB Toolbars . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-12
Quick Access Toolbar . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-12
Current Folder Toolbar . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-12
Toolbar Preferences . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-12

Change Desktop Layout . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-14
Select Preconfigured Layout . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-15
Hide Tools . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-16
Minimize Tools . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-16
Open Tools . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-18
Undock Tools and Documents . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-18
Reorder and Tile Documents . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-19
Save Desktop Layouts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-21

Accessibility in MATLAB . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-22
Navigate Using the Keyboard . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-22
Work with a Screen Reader . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-22
Zoom . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-23
Change MATLAB Desktop Colors . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-24
Increase Clarity of Plots . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-25

Use Keyboard Shortcuts to Navigate MATLAB . . . . . . . . . . . . . . . . . . . . . 2-28
Installed MATLAB . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-28

vi Contents



MATLAB Online . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-29
Navigate Figures in MATLAB Online . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-30
Additional Keyboard Shortcuts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-31

Use a Screen Reader in MATLAB Online . . . . . . . . . . . . . . . . . . . . . . . . . . 2-33
Screen Reader Tips . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-33
Navigate MATLAB Using a Screen Reader . . . . . . . . . . . . . . . . . . . . . . . 2-34
Enter Statements in the Command Window Using a Screen Reader . . . . 2-35
Create Scripts Using a Screen Reader . . . . . . . . . . . . . . . . . . . . . . . . . . 2-36
Explore Plotted Data Using a Screen Reader . . . . . . . . . . . . . . . . . . . . . 2-39
Limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-40

Customize Keyboard Shortcuts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-42
View Keyboard Shortcuts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-42
Customize Keyboard Shortcuts for Individual Actions . . . . . . . . . . . . . . . 2-43
Manage Sets of Keyboard Shortcuts . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-45

Set Print Options for Command Window and Editor . . . . . . . . . . . . . . . . 2-47
Specify Layout Options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-47
Add Header . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-47
Change Fonts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-49

Web Browsers and MATLAB . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-50
About Web Browsers and MATLAB . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-50
Specify Proxy Server Settings for Connecting to the Internet . . . . . . . . . 2-52
Specify the System Browser for Linux Platforms . . . . . . . . . . . . . . . . . . . 2-52

Manage Your Licenses . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-54
Update Current Licenses . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-54
Activate Software . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-54
Deactivate Software . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-55
Link a License to Your Account . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-56
Get a Trial . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-56

Update an Existing Installation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-58
Update from Notifications . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-58
Check for Updates . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-58

macOS Platform Conventions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-59
Mouse Instructions and macOS Platforms . . . . . . . . . . . . . . . . . . . . . . . . 2-59
Navigating Within the MATLAB Root Folder on macOS Platforms . . . . . . 2-59
MATLAB Dock Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-59

Where MATLAB Stores Preferences . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-61
Temporary Preferences Folder . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-61
Effects of Installation and Deinstallation on the Preferences Folder . . . . 2-61

Import Preferences From Other Releases . . . . . . . . . . . . . . . . . . . . . . . . . 2-62
Use Default Preferences . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-62

Web Preferences . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-64

vii



Entering Commands
3

Enter Statements in Command Window . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-2

Find Functions to Use . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-4

Format Output . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-7
Format Line Spacing in Output . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-7
Format Floating-Point Numbers . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-7
Wrap Lines of Code to Fit Window Width . . . . . . . . . . . . . . . . . . . . . . . . . 3-8
Suppress Output . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-8
View Output by Page . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-8
Clear the Command Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-9

Stop Execution . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-10

Find Text in Command Window or History . . . . . . . . . . . . . . . . . . . . . . . . 3-11
Find Text in the Command Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-11
Find Text in the Command History Window . . . . . . . . . . . . . . . . . . . . . . . 3-12

Rerun Favorite Commands . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-14
Create and Run Favorite Commands . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-14
Organize Favorite Commands . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-14

Set Command Window Preferences . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-16
General Preferences for the Command Window . . . . . . . . . . . . . . . . . . . 3-16
Command Window Automatic Completions Preferences . . . . . . . . . . . . . 3-17

Set Keyboard Preferences . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-19

Check Syntax as You Type . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-20
Syntax Highlighting . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-20
Delimiter Matching . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-20
Code Suggestions and Completions . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-21

Set Command History Preferences . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-25
Change the Command History Date Format . . . . . . . . . . . . . . . . . . . . . . 3-26

Help and Product Information
4

Ways to Get Function Help . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-2

MATLAB Code Examples . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-3
Standalone Examples . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-3
Inline Examples . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-4

Search Syntax and Tips . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-5
Search for Symbols and Special Characters . . . . . . . . . . . . . . . . . . . . . . . 4-5
Use Operators to Improve Results . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-5

viii Contents



Filter Results . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-6
Where the Search Engine Searches . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-6

Bookmark and Share Page Locations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-7
Bookmark Favorite Pages . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-7
View Page Locations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-7

Contact Technical Support . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-9

Help Preferences . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-11

Translated Documentation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-13
Set Documentation Language in MATLAB . . . . . . . . . . . . . . . . . . . . . . . . 4-13
Set Documentation Language on MathWorks Help Center Website . . . . . 4-13

Information About Your Installation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-15

Install Documentation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-16

Workspace Browser and Variable Editor
5

Create and Edit Variables . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-2
Create Variables . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-2
View Workspace Contents . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-2
View Variable Contents . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-3
Edit Variable Contents . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-4
Resize or Reshape Variables . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-7
Copy, Rename, and Delete Variables . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-8
Navigate Variable Contents . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-9

Display Statistics in the Workspace Browser . . . . . . . . . . . . . . . . . . . . . . 5-10
Improve Workspace Browser Performance During Statistical Calculations

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-10
Include or Exclude NaN Values in Statistical Calculations . . . . . . . . . . . . 5-10

Save and Load Workspace Variables . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-12
Save Workspace Variables . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-12
Load Workspace Variables . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-12
View Contents of MAT-File . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-13

Workspace and Variable Preferences . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-14
Workspace Preferences . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-14
Variables Preferences . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-15

ix



Managing Files in MATLAB
6

Find Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-2
Simple Search for File Names . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-2
Advanced Search for Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-2
Advanced Search in MATLAB Online . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-4

Compare Files and Folders and Merge Files . . . . . . . . . . . . . . . . . . . . . . . . 6-6
Comparison Process . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-6
Compare Folders and Zip Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-7
Compare Text Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-11
Merge Text Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-13
Compare Binary Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-14
Compare Other File Types . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-15
Additional Comparison Tools . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-15
Comparison Preferences . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-15

Compare and Merge Live Scripts and Functions . . . . . . . . . . . . . . . . . . . 6-17
Select Files to Compare . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-17
Explore Differences . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-17
Merge Changes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-19

Compare and Merge Apps . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-21
Select Files to Compare . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-21
Explore Differences . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-21
Merge Changes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-23

Compare and Merge MAT-Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-25
Select Files to Compare . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-25
Explore Differences . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-25
Compare Variables . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-27
Merge Changes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-27

Compare XML Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-29
Choose XML Files to Compare . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-29
Change Comparison Type . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-30
Navigate the XML Comparison Report . . . . . . . . . . . . . . . . . . . . . . . . . . 6-30
Save Comparison Log Files in a Zip File . . . . . . . . . . . . . . . . . . . . . . . . . 6-31
Export Results to the Workspace . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-32

Manage Files and Folders . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-34
Manage Files and Folders in MATLAB Online . . . . . . . . . . . . . . . . . . . . . 6-35

Files and Folders that MATLAB Accesses . . . . . . . . . . . . . . . . . . . . . . . . . 6-37
Where Does MATLAB Look for Files? . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-37
Files and Folders You Should Add to the Search Path . . . . . . . . . . . . . . . 6-37
When Multiple Files Have the Same Name . . . . . . . . . . . . . . . . . . . . . . . 6-37
Locations of MathWorks Products . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-38

Current Folder Browser Preferences . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-39

Specify File Names . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-41
Construct Valid Path and File Names . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-41

x Contents



Case Sensitivity of File Names . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-43

Create and Extract from Zip Archives . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-44
Create a Zip Archive . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-44
Add Files to a Zip Archive . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-44
Extract Files from a Zip Archive . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-44
Compare Zip Archive to Unzipped Files . . . . . . . . . . . . . . . . . . . . . . . . . 6-45

What Is the MATLAB Search Path? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-46
userpath Folder on the Search Path . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-46
MATLABPATH Environment Variable . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-46
Determine If Files and Folders Are on the Search Path . . . . . . . . . . . . . . 6-47
The Search Path Is Not the System Path . . . . . . . . . . . . . . . . . . . . . . . . . 6-48
How MATLAB Stores the Search Path . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-48

Change Folders on Search Path . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-50
Add or Remove Folders on the Search Path Programmatically . . . . . . . . . 6-50
Change Folders on Search Path Interactively . . . . . . . . . . . . . . . . . . . . . 6-50
Change Folders Using Current Folder Browser . . . . . . . . . . . . . . . . . . . . 6-52
Change Folders on Search Path Using MATLAB Editor . . . . . . . . . . . . . . 6-53

Use Search Path with Different MATLAB Installations . . . . . . . . . . . . . . 6-54

Add Folders to the MATLAB Search Path at Startup . . . . . . . . . . . . . . . . 6-55
Use a startup.m File . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-55
Set the MATLABPATH Environment Variable . . . . . . . . . . . . . . . . . . . . . . 6-55

Assign userpath as Startup Folder (Macintosh or UNIX) . . . . . . . . . . . . . 6-57

Path Unsuccessfully Set at Startup . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-58

Errors When Updating Folders on Search Path . . . . . . . . . . . . . . . . . . . . 6-60

Troubleshoot Invalid or Unresponsive Windows Change Notification
Handles . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-61

Control How MATLAB Detects Changes in Files and Folders . . . . . . . . . . 6-61
Clear Functions from Memory . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-62
Configure Change Notification Handle Warnings . . . . . . . . . . . . . . . . . . 6-62

Editor Preferences
7

Editor/Debugger Preferences . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-2
General Preferences for the Editor/Debugger . . . . . . . . . . . . . . . . . . . . . . 7-2
Editor/Debugger Display Preferences . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-3
Editor/Debugger Tab Preferences . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-4
Editor/Debugger Language Preferences . . . . . . . . . . . . . . . . . . . . . . . . . . 7-5
Editor/Debugger Code Folding Preferences . . . . . . . . . . . . . . . . . . . . . . . 7-7
Editor/Debugger Backup Files Preferences . . . . . . . . . . . . . . . . . . . . . . . . 7-8
Editor/Debugger Autoformatting Preferences . . . . . . . . . . . . . . . . . . . . . . 7-9
Editor/Debugger Automatic Completions Preferences . . . . . . . . . . . . . . . 7-10
Editor/Debugger Saving Preferences . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-13

xi



Code Analyzer Preferences . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-14
Code Analyzer Preferences . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-14
Search for Messages in the Code Analyzer Preferences . . . . . . . . . . . . . 7-15

Configure Code Analyzer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-18
Sample Configuration File . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-18
Configuration File Information . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-19
Base Configuration Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-19
Add Custom Checks for Functions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-19
Configure Maximum Input and Output Arguments . . . . . . . . . . . . . . . . . 7-20
Modify Existing Code Analyzer Checks . . . . . . . . . . . . . . . . . . . . . . . . . . 7-21

Index of Code Analyzer Checks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-22
Incomplete Analysis . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-22
Syntax Errors . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-23
Language Specification Errors . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-26
Bugs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-34
Custom Checks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-36
Compatibility Considerations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-37
Good Practices . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-95
Unset Variables . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-101
Unused Constructions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-101
Suggested Improvements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-103
Readability Improvements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-118
Formatting Suggestions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-120
Performance Improvements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-120
MATLAB for Code Generation Messages . . . . . . . . . . . . . . . . . . . . . . . . 7-123
MATLAB Compiler (Deployment) Messages . . . . . . . . . . . . . . . . . . . . . 7-124
System Objects . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-124
Unsupported Features . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-125
Behavior Changes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-127
Behavior Changes with Low Reliability Messages . . . . . . . . . . . . . . . . . 7-127
Upcoming Behavior Changes with Low Reliability Messages . . . . . . . . . 7-150

Add-Ons
8

Get and Manage Add-Ons . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8-2
Get Add-Ons . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8-2
Install Add-Ons from File . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8-3
Default Add-On Installation Folder . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8-3
Manage Add-Ons . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8-4
Update Add-Ons . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8-4
Run Apps . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8-4

Configure Add-Ons After Installation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8-6
Install Supported Compiler . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8-6
Additional Configuration Steps . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8-6

xii Contents



Internationalization
9

Locale Setting Concepts for Internationalization . . . . . . . . . . . . . . . . . . . . 9-2
Default Locale Setting . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9-2
Supported Character Sets and Encodings . . . . . . . . . . . . . . . . . . . . . . . . . 9-2
Platform-Specific Localized Formats for Current Folder Browser . . . . . . . . 9-3

Limitations to International Character Support . . . . . . . . . . . . . . . . . . . . . 9-4

Set Locale on Microsoft Windows Platforms . . . . . . . . . . . . . . . . . . . . . . . . 9-5
Locale on Windows 10 Platforms . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9-5
Locale on Windows 7 Platforms . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9-5

Set Locale on macOS Platforms . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9-7

Set Locale on Linux Platforms . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9-8

Unexpected Behavior on macOS Platforms . . . . . . . . . . . . . . . . . . . . . . . . . 9-9

Characters Incorrectly Displayed on Windows Systems . . . . . . . . . . . . . . 9-10

datenum Might Not Return Correct Value . . . . . . . . . . . . . . . . . . . . . . . . 9-11

Numbers Display Period for Decimal Point . . . . . . . . . . . . . . . . . . . . . . . . 9-12

Script Compatibility . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9-13

Change the MATLAB Desktop Language . . . . . . . . . . . . . . . . . . . . . . . . . . 9-14

X Servers and International Keyboard Layouts . . . . . . . . . . . . . . . . . . . . . 9-16

MATLAB Online
10

Access Files in MATLAB Online . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10-2
Upload and Download Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10-2
Preview Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10-2
Restore Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10-2

Cloud Storage
11

Open in MATLAB Online from GitHub . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11-2
Create Links . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11-2
Share Links . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11-2

xiii



MATLAB Drive
12

Install MATLAB Drive Connector . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12-2
Install Instructions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12-2
Uninstall Instructions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12-2

MATLAB Drive Preferences and Account Information . . . . . . . . . . . . . . . 12-4
Preferences . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12-4
Storage Quota . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12-4

Access Files in Your MATLAB Drive . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12-6
Access Files in MATLAB Drive Online . . . . . . . . . . . . . . . . . . . . . . . . . . . 12-6
Access Files on Your System . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12-7

Add Files to MATLAB Drive . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12-9
Sync Exclusions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12-9

Share Folders Using MATLAB Drive . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12-11
Share Folder By Personal Invitation . . . . . . . . . . . . . . . . . . . . . . . . . . . 12-11
Share Folder With View-Only Link . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12-13
Access Folders Shared with You . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12-14
Manage Shared Folder . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12-16
Sharing Limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12-19

Restore Deleted Files in MATLAB Drive Online . . . . . . . . . . . . . . . . . . . 12-21

Manage File Conflicts and Update Issues in MATLAB Drive . . . . . . . . . 12-22
File Update Issues . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12-22

Start and Stop MATLAB Drive Connector . . . . . . . . . . . . . . . . . . . . . . . . 12-23
Start MATLAB Drive Connector . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12-23
Pause and Resume Syncing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12-23
Stop MATLAB Drive Connector . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12-24

View MATLAB Drive Connector Status and Notifications . . . . . . . . . . . 12-25

Post-Installation Tasks
13

Configure the MATLAB Startup Accelerator . . . . . . . . . . . . . . . . . . . . . . . 13-2
Change When the MATLAB Startup Accelerator Runs . . . . . . . . . . . . . . . 13-2

xiv Contents



Startup and Shutdown

• “Start MATLAB on Windows Platforms” on page 1-2
• “Associate .mat Files with MATLAB” on page 1-4
• “Start MATLAB on Linux Platforms” on page 1-5
• “Start MATLAB on macOS Platforms” on page 1-6
• “Exit MATLAB” on page 1-8
• “Recovering Data After Abnormal Termination” on page 1-10
• “Crash Reporting” on page 1-11
• “When MATLAB Terminates Unexpectedly” on page 1-12
• “Specifying Java Startup Options” on page 1-13
• “MATLAB Startup Folder” on page 1-14
• “Commonly Used Startup Options” on page 1-17
• “Specify Startup Options” on page 1-18
• “Toolbox Path Caching in MATLAB” on page 1-21
• “Remove canberra-gtk-module and pk-gtk-module Messages” on page 1-23

1



Start MATLAB on Windows Platforms
Choose one of these ways to start MATLAB.

• “Select MATLAB Icon” on page 1-2
• “Call matlab from Windows System Command Line” on page 1-2
• “Call matlab from MATLAB Command Prompt” on page 1-2
• “Open File Associated with MATLAB” on page 1-3
• “Select MATLAB Executable from Windows Explorer Tool” on page 1-3

When you start MATLAB, it automatically adds the userpath folder to the search path. MATLAB also
reopens any desktop components that were open when you last shut down.

To customize startup, see “Specify Startup Options” on page 1-18.

The MATLAB startup folder is the folder you are in when you get the MATLAB prompt. To change the
default startup folder, see “MATLAB Startup Folder” on page 1-14.

If you have trouble starting MATLAB, then see “Installation and Licensing”.

Select MATLAB Icon
On Microsoft Windows platforms, double-click the MATLAB icon. With this option, the startup folder
is the last working folder from the previous MATLAB session or the custom path specified in the
Initial working folder preference. The Initial working folder preference is located in the General
Preferences page of the Preferences window.

You also can specify a custom startup folder in the MATLAB shortcut icon using the Start in field.
However, this technique is the same as setting a custom path in the Initial working folder
preference. If you enter an invalid path in the Start in field, then the startup folder is unpredictable.
To set a custom path in the Start in field:

1 Right-click the shortcut icon for MATLAB  and select Properties from the context menu. The
Properties dialog box for MATLAB opens to the Shortcut pane.

2 In the Start in field, type the full path to a folder on your system, and then click OK.

Call matlab from Windows System Command Line
From the Windows system prompt, type matlab.

The startup folder is the folder in which you run the matlab command. To use the folder specified by
the Initial working folder preference, type:

matlab -useStartupFolderPref

Call matlab from MATLAB Command Prompt
If you start another MATLAB session from within MATLAB, then the startup folder is folder where you
call the command:

!matlab

1 Startup and Shutdown
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To display the startup folder, type pwd before calling matlab.

Open File Associated with MATLAB
The MATLAB installer sets up associations between certain file types and MathWorks® products.
MATLAB starts when you open one of those files. The startup folder is the folder containing the file.

For example, using the Windows Explorer tool, double-click a file with a .m extension. MATLAB starts
and opens the file in the MATLAB Editor.

Select MATLAB Executable from Windows Explorer Tool
When you double-click the matlab.exe file from the Windows Explorer, the startup folder is one of
the following:

• The last working folder from the previous MATLAB session.
• The custom path specified in the Initial working folder preference.

See Also
matlab (Windows) | userpath | Preferences

More About
• “Specify Startup Options” on page 1-18
• “MATLAB Startup Folder” on page 1-14
• “Installation and Licensing”
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Associate .mat Files with MATLAB
To associate a .mat extension type with MATLAB, use Microsoft Windows Default Programs. For
information about using this option, see your Windows documentation.

By default, MATLAB associates the latest installed version to MATLAB file types. However, once you
use the Windows Control Panel or the file manager to associate a MATLAB version to a file type, you
must manually re-associate the type with each new installation of MATLAB. If you want to return to
the default behavior, then uninstall every MATLAB that is manually associated to any MATLAB file
type. Then reinstall the latest MATLAB release.

1 Startup and Shutdown
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Start MATLAB on Linux Platforms
To view supported Linux distributions, see Linux System Requirements.

To start MATLAB on Linux platforms, type matlab at the operating system prompt. If you did not set
up symbolic links in the installation procedure, then type matlabroot/bin/matlab. matlabroot is
the name of the folder in which you installed MATLAB. To see the folder, type matlabroot.

After starting MATLAB, the desktop opens. Desktop components that were open when you last shut
down MATLAB reopen. If the DISPLAY environment variable is not set or is invalid, then the desktop
does not display.

MATLAB automatically adds the userpath folder to the search path.

To customize startup, see “Specify Startup Options” on page 1-18.

The MATLAB startup folder is the folder you are in when you get the MATLAB prompt. To change the
default startup folder, see “MATLAB Startup Folder” on page 1-14.

If you have trouble starting MATLAB, then see “Installation and Licensing”.

Startup Folder
On Linux platforms, the default startup folder is the folder from which you started MATLAB.

To specify the userpath as the startup folder, set the value of the environment variable
MATLAB_USE_USERWORK to 1 before startup. By default, userpath is userhome/Documents/
MATLAB. To specify a different folder for userpath, and for other options, call the MATLAB
userpath function.

Execute MATLAB Script from Remote ssh Login
To execute a MATLAB script hello.m via a remote ssh login, in a terminal window type:

ssh local.foo.com matlab -nodisplay -nojvm < hello.m 

The ssh command pipes hello.m to MATLAB running on the remote host local.foo.com. The -
nodisplay option starts MATLAB without the desktop.

See Also
matlab (Linux) | userpath | matlabroot | Preferences

More About
• “Specify Startup Options” on page 1-18
• “MATLAB Startup Folder” on page 1-14
• “Installation and Licensing”
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Start MATLAB on macOS Platforms
To view supported macOS operating systems, see Mac System Requirements.

Choose one of these ways to start MATLAB.

• “Start from Applications Folder” on page 1-6
• “Start from Terminal Window” on page 1-6

When you start MATLAB, it automatically adds the userpath folder to the search path. MATLAB also
reopens any desktop components that were open when you last shut down.

To customize startup, see “Specify Startup Options” on page 1-18.

The MATLAB startup folder is the folder you are in when you get the MATLAB prompt. To change the
default startup folder, see “MATLAB Startup Folder” on page 1-14.

If MATLAB fails to start due to a problem with required system components such as Java® software,
then diagnostics run automatically. The software advises you of the problem and offers suggestions to
correct it. For information about other startup problems, see “Installation and Licensing”.

Start from Applications Folder
• Double-click the MATLAB icon in the matlabroot folder. Replace matlabroot with the name of

the folder in which you installed MATLAB.

The startup folder is the last working folder from the previous MATLAB session or the custom path
specified in the Initial working folder preference. The Initial working folder preference is located
in the General Preferences page of the Preferences window.

Start from Terminal Window
• To start from the Terminal window, you need to know the value of matlabroot, the full path to

the folder where MATLAB is installed. If you do not know the path, then open MATLAB from the
Applications folder, type matlabroot, and note the value. Exit MATLAB.

• Open a Terminal window.
• Navigate to the following location from your terminal window:

matlabroot/bin
• Start MATLAB.

./matlab

The startup folder is the MATLAB installation folder.

See Also
matlab (macOS) | userpath | matlabroot | Preferences

More About
• “Specify Startup Options” on page 1-18
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• “MATLAB Startup Folder” on page 1-14
• “Installation and Licensing”

 Start MATLAB on macOS Platforms
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Exit MATLAB

In this section...
“Ways to Quit or Exit” on page 1-8
“Confirm Exiting” on page 1-8
“Run Script When Exiting” on page 1-9

Ways to Quit or Exit
At any time, do one of the following:

• Click the close button  on the MATLAB desktop.
• Click  on the left side of the desktop title bar and select Close.
• Type quit or exit at the command prompt.

MATLAB closes after:

• Prompting you to confirm exiting on page 1-8, if that preference is specified.
• Prompting you to save any unsaved files
• Running a script when exiting on page 1-9, if the finish.m script exists in the current folder or

on the search path.

Confirm Exiting
To set a preference that displays a confirmation dialog box when you exit:

1 On the Home tab, in the Environment section, click  Preferences.
2 Select MATLAB > General > Confirmation Dialogs.
3 Select the Confirm before exiting MATLAB check box and click OK.

MATLAB then displays the following dialog box when you exit.

You can also display your own exit confirmation dialog box using a finish.m script, as described in
the following section.

1 Startup and Shutdown
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Run Script When Exiting
When MATLAB exits, it runs the script finish.m, if the file exists in the current folder or anywhere
on the search path. You create the script containing statements such as saving the workspace or
displaying a confirmation dialog box. For more information, see finish.

There are two sample files in matlabroot/toolbox/local that you can use as the basis for your
own finish.m file:

• finishsav.m — Includes a save function so the workspace is saved to a MAT-file.
• finishdlg.m — Displays a confirmation dialog box that allows you to cancel quitting.

See Also
exit | quit | finish | Preferences

More About
• “Recovering Data After Abnormal Termination” on page 1-10
• “Crash Reporting” on page 1-11
• “Installation and Licensing”
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Recovering Data After Abnormal Termination
If MATLAB terminates unexpectedly, then you might lose information. After you start MATLAB again,
you can try the following suggestions to recover some of the information. Some of these suggestions
refer to actions you need to take during the session before MATLAB terminates. If you did not take
those actions, then consider regularly performing them to help you recover from any future abnormal
terminations you might experience.

• Use the Command History or the file on which it is based, history.m, to run statements from the
previous session. You might be able to recreate data as it was before the termination.

• If you used the diary function or -logfile startup option for the session in which MATLAB
terminated unexpectedly, then you might be able to recover output.

• If you saved the workspace to a MAT-file during the session, then you can recover it by loading the
MAT-file.

• If you were editing a file in the Editor when MATLAB terminated unexpectedly, and you had the
backup feature enabled, then you should be able to recover changes you made to files you had not
saved. To recover, open the backup version filename.asv in the Editor. Then save it as
filename.m to use the last good version of filename.

• If you were in a Simulink® session when a segmentation violation occurred, and you have the
Simulink Autosave Options preference selected, then the last autosave file for the model reflects
the state of the autosave data before the segmentation violation. Because Simulink models might
be corrupted by a segmentation violation, a model is not autosaved after a segmentation violation
occurs. To recover the file, open the model.

See Also
diary | save | load

Related Examples
• “Save and Load Workspace Variables” on page 5-12
• “Save and Back Up Code”

More About
• “Commonly Used Startup Options” on page 1-17
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Crash Reporting
If MATLAB crashes, then the MathWorks Crash Reporter dialog box prompts you to send the crash
report to MathWorks. Doing so helps us improve our products. The crash report contains one or more
crash logs containing information on the stack trace and the MATLAB configuration. You can see the
entire contents of the crash report by clicking the Show Report button in the dialog box. This data,
along with information that you provide as reproduction steps, is the only information sent to
MathWorks.

Reproduction steps are most helpful if you know what appears to cause the crash, but any
information on what you were doing at the time helps our developers better understand the cause.

• If you do know the cause of the crash, then look for information about it in the MathWorks Bug
Reports database.

• If the problem is reproducible, then submit a Service Request at https://www.mathworks.com/
support/contact_us.html.

Locating Crash Logs
In some situations, The Crash Reporter does not open. For example, the Crash Reporter is
unavailable when you start MATLAB with the -batch option or run it in deployed mode. If you
experience abnormal termination, but do not see the Crash Reporter, then you can email the crash
logs to MathWorks instead at https://www.mathworks.com/support/contact_us.html. The crash logs
are files with the prefix matlab_crash_dump, java.log, or hs_err. To locate the logs, type one of
these commands in the MATLAB Command Window, replacing prefix with matlab_crash_dump,
java.log, and hs_err.

• On Windows platforms

dir(fullfile(tempdir,'prefix.*.*'))

Alternatively, open Windows Explorer and navigate to the %USERPROFILE%\AppData\Local\
folder.

• On Linux and macOS platforms

dir(fullfile('~','prefix.*'))

Alternatively on macOS, open a Finder window. Press Command+Shift+G to open the Go To
Folder dialog box and enter ~.

See Also
tempdir

More About
• “When MATLAB Terminates Unexpectedly” on page 1-12
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When MATLAB Terminates Unexpectedly
If MATLAB detects an internal error, then MATLAB displays one of two dialog boxes: the “MathWorks
Crash Reporter” on page 1-12 or the “MathWorks Crash Analyzer” on page 1-12. In both cases, the
internal state of MATLAB is unreliable and not suitable for further use.

MathWorks Crash Reporter
The MathWorks Crash Reporter provides an easy mechanism to send any relevant crash logs to
MathWorks Technical Support. If you click Send Report and provide a valid email address, then you
should receive an automated message within 5 minutes. If you want help, reply to the automated
message and a technical support agent will contact you.

If you do not receive an email, then you can directly contact Technical Support at https://
www.mathworks.com/support/contact_us.html.

MathWorks Crash Analyzer
When MATLAB terminates unexpectedly, MATLAB locally analyzes the crash report on your machine
to determine a potential cause. If there is a potential solution, MATLAB displays the MathWorks
Crash Analyzer dialog box. Click View Solution to open a web page in your browser that points to
the relevant MATLAB Answers™ page or MathWorks Bug Reports database. Follow the steps in the
solution. To apply a fix, you must restart MATLAB.

After viewing the solution, if you feel that it is not relevant, then click Send Report and enter
reproduction steps in the window.

If you apply the fix and still experience a crash, then click Send Report or create a Service Request
directly at https://www.mathworks.com/support/contact_us.html.

See Also

More About
• “Crash Reporting” on page 1-11
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Specifying Java Startup Options
You can specify custom Java startup options by creating a java.opts file, a text file containing one
option per line. For example, use the -Dproperty=value command to assign a value to a system
property.

Put the java.opts file in one of the following folders:

• MATLAB startup folder, if starting MATLAB from an operating system prompt. For more
information, see “MATLAB Startup Folder” on page 1-14.

• If there is no java.opts file in the startup folder, then MATLAB checks the matlabroot/bin/
arch folder. matlabroot is the output of the matlabroot function. arch is the output of the
MATLAB computer('arch') function, for example glnxa64.

A java.opts file in this location applies to all users, but individual users might not have
permissions to modify files there.

Do not use a java.opts file in the following situations:

• To enable the use of the Java debugger, use the matlab -jdb command. For information, see
matlab (Linux) or matlab (macOS).

• To adjust the Java heap size on desktop versions of MATLAB, use “Java Heap Memory
Preferences”.

• To modify the static Java class path, create a javaclasspath.txt file. For information, see
“Static Path of Java Class Path”.

To modify the library path, create a javalibrarypath.txt file. For information, see “Locate
Native Method Libraries”.

• To override built-in options that MATLAB specifies to Java at startup. Options in java.opts are
appended to the end of the built-in list. Whether these additional options override built-in options
is JVM-dependent and can change between Java versions. To see what options MATLAB provides
to Java, run this command:
java.lang.management.ManagementFactory.getRuntimeMXBean.getInputArguments

See Also
matlab (Linux) | matlab (macOS)

Related Examples
• “Java Heap Memory Preferences”
• “Static Path of Java Class Path”
• “Locate Native Method Libraries”

More About
• “MATLAB Startup Folder” on page 1-14
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MATLAB Startup Folder

Default Startup Folder
By default, MATLAB sets the startup folder based on the way you start MATLAB. To identify the
startup folder, type pwd at the command line immediately after starting MATLAB and before typing
any other commands. You can change the startup folder using the General Preferences options in
the Preferences Window. For convenience, make this folder a folder that you frequently use.

Note If a startup.m file changes the current folder, then this value overrides the initial working
folder value. Do not add cd statements to startup.m. For more information about user-defined
options, see startup.

Default Folder on Windows Platforms

How You Start MATLAB Startup Folder
Double-click the MATLAB icon on
your Windows desktop or in the Start
menu

Last working folder from the previous MATLAB session or the
custom path specified in the Initial working folder
preference. The Initial working folder preference is located
in the General Preferences page of the Preferences
window.

From a Windows system prompt Folder in which you run the matlab command (To use the
folder specified by the Initial working folder preference,
use the -useStartupFolderPref startup option.)

From the MATLAB command prompt Folder in which you run the !matlab command
Double-click a file type associated
with MATLAB

Folder containing the file

Double-click the matlab.exe
executable file from Windows
Explorer Tool

Last working folder from the previous MATLAB session or the
custom path specified in the Initial working folder
preference

For more information, see “Start MATLAB on Windows Platforms” on page 1-2.

If you start MATLAB by double-clicking the MATLAB shortcut icon and the startup folder is set to an
unexpected location, follow these steps to ensure that the Start in field in the MATLAB shortcut icon
is empty:

1 Right-click the shortcut icon for MATLAB  and select Properties from the context menu. The
Properties dialog box for MATLAB opens to the Shortcut pane.

2 If the Start in field contains text, clear the text.
3 Click OK and try starting MATLAB again.

1 Startup and Shutdown
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Default Folder on macOS Platforms

How You Start MATLAB Startup Folder
Double-click the MATLAB application Last working folder from the previous MATLAB session or the

custom path specified in the Initial working folder
preference, located in the General Preferences page of the
Preferences window

Start MATLAB from a Terminal
window

Folder in which you run the matlab command

For more information, see “Start MATLAB on macOS Platforms” on page 1-6.

Default Folder on Linux Platforms

On Linux platforms, the default startup folder is the folder from which you started MATLAB.

For more information, see “Start MATLAB on Linux Platforms” on page 1-5.

Change Startup Folder
Starting in R2014b, you can change the startup folder using the General Preferences options in the
Preferences Window. On the Home tab, in the Environment section, click Preferences. Select
MATLAB > General. Choose an option for the Initial working folder preference.

Alternatively on Windows platforms, specify the initial working folder in the MATLAB shortcut icon.
For more information, see “Select MATLAB Icon” on page 1-2.

userpath as Initial Working Folder
Using userpath as the Initial working folder value offers these benefits.

• You can store the MATLAB files you work with in one folder, such as Documents/MATLAB.
• You can always run your files because MATLAB automatically adds the userpath folder to the top

of the search path.
• The first time you run a new version of MATLAB, the software automatically creates the

userpath folder if it does not exist.
• When you upgrade to a newer version of MATLAB, the software automatically continues to use the

same startup folder and your existing files.
• The default userpath uses the benefits provided by the standard location in the Windows and

macOS environments for storing personal files. Files in the Documents/MATLAB folder are
available to you when you use other machines. Each user has an individual Documents/MATLAB
folder. Other users, even those using your machine, cannot access files in your Documents/
MATLAB folder.

See Also
startup | Preferences
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Related Examples
• “Start MATLAB on Windows Platforms” on page 1-2
• “Start MATLAB on macOS Platforms” on page 1-6
• “Start MATLAB on Linux Platforms” on page 1-5

1 Startup and Shutdown
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Commonly Used Startup Options
This table lists commonly used startup options for the matlab command. For a complete list of
options, refer to the input arguments for matlab (Windows), matlab (macOS), or matlab
(Linux).

Platform Option Description
All -c licensefile Set LM_LICENSE_FILE to licensefile. It can have the form

port@host.
All -h or -help Display startup options (without starting MATLAB).
All -logfile

"logfilename"
Automatically write output from MATLAB to the specified log file.

Windows
platforms

-minimize Start MATLAB with the desktop minimized. Any desktop tools or
documents that were undocked when MATLAB was last closed are not
minimized at startup.

macOS and
Linux
platforms

-nojvm Start MATLAB without loading the JVM™ software. This minimizes
memory usage and improves initial startup speed, but restricts
functionality. With nojvm, you cannot use the desktop, figures, or any
tools that require Java software.

For example, you cannot set preferences if you start MATLAB with the
-nojvm option. However, you can start MATLAB once without the -
nojvm option, set the preference, and quit MATLAB. MATLAB
remembers that preference when you start it again, even if you use the
-nojvm option.

All -nosplash Start MATLAB without displaying its splash screen.
All -batch "statement" Run the specified statement non-interactively.
All -r "statement" Run the specified statement interactively.
All -singleCompThread Limit MATLAB to a single computational thread. This option is for

numerical computations only.

On Windows systems, this option uses the multithreading capabilities of
the computer on which it is running by default.

For a complete list of options, refer to the input arguments for matlab (Windows), matlab
(macOS), or matlab (Linux).

See Also
matlab (Windows) | matlab (macOS) | matlab (Linux)
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Specify Startup Options

In this section...
“Startup Options from Operating System Prompt” on page 1-18
“Startup Options in Shortcut on Windows Systems” on page 1-18
“Startup Options in MATLAB Startup File” on page 1-19
“Passing Perl Variables on Startup” on page 1-19
“Startup and Calling Java Software from MATLAB” on page 1-19

Startup Options from Operating System Prompt
Startup options instruct MATLAB to perform certain operations when you start the program. Startup
options also are called command flags or command-line switches. When you start at the operating
system prompt, specify the options as arguments to the matlab command. For example, the following
starts MATLAB and suppresses the display of the splash screen.

matlab -nosplash

On Windows platforms, you can precede a startup option with either a hyphen (-) or a slash (/). For
example, -nosplash and /nosplash are equivalent.

Startup Options in Shortcut on Windows Systems
You can add selected startup options to the target path for your shortcut on the Windows platform for
MATLAB.

To use startup options for the MATLAB shortcut icon, follow these steps:

1 Right-click the shortcut icon for MATLAB  and select Properties from the context menu. The
Properties dialog box for MATLAB opens to the Shortcut pane.

2 In the Target field, after the target path for "matlab.exe", add the startup option, and click
OK.

This example runs the MATLAB results script or function after startup, where results.m is in the
startup folder or on the MATLAB search path. The text in the Target field is similar to the following:

"C:\Program Files\MATLAB\R2016b\bin\matlab.exe" -r "results"

Include the statement, but not the option (-r) in double quotation marks.

Use semicolons or commas to separate multiple statements. This example changes the format to
short, and then runs the MATLAB code file results:

"... matlab.exe" -r "format('short');results"

Separate multiple options with spaces. This example starts MATLAB without displaying the splash
screen, and then runs the MATLAB code file results:

"... matlab.exe" -nosplash -r "results"

1 Startup and Shutdown

1-18



Startup Options in MATLAB Startup File

The startup.m file is a file you create to specify startup options. Create the startup.m file in a
folder on the MATLAB search path. Use startup.m to modify the default search path, predefine
variables in your workspace, or define defaults for graphics objects. For example, the following
statement adds the user-defined folder /home/myname/mytools to the search path.

addpath /home/myname/mytools

To change the current folder on startup to mytools, set the Initial working folder value, located in
the General Preferences options in the Preferences window:

/home/myname/mytools

At startup, MATLAB automatically executes the matlabrc.m file and startup.m, if it exists on the
MATLAB search path. The file matlabrc.m, which is in the matlabroot/toolbox/local folder, is
reserved for use by MathWorks and by system administrators on multiuser systems. To locate the
startup.m file, type:

which startup

If MATLAB finds a startup.m file, then it displays the path to the file.

Note

MATLAB executes any file on the search path named startup that has an executable file extension.
Examples of an executable file extension are .m, .mlx, and .mlapp.

Passing Perl Variables on Startup
You can pass Perl variables to MATLAB on startup by using the -r option of the matlab function. For
example, assume a MATLAB function test that takes one input variable:

function test(x)

To pass a Perl variable instead of a constant as the input parameter, follow these steps. This command
starts MATLAB and runs test with the input argument 10.

1 Create a Perl script such as

 #!/usr/local/bin/perl
 $val = 10; 
 system('matlab -r "test(' . ${val} . ')"');

2 Invoke the Perl script at the prompt using a Perl interpreter.

For more information, see the -r option in matlab (Windows), matlab (macOS), or matlab
(Linux).

Startup and Calling Java Software from MATLAB
When MATLAB starts, it constructs the class path for Java software using javaclasspath.txt and
javalibrarypath.txt files. For more information, see “Java Class Path” and “Locate Native
Method Libraries”.
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For information about memory allocation for Java objects, see “Java Heap Memory Preferences”.

See Also
matlab (Windows) | matlab (macOS) | matlab (Linux) | Preferences

More About
• “Commonly Used Startup Options” on page 1-17
• “What Is the MATLAB Search Path?” on page 6-46
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Toolbox Path Caching in MATLAB

In this section...
“About Toolbox Path Caching in MATLAB” on page 1-21
“Using the Cache File Upon Startup” on page 1-21
“Updating the Cache and Cache File” on page 1-21

About Toolbox Path Caching in MATLAB
For performance reasons, MATLAB disables folder change detection for the matlabroot folder and
caches the folder information across sessions. The disabled folder change detection and caching
features are mostly transparent to you. However, if MATLAB does not see the latest versions of your
MATLAB code files or if you receive warnings about the path cache, then you might need to update
the cache.

Using the Cache File Upon Startup
Upon startup, MATLAB gets information from a cache file to build the matlabroot folder cache.
Because of the cache file, startup is faster, especially if you run MATLAB from a network server or if
you have many folders within the matlabroot folder. When you end a session, MATLAB updates the
cache file.

MATLAB does not use the cache file at startup if you clear the Enable toolbox path cache check
box in General Preferences page of the Preferences Window. Instead, it creates the cache by
reading from the operating system folders, which is slower than using the cache file.

Updating the Cache and Cache File
How the Toolbox Path Cache Works

MATLAB caches (essentially, stores in a known files list) the names and locations of files in the
matlabroot folder. This folder is for files provided with MathWorks products that should not change
except for product installations and updates. Caching those folders provides better performance
during a session because MATLAB does not actively monitor those folders.

We strongly recommend that you save any MATLAB code files you create and any files provided by
MathWorks that you edit in a folder that is not in the matlabroot folder tree. If you keep your files
in the matlabroot folder, then they might be overwritten when you install a new version of MATLAB.

When to Update the Cache

When you add files to the matlabroot folder, the cache and the cache file need to be updated.
MATLAB updates the cache and cache file automatically when you install toolboxes or toolbox
updates using the installer for MATLAB. MATLAB also updates the cache and cache file automatically
when you use MATLAB tools, such as when you save files from the MATLAB Editor to the
matlabroot folder.

When you add or remove files in the matlabroot folder by some other means, MATLAB might not
recognize those changes. For example, when you:
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• Save new files in the matlabroot folder using an external editor
• Use operating system features and commands to add or remove files in the matlabroot folder

and then attempt to use one of the new files, MATLAB displays this message:

Undefined function or variable

Update the cache so MATLAB recognizes the changes you made in the matlabroot folder.

Steps to Update the Cache

To update the cache and the cache file,

1 On the Home tab, in the Environment section, click  Preferences. Select MATLAB >
General.

2 Click Update Toolbox Path Cache and click OK.

Function Alternative

To update the cache, use rehash toolbox. To update both the cache and the cache file, use rehash
toolboxcache. For more information, see rehash.
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Remove canberra-gtk-module and pk-gtk-module Messages
On some Linux distributions, one or both of these messages appear in the terminal window when
starting MATLAB. These messages are informational and have no effect on MATLAB.

Gtk-Message: <timestamp>: Failed to load module "canberra-gtk-module"
Gtk-Message: <timestamp>: Failed to load module "pk-gtk-module"

To suppress these messages, open a terminal with root privileges and execute the relevant commands
to install the libcanberra Linux package.

Red Hat Distributions
On Red Hat distributions (including CentOS and Fedora®):

• Install the package.

yum install libcanberra-gtk2
• Set the GTK_PATH.

• sh or bash commands:

$ export GTK_PATH=/usr/lib64/gtk-2.0
• csh/tcsh commands:

% setenv GTK_PATH /usr/lib64/gtk-2.0

Debian-Based Distributions
On Debian®-based distributions (including Ubuntu®):

• Install the package.

apt-get install libcanberra-gtk-module
• Set the GTK_PATH.

• sh or bash commands:

$ export GTK_PATH=/usr/lib/x86_64-linux-gnu/gtk-2.0
• csh/tcsh commands:

% setenv GTK_PATH /usr/lib/x86_64-linux-gnu/gtk-2.0
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Desktop

• “Zoom and Change Desktop Fonts” on page 2-2
• “Change Desktop Colors” on page 2-7
• “Customize MATLAB Toolbars” on page 2-12
• “Change Desktop Layout” on page 2-14
• “Accessibility in MATLAB” on page 2-22
• “Use Keyboard Shortcuts to Navigate MATLAB” on page 2-28
• “Use a Screen Reader in MATLAB Online” on page 2-33
• “Customize Keyboard Shortcuts” on page 2-42
• “Set Print Options for Command Window and Editor” on page 2-47
• “Web Browsers and MATLAB” on page 2-50
• “Manage Your Licenses” on page 2-54
• “Update an Existing Installation” on page 2-58
• “macOS Platform Conventions” on page 2-59
• “Where MATLAB Stores Preferences” on page 2-61
• “Import Preferences From Other Releases” on page 2-62
• “Web Preferences” on page 2-64
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Zoom and Change Desktop Fonts

You can change the zoom level, font size, name, and style used by tools in MATLAB. You also can
install new fonts to use with MATLAB.

Zoom
You can change the zoom level in the Editor, Live Editor, and Help browser. To zoom in and out, hold
the Ctrl key and move the scroll wheel. On macOS systems, use the Command key instead.

Alternatively, you can zoom in and out using the available keyboard shortcuts.

Action Keyboard Shortcut
Zoom in Ctrl+Plus

On macOS systems, use Command+Shift+Plus.
Zoom out Ctrl+Minus

On macOS systems, use Command+Shift
+Minus.

Reset Zoom

(Not supported in Help browser)

Ctrl+Alt+0

On macOS systems, use Command+Alt+0.

Alternatively, you can change the zoom level in the Editor and Live Editor by going to the View tab

and selecting  Zoom In,  Zoom Out, or  Reset Zoom.

In MATLAB Online™, to change the zoom level, adjust the zoom settings for your web browser.

Change Font Size
You can change the font size in MATLAB using preferences or settings. This table describes how to
change the font size for each tool.

Tool Procedure
Live Editor Specify the font size for code and text

programmatically using settings. For example,
this code changes the code font size in the Live
Editor.

s = settings;
s.matlab.fonts.editor.code.Size.TemporaryValue = '26pt'

For more information, see matlab.fonts Settings.
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Tool Procedure
Code tools

• Editor
• Command Window
• Command History

Specify the font size using font preferences.

On the Home tab, in the Environment section,
click  Preferences. Select MATLAB > Fonts
and, in the Desktop code font section, select a
font size.

Text-based tools

• Current Folder browser
• Workspace browser
• Variables editor

Specify the font size using font preferences.

On the Home tab, in the Environment section,
click  Preferences. Select MATLAB > Fonts
and in the Desktop text font section, clear the
Use system font check box. Then, select a font
size.

Charts See “Add Title and Axis Labels to Chart”.

In MATLAB Online, to change the font size, in the Preferences window, go to MATLAB >
Appearance > Fonts. Changing the font size is only supported for the Editor, Live Editor, Command
Window, and Command History.

Change Font Name and Style
You can change the font name and style in MATLAB using several different methods, depending on
the tool. This table describes how to change the font name and style for each tool in MATLAB.

Tool Procedure
Live Editor Specify the font name and style for code and text

programmatically using settings. For example,
this code changes the font name and style of
normal text in the Live Editor.

s = settings;
s.matlab.fonts.editor.normal.Name.PersonalValue = 'Calibri';
s.matlab.fonts.editor.normal.Style.PersonalValue = {'bold'};

For more information, see matlab.fonts Settings.
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Tool Procedure
Code tools

• Editor
• Command Window
• Command History

Specify the font name and style using font
preferences.

On the Home tab, in the Environment section,
click  Preferences. Select MATLAB > Fonts
and, in the Desktop code font section, select a
font name and style.

By default, the code font is set to monospaced to
preserve vertical alignment. When the font is set
to monospaced, the actual displayed font in the
Editor is different than the font displayed in the
Command Window and Command History. This is
because monospaced is a logical font, not a
physical font. To avoid this discrepancy, specify
the font name as a physical font, for example,
Courier New.

Text-based tools

• Current Folder browser
• Workspace browser
• Variables editor

Specify the font name and style using font
preferences.

On the Home tab, in the Environment section,
click  Preferences. Select MATLAB > Fonts
and, in the Desktop text font section, clear the
Use system font check box. Then, select a font
name and style. By default, the text font is set to
your system font.

Help Browser

MATLAB web browser

Changing the font name and style is not
supported.

In MATLAB Online, to change the font name and font style, in the Preferences window, go to
MATLAB > Appearance > Fonts. Changing the font size is only supported for the Editor, Live
Editor, Command Window, and Command History.

To apply antialiasing and create a smoother desktop appearance on Linux systems, select Use
antialiasing to smooth desktop fonts. You must restart MATLAB for the preference to take effect.
On Microsoft Windows and macOS platforms, MATLAB uses system setting for antialiasing.

Advanced Customization

You can further customize fonts in MATLAB by changing the font preferences for an individual tool.
To change the font preferences, on the Home tab, in the Environment section, click 
Preferences. Select MATLAB > Fonts > Custom and choose a tool from the list of Desktop tools.
Then, select the font to use:

• Desktop code — Select this option to use the desktop code font for this tool.
• Desktop text — Select this option to use the desktop text font for this tool.
• Custom — Select this option to specify a custom font for this tool. Then, specify a font name,

style, and size. Some options are not supported for all tools.
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For example, to change the Editor font to a custom font, in the list of Desktop tools, select Editor.
Then, in the Font to use section, select Custom and specify the desired font name, style, and size.

In MATLAB Online, setting custom font preferences is only supported for the Editor, Command
Window, and Command History.

To change the font name and style of code and text for the Live Editor, use settings. For more
information, see matlab.fonts Settings.

Default Font Preferences

This table shows the default font preferences for the tools in MATLAB. You can use this table to
restore fonts to their original state.

Tool Font to Use Default Font
Command History Desktop code Monospaced, plain, 10 point

When the font is set to monospaced,
the actual displayed font in the
Editor is different than the font
displayed in the Command Window
and Command History. This is
because monospaced is a logical
font, not a physical font. To avoid
this discrepancy, specify the font
name as a physical font, for
example, Courier New.

Command Window
Editor (and Shortcuts Editor)

Current Folder browser (and Path
browser)

Desktop text Your system's current font

Workspace browser
Variables editor
Function Browser
Profiler Custom Sans serif, plain, 10 point

Add New Font
You can install new fonts to use with MATLAB. A common reason to install additional fonts is to read
files created in different languages. For details on adding fonts to your system, refer to the
documentation for your system.

Choose a new font that is compatible with MATLAB. MATLAB only includes compatible fonts in the
font preferences.

• For desktop components (such as the Command Window), figure windows, and uicontrols, fonts
must be compatible with TrueType and Microsoft OpenType® fonts

• For graphics objects, such as xlabel, ylabel, title, and text, fonts must be TrueType and
Microsoft OpenType fonts

Install your new font in a location where MATLAB looks for fonts. MATLAB looks for fonts in these
locations:
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• The operating system's standard location (see your system administrator for details)
• The /jre/lib/fonts folder where Java software is installed on your system

If you install a font with MATLAB running, restart MATLAB to include the font in the font
preferences.

Then, to use the new font, follow the instructions in “Change Font Name and Style” on page 2-3.

See Also
Preferences

Related Examples
• “Add Title and Axis Labels to Chart”
• “Change Desktop Colors” on page 2-7
• “Set Print Options for Command Window and Editor” on page 2-47
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Change Desktop Colors

You can change the colors used by tools in MATLAB, including the text and background colors, syntax
highlighting colors, and output colors. In MATLAB Online, you also can use themes to change the
colors of the MATLAB desktop, for example, by selecting a dark theme. For more information, see
“Select Theme in MATLAB Online” on page 2-10.

Change Text and Background Colors
By default, the tools in the MATLAB desktop environment use the same text and background colors
that your system uses in other applications. You can change the text and background colors for
certain desktop tools, including the Editor, Live Editor, Command Window, Current Folder browser,
Workspace browser, and Import Wizard.

To change the text and background colors:

1 On the Home tab, in the Environment section, click  Preferences.
2 Select MATLAB > Colors.

In MATLAB Online, select MATLAB > Appearance > Colors.
3 In the Desktop tool colors section, clear the Use system colors check box.

In MATLAB Online, the Use system colors check box is not available and this step can be
skipped.

4 Use the Text and Background fields to change the colors. For example, select white for the text
color and black for the background color.

The Syntax Highlighting sample and Command Window sample areas show a preview of the
selected colors.

To restore the default text and background colors, click the Restore Default Colors button at
the bottom of the Preferences window.

The Live Editor automatically selects colors for titles and headings based on the selected background
color. To further customize the colors of titles and headings, use settings. For more information, see
matlab.fonts Settings.

Changing the text and background colors does not change the colors of the toolstrip or Help browser.
In MATLAB Online, changing the text and background colors also does not change the colors of the
Workspace panel.

 Change Desktop Colors

2-7



Change Syntax Highlighting Colors

MATLAB conveys syntax information in code using different colors. This feature, known as syntax
highlighting, helps you to identify syntax elements, such as if/then/else statements, at a glance.
Syntax highlighting appears in code files, in code you enter in the Command Window, and in error
and warning messages. It does not appear in other kinds of output.

To change the colors used for syntax highlighting in MATLAB code:

1 On the Home tab, in the Environment section, click  Preferences.
2 Select MATLAB > Colors.

In MATLAB Online, select MATLAB > Appearance > Colors.
3 In the MATLAB syntax highlighting colors section, use the Keywords, Comments, Strings,

Unterminated strings, System commands, Syntax errors, and Validation sections fields to
change the colors. For example, select magenta for the strings color and purple for the
unterminated strings color.

The Syntax highlighting sample area shows a preview of the selected colors.

To restore the default syntax highlighting colors, click the Restore Default Colors button at the
bottom of the Preferences window.

To disable syntax highlighting, in the Preferences window, select MATLAB > Editor/Debugger >
Language. Then, in the Syntax highlighting section, clear the Enable syntax highlighting check
box. In MATLAB Online, this option is located under MATLAB > Editor/Debugger > MATLAB
Language.

The Editor also provides syntax highlighting for other languages. To change the syntax highlighting
colors for other languages, in the MATLAB > Editor/Debugger > Language Preferences window,
select a language in the Language field. Then, change the colors for that language. To disable syntax
highlighting for the language, clear the Enable syntax highlighting check box. In MATLAB Online,
these options are located under MATLAB > Editor/Debugger > Other Languages.

For more information about syntax highlighting, see “Check Syntax as You Type” on page 3-20.

Change Output Colors
MATLAB uses different colors to identify errors, warnings, and links in Command Window and Live
Editor output.
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To change the colors used for errors, warnings, and links in output:

1 On the Home tab, in the Environment section, click  Preferences.
2 Select MATLAB > Colors.

In MATLAB Online, select MATLAB > Appearance > Colors.
3 In the MATLAB output colors section, use the Error text, Warning text, and Hyperlinks in

Command Window fields to change the colors. For example, select magenta for error text and
green for warning text.

The Command Window sample area shows a preview of the selected colors.

To restore the default output colors, click the Restore Default Colors button at the bottom of
the Preferences window.

Change Programming Tools Colors

In the Editor and Live Editor, MATLAB uses additional colors to identify Code Analyzer messages,
variables, and functions. To change these colors, go to the Home tab, and in the Environment
section, click  Preferences. Then, select MATLAB > Colors > Programming Tools. In MATLAB
Online, select MATLAB > Appearance > Colors > Programming Tools.

Code Analyzer Colors

To change the colors used to identify Code Analyzer messages in the Editor and Live Editor, in the
Code analyzer colors section, select colors from the Warnings and Autofix highlight fields. To
disable highlighting autofixes in the Editor and Live Editor, clear the Autofix highlight check box.

For more information about using the Code Analyzer, see “Check Code for Errors and Warnings Using
the Code Analyzer”.

Variable and Function Colors

When you select a variable or function in the Editor or Live Editor, MATLAB highlights all
occurrences of that specific variable or function. To change the color of this highlight, in the Variable
and function colors section, select a color from the Automatically highlight field. To disable
automatic highlighting in the Editor and Live Editor, clear the Automatically highlight check box.
For more information about automatic highlighting, see “Find and Replace Functions or Variables in
Current File”.

MATLAB also uses text of a different color to call out variables with shared scope in the Editor and
Live Editor. To change the color of variables with shared scope, in the Variable and function colors
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section, select a color from the Variables with shared scope field. To disable calling out variables
with shared scope in the Editor and Live Editor, clear the Variables with shared scope check box.
For more information about variables with shared scope, see “Check Variable Scope in Editor”.

Select Theme in MATLAB Online
In MATLAB Online, you also can use themes to change the colors of the MATLAB desktop. Themes
are not supported in an installed version of MATLAB.

Windows and macOS systems support light and dark color schemes. By default, MATLAB Online is
configured to match the current operating system color scheme using the system theme. If the
selected color scheme for the operating system changes, the colors of the MATLAB desktop change to
match the new scheme.

To change the selected theme, on the Home tab, in the Environment section, click  Preferences.
Select MATLAB > Appearance and select a theme from the Theme field. For example, select Dark
to select a dark theme or System to select a theme that matches the current operating system
scheme.

The MATLAB Appearance Preferences page shows a preview of the selected theme.

After selecting a theme, you can further customize the colors of the MATLAB desktop by selecting
MATLAB > Appearance > Colors and changing the colors in the Desktop tool colors, MATLAB
syntax highlighting colors, and MATLAB output colors sections.

Note  MATLAB does not save color customizations when the theme changes. If you select a new
theme or the theme changes to match a modification to the operating system color scheme, MATLAB
reverts to using the default colors for that theme and your customizations are lost. To avoid
unexpectedly losing color customizations when the operating system color scheme changes, select
the Light or Dark option from the Theme field before making any color customizations.
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See Also
matlab.fonts | Preferences

Related Examples
• “Zoom and Change Desktop Fonts” on page 2-2
• “Set Print Options for Command Window and Editor” on page 2-47
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Customize MATLAB Toolbars
In MATLAB, you can change the location of the quick access and the Current Folder toolbars. You also
can choose which controls appear in the toolbars.

Quick Access Toolbar
The quick access toolbar provides access to frequently used operations. This toolbar is always visible,
even when you navigate between different MATLAB toolstrip tabs.

By default, the quick access toolbar is located at the upper-right corner of the MATLAB desktop. To
change the location of the quick access toolbar, on the Home tab, in the Environment section, click
Layout, and then select an option for the Quick Access Toolbar. Moving the quick access toolbar is
not supported in MATLAB Online.

To add a toolstrip control to the quick access toolbar, right-click the control and then select Add to
Quick Access Toolbar. You also can select from a list of common controls by going to the quick
access toolbar and clicking the  button. To remove a control from the quick access toolbar, right-
click the control and select Remove from Quick Access Toolbar. To arrange controls in the quick
access toolbar, drag them to the desired locations.

To further customize the quick access toolbar, click the  button on the toolbar and select
Customize Toolbar. Then, select from the options described in “Toolbar Preferences” on page 2-12.

Current Folder Toolbar
You can use the Current Folder toolbar to view and change the current folder.

By default, the Current Folder toolbar is located under the toolstrip. To change the location of the
Current Folder toolbar, on the Home tab, in the Environment section, click Layout, and then select
an option for the Current Folder Toolbar. Moving the Current Folder toolbar is not supported in
MATLAB Online.

To add, remove, or rearrange the controls that appear in the Current Folder toolbar, right-click the
toolbar and select Customize. Then, select from the options described in “Toolbar Preferences” on
page 2-12.

Toolbar Preferences

You can customize the quick access and Current Folder toolbars using the Toolbar preferences. To
open the Toolbar preferences, go to the Home tab, and in the Environment section, click 
Preferences. Select MATLAB > Toolbars and in the Toolbar section, select the toolbar that you
want to customize.

To rearrange controls in the selected toolbar, in the Layout section, drag the icon for a control or
separator bar to a new location. You also can select a control icon or separator bar and then use the
buttons below the control icons to move the selected control. For example, to move the MATLAB
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desktop Cut button to the beginning of the quick access toolbar, select the Cut icon , and then click
the  button.

To add or remove controls from the selected toolbar, select or clear the check box for those controls.
For example, to easily create new folders in the current folder, you can add a New Folder button to
the Current Folder toolbar. To do so, select the  Folder button and click OK. MATLAB adds the
button to the toolbar.

See Also
Preferences

More About
• “Rerun Favorite Commands” on page 3-14
• “Use Keyboard Shortcuts to Navigate MATLAB” on page 2-28
• “Customize Keyboard Shortcuts” on page 2-42
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Change Desktop Layout

When you start MATLAB, the desktop appears in its default layout.

By default, the desktop includes these tools:

Tool Position Description
Toolstrip Top of desktop By default, the toolstrip includes three tabs,

Home, Plots, and Apps.
Current Folder Toolbar Top of desktop

underneath toolstrip
View and change the current folder.

Current Folder Browser Left side of desktop Manage files and folders in MATLAB. Actions
include viewing, creating, opening, moving, and
renaming files and folders in the current folder.

Workspace Browser Right side of desktop View and manage the contents of the workspace
in MATLAB.

In MATLAB Online and on systems with a lower
screen resolution, MATLAB defaults to a two-
column layout with the Workspace panel on the
left side of the desktop, underneath the Files
panel.

Command Window Middle of desktop Enter individual statements at the command line
and view the resulting output.
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To change the desktop layout, you can choose from a set of preconfigured desktop layouts or you can
create your own layout by hiding, minimizing, and undocking individual tools. You also can change
the layout of documents within a tool by undocking, reordering, or tiling them. Then, you can save
your layouts and reuse them again at a later time.

In MATLAB Online, you also can use the sidebars on either side of the desktop to access desktop tools
and change the desktop layout. The sidebars show the tools, such as the Workspace panel and the
Files panel, that are docked on either side of the desktop. If there are no tools docked on one side,
the sidebar for that side is hidden. You can use the sidebars to show and hide tools, group them
together, and move them from one location to another.

Select Preconfigured Layout
MATLAB provides a set of preconfigured desktop layouts that are optimized for certain workflows. To
select a preconfigured layout, on the Home tab, in the Environment section, click Layout and select
a layout. To restore the MATLAB desktop to its default layout, select Default.

For example, if you work mostly in the Command Window, select the All but Command Window
Minimized option (Command Window Only in MATLAB Online) to maximize the Command Window
and minimize all other tools in the desktop.
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Hide Tools
To hide a tool, click the  button on the title bar of a tool and select Close. You also can close some
tools by going to the Home tab, and in the Environment section, clicking the Layout button. Then,
in the Show section, clear one or more of the options in the list. To hide just the title bar for all tools,
clear the Panel Titles option.

In MATLAB Online, to hide a tool, click its icon in the sidebar. You also can hide some tools by going
to the Home tab, and in the Environment section, clicking the Layout button. Then, in the Layout
Options section, clear one or more of the options in the list. You also can optimize your desktop
layout by minimizing tools.

Minimize Tools
Minimize tools in the desktop to optimize the layout while still maintaining quick access to tools that
you use periodically.

To minimize the toolstrip, at the lower right corner of the toolstrip, click the  button. The toolstrip
minimizes but the tabs remain visible. To restore the toolstrip, select one of the tabs to display the
toolstrip, and then, in the lower right corner of the toolstrip, click the  button.
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To minimize other tools including the Current Folder browser, Command Window, Editor, and Live
Editor, on the title bar of the tool, click the  button and select Minimize. The minimized tool
appears along the edge of the desktop indicated by the arrow in the Minimize icon. For example, the
minimize icon  indicates that the tool minimizes to the right edge of the desktop by default. To
move a minimized tool to a different edge of the desktop, drag the tools to the desired location.

For example, to minimize the Current Folder browser, at top right of the Current Folder browser, click
the  button and select Minimize. The Current Folder browser minimizes to the left side of the
screen.

To open a minimized tool temporarily on the desktop, click the tool. To restore the tool to its original
size, double click the tool. Alternatively, you can click the  button and select Restore.

In MATLAB Online, to minimize a tool, click its icon in the sidebar. For example, if the MATLAB
Online desktop is in the default layout with the Files panel and Workspace panel open in the left
sidebar, you can hide both tools by clicking the icon group for the two tools. If the left or right sidebar
contains multiple tools, you can minimize an individual tool by clicking the Collapse  button to the
left of its title bar.
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Open Tools
To open tools that you previously hid, on the Home tab, in the Environment section, click Layout.
Then, in the Show section, select the desktop tool that you want to show on the desktop.

You also can open some tools programmatically using a function. For example, to open the Editor, use
the edit function. To open the Workspace browser, use the workspace function.

Undock Tools and Documents

Undock tools to open them in a separate window and move them outside the MATLAB desktop. To
undock a tool, on the title bar of the docked tool, click the  button and select Undock. Alternatively,
drag the tool by its title bar to a new location outside of the MATLAB desktop. To move an undocked
tool back into the desktop, at the upper right of the undocked tool, click the  button, and select
Dock.

You also can undock individual documents within a tool such as an individual script file open in the
Editor. To undock an individual document, right-click the document tab and select Undock.
Alternatively, you can click the  button on the title bar of the tool and select Undock document.

For example, if you have the file fact.m open in the Editor, to undock just that file, on the title bar of
the Editor, click the  button and select Undock fact.m. MATLAB opens fact.m in a separate
window and leaves the Editor docked in the desktop. To move the file back into the desktop, at the
top right of the undocked file, click the  button and select Dock. If you have multiple undocked
documents and want to move them all back into the desktop, select Dock All in tool.
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Undocked tools and documents appear on the Windows task bar, or the equivalent for your platform.
Click the task bar icon for a tool or document to make it active.

In MATLAB Online, undocking tools and documents is not supported.

Reorder and Tile Documents

When you open MATLAB documents, they open in the associated tool, such as the Editor, Live Editor,
or Variables editor. Individual documents open as separate tabs within the tool. To optimize the layout
of multiple documents, you can reorder or tile them. You also can change where the tabs appear
within a tool.

By default, the tabs appear at the top of the document. To reorder individual document tabs within a
tool, drag the tabs to a different position. To reorder document tabs alphabetically, on the View tab,
in the Document Tabs section, select Alphabetize. In MATLAB Online, to alphabetize document
tabs, on the title bar of the tool, click the  button and select Alphabetize.

To change the position of the tabs in a tool, on the View tab, click Tabs Position and select from the
available options. For example, to display tabs on the side of the Editor instead of at the top, with the
Editor open, go to the View tab, click Tabs Position, and select Left. MATLAB displays the Editor
tabs of the left side of the tool. In MATLAB Online, to change the position of the tabs in a tool, click
the  button, select Tab Position, and select from the available options.
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To view multiple documents at once in a tool, you can tile the documents. To tile documents in the
Editor, Live Editor, and Variables editor, go to the View tab and in the Tiles section, select a tile

option. For example, to view two files side by side in the Editor, go to the View tab and select the 
Left/Right button. In MATLAB Online, to tile documents, on the title bar of the tool, click the 
button, select Tile All, and then select a tile option.

To move a tiled document, drag the document tab to another tile. If you drag it to a tile that already
contains a document, the document you are dragging covers up the other document.

To tile documents in a Figure panel, Help browser, or web browser, on the right side of the title bar of
the tool, select the , , , or  option button.
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Save Desktop Layouts
When you end a session, MATLAB saves the current desktop layout. The next time that you start
MATLAB, the desktop appears as you left it.

If you alternate between two or more customized desktop layouts, you can save them all to easily
switch between them. To save a layout, on the Home tab, in the Environment section, click Layout,
and select Save Layout (or Save Current Layout in MATLAB Online). MATLAB stores all saved
layouts in the preferences folder. MATLAB saves the current desktop layout at the end of a session in
the file MATLABDesktop.xml.

To use a saved layout, on the Home tab, click Layout, and select your saved layout. To delete or
rename saved layouts, select Organize Layouts. In MATLAB Online, right-click the layout and select
Delete or Rename from the context menu.

Some tools, such as the Help browser, web browser, and Variables editor, do not reopen automatically,
even if they were open when you ended the last session. You can use startup options to specify tools
that you want to open on startup. For more information, see “Specify Startup Options” on page 1-18.

See Also
Preferences

Related Examples
• “Customize MATLAB Toolbars” on page 2-12
• “Zoom and Change Desktop Fonts” on page 2-2
• “Change Desktop Colors” on page 2-7
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Accessibility in MATLAB
MATLAB provides several features to help make it accessible to users. To navigate MATLAB using just
a keyboard, you can use keyboard shortcuts. In MATLAB Online, you can use a screen reader and a
keyboard to interact with the different tools in MATLAB. Finally, to make the desktop more visible,
you can zoom in, change its colors, or increase the clarity of plots.

For our best accessibility support, use MATLAB Online. MathWorks is committed to improving the
accessibility of its software products, focusing first on the accessibility of MATLAB Online. See our
Accessibility Statement for MATLAB for the latest information on accessible workflow support.

Navigate Using the Keyboard
You can use keyboard shortcuts to navigate MATLAB with just a keyboard. Navigating with a
keyboard differs depending on whether you are using MATLAB Online or an installed version of
MATLAB.

In MATLAB Online, to move forward through the different areas of the MATLAB Online desktop, press
Ctrl+F6. To move backward, press Ctrl+Shift+F6. On macOS systems, use the Command key
instead of the Ctrl key. To display a list of navigational keyboard shortcuts, press Ctrl+/.

In an installed version of MATLAB, to move forward through the different areas of the MATLAB
desktop, press Ctrl+Tab. To move backward, press Ctrl+Shift+Tab. To select a toolstrip tab, press
Alt to show the access keys for the tabs and then <character> to select the tab, where
<character> is the displayed access key for the desired tab. After selecting a tab, press
<character> to select an item on the tab, where <character> is the displayed access key for the
desired toolstrip item. Accessing the toolstrip using keyboard shortcuts in an installed version of
MATLAB is not supported on macOS.

For more information, see “Use Keyboard Shortcuts to Navigate MATLAB” on page 2-28.

Work with a Screen Reader
In MATLAB Online, you can use a screen reader and a keyboard to interact with the Command
Window, create and edit scripts and functions in the Editor, and navigate through the different areas
of the MATLAB desktop. MATLAB Online is tested with the NVDA screen reader on Windows 10
running MATLAB Online in the Google Chrome® browser. For more information about NVDA, see Get
Help on the NV Access website.

For example, on a Windows system with the NVDA screen reader and MATLAB Online running, enter
individual statements in the Command Window.

1 With the cursor in the Command Window, create a variable named x by entering this statement
in the Command Window.

x = 1

MATLAB adds x to the workspace and displays the results in the Command Window. You hear:

Greater greater
X equals one

When you hear Greater greater, the Command Window is ready for the next statement at the
command-line prompt (>>).
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2 Create another variable y by entering the following statement in the Command Window.

y = cos(x)

You hear the results:

Y equals zero point five four zero three
3 Clear all text from the Command Window by entering the following statement in the Command

Window.

clc

You hear:

Greater greater

The Command Window is ready for the next statement.

For more information, see “Use a Screen Reader in MATLAB Online” on page 2-33.

Zoom
You can adjust the zoom level in MATLAB. The way you zoom differs depending on whether you are
using MATLAB Online or an installed version of MATLAB.

In MATLAB Online, you can zoom in and out of the entire desktop by adjusting the zoom settings for
your web browser.

In an installed version of MATLAB, you can change the zoom level in the Editor, Live Editor, and Help
browser. To zoom in and out, hold the Ctrl key and move the scroll wheel. On macOS systems, use the
Command key instead.

Alternatively, you can zoom in and out using the available keyboard shortcuts.

Action Keyboard Shortcut
Zoom in Ctrl+Plus

On macOS systems, use Command+Shift+Plus
Zoom out Ctrl+Minus

On macOS systems, use Command+Shift
+Minus

Reset Zoom

(Not supported in Help browser)

Ctrl+Alt+0

On macOS systems, use Command+Alt+0

For tools such as the Command Window, Current Folder browser, and Workspace browser, you can
increase or decrease the displayed font size using font preferences. For more information, see “Zoom
and Change Desktop Fonts” on page 2-2.

Maximize Focus Area When Zooming

To maximize the space for your current area of focus when zooming, minimize the tools that you are
currently not using. In MATLAB Online, to minimize a tool, click its icon in the sidebar. For example,
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if the MATLAB Online desktop is in the default layout with the Files panel and Workspace panel open
in the left sidebar, you can hide both tools by clicking the icon group for the two tools. If the left or
right sidebar contains multiple tools, you can minimize an individual tool by clicking the Collapse 
button to the left of its title bar.

In an installed version of MATLAB, to minimize tools such as the Current Folder browser, Command
Window, Editor, and Live Editor, on the title bar of the tool, click the action menu button  and select
Minimize. For example, to minimize the Current Folder browser, at top right of the Current Folder
browser, click the action menu button  and select Minimize.

For more information about minimizing tools, see “Change Desktop Layout” on page 2-14.

Change MATLAB Desktop Colors
You can change the text and background colors for certain desktop tools in MATLAB, including the
Editor, Command Window, Current Folder browser, Workspace browser, and Import Wizard.

To change the text and background colors:

1 In the Command Window, type preferences Colors to open the Preferences window with the
MATLAB Colors Preferences page selected.

2 In the Desktop tool colors section, clear the Use system colors check box.

In MATLAB Online, the Use system colors check box is not available and this step can be
skipped.

3 Use the Text and Background fields to change the colors. For example, select white for the text
color and black for the background color.

The Syntax Highlighting sample and Command Window sample areas show a preview of the
selected colors.
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To restore the default text and background colors, click the Restore Default Colors button at the
bottom of the Preferences window.

In MATLAB Online, you also can use themes to change the colors of the MATLAB desktop.

To select a theme:

1 In the Command Window, type preferences Appearance to open the Preferences window
with the MATLAB Appearances Preferences page selected.

2 Select a MATLAB Theme. For example, select a dark theme.

For more information about the different ways to change the desktop colors in MATLAB, see “Change
Desktop Colors” on page 2-7.

Increase Clarity of Plots
You can increase the clarity of plots in MATLAB by changing the color and size of markers, lines, and
text within the plots. To change the color and size of markers, lines, and text, modify the properties of
the plot. The list of properties for a plot depends on the object type it creates. For more information,
see the documentation for the plot function you are using.

For example, create a plot with two lines.

x = linspace(-2*pi,2*pi);
y1 = sin(x);
y2 = cos(x);
p = plot(x,y1,x,y2);
title("2-D Line Plot")
legend("Line 1","Line 2")

Add contrast between the two lines and make them more visible using the LineWidth, Marker,
MarkerEdgeColor, and MarkerSize properties. For more information, see Line Properties.
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p(1).LineWidth = 2;
p(1).Marker = "*";
p(1).MarkerEdgeColor = "b";
p(1).MarkerSize = 8;

p(2).LineWidth = 3;

You also can use the fontsize function to change the font size for objects in a plot. For example,
increase the font size of the title, legend, and axes labels in the plot until they are more easily
readable.

fontsize(gcf,"increase")
fontsize(gcf,"increase")
fontsize(gcf,"increase")

2 Desktop

2-26



See Also
matlab.fonts

Related Examples
• “Use Keyboard Shortcuts to Navigate MATLAB” on page 2-28
• “Use a Screen Reader in MATLAB Online” on page 2-33
• “Zoom and Change Desktop Fonts” on page 2-2
• “Change Desktop Colors” on page 2-7
• Accessibility Statement for MATLAB
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Use Keyboard Shortcuts to Navigate MATLAB
Using keyboard shortcuts to navigate MATLAB can increase productivity and is useful in situations
where using a mouse is not an option.

Installed MATLAB
If you have MATLAB installed on your system, this table describes the actions and related keyboard
shortcuts useful for navigating MATLAB without a mouse.

Action Keyboard Shortcut
Move to the next visible panel. Ctrl+Tab
Move to the previous visible panel. Ctrl+Shift+Tab
Move to the next tab in a panel. Ctrl+Page Down
Move to the previous tab in a panel. Ctrl+Page Up
Make an open tool the active tool. • Command Window: Ctrl+0

• Command History: Ctrl+1
• Current Folder: Ctrl+2
• Workspace: Ctrl+3
• Profiler: Ctrl+4
• Figure Palette: Ctrl+6
• Plot Browser: Ctrl+7
• Property Editor: Ctrl+8
• Editor: Ctrl+Shift+0
• Figures: Ctrl+Shift+1
• Web browser: Ctrl+Shift+2
• Variables Editor: Ctrl+Shift+3
• Comparison Tool: Ctrl+Shift+4
• Help browser: Ctrl+Shift+5

On macOS systems, use the Command key instead of the
Ctrl key.

Move between code and output in the
Live Editor when output in on the right.

Ctrl+Shift+O

On macOS systems, use Option+Command+O instead.
Show access keys for the toolstrip tabs. Alt

Not supported on macOS systems.
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Action Keyboard Shortcut
Select or open a toolstrip tab and show
the access keys for each item on the
tab.

Press Alt to show the access keys for the toolstrip tabs and
then <character> to select or open a tab, where
<character> is the displayed access key for the desired
toolstrip tab.

For example, press Alt followed by H to select or open the
Home tab and display the access keys for the items on that
tab.

Not supported on macOS systems.
Select a toolstrip item. Press Alt and then <character> to select the current

toolstrip tab, where <character> is the displayed access
key for the current tab. Then, press <character> to select
a toolstrip item, where <character> is the displayed
access key for the desired item.

For example, press Alt followed by H to select the Home
tab and then S to create a new script.

Not supported on macOS systems.

You cannot customize most of these shortcuts. For information about customizable keyboard
shortcuts and how to view and modify them, see “Customize Keyboard Shortcuts” on page 2-42.

MATLAB Online

MATLAB Online provides access to MATLAB from a standard web browser. Because MATLAB Online
runs in a browser, navigation using the keyboard is slightly different.

This table describes the actions and related keyboard shortcuts useful for navigating MATLAB Online
without a mouse.

Action Keyboard Shortcut
Move forward through the different
areas of the MATLAB Online desktop,
including the toolstrip, Current Folder
toolbar, sidebar panels, and Command
Window.

Ctrl+F6

On macOS systems, use Command+F6 instead.

Move backward through the different
areas of the MATLAB Online desktop,
including the toolstrip, Current Folder
toolbar, sidebar panels, and Command
Window.

Ctrl+Shift+F6

On macOS systems, use Command+Shift+F6 instead.

Move into a tool, for example, into the
current toolstrip tab.

Tab
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Action Keyboard Shortcut
Move between controls within a tool,
for example, between toolstrip tabs or
between the items on a toolstrip tab.

Up/Down Arrow, Left/Right Arrow

Make an open tool the active tool. • Command Window: Ctrl+0
• Command History: Ctrl+1
• Files panel: Ctrl+2
• Workspace panel: Ctrl+3

On macOS systems, use the Command key instead of the
Ctrl key.

Close controls within a tool, for
example, documents in the Editor and
Live Editor.

Delete

Move between code and output in the
Live Editor when output is on the right.

Ctrl+Shift+O

On macOS systems, use Option+Command+O instead.
Open context menu. Shift+F10
Show access keys for the toolstrip. Alt

Not supported on macOS systems.
Open a toolstrip tab and show access
keys for the toolstrip.

Alt+<character>

For example, pressing Alt followed by H accesses the
Home tab and displays access keys for the features
available on that tab.

Not supported on macOS systems.
Perform a search. Ctrl+Shift+Space

On macOS systems, use Command+Shift+Space instead.
Open Preferences Window Ctrl+,

On macOS systems, use Command+, instead.
Display a compact list of keyboard
shortcuts.

Ctrl+/

On macOS systems, use Command+/ instead.

Customizing shortcuts is not supported in MATLAB Online.

Navigate Figures in MATLAB Online
In MATLAB Online, you can explore plotted data using keyboard shortcuts. Once a figure is selected,
the shortcuts described above are slightly modified.

This table describes the actions and related keyboard shortcuts useful for navigating figures in
MATLAB Online without a mouse.
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Action Keyboard Shortcut
Navigate Forward Tab

When focus is on the figure, this means Tab steps into the
axes. If there are multiple axes in a figure, and focus is on
the first axes, then Tab steps to the next axes.

Reverse Navigation Shift+Tab

Navigate axes in the reverse order as Tab.
Navigate Down Ctrl+Down Arrow

If focus is on a set of axes, then Ctrl+Down Arrow focuses
the first focusable element within the axes. For example, if
a title is present, focus jumps from the axes to the title. If
no titles or labels are present, then focus jumps from the
axes to an object within the axes.

Navigate up Ctrl+Up Arrow

Focus shifts from an element to its parent element. For
example, if focus is on a line, then Ctrl+Up Arrow shifts
focus to the axes.

Additional Keyboard Shortcuts
In addition to navigation, keyboard shortcuts are useful for accessing other frequently used actions in
MATLAB.

This table describes several of these actions and their related keyboard shortcuts. For additional
keyboard shortcuts, see the documentation for a specific tool or feature.

Action Keyboard Shortcut
Cancel the current action. Esc (escape)

For example, if you click the name of the Edit menu, the
whole menu appears. Pressing Esc hides the menu again.

In the Function Browser, pressing Esc up to three times has
the following effects:

1 Dismiss the search history.
2 Clear the search field.
3 Close the Function Browser.

Interrupt MATLAB execution. Ctrl+C

On Windows and Linux systems, you also can use Ctrl
+Break. On macOS systems, you also can use Command+.
(period).

You cannot customize these shortcuts. For information about customizable keyboard shortcuts and
how to view and modify them, see “Customize Keyboard Shortcuts” on page 2-42.
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See Also

More About
• “Customize Keyboard Shortcuts” on page 2-42
• “Rerun Favorite Commands” on page 3-14
• “Customize MATLAB Toolbars” on page 2-12
• “Accessibility in MATLAB” on page 2-22

2 Desktop

2-32



Use a Screen Reader in MATLAB Online
In MATLAB Online, you can use a screen reader and a keyboard to interact with the Command
Window, create and edit scripts and functions in the Editor, and navigate through the MATLAB
desktop tools. MATLAB Online is tested with the NVDA screen reader on Windows 10 running
MATLAB Online in the Google Chrome browser. For more information about NVDA, see Get Help on
the NV Access website.

Screen Reader Tips
Reduce Blank Lines in Output

To improve the screen reader experience when working in the Command Window, suppress excess
blank lines in output for the current session using the format command.

format compact;

To maintain the compact format across all future sessions, use settings to set the personal value for
line spacing in output display.

s = settings;
s.matlab.commandwindow.DisplayLineSpacing.PersonalValue = 'compact';

Modifying Graphics Objects

When working with graphics objects, avoid using the Property Inspector to view and modify
properties. Instead, view and modify graphics object properties programmatically. For example, the
plot function returns a chart line object. You can use dot notation to view and set properties.

p = plot(1:10,1:10);
p.LineWidth = 3; 

Alternatively, you can set properties using name-value arguments when creating the object, such as
plot(1:10,1:10,'LineWidth',3).

For more information about viewing and modifying graphics object properties, see “Modify Graphics
Objects”.

Accessing MathWorks Documentation

To ensure the best experience when viewing and searching the documentation using a screen reader,
open it in a separate browser tab or window at https://www.mathworks.com/help/.

Using MATLAB with -nodesktop Option

If you run MATLAB without the desktop using the -nodesktop start-up option, these tips can help
improve your screen reader experience:

• Use the format function to suppress excess blank lines in output, making it easier to navigate
diary files. For more information, see “Reduce Blank Lines in Output” on page 2-33.

• Include a filename when calling the diary function to save the Command Window text to a
separate file. You can call the diary function multiple times during a MATLAB session with
different filenames to save different sets of text to different files.
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For a more accessible alternative to using MATLAB with the -nodesktop option, use the Command
Window Only layout in MATLAB Online instead. Using the Command Window Only layout in MATLAB
Online gives you access to more keyboard shortcuts and, when needed, the full functionality of the
MATLAB desktop. To select the Command Window Only layout in MATLAB Online, go to the Home
tab, and in the Environment section, click the Layout button and then select Command Window
Only.

Navigate MATLAB Using a Screen Reader
When you first start MATLAB Online, the cursor is in the Command Window.

To move forward through the different areas of the MATLAB Online desktop, press Ctrl+F6 (or
Command+F6 on macOS systems). To move backward, press Ctrl+Shift+F6 (or Command+Shift
+F6 on macOS systems). You also can use a keyboard shortcut to navigate directly to some open
tools.

This table describes the different areas of the MATLAB Online desktop and their default positions.

Area Position Description
Toolstrip Top of desktop By default, the toolstrip includes three tabs,

Home, Plots, and Apps.

To navigate between the toolstrip tabs, use the
arrow keys. To enter and navigate within the
toolstrip tabs, use the Tab key.

Current Folder toolbar Top of desktop
underneath toolstrip

View and change the current folder.

Files panel Left side of desktop Manage files and folders in MATLAB. Actions
include viewing, creating, opening, moving, and
renaming files and folders in the current folder.

To navigate to the Files panel directly, press Ctrl
+2 (or Command+2 on macOS systems).

Workspace panel Left side of desktop
underneath Files panel

View and manage the contents of the workspace
in MATLAB.

To navigate to the Workspace panel directly,
press Ctrl+3 (or Command+3 on macOS
systems).

Command Window Bottom middle of
desktop

Enter individual statements at the command line
and view the resulting output.

To navigate to the Command Window directly,
press Ctrl+0 (or Command+0 on macOS
systems).

Editor Middle of desktop,
above Command
Window

Edit or create files.
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Area Position Description
Docked figures Middle of desktop,

above Command
Window

Plot data in embedded figures.

For example, you can use the toolstrip to send feedback about the current release:

1 On a Windows system with the NVDA screen reader running, open a Google Chrome browser and
start MATLAB Online.

2 With the cursor in the Command Window, press Ctrl+F6 to navigate to the toolstrip. You hear:

Toolstrip region 
Toolstrip tab control 
Home tab selected one of three

3 Press the Tab key to enter the Home tab and then continue pressing the Tab key until you reach
the Feedback button. You hear:

Feedback button
Send us feedback or report a bug

4 Press Enter. The Send Feedback dialog box opens.

For more information about the MATLAB desktop, see “Change Desktop Layout” on page 2-14.

Enter Statements in the Command Window Using a Screen Reader
As you work in MATLAB, you can enter individual statements in the Command Window using a screen
reader and a keyboard.

For example:

1 On a Windows system with the NVDA screen reader running, open a Google Chrome browser and
start MATLAB Online.

2 If the cursor is not in the Command Window, press Ctrl+0 (or Command+0 on macOS systems)
to navigate to the Command Window. You hear:

Command Window region
Command Window edit multiline
Greater greater

3 Create a variable named x by typing this statement in the Command Window.

x = 1

MATLAB adds x to the workspace and displays the results in the Command Window. You hear:

Greater greater
X equals one

When you hear Greater greater, the Command Window is ready for the next statement at the
command-line prompt (>>).

4 Create another variable y by entering the following statement in the Command Window.

y = cos(x)

You hear:
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Y equals zero point five four zero three
5 Set the value of x to the value of y by entering the following statement in the Command Window.

x = y

You hear:

X equals zero point five four zero three
6 Save the variables from the current workspace in the file test.mat by entering the following

statement in the Command Window.

save test.mat

MATLAB saves the file in the current folder. You hear:

Greater greater
7 Remove the variables from the workspace by entering the following statement in the Command

Window.

clear

You hear:

Greater greater
8 Clear all text from the Command Window by entering the following statement in the Command

Window.

clc

You hear:

Greater greater

The Command Window is ready for the next statement.

For more information about entering statements in the Command Window, see “Enter Statements in
Command Window” on page 3-2.

Create Scripts Using a Screen Reader
Scripts are the simplest kind of program file because they have no input or output arguments. They
are useful for automating series of MATLAB commands, such as computations that you have to
perform repeatedly from the command line or series of commands you have to reference.

Create and Run Scripts

You can create and run scripts using a screen reader and a keyboard.

For example to create and run the script myrandom.m:

1 On a Windows system with the NVDA screen reader running, open a Google Chrome browser and
start MATLAB Online.

2 Navigate to the toolstrip by typing Ctrl+F6 until you hear:
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Toolstrip region
Toolstrip tab control
Home tab selected one of three

3 Press the Tab key to enter the Home tab. The New Script button is selected. You hear:
Home property page
File grouping
New script button 
Create a new script in the current folder

4 Press Enter to create a new script. MATLAB creates the script and opens it in the Editor. You
hear:

Untitled property page
Edit multiline, line one

5 Add this code that generates an array of random numbers and then calculates the size and mean
of the array.

n = 50;
r = rand(n,1);

sz = size(r)
m = mean(r)

6 Type Ctrl+S to save the file. MATLAB opens the Save As dialog box. You hear:

Save as dialog
Edit untitled.m

Alternatively, you can open the Save As dialog box using the Save button on the toolstrip.
7 Type Ctrl+A to select the default file name and then enter a name for the script. For example,

enter the name myrandom.m. Press Enter to save the file.
8 To run the script, make sure that focus is inside the script, and then press F5. If focus is not

inside the script, pressing F5 reloads MATLAB Online in the browser.

MATLAB runs the script and displays the output in the Command Window. You hear:

myrandom.m property page
Edit multiline, line 2 
n equals 50
sz equals 50 1 
m equals zero point five one seven two

Alternatively, you can run the script using the Run button on the toolstrip.

For more information about creating scripts, see “Create Scripts”.

Open and Edit Scripts

You can open and edit scripts using a screen reader and a keyboard.

For example, to open and edit the script myrandom.m:

1 On a Windows system with the NVDA screen reader running, open a Google Chrome browser and
start MATLAB Online.

2 If the cursor is not in the Command Window, press Ctrl+0 (or Command+0 on macOS systems)
to navigate to the Command Window. You hear:
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Command Window region
Command Window edit multiline
Greater greater

3 Open myrandom.m by typing this statement in the Command Window:

open myrandom.m

You hear:

myrandom.m property page
Edit multiline, line 1 
n equals 50

Alternatively, you can open the script using the Open button on the toolstrip.
4 Use the arrow keys to navigate through the lines in the script and edit the code. For example, go

to line 4 in the code by pressing the Down Arrow key until you hear:

line 4 sz equals size r
5 Go to the end of line 4 by pressing the Right Arrow key until you hear:

Line feed
6 Type a semi column (;) and save your changes by typing Ctrl+S.

Delete Scripts

You can delete scripts or other files or folders using a screen reader and a keyboard.

For example, to delete the script myrandom.m:

1 On a Windows system with the NVDA screen reader running, open a Google Chrome browser and
start MATLAB Online.

2 If the cursor is not in the Command Window, press Ctrl+0 (or Command+0 on macOS systems)
to navigate to the Command Window. You hear:

Command Window region
Command Window edit multiline
Greater greater

3 Delete myrandom.m by typing this statement in the Command Window:

delete myrandom.m

You hear:

Greater greater

Alternatively, you can delete the script using the Files panel:

1 Press Ctrl+2 (or Command+2 on macOS systems) to navigate to the Files panel. You hear:

Complimentary landmark files button heading level two
2 The Files panel contains a table with the list of files and folders in the current folder. Press the

Tab key to select the table. You hear:

Files region
Table
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3 Select myrandom.m by pressing the Up/Down Arrow until you hear:

myrandom.m script preview row collapsed level 1
4 Press the Delete key. The Delete File dialog box opens and you hear:

Delete file dialog
Question icon are you sure you want to delete this file?
Clickable yes button delete file
Button yes button no

5 Press Enter to delete the file.

For more information, see “Manage Files and Folders” on page 6-34.

Explore Plotted Data Using a Screen Reader
Plotting data in figures allows visualization of data. They can be used to quickly survey data and
display the output of code. You can explore figures using a screen reader and a keyboard.

For example:

On a Windows system with the NVDA screen reader running, open a Google Chrome browser and
start MATLAB Online.

1 If the cursor is not in the Command Window, press Ctrl+0 (or Command+0 on macOS systems)
to navigate to the Command Window. You hear:

Command Window region
Command Window edit multiline
Greater greater

2 Create a variable named x by typing this statement in the Command Window:

x = 1:5

MATLAB adds x to the workspace and displays the results in the Command Window.

You hear:

Greater greater
X equals one two three four five

When you hear Greater greater, the Command Window is ready for the next statement at the
command-line prompt (>>).

3 Create another variable y by entering the following statement in the Command Window.

y = 2*x

You hear:

Y equals two four six eight ten
4 Plot the data of y against the data of x by entering the following statement in the Command

Window.

plot(x,y)

You hear:
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Figure 1
The current axes object contains one objects of type line

5 Bring the cursor back to the Command Window by pressing Ctrl+0 (or Command+0 on macOS
systems).

You hear:

Command Window region
Command Window edit multiline
Greater greater

6 Add a title and legend to the figure.

title("My Plot")
legend

You hear:

Figure 1
The current axes object contains one objects of type line

7 Navigate to the new figure tab by typing Ctrl+F6 until you hear:

Tab control
Figure 1 tab selected
Figure 1, 1 of 1

8 Press Tab twice to select the figure axes.

You hear:

Figure 1
The current axes object contains one objects of type line
The axes object with title my plot contains one objects of type line

9 Type NVDA Modifier Key+Space to switch to focus mode for the figure axes. By default, the
NVDA Modifier Key is the Insert key.

10 Type Ctrl+Down Arrow to select the title inside the axes.

You hear:

Text my plot

11 Press Tab to select the line object. If axes contain multiple objects, press Tab to navigate
through them.

For more information about exploring plotted data, see “Interactively Explore Plotted Data”.

Limitations
Live Editor

Using a screen reader is not supported in the Live Editor. To create scripts and functions, use the
Editor instead.
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See Also

More About
• “Use Keyboard Shortcuts to Navigate MATLAB” on page 2-28
• “Desktop Basics”
• “Accessibility in MATLAB” on page 2-22
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Customize Keyboard Shortcuts

Keyboard shortcuts are useful for accessing desktop features quickly. To optimize your experience,
you can customize the current set of keyboard shortcuts in MATLAB.

There are several ways you can modify the current set of keyboard shortcuts. You can:

• Create new keyboard shortcuts or modify existing ones.
• Choose among available sets of keyboard shortcuts.
• Create customized sets of keyboard shortcuts or use existing customized sets.

To view or modify the current set of keyboard shortcuts, use the Keyboard Shortcuts Preferences
options in the Preferences Window. To open the Keyboard Shortcuts Preferences page in the
Preferences Window, go to the Home tab, and in the Environment section, click  Preferences.
Then, select MATLAB > Keyboard > Shortcuts.

View Keyboard Shortcuts
For actions performed with a menu item, keyboard shortcuts appear in the menu itself. This is true
whether the menu item is in the toolstrip or in a context menu. If a menu item does not display a
keyboard shortcut, then a keyboard shortcut for the action does not exist.

For actions that are not performed with a menu item, to find keyboard shortcuts, open the Keyboard
Shortcuts Preferences page in the Preferences Window. Then, in the search box, enter the name of
the tool or action for which you want to see the keyboard shortcuts. For example, type Editor
clear to find the keyboard shortcut for clearing selected text in the Editor.

To view the shortcuts for an action, select the action name. For example, select Clear Selection.
MATLAB displays the keyboard shortcuts for the selected action. For example, the keyboard shortcut
for the Clear Selection action in the Editor is the Escape key.
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Create a List of All Keyboard Shortcuts in a Set

You can create a list of all the keyboard shortcuts in the current set by copying them to the clipboard
and pasting them in a text file or spreadsheet application, such as Microsoft Excel®. For the best
formatting, use a spreadsheet application. To copy all the keyboard shortcuts, open the Keyboard
Shortcuts Preferences page in the Preferences Window. Click the Actions button  and from the
drop-down menu, choose Copy to Clipboard. Paste the data into the desired application.

Customize Keyboard Shortcuts for Individual Actions

Customizing a keyboard shortcut is useful if you frequently perform an action and the action does not
have a keyboard shortcut defined, or if the defined keyboard shortcut is hard to use or conflicts with a
different shortcut. For an overview on customizing keyboard shortcuts, watch the Customizable
Keyboard Shortcuts video. You must have an internet connection to watch the video.

To customize a keyboard shortcut:

1 Open the Keyboard Shortcuts Preferences page in the Preferences Window and, in the search
box, type an existing keyboard shortcut or the name of an action, tool, or menu.

For example, you can type Ctrl+R (shortcut), Delete (action), Command Window (tool), or File
(menu).

You can enter most keyboard shortcuts by either pressing keystrokes or typing the key names. If
using keystrokes for a keyboard shortcut does not work, try typing the key names instead. For
example, if pressing the Ctrl key and then R does not work, try typing the text Ctrl+R.

MATLAB displays the list of matching actions for which you can customize or define a keyboard
shortcut. If you specify the name of a tool, MATLAB displays actions associated with the tool or
menu, as well as any action names that contain the specified text.

2 Select the name of the action for which you want to define or modify a keyboard shortcut.
3 Click the Add button .

An editable text box opens in the Shortcut column.
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4 Specify the keystrokes you want to use for the keyboard shortcut.

A keystroke can be a single key or the combination of a modifier (Alt, Shift, or Ctrl) and another
key. Specify a keystroke by performing it, not by typing the names of the keys character by
character. For example, press the Ctrl key and the Y key. Do not type C-t-r-l-+-Y.

Alternatively, you can choose a shortcut from the drop-down menu.

To specify multiple keystrokes for one action, or to limit the number of keystrokes for an action,
click the down arrow next to the key icon  in the Shortcuts box. Then, select either Limit to
1 keystroke, Limit to 2 keystrokes, or Limit to 3 keystrokes. For example, to
specify Ctrl+Y, Shift+Z, F9 as the three keystrokes for an action, select Limit to 3
keystrokes and then type the keystrokes.

5 In the Tools with shortcut column, click the down arrow and select which tools you want to
assign the keyboard shortcut to.

6 Evaluate and resolve any conflicts, indicated by the error icon  and informational icon . The
error icon  indicates that two different actions within the same tool have the same shortcut.
The informational icon  indicates that two different actions in two different tools have the same
shortcut.

There is no requirement to resolve keyboard shortcut conflicts. However, if the same shortcut
specifies two different actions, the shortcuts can be confusing to use. Resolving all conflicts
indicated by the error icon  is recommended, although in some situations, resolving a conflict
might be unnecessary. For example, resolving the conflict might be unnecessary if the conflict is
temporary or the two actions are associated with different modes of the same tool. Resolving
conflicts indicated by the informational icon  is recommended if you use both tools frequently
and you perform both actions frequently.

To resolve a conflict, change or delete shortcuts such that there is a one-to-one correspondence
between shortcuts and frequently used actions.

7 Click OK or Apply.

New or modified keyboard shortcuts become available immediately. Changed shortcuts that
correspond to menu items immediately appear in the menu.

To delete a keyboard shortcut for a selected action, select the keyboard shortcut that you want to
delete and click the Delete button .
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Restore Default Keyboard Shortcut Sets

If you modify keyboard shortcuts, and then decide you do not want to keep the changes, you can
restore the default shortcuts. To restore the default state of a keyboard shortcut, click the Actions
button  and select Undo Modifications to <Set Name> Default Set (modified), where <Set
Name> is the name of the modified default set.

Note Undoing modifications reverts all keyboard shortcuts changes that you made to the set. You
cannot undo modifications on a shortcut-by-shortcut basis.

Restrictions When Customizing Keyboard Shortcuts

There are some actions and tools for which you cannot change the keyboard shortcuts. Actions for
which the keyboard shortcut cannot be customized do not appear when you search for them in the
Keyboard Shortcuts Preferences page in the Preferences Window. Examples of these actions
include canceling the current action (Esc), interrupting MATLAB execution (Ctrl+C), and some of the
navigational actions described in “Use Keyboard Shortcuts to Navigate MATLAB” on page 2-28.

In addition, you cannot change the keyboard shortcuts associated with these tools or portions of
tools:

• Figure windows — For example, you cannot modify the keyboard shortcut, Ctrl+S, for saving a
MATLAB .fig file.

• Toolboxes — For example, you cannot modify keyboard shortcuts in the SimBiology® desktop.
• Incremental search — You can modify the keyboard shortcuts for initiating a forward or backward

incremental search. However, you cannot change the keyboard shortcuts that you use within
incremental search mode, such as Ctrl+Shift+S to search forward.

• Dialog boxes — For example, you cannot create a keyboard shortcut for the OK button.

Manage Sets of Keyboard Shortcuts
Select Set of Keyboard Shortcuts

By default, MATLAB uses the keyboard shortcut settings for your current platform. To select a
different set of keyboard shortcuts, open the Keyboard Shortcuts Preferences page in the
Preferences Window and, in Active settings, select from the available options. To use a keyboard
shortcut settings file that is on your system but not in the Active settings list, select Browse... to
find and select the desired file.

This table lists the keyboard shortcut settings files installed with MATLAB.

Operating
System

Keyboard Shortcut Settings Files Installed with MATLAB

Windows • Windows Default Set (Default)
• Emacs Default Set

Linux • Emacs Default Set (Default)
• Windows Default Set

macOS • Macintosh Default Set (Default)
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You also can download keyboard shortcut settings files from File Exchange. For example, to restore
the MATLAB default keyboard shortcuts that were in place for MATLAB Version 7.9 (R2009a) and
earlier releases, go to File Exchange and search for MATLAB Desktop R2009a Default
Keyboard Shortcut sets. Download and extract the set and then select it as the active settings
file. A valid keyboard shortcut settings file appears with a keyboard key icon .

Compare Sets of Keyboard Shortcuts

To compare the current set of keyboard shortcuts to another set:

1 Open the Keyboard Shortcuts Preferences page in the Preferences Window and click the
Actions button .

2 From the drop-down menu, choose the set of keyboard shortcuts to which you want to compare
the current set.

3 The Comparison Tool opens and displays the two keyboard shortcut sets side-by-side. For more
information about how to read the results, see “Compare Text Files” on page 6-11.

Save Set of Keyboard Shortcuts to File

Saving a set of keyboard shortcuts to a settings file is useful if you want to:

• Save the changes you make to a default keyboard shortcut set to a new set.
• Use a set of customized keyboard shortcuts on another system running MATLAB.
• Overwrite a previously saved set of keyboard shortcuts.
• Share a set of keyboard shortcuts with others, for example, on File Exchange.

To save a keyboard shortcut settings file, open the Keyboard Shortcuts Preferences page in the
Preferences Window. Then, click the Actions button  and select Save As. MATLAB saves the file
as an .xml file in the folder that you specify.

You cannot overwrite the default settings files that install with MATLAB. MATLAB saves modifications
that you make to a default set using the name of the default set appended with the text (modified),
for instance, Windows default (modified).

Delete Set of Keyboard Shortcuts

To delete a previously saved set of keyboard shortcuts, open the Keyboard Shortcuts Preferences
page in the Preferences Window and in Active settings, select the set of keyboard shortcuts that you
want to delete. Click the Actions button  and select Delete filename, where filename is the
name of a keyboard shortcut set you want to delete. You cannot delete default keyboard shortcut sets,
such as Windows Default Set.

See Also

More About
• “Use Keyboard Shortcuts to Navigate MATLAB” on page 2-28
• “Rerun Favorite Commands” on page 3-14
• “Customize MATLAB Toolbars” on page 2-12
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Set Print Options for Command Window and Editor
In this section...
“Specify Layout Options” on page 2-47
“Add Header” on page 2-47
“Change Fonts” on page 2-49

You can customize how pages look when printing from the Command Window and Editor.

To specify page setup options, open the Page Setup dialog box using one of these methods:

• Command Window — Right-click in the Command Window and select Page Setup.
• Editor — Go to the Editor tab, and in the File section, select Print > Page Setup.

The Live Editor has a different way of controlling how pages look when printing. To change the page
setup options when exporting in the Live Editor, use settings. For more information, see the
matlab.editor.export settings described in matlab.editor.

Specify Layout Options
To specify layout options when printing, in the Page Setup dialog box, select the Layout tab. (On
macOS platforms, select MATLAB in the Settings menu to see the Layout tab.) Then, select from
the available options as described in the table below. A preview pane shows a sample document with
the selected layout options.

Layout Option Description
Print header Include a header at the top of each printed page.
Print line numbers Print line numbers.
Wrap lines Wrap any lines that are longer than the printed page width.

Otherwise, the line is cut off at page boundaries.
Syntax highlighting Specify how MATLAB elements appear when printed. Options

include:

• Black and white text — MATLAB elements print in black and
white with no highlighting.

• Colored Text — MATLAB elements print using the syntax
highlighting colors displayed in the Command Window or
Editor.

• Styled Text — Keywords print in bold, comments print in
italics, and all other text prints as plain text. Output is not
styled.

Add Header
When printing from the Command Window or Editor, you can include a header on each printed page.
The header includes information such as the current date and time, the name of the file you are

 Set Print Options for Command Window and Editor

2-47



printing, and the page number. To include a header, in the Page Setup dialog box, select the Layout
tab and then select Print header.

To change the format and layout of the header, select the Header tab and then select from the
available options, as described in the table below. (On macOS platforms, select MATLAB in the
Settings menu to see the Header tab.) The preview area shows a sample of the header with the
selected options.

Header Option Description
Page number Format for the page number. Options include # of n, Page #, and

# / n
Border Border style for the header. Options include Single line, Double

line, Box, Shaded box, and None.
Layout Layout style for the header. Options include:

• Standard one line

• Standard two lines

• Simple one line

• Simple two lines

(This option is not available for Command Window printing.)

For example, in the Editor, print the example file fourier_demo2.m with a standard two line header
and a double line border.
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Change Fonts
You can specify the font to use when printing. By default, MATLAB uses the Editor or Command
Window font when printing.

To specify a different font to use when printing, follow these steps:

1 In the Page Setup dialog box, select the Fonts tab. (On macOS platforms, select MATLAB in the
Settings menu to see the Fonts tab.)

2 In the Choose font field, select Header to change the font for the header text, or Body to
change the font for all of text in Command Window or Editor except for header text.

3 Select Use custom font and then specify the font name, style, and size. The Sample area shows
a preview of the selected font.

See Also
print | matlab.editor

Related Examples
• “Print Figure from File Menu”
• “Zoom and Change Desktop Fonts” on page 2-2
• “Change Desktop Colors” on page 2-7

 Set Print Options for Command Window and Editor

2-49



Web Browsers and MATLAB

In this section...
“About Web Browsers and MATLAB” on page 2-50
“Specify Proxy Server Settings for Connecting to the Internet” on page 2-52
“Specify the System Browser for Linux Platforms” on page 2-52

About Web Browsers and MATLAB
From MATLAB, Web sites and documents can display in any of the following browsers:

• MATLAB Web browser
• Help browser
• Your system Web browser, such as Mozilla® Firefox®

MATLAB uses the different browsers to display different types of information:

• Web sites display in your system browser.
• Documentation displays in the Help browser.
• Other HTML files display in the MATLAB Web browser. For example, after publishing a MATLAB

program file to HTML, the HTML file displays in the MATLAB Web browser:
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MATLAB Web and Help Browsers

The MATLAB Web and Help browsers may not support all the features that a particular Web site or
HTML page uses. For example, the MATLAB Web browser does not display .bmp (bitmap) image files.
Instead use .gif or .jpeg formats for image files in HTML pages.

To display an HTML document in the MATLAB Web browser, double-click the document name in the
Current Folder browser.

System Browser

The system browser that MATLAB uses depends on your platform:

• On Microsoft Windows and Apple Macintosh platforms, MATLAB uses the default browser for your
operating system.

• On UNIX® platforms, MATLAB uses the Mozilla Firefox browser. You can specify a different system
browser for MATLAB using Web preferences on page 2-52.
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Specify Proxy Server Settings for Connecting to the Internet
If your network uses a firewall or another method of protection that restricts Internet access, provide
information about your proxy server to MATLAB. Be aware that:

• MATLAB supports non-authenticated, basic, digest, and NTLM proxy authentication types.
• If a proxy with basic authentication is specified, MATLAB only supports HTTP connections. HTTPS

connections are not supported.
• You cannot specify the proxy server settings using a script.
• There is no automated way to provide the proxy server settings your system browser uses to

MATLAB.

To specify the proxy server settings:

1 On the Home tab, in the Environment section, click  Preferences. Select MATLAB > Web.
2 Select the Use a proxy server to connect to the Internet check box.
3 Specify values for Proxy host and Proxy port.

Examples of acceptable formats for the host are: 172.16.10.8 and ourproxy. For the port,
enter an integer only, such as 22. If you do not know the values for your proxy server, ask your
system or network administrator for the information.

If your proxy server requires a user name and password, select the Use a proxy with
authentication check box. Then enter your proxy user name and password.

4 Ensure that your settings work by clicking the Test connection button.

MATLAB attempts to connect to https://www.mathworks.com:

• If MATLAB can access the Internet, Success! appears next to the button.
• If MATLAB cannot access the Internet, Failed! appears next to the button. Correct the values

you entered and try again. If you still cannot connect, try using the values you used when you
authenticated your MATLAB license.

5 Click OK to accept the changes.
6 Restart MATLAB to enable the changes.

Specify the System Browser for Linux Platforms
On Linux platforms, you can specify the system browser to use. Specifying the system browser is not
supported on Windows and Mac platforms.

To specify the system browser:

1 On the Home tab, in the Environment section, click  Preferences. Select MATLAB > Web.
2 Under System Web browser, in the Command field, specify the system command to open the

browser, for example, opera, which opens the Opera Web browser.
3 Add options for opening your system browser in the Options field. For example, geometry

1064x860 specifies the size of the window for Opera.
4 Click OK.

Note If you specify Firefox as the system browser using the system command firefox, specify a
display option to ensure that the browser opens correctly.
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See Also
web

More About
• “Web Preferences” on page 2-64
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Manage Your Licenses
You can manage many licensing-related tasks, such as activating licenses, deactivating licenses, or
updating licenses, through MATLAB or your MathWorks Account on www.mathworks.com.

Note Some options for license actions require an internet connection. If your internet connection
requires a proxy server, use MATLAB web preferences to specify the server host and port. See
“Specify Proxy Server Settings for Connecting to the Internet” on page 2-52 for more information.

Update Current Licenses
The simplest way to update your license file is from within MATLAB. You should perform this task
within your MathWorks Account only if you cannot access MathWorks from your computer. For
additional details on updating licenses, see “Update Your License”, or, if you are a license
administrator, see “Update Network License”.

User Interface Description
MATLAB On the Home tab, in the Resources section, click Help > Licensing >

Update Current Licenses.

MATLAB displays a list of all your MathWorks licenses on this computer, with
their status. When you select a license and click Update, MATLAB contacts
MathWorks to retrieve the most current version of the License File for the
license. The update process overwrites the current License File on your
system. You need to restart MATLAB.

MathWorks Account 1 Sign in to mathworks.com. If you are already signed in, select My
Account from the drop-down menu under your account icon.

2 Under My Software, click the license you want to update. If you have
more licenses than fit on the screen, click View additional Licenses or
Trials and then click the license you want. Clicking a license takes you to
the License Center.

3 In the License Center, click the Install and Activate tab.
4 Click Update License File.
5 Click one of the icons under Get License File. You can download the

license file or have it emailed to you.
6 Follow all prompts.

MathWorks retrieves the most current version of the License File for the
license. You need to restart MATLAB.

Activate Software
The simplest way to activate your software is from within MATLAB. You should perform this task
within your MathWorks Account only if your computer cannot communicate with MathWorks. For
additional details on activation, see “Activate MATLAB Installation Manually”.
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User Interface Description
MATLAB On the Home tab, in the Resources section, click Help > Licensing >

Activate.

MATLAB starts the activation application, which walks you through the
activation process. Answer the questions on each dialog box, select the license
you want to activate, and click Activate.

MathWorks Account 1 Sign in to mathworks.com. If you are already signed in, select My
Account from the drop-down menu under your account icon.

2 Under My Software, click the license you want to activate. If you have
more licenses than fit on the screen, click View additional Licenses or
Trials, and then click the license you want.

3 Click the Install and Activate tab.
4 Click Activate to Retrieve License File or Activate a Computer.
5 Follow all prompts.

Deactivate Software
Although you can deactivate the software from within MATLAB, if you cannot access the computer to
deactivate, you can still deactivate the software from your MathWorks Account.

For more details on deactivating MathWorks software, see “Deactivate Your Installation”.

User Interface Description
MATLAB On the Home tab, in the Resources section, click Help > Licensing >

Activate > Deactivate.

MATLAB displays a list of all your MathWorks licenses on this computer, with
their status. When you select a license and click Deactivate, MATLAB
deactivates all releases on this computer associated with the license, and
updates the licensing information at the MathWorks website. You will not be
able to use MathWorks software with that license on this computer.

If you are not connected to the Internet, MATLAB deactivates the licenses on
your computer but cannot update the corresponding license information stored
at the MathWorks website. In this scenario, MATLAB returns a deactivation
string. To complete deactivation, save a copy of this string, go to a computer
with an internet connection, and visit the License Center at the MathWorks
website. There you can sign in to your MathWorks Account and enter the
deactivation string.
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User Interface Description
MathWorks Account 1 Sign in to mathworks.com. If you are already signed in, select My

Account from the drop-down menu under your account icon.
2 Under My Software, click the license you want to deactivate. If you have

more licenses than fit on the screen, click View additional Licenses or
Trials, and then click the license you want.

3 Click the Install and Activate tab.
4 Find the activated computer in the list, then click the deactivate icon 

on the right-hand side of the display.
5 Follow all prompts.

MathWorks deactivates all releases on the specified computer, and updates the
licensing information in License Center.

Link a License to Your Account
User Interface Description
MATLAB You cannot perform this task from within MATLAB.
MathWorks Account 1 Sign in to mathworks.com. If you are already signed in, select My

Account from the drop-down menu under your account icon.
2 Under My Software, click Link an additional license.
3 Follow all prompts.

If you are linking a network license, you may need to get the license number
from your organization's license administrator.

Get a Trial
Start a free 30-day trial of MathWorks software.

Although you can get a trial from within MATLAB or from your MathWorks Account, the simplest way
is to go directly to Free MATLAB Trial on mathworks.com.

User Interface Description
MATLAB To get a trial, go to Add-Ons > Get Add-Ons. Click on a toolbox, and then

click Get Trial. Follow all prompts.
MathWorks Account 1 Sign in to mathworks.com. If you are already signed in, select My

Account from the drop-down menu under your account icon.
2 Under My Software, click Get a trial. Follow all prompts.

See Also
license
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Related Examples
• “Install Products”
• “Manage Products”
• “Administer Network Licenses”
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Update an Existing Installation
You can download and install a more recent version of the release of MATLAB that you currently have
installed. For example, if you have R2020a installed, you might be able to download a more recent
version of R2020a. This version is called a MATLAB update. When you install a MATLAB update, you
get not only the most recent update for your version but also all previous updates for your version as
well.

Update from Notifications
Since R2019a

If a more recent version is available, a notification displays in MATLAB when you start the program.

To install the MATLAB update, click the notification icon and then select Install Update. If you click
the notification but decide not to install the update, the notification is cleared; however, you can still
install the update at a later time.

Check for Updates
Since R2016b

You also can check for updates manually. You must have an active internet connection to check for
and update your installation.

On the Home tab, click Help > Check for Updates. The Add-On Manager opens with the Updates
tab selected. If there is an update available for your version of MATLAB, click the Update button to
the right of the update name to install it. If there is no update available for your version or if you have
already installed the latest update, MATLAB displays that information.

In R2019a: On the Home tab, click Help > Check for Updates > Products. If there is an update
available, click Install Update.

Before R2019a: On the Home tab, click Add-Ons > Check for Updates > Products.

See Also

More About
• “Get New MATLAB Release”
• “Get and Manage Add-Ons” on page 8-2
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macOS Platform Conventions
In this section...
“Mouse Instructions and macOS Platforms” on page 2-59
“Navigating Within the MATLAB Root Folder on macOS Platforms” on page 2-59
“MATLAB Dock Menu” on page 2-59

Mouse Instructions and macOS Platforms
The documentation typically presents conventions for Microsoft Windows platforms. Therefore, some
conventions and operations differ on the macOS platform from those that appear in the rest of the
documentation. The intended action for the macOS platform is typically obvious. Mouse operations
follow macOS conventions.

Make the following replacements to adjust documented mouse instructions for Macintosh platforms if
you are using a one-button mouse:

• Replace right-click with Ctrl+click
• Replace middle-click with Command+click

Navigating Within the MATLAB Root Folder on macOS Platforms
On macOS platforms, MATLAB is installed as an application bundle. The root folder, the string
returned by the matlabroot command, has a .app extension.

To view the contents of the MATLAB root folder in the Mac Finder, right-click the MATLAB
application bundle, and then select Show Package Contents from the context menu.

To view the content of the MATLAB root folder from within MATLAB:

1
On the Home tab, in the File section, click 

2 In the File Browser dialog box, press Command+Shift+G to open the Go To Folder dialog box.
3 Enter the full path to a folder within the MATLAB application package, for example, /

Applications/MATLAB_R2019a.app/bin.
4 Press Go.

To open a file with a MATLAB command, such as edit, specify the full path of the MATLAB root
folder. For example:

edit(fullfile(matlabroot,'/toolbox/matlab/demos/lotka.m'))

MATLAB Dock Menu
Starting in MATLAB R2012a, the MATLAB Dock menu lists open windows and documents associated
with the running MATLAB. Choosing an open document from the Dock menu brings the selected
document's window to the foreground. In addition, the MATLAB Dock menu includes the item Open
Additional Instance of MATLAB. This option starts another instance of MATLAB. You can select
Options > Keep in Dock, but only for the first MATLAB instance. Use Open Additional Instance
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of MATLAB to start additional instances rather than trying to keep multiple MATLAB icons in the
Dock.
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Where MATLAB Stores Preferences

MATLAB and other MathWorks products store their preferences in the preferences folder. To see the
full path for the preferences folder type prefdir in the MATLAB Command Window. The name of the
preferences folder matches the name of the release. For instance, for release R2016b, the name of
the preferences folder is R2016b.

On macOS and iOS, the preferences folder might be inside another folder that is hidden. If so, to
access the hidden folder:

1 In the Finder, select Go > Go to Folder.
2 In the resulting dialog box, type the path returned by prefdir, and then press Enter.

You must have write access to the preferences folder. Otherwise, MATLAB generates an error in the
Command Window when you try to change preferences. MATLAB also can generate an error if the
preferences folder is hidden.

Temporary Preferences Folder
In some situations, if MATLAB is unable to create or use the preferences folder when starting up, it
creates a temporary preferences folder. If a preferences folder exists for any of the three releases of
MATLAB that immediately precede the one you are starting up, MATLAB copies the preference files
from that release to the temporary preferences folder. Otherwise, MATLAB creates the default
preference files for the current release. MATLAB continues to use the temporary preferences folder
until the issue is resolved.

If you make changes to preferences while MATLAB is using the temporary preferences folder, the
preferences persist across sessions. But, once the issue is resolved that was preventing MATLAB from
accessing the preferences folder, any changes made to the preferences while using the temporary
preferences folder are lost.

Each version of MATLAB can have a temporary preferences folder. MATLAB does not migrate
preferences from the temporary preferences folder across releases.

Effects of Installation and Deinstallation on the Preferences Folder
Installing MATLAB has no effect on the preferences folder. That is, MATLAB creates, checks, copies,
and writes to the preferences folder when it starts up, not when you install it. When you uninstall
MATLAB, there is an option in the uninstaller to remove the preferences folder. However, this option
is not selected by default.

See Also
prefdir | Preferences

Related Examples
• “Import Preferences From Other Releases” on page 2-62
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Import Preferences From Other Releases
When you start a newly installed version of MATLAB for the first time, it attempts to import your
preferences from a previous release installed on your system. MATLAB looks for preferences folders
according to these guidelines.

• MATLAB looks for a preferences folder for release R2019b or newer. If MATLAB finds one or more
preferences folders matching that criteria, it migrates the files from the most recent version.

For example, if you start R2021b and preferences folders exist for both the R2020b and R2019b
releases, then MATLAB migrates the files from the R2020b preferences folder to the R2021b
preferences folder.

Note For releases before R2021b, MATLAB looks back three releases. For example, if you start
R2019a, MATLAB looks for preferences from R2018b, R2018a, and R2017b.

• If a preferences folder does not exist from a valid previous release, then MATLAB creates the
default preference files for the release starting up.

For example, if you start R2021a, MATLAB looks for preferences for versions R2020b, R2020a,
and R2019b. If none of those is installed, MATLAB creates the default files for the R2021a release.
This is true even if a preferences folder exists for the R2019a release or earlier.

• If you install a release older than the current version, MATLAB does not import preferences from
releases that are newer than that release.

To see the full path for the preferences folder, type prefdir in the MATLAB Command Window. The
name of the preferences folder matches the name of the release you are running. For example, for
MATLAB R2021a, the name of the preferences folder is R2021a.

prefdir

ans =
    'C:\Users\username\AppData\Roaming\MathWorks\MATLAB\R2021a'

On macOS and iOS, the preferences folder might be inside another folder that is hidden. If so, to
access the hidden folder:

1 In the Finder, select Go > Go to Folder.
2 In the resulting dialog box, type the path returned by prefdir, and then press Enter.

Use Default Preferences
Instead of importing preferences from a previous release, you can use the default preferences for the
new release. To use the default preferences, delete all of the files in the preferences folder for the
corresponding release. Use the prefdir command to determine the full path of the preferences
folder.

For example, to use the default preferences for R2021a, start MATLAB, and in the Command Window,
type prefdir to determine the location of the preferences folder.

prefdir

ans =
    'C:\Users\username\AppData\Roaming\MathWorks\MATLAB\R2021a'
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Close MATLAB, delete all of the files in the folder C:\Users\username\AppData\Roaming
\MathWorks\MATLAB\R2021a, and then start MATLAB again. MATLAB starts with all preferences
set to their default values. One file to consider keeping is history.m. For more information, see “Set
Command History Preferences” on page 3-25.

Alternatively, if you have not started the new release yet, create an empty preferences folder for it.
This will prevent MATLAB from importing preferences when you do open the new release, and force
it to use the default preferences instead. For example, to use the default preferences for MATLAB
R2021a, if your MATLAB preferences are stored in the C:\Users\username\AppData\Roaming
\MathWorks\MATLAB folder, create the folder C:\Users\username\AppData\Roaming
\MathWorks\MATLAB\R2021a.

See Also
prefdir | Preferences

Related Examples
• “Where MATLAB Stores Preferences” on page 2-61
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Web Preferences

Web preferences enable you to specify internet connection information to MATLAB.

Limitations

• MATLAB supports nonauthenticated, basic, digest, and NTLM proxy authentication types.
• You cannot specify proxy server settings using a script.
• There is no automated way to provide MATLAB with the proxy server settings that your system

browser uses.

You can set Web preferences on the Home tab, in the Environment section. Click  Preferences.
Select MATLAB > Web, and then adjust preference options as described in this table.

Preference Usage
Use a proxy server to connect to
the Internet

Provide information that MATLAB needs to access the Internet when your
network uses a firewall or another method of protection that restricts
internet access.

Proxy host Specify a value for the Proxy host. For example, 172.16.10.8 or
ourproxy. If you do not know the values for your proxy server, ask your
system or network administrator for the information.

Proxy port Specify an integer value for the Proxy port. For example, 22. If you do
not know the values for your proxy server, ask your system or network
administrator for the information.

Use a proxy with authentication Specifies that your proxy server requires a user name and password.
Proxy username Specify the proxy server user name.
Proxy password Specify the proxy server password.
Test connection Ensure that your settings work.

If MATLAB cannot access the Internet, Failed! appears next to the
button. Correct the values you entered and try again. If you still cannot
connect, try using the values you used when you authenticated your
MATLAB license.

System Web browser UNIX platforms only, excluding Macintosh:

Specify the system Command to use to open the system browser. For
example, opera, opens the Opera Web browser.

Specify the Options to use for the system browser. For example,
geometry 1064x860 specifies the size of the window for Opera.

If you specify Firefox as the system browser using the system command
firefox, specify a display option to ensure that the browser opens
correctly.
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Entering Commands

• “Enter Statements in Command Window” on page 3-2
• “Find Functions to Use” on page 3-4
• “Format Output” on page 3-7
• “Stop Execution” on page 3-10
• “Find Text in Command Window or History” on page 3-11
• “Rerun Favorite Commands” on page 3-14
• “Set Command Window Preferences” on page 3-16
• “Set Keyboard Preferences” on page 3-19
• “Check Syntax as You Type” on page 3-20
• “Set Command History Preferences” on page 3-25
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Enter Statements in Command Window

As you work in MATLAB, you can enter individual statements in the Command Window. For example,
create a variable named a by typing this statement at the command line:

a = 1

MATLAB immediately adds variable a to the workspace and displays the result in the Command
Window.

a =

     1

When you do not specify an output variable, MATLAB uses the variable ans, short for answer, to
store the results of your calculation.

sin(a)

ans =

    0.8415

The value of ans changes with every command that returns an output value that is not assigned to a
variable.

If you end a statement with a semicolon, MATLAB performs the computation, but suppresses the
display of output in the Command Window.

b = 2;

To enter multiple statements on multiple lines before running any of the statements, use Shift+Enter
between statements. This action is unnecessary when you enter a paired keyword statement on
multiple lines, such as for and end.

You also can enter more than one statement on the same line by separating statements. To distinguish
between commands, end each one with a comma or semicolon. Commands that end with a comma
display their results, while commands that end with a semicolon do not. For example, enter the
following three statements at the command line:

A = magic(5),  B = ones(5) * 4.7;  C = A./B

A =
    17    24     1     8    15
    23     5     7    14    16
     4     6    13    20    22
    10    12    19    21     3
    11    18    25     2     9

C =
    3.6170    5.1064    0.2128    1.7021    3.1915
    4.8936    1.0638    1.4894    2.9787    3.4043
    0.8511    1.2766    2.7660    4.2553    4.6809
    2.1277    2.5532    4.0426    4.4681    0.6383
    2.3404    3.8298    5.3191    0.4255    1.9149
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MATLAB displays only the values of A and C in the Command Window.

To recall previous lines in the Command Window, press the up- and down-arrow keys, ↑ and ↓. Press
the arrow keys either at an empty command line or after you type the first few characters of a
command. For example, to recall the command b = 2, type b, and then press the up-arrow key.

To clear a command from the Command Window without executing it, press the Escape (Esc) key.

You can evaluate any statement already in the Command Window. Select the statement, right-click,
and then select Evaluate Selection.

In the Command Window, you also can execute only a portion of the code currently at the command
prompt. To evaluate a portion of the entered code, select the code, and then press Enter.

For example, select a portion of the following code:

hello

See Also
Command Window

Related Examples
• “Check Syntax as You Type” on page 3-20
• “Set Command Window Preferences” on page 3-16
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Find Functions to Use
This example shows how to find the name and description of a MathWorks function from the
Command Window using the Function browser.

1 In the Command Window, click the Browse for functions button  to the left of the prompt. The
Function browser opens.

Tip The Function browser closes when you move the pointer outside of it. To keep the browser
open, drag it by the top edge to a different location.

2 Optionally, select a subset of products to display in the list. Click the product area at the bottom
of the browser (where the text All installed products appears by default), and then set the
Selected Products preference and click OK. This preference also applies to the Help browser.

3 Find functions by browsing the list or by typing a search term. For example, search for the term
fourier.
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In the search results, a parenthetical term after a function name indicates either that the
function is in a product folder other than MATLAB, or that there are multiple functions with the
same name. For example, fft (comm) corresponds to the fft function in the Communications
Toolbox™ folder.

4 Select a function that you would like to use or learn more about, as follows.

• Insert the function name into the current window by double-clicking the name. Alternatively,
drag and drop the function name into any tool or application.

• View syntax information for the function by single-clicking its name. A brief description for
each of the syntax options displays in a yellow pop-up window.

Tip The pop-up window automatically closes when you move your pointer to a new item in the
results list. To keep the pop-up window open, drag it by the top edge to a different location.
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You can change the font that the Function browser uses by setting preferences. On the Home tab, in
the Environment section, select Preferences > Fonts. By default, the Function browser uses the
desktop text font and the pop-up window uses the Profiler font.
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Format Output
MATLAB displays output in both the Command Window and the Live Editor. You can format the
output display using several provided options.

Format Line Spacing in Output
By default, MATLAB displays blanks lines in Command Window output.

You can select one of two line spacing options in MATLAB.

• loose — Keeps the display of blank lines (default).

>> x = [4/3 1.2345e-6]

x =

    1.3333    0.0000

• compact — Suppresses the display of blank lines.

>> x = [4/3 1.2345e-6]
x =
    1.3333    0.0000

To change the line spacing option, do one of the following:

• On the Home tab, in the Environment section, click  Preferences. Select MATLAB >
Command Window, and then choose a Line spacing option.

• Use the format function at the command line, for example:

format loose
format compact

Note Line spacing options do not apply in the Live Editor.

Format Floating-Point Numbers
You can change the way numbers display in both the Command Window and the Live Editor. By
default, MATLAB uses the short format (5-digit scaled, fixed-point values).

For example, suppose that you enter x = [4/3 1.2345e-6] in the Command Window. The MATLAB
output display depends on the format you selected. This table shows some of the available numeric
display formats, and their corresponding output.

Numeric Display Format Example Output
short (default) x = 1.3333 0.0000
short e x = 1.3333e+00 1.2345e-06
long x = 1.333333333333333 0.000001234500000
+ x = ++
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Note The text display format affects only how numbers are shown, not how MATLAB computes, or
saves them.

To format the way numbers display, do one of the following:

• On the Home tab, in the Environment section, click  Preferences. Select MATLAB >
Command Window, and then choose a Numeric format option.

• Use the format function, for example:

format short
format short e
format long

See the format reference page for a list and description of all supported numeric formats.

Wrap Lines of Code to Fit Window Width
A line of code or its output can exceed the width of the Command Window, requiring you to use the
horizontal scroll bar to view the entire line. To break a single line of input or output into multiple
lines to fit within the current width of the Command Window:

1 On the Home tab, in the Environment section, click  Preferences. Select MATLAB >
Command Window.

2 Select Wrap Lines.
3 Click OK.

Note Line wrapping options do not apply in the Live Editor.

Suppress Output
To suppress code output, add a semicolon (;) to the end of a command. This is useful when code
generates large matrices.

Running the following code creates A, but does not show the resulting matrix in the Command
Window or the Live Editor:

A = magic(100);

View Output by Page

Output in the Command Window might exceed the visible portion of the window. You can view the
output, one screen at a time:

1 In the Command Window, type more on to enable paged output.
2 Type the command that generates large output.
3 View the output:

• Advance to the next line by pressing Enter.
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• Advance to the next page by pressing Space Bar.
• Stop displaying the output by pressing q.

To disable paged output, type more off.

Note Paged output options do not apply in the Live Editor.

Clear the Command Window
If the Command Window seems cluttered, you can clear all the text (without clearing the workspace)
by doing one of the following:

• On the Home tab, in the Code section, select Clear Commands > Command Window to clear
the Command Window scroll buffer.

• Use the clc function to clear the Command Window scroll buffer.
• Use the home function to clear your current view of the Command Window, without clearing the

scroll buffer.

See Also
clc | format | home | more
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Stop Execution
To stop execution of a MATLAB command, press Ctrl+C or Ctrl+Break.

On Apple Macintosh platforms, you also can use Command+. (the Command key and the period
key).

Ctrl+C does not always stop execution for files that run a long time, or that call built-ins or MEX-files
that run a long time. If you experience this problem, include a drawnow, pause, or getframe
function in your file, for example, within a large loop. Also, Ctrl+C might be less responsive if you
start MATLAB with the -nodesktop option.

Note For certain operations, stopping the program might generate errors in the Command Window.

To programmatically stop execution of a function or script before reaching the end, use the return
function. MATLAB returns control to the Command Window or the invoking function.

See Also
drawnow | getframe | pause | return
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Find Text in Command Window or History
In this section...
“Find Text in the Command Window” on page 3-11
“Find Text in the Command History Window” on page 3-12

Find Text in the Command Window
You can search text currently in the Command Window. This includes text that is visible on the
screen, and text that is in the scroll buffer. In MATLAB Online, to search text in the Command
Window, use the Ctrl+F keyboard shortcut to open the find and replace dialog box.

Search Using Find Dialog Box

To search for specified text in the Command Window, on the Command Window title bar, click the
action button , and then select Find. The Find dialog box opens. The search begins at the current
cursor position. MATLAB finds the text you specified and highlights it.

MATLAB beeps when a search for Find Next reaches the end of the Command Window, or when a
search for Find Previous reaches the top of the Command Window. If you have Wrap around
selected, MATLAB continues searching after beeping.

To search for the specified text in other MATLAB desktop tools, change the selection in the Look in
field.

You can increase the amount of information available in the Command Window so that more text is
available for searching. Doing so requires more memory. On the Home tab, in the Environment
section, click  Preferences. Select MATLAB > Command Window, and then increase the setting
for Number of lines in the command window scroll buffer.

Clearing the command window (for example, with the clc function), empties the scroll buffer. The
cleared text is no longer available for searching. To clear your display in the Command Window
without clearing the buffer, use the home function.

Search Using Keyboard Shortcuts

You can also perform an incremental search in the Command Window using keyboard shortcuts.

1 Begin an incremental search by using one of the defined keyboard shortcuts.

Action Windows Default
Shortcut

Macintosh or Emacs Default
Shortcut

Initiate a forward
incremental search.

Ctrl+Shift+S Ctrl+S

Initiate a backward
incremental search.

Ctrl+Shift+R Ctrl+R

An incremental search field appears in the bottom right corner of the MATLAB Desktop window.
For a forward search, the text F Inc Search appears. The F indicates a forward search.
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2 Begin typing your search term.

When you enter lowercase letters in the incremental search field, MATLAB looks for both
lowercase and uppercase instances of the letters. For example, if you enter b, MATLAB looks for
b and B. However, if you enter uppercase letters, MATLAB only looks for instances that match the
case you entered.

3 Perform incremental search actions using these keyboard shortcuts:

Action Keyboard Shortcut
Complete a partially highlighted set of characters. Ctrl+W
Find the next occurrence of a set of characters. Ctrl+S
Remove characters from the incremental search
field, back to the last successful search

Ctrl+G

If you search for a set of characters that does not appear in the Command Window text, Failing
appears in the incremental search field.

4 End incremental searching by pressing Esc (escape), Enter, or any other key that is not a
character or number.

The incremental search field disappears. The cursor remains at the position where the text was
last found, with the search text highlighted.

Find Text in the Command History Window
You can search for text in the Command History Window. You can search for text either at the
beginning of a command, or anywhere within a command.

1 In the Command History window, type in the Search field. To display the Search field if it is not
visible, click the action button , and then select Find.

2 Begin typing your search term.

The Command History window searches backward and selects the previous entry that contains
the sequence of letters you typed.

3 Select from the different search options using the buttons to the right of the search field. Options

include Match case , Match anywhere within command , and Match at beginning of

command .
4 Find the previous or next occurrence of the entry with the up and down arrow keys, respectively.
5 Press Esc to clear the search.

In MATLAB Online, to search for text in the Command History window, click the Command History

icon  in the sidebar and use the Search field to perform a search.

See Also
Command Window | Command History
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Related Examples
• “Find and Replace Text in Files and Go to Location”
• “Find Files” on page 6-2
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Rerun Favorite Commands
Create and Run Favorite Commands

MATLAB favorite commands (previously called command shortcuts) are an easy way to run a group of
MATLAB language statements that you use regularly. For example, you can use a favorite command to
set up your environment when you start working, or to set the same properties for figures you create.

To create a favorite command:

1 On the Home tab, in the Code section, click Favorites and then click New Favorite. The
Favorite Command Editor dialog box opens.

2 In the Label field, enter a name for the favorite command. For this example, enter Setup
Workspace.

3 In the Code field, type the statements you want the favorite command to run. You also can drag
and drop statements from the Command Window, the Command History Window, or a file.
MATLAB automatically removes any command prompts (>>) from the Code field when you save
the favorite command.

For example, enter these statements:

format compact
clear
workspace
filebrowser
clc

4 In the Category field, type the name of a new category or select an existing category from the
drop-down list. If you leave this field blank, the favorite command appears in the default
Favorite Commands category.

5 In the Icon field, select an icon.
6 To add the favorite command to the quick access toolbar, select both the Add to quick access

toolbar and Show label on quick access toolbar options.
7 To run the statements in the Code section and ensure that they perform the desired actions, click

Test.
8 When you are done configuring the favorite command, click Save.

To run a favorite command, on the Home tab, click Favorites and then click the icon for the desired
favorite command. All the statements in the Code field of the Favorite Command Editor execute as if
you ran those statements from the Command Window, although they do not appear in the Command
History window.

To edit a favorite command, click the Edit favorite command button  to the right of the favorite

command. To delete a favorite command, click the Delete favorite command button  to the right of
the favorite command. You also can right-click the favorite command and select Edit Favorite or
Delete Favorite.

Organize Favorite Commands
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You can organize your favorite commands by storing them in different categories.

To create a new category:

1 On the Home tab, in the Code section, click Favorites and then click New Category. The
Favorite Category Editor dialog box opens.

2 In the Label field, enter a name for the category. For this example, enter My Favorite
Favorites.

3 In the Icon field, select an icon.
4 To add the category to the quick access toolbar, select both the Add to quick access toolbar

and Show label on quick access toolbar options.
5 Click Save.

To move a category up or down in the list of categories, or to move a favorite command within a
category, drag the category or favorite command to the desired location. You also can use the Move

category to top  and Move category to bottom  buttons to the right of the category.

To change whether a single category or favorite command appears in the quick access bar, click the

Add to quick access toolbar  and Remove from quick access toolbar  buttons to the right of the
category or favorite command. In MATLAB Online, right-click the category or command and select
Add to quick access toolbar. To add all favorite commands to the quick access bar, on the
Home tab, right-click Favorites and select Add to quick access toolbar.

To further configure which favorite commands and categories appear in the quick access bar, on the
Home tab, in the Code section, click Favorites and then click  Quick Access. Configuring the
quick access bar is not supported in MATLAB Online.

See Also

More About
• “Customize Keyboard Shortcuts” on page 2-42
• “Set Command History Preferences” on page 3-25
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Set Command Window Preferences

You can customize the visual display and behavior of the Command Window and the command output
within it using Command Window preferences.

General Preferences for the Command Window
You can specify what is displayed in the Command Window and how it is displayed including the
default format of Datetime objects.

On the Home tab, in the Environment section, click  Preferences. Select MATLAB > Command
Window, and then adjust the options as described in this table.

Some Command Window preferences are not available in MATLAB Online.

Preference Usage
Text display Select a Numeric format option to specify the output format of numeric

values in the Command Window.

For details, see “Format Floating-Point Numbers” on page 3-7.
Select a Line spacing option to specify whether blank lines appear in
Command Window output. To suppress blank lines, select compact. To display
blank lines, select loose.

Datetime format Select a Locale option to specify the default input locale of the Datetime
object. You also can enter a custom locale. For more information, including a
list of common values, see datetime.
Select a Default date and time format option to specify the default format
of the Datetime object. You also can enter a custom format. For more
information, see the Format property for datetime arrays.
Select a Default date-only format option to specify the default date format
of the Datetime object. You also can enter a custom format. For more
information, see the Format property for datetime arrays.

Display Select Wrap lines to make each line of input or output in the Command
Window break into multiple lines to fit within the current width of the
Command Window.

For details, see “Wrap Lines of Code to Fit Window Width” on page 3-8.
Select Set matrix display width to eighty columns to limit the width of
matrix output.

If you also select Wrap lines, and the width of the Command Window is fewer
than 80 characters, each row of 80 characters of matrix output wraps to fit
within the width of the Command Window.
Select Show getting started message bar to display the Command Window
message bar that provides links to introductory information.
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Preference Usage
Select Show function browser button to display the Browser for functions
button  to the left of the prompt in the Command Window. You can use the
Function browser to search for MATLAB functions.
Select Suggest corrections for mistyped functions and variables to
display suggestions in the Command Window. If you enter an undefined
function, variable name, or MATLAB operator, MATLAB displays:

Did you mean:

followed by a suggested command at the command line. You can press Enter
to execute that command or Esc to delete the suggestion.
Number of lines in command window scroll buffer specifies the maximum
number of lines displayed in the Command Window. A larger scroll buffer
provides a larger base for search features, but requires more memory. By
default, the scroll buffer is set to 5,000 lines.

The scroll buffer size does not impact the number of lines that you can recall.
By default, you can use the up arrow key ↑ to recall all lines shown in the
Command History window, regardless of how many lines you see in the
Command Window.

Tab key Tab size specifies the number of spaces assigned to the tab key.

This setting does not apply if you have enabled tab completion for the
Command Window or Editor. To enable or disable tab completion, on the
Home tab, select Preferences > Keyboard.

Command Window Automatic Completions Preferences

You can change how MATLAB suggests and completes names in the Command Window.

On the Home tab, in the Environment section, click  Preferences. Select MATLAB > Command
Window > Automatic Completions, and then adjust the options as described in this table.

Preference Usage
Suggestions and completions Select Enable tab completion to suggest names when you type the first few

characters of the name and press the Tab key in the Command Window.

For more information, see “Check Syntax as You Type” on page 3-20.
Select Tab key narrows completions to continue to reduce the list of
suggestions as you type each additional character and press the Tab key.

For more information, see “Check Syntax as You Type” on page 3-20.
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Preference Usage
Select Enable function hints to display function syntax suggestions in the
Command Window.

When enabled, if you type a function name with an opening parenthesis, and
then pause, a tooltip opens showing the basic syntax information for the
function.

For more information, see “Check Syntax as You Type” on page 3-20.

In MATLAB Online, to show suggestions as you type in the Command Window, select Show
suggestions automatically. To show suggestions when you press the Tab key, select Use tab to
show suggestions (in addition to ctrl+space). To accept suggestions using the Right Arrow key,
select Use right arrow to accept suggestions (in addition to tab and enter).

See Also

More About
• “Check Syntax as You Type” on page 3-20
• “Set Keyboard Preferences” on page 3-19
• “Zoom and Change Desktop Fonts” on page 2-2
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Set Keyboard Preferences

You can set delimiter matching options in the Command Window, Editor, and Live Editor.

On the Home tab, in the Environment section, click  Preferences. Select MATLAB > Keyboard,
and then adjust the options as described in this table.

Preference Usage
Delimiter Matching Specify when and if MATLAB alerts you to matched and mismatched

delimiters. Delimiters include parentheses, brackets, braces, and, in the
Editor only, paired keywords.

Select Show matches and mismatches when typing for MATLAB to alert
you to matched and mismatched delimiters as you type.

Select Show matches and mismatches when using arrow keys for
MATLAB to alert you to matched and mismatched delimiters when you move
the cursor over a delimiter by using an arrow key.

For details, see “Delimiter Matching” on page 3-20.

See Also

Related Examples
• “Check Syntax as You Type” on page 3-20
• “Set Command Window Preferences” on page 3-16
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Check Syntax as You Type
In this section...
“Syntax Highlighting” on page 3-20
“Delimiter Matching” on page 3-20
“Code Suggestions and Completions” on page 3-21

Syntax Highlighting
To help you identify MATLAB elements, some entries appear in different colors in the Command
Window, the Editor, and the Live Editor. This color display is known as syntax highlighting. By default:

• Keywords are blue.
• Character vectors and strings are purple.
• Unterminated character vectors are maroon.
• Comments are green.

% check to see if A is greater than B
if A > B
"greater"
elseif A < B
"less"
end

Except for errors, output in the Command Window does not appear with syntax highlighting.

MATLAB software copies the selection to the clipboard in RTF format, which many Microsoft
Windows and macOS applications support. When you paste or drag a selection from the Editor and
Live Editor to another application, such as Microsoft Word, the pasted text maintains the syntax
highlighting colors and font characteristics from the Editor and Live Editor.

To change syntax highlighting preferences, on the Home tab, in the Environment section, click 
Preferences. Then, select MATLAB > Editor/Debugger > Language and from the Language
drop-down list, choose a language. To change syntax highlighting preferences in MATLAB Online,
select Editor/Debugger > MATLAB Language or Editor/Debugger > Other Languages.

Delimiter Matching

MATLAB indicates matched and mismatched delimiters, such as parentheses, brackets, and braces, to
help you avoid syntax errors. MATLAB also indicates paired language keywords, such as for, if,
while, else, and end statements.

In the Editor and Live Editor, MATLAB indicates matching delimiters by briefly underlining both
delimiters in the pair. In the Command Window, matching delimiters are indicated by highlighting
instead of underlining. In MATLAB Online, the Command Window behavior matches the Editor and
Live Editor behavior.

MATLAB indicates mismatching delimiters in the Editor, Live Editor, and Command Window by briefly
crossing out the mismatched delimiter.
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If a matching delimiter exists, but it is not visible on the screen, a window opens and displays the line
containing the matching delimiter. Click in the window to go to that line.

You can change if and when MATLAB alerts you to matched and mismatched delimiters. On the
Home tab, in the Environment section, click  Preferences. Select MATLAB > Keyboard and in
the Delimiter matching section, select from the available options.

Code Suggestions and Completions

When you write code in the Command Window, Editor, Live Editor, and App Designer, MATLAB shows
suggestions for the names of functions, models, MATLAB objects, files, folders, variables, structures,
graphics properties, parameters, and options. In addition, MATLAB shows basic syntax information
for functions. You can use these suggestions to write commands faster and avoid typographical
errors.

Name Suggestions

In the Editor, Live Editor, and App Designer, name suggestions appear as you type. You also can press
Ctrl+Space or the Tab key to show suggestions. MATLAB shows the first 100 name suggestions as
you type. To show new and more refined suggestions, continue typing.

To insert a suggestion in your code, use the arrow keys to select the name that you want, and then
press the Right Arrow, Tab, or Enter key to accept the suggestion. To clear the list of suggestions
without selecting anything, press the Esc key.

In the Command Window, name suggestions appear only after you press the Tab key. To show
suggestions, type the first few characters of the name that you want suggestions for, and then press
the Tab key. Use the arrow keys to select the name that you want, and then press the Tab key again
to accept the suggestion. In MATLAB Online, the Command Window also shows suggestions as you
type and when you press Ctrl+Space or the Tab key.

Name suggestions are useful when completing the names and values of graphics properties. For
example, plot(x,y,"LineStyle","-").
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You also can use suggestions to complete parameter names and options for certain functions. For
example, format("shortEng").

MATLAB displays suggestions based on its current state, including:

• Variables that are defined in the current workspace
• Files and folders that are on the search path or in the current folder
• Variables, functions, class properties, and class methods that are defined in the active document

and available at the current location of the cursor

MATLAB does not complete field names of structure arrays defined only within the active document.

Tip To insert a tab within a statement when suggestions and completions are enabled in the Editor,
Live Editor, and App Designer, first, add a space. Then, press the Tab key. Alternatively, go to the
Home tab, and in the Environment section, click  Preferences. Select MATLAB > Editor/
Debugger > Automatic Completions and in the Suggestions and completions section, clear the
Use tab to show suggestions (in addition to ctrl+space) option. If there are no available
completions, MATLAB always inserts a tab.

In the Command Window, to insert a tab, you must disable showing name suggestions on tab. To
disable showing name suggestions, in the Preferences window, select MATLAB > Command
Window > Automatic Completions and clear the Enable tab completion option. In the MATLAB
Online Command Window, clear the Use tab to show suggestions (in addition to ctrl+space)
option.
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Function Syntax Suggestions

When you type the name of a function followed by an opening parenthesis, MATLAB shows the basic
syntax information for the function. In the Editor, Live Editor, App Designer, and MATLAB Online
Command Window, if a function has multiple syntaxes, you can use the drop-down arrow to the right
of the syntax to show all available syntaxes. Alternatively, use Ctrl+Down Arrow to show and hide
the additional syntaxes. On macOS systems, use the Command key instead of Ctrl.

You can type an input for any argument that appears in blue. Enter your own input variables or
values, and not the argument names shown in the suggestion. The displayed syntax options change
based on the arguments you enter.

In the Editor, Live Editor, App Designer, and MATLAB Online Command Window, MATLAB shows
descriptions for each argument. Optional arguments are indicated by the (Optional) keyword next to
the argument description. If MATLAB suggests multiple arguments, click the arrow to the right of the
argument description to view the additional arguments. Alternatively, you can use the Ctrl+Alt
+Right Arrow and Ctrl+Alt+Left Arrow keyboard shortcuts.

To open the documentation for the function MATLAB is showing syntax suggestions for, click the Help
button  to the left of the function syntax suggestions, or, in the Command Window, click the More
Help... link below the function syntax suggestions.

Suggestions for function syntaxes and arguments appear for MATLAB installed functions and for
functions that you create. The suggestions for MATLAB functions come from the documentation. The
suggestions for functions that you create come from the function definition statement (first
executable line) in the MATLAB program file. That file must be on the search path or in the current
folder. For more information about adding help to the functions that you create, see “Add Help for
Your Program” and “Customize Code Suggestions and Completions”.

Disable Suggestions and Completions

In the Editor, Live Editor, and App Designer, you can disable showing suggestions automatically. You
also can disable the use of the Tab key for showing suggestions and the use of the Right Arrow key
for accepting suggestions. To disable these options, go to the Home tab, and in the Environment
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section, click  Preferences. Select MATLAB > Editor/Debugger > Automatic Completions
and in the Suggestions and completions section, clear one or more of the options:

• To disable showing suggestions automatically, clear the Show suggestions automatically option.
• To disable showing suggestions after you press the Tab key, clear the Use tab to show

suggestions (in addition to ctrl+space) option. When this option is cleared, you can still show
suggestions by pressing Ctrl+Space.

• To disable accepting a suggestion using the Right Arrow key, clear the Use right arrow to
accept suggestions (in addition to tab and enter) option. When this option is cleared, you can
still accept a suggestion using the Tab and Enter keys.

In the Command Window, you can disable showing name suggestions and function syntax
suggestions. To disable showing name suggestions, in the Preferences window, select MATLAB >
Command Window > Automatic Completions and clear the Enable tab completion option. To
disable showing function syntax suggestions, clear the Enable function hints option. To disable
reducing the list of suggestions as you type each additional character and press the Tab key, clear the
Tab key narrows completions option.

In MATLAB Online, the Command Window behavior matches the Editor, Live Editor, and App
Designer behavior. To disable showing suggestions automatically, using the Tab key for showing
suggestions, and using the Right Arrow key for accepting suggestions, in the Preferences window,
select MATLAB > Command Window > Automatic Completions. Then, in the Suggestions and
completions section, clear one or more of the options.

See Also

Related Examples
• “Enter Statements in Command Window” on page 3-2
• “Set Command Window Preferences” on page 3-16
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Set Command History Preferences

You can exclude statements from the command history and specify how many commands to save to
the command history file, History.xml. MATLAB uses the command history file for both the
Command History window and statement recall in the Command Window.

Note When you exclude statements from the command history file, you cannot recall them in the
Command Window, nor can you view them in the Command History window.

You can also change the way you search for previously executed statements in the command history.
Select from different search text matching options and change the way results are displayed in the
Command History window.

To set Command History preferences, on the Home tab, in the Environment section, click 
Preferences. Select MATLAB > Command History, and then adjust the options as described in the
following table.

Some Command History preferences are not available in MATLAB Online.

Option Usage
Save Select Save exit/quit commands to save exit and quit

commands in the command history.
Select Save consecutive duplicate commands to save
consecutive executions of the same statement in the command
history.

• With this option selected, if you run magic(5) two times in a
row, the entries for magic(5) appear on separate lines in the
command history.

• With this option cleared, the command history retains only one
entry for magic(5) and displays a tally of consecutive
executions to the left.

Select Don't save history file to prevent saving the command
history across sessions. This option is useful when multiple users
share the same machine. For example, the option prevents each
user from viewing statements others have run.

Any entries predating the current session remain unless you first
delete entries from the Command History window.
Save last n commands specifies the number of commands to save.

Match Select Match anywhere to retrieve statements that contain the
search text in any location.

Select Match beginning to retrieve statements that begin with the
search text. This option is selected by default.
Select Match case to retrieve statements that match the case of the
search text.
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Option Usage
Select Filter matches to display only statements that match the
search text. Clear Filter matches to display all previously executed
statements and highlight the statements that match the search text.

Show Select Show match toolbar to display a search toolbar at the top of
the Command History window. Search for previously executed
statements using the search field and change Match preferences
using the provided buttons.
Select Show match locations to display yellow markers to the
right of the scroll bar in the Command History window that indicate
the location of matches throughout the command history.
Select Show execution time to display an approximate execution
time to the right of each statement. Times display for any
statements that take longer than 0.1 seconds to execute.

Favorite Commands Select Don't show to disable showing favorite commands in the
Command History window.

Select Show default category to only show the default Favorite
Commands category in the Command History window.

Select Show all categories to show all the favorite commands
categories in the Command History window.

Change the Command History Date Format
MATLAB uses the short date format of your operating system to display dates in the Command
History window. To change the date format, for instance from MM/DD/YYYY to DD/MM/YYYY:

1 Change the short date format for your operating system as described in its documentation.
2 Restart MATLAB.

Note Clearing the command history deletes all entries from the Command History window. You
can no longer recall those entries in the Command Window.

See Also
Command History
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Help and Product Information

• “Ways to Get Function Help” on page 4-2
• “MATLAB Code Examples” on page 4-3
• “Search Syntax and Tips” on page 4-5
• “Bookmark and Share Page Locations” on page 4-7
• “Contact Technical Support” on page 4-9
• “Help Preferences” on page 4-11
• “Translated Documentation” on page 4-13
• “Information About Your Installation” on page 4-15
• “Install Documentation” on page 4-16
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Ways to Get Function Help

Each MATLAB function has supporting documentation that includes examples and describes the
function inputs, outputs, and calling syntax. This table describes ways to access that documentation.

Type of Help How to Access Example or Icon
Reference page in Help browser Use the doc command.

— or —
Select a function name in the
Editor, Command Window, or
Help browser; right-click; and
then select Help on Selection.

doc mean

Function syntax hints in
Command Window

After you type an open
parenthesis for function inputs,
pause or press Ctrl + F1.

mean(

Abbreviated help text in
Command Window

Use the help command. help mean

Function browser in Command
Window

Click the function icon to the
left of the command prompt.

Complete documentation in
Help browser

Click the Help button on the
quick access toolbar or on the
Home tab.
— or —
Enter search terms in the
Search box.

See Also
doc

More About
• “MATLAB Code Examples” on page 4-3
• “Search Syntax and Tips” on page 4-5
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MATLAB Code Examples
Standalone Examples
A standalone example is a readable version of a MATLAB script or live script that shows how to
accomplish a particular task. MATLAB and all MATLAB toolboxes include examples as part of the
installed documentation. (Before release R2012b, these examples were called demos.)

To access examples, click Examples at the top of a documentation page. The Help browser displays
the examples for the current product category.

MATLAB includes examples that demonstrate various functionalities. For instance, to view examples
demonstrating plotting in MATLAB, navigate to the MATLAB > Graphics > 2-D and 3-D Plots
category and click Examples at the top of the page.

To copy the example and supporting files onto your system and open the example, use the buttons at
the top of each example:

• When viewing an example in the Help browser — Click the button to open the example in
MATLAB. For instance, if the example is a live script, click the Open Live Script button to open
the example live script in MATLAB.

• When viewing an example in a web browser — Click the Copy Command button to copy the
command that opens the example. Then, enter the copied command into the MATLAB Command
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Window. You also can open some examples directly in your web browser by clicking the Try This
Example button.

Once the example is open, run it by clicking Run . To run the example one section at a time and
view the incremental results, select the first section and then step through the script by clicking Run
and Advance .

Additional examples, created by members of the MATLAB community, are available at the File
Exchange.

Inline Examples
The product documentation also includes inline code excerpts, such as examples on function pages
like cos or plot. You can run inline code from the Help browser by selecting the code, right-clicking,
and then selecting Evaluate Selection, as shown.

See Also
demo | echodemo | openExample

Related Examples
• “Create and Run Sections in Code”

External Websites
• File Exchange
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Search Syntax and Tips

You can search for keywords in the documentation by entering text in the Search box in the top-right
corner of the desktop or by entering text in the Help browser.

When you open a page from the search results, the keywords that you searched for appear
highlighted. To clear the highlighting, press the Esc key.

Search for Symbols and Special Characters
The search engine ignores common, insignificant words such as a, an, the, and of, unless they are
part of an exact phrase in quotation marks. It also ignores capitalization, punctuation, and special
characters such as +. To find a symbol or special character:

• Search for the word instead of the symbol or character, such as plus instead of +.
• View the documentation on “MATLAB Operators and Special Characters”.
• Search the PDF documentation, available from the documentation home page.

Use Operators to Improve Results
Searches can include the following operators:

"" Exact phrase

Example: "plot tools" finds pages that contain plot tools, in that sequence, with no
words between them.

* Wildcard

Requires at least two nonwildcard characters, and cannot appear at the start of a keyword
or in an exact phrase.

Example: plot* finds plot, plot3, and plotting.
OR Boolean OR

Example: plot OR graph finds pages with either plot or graph.
NOT Boolean NOT

Example: "plot tools" NOT "time series" finds pages with plot tools but excludes
pages with time series.

AND Boolean AND

Implied when no operator is present between keywords.

Example: plot AND tools is equivalent to "plot" "tools".

The Help browser search evaluates NOT operators first, OR operators second, and AND operators last.
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For example, this text searches for pages that contain either plotting tool or plot tools and contain
workspace, but do not contain time series.

"plotting tool" OR "plot tools" NOT "time series" AND workspace

Filter Results
You can filter search results using facets that appear on the left side of the page. For example, view
MATLAB topics by selecting MATLAB and Help Topics.

Where the Search Engine Searches
The search engine searches the following text in the documentation:

• Documentation — Text and code shown in the Help browser
• User interface examples — Help comments in the program file
• Videos — Titles

See Also
docsearch

Related Examples
• “Ways to Get Function Help” on page 4-2
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Bookmark and Share Page Locations

In this section...
“Bookmark Favorite Pages” on page 4-7
“View Page Locations” on page 4-7

Bookmark Favorite Pages
In the Help browser, bookmarks are called favorites. You can add, find, and organize favorites by

clicking the Favorites button in the Help browser, .

When you add a favorite, do not change the Callback. MATLAB requires special values to create a
shortcut that opens the page in the Help browser. In addition, if you want the bookmark to appear in
your list of favorites, keep the Category set to Help Browser Favorites, as shown.

Note You cannot migrate favorites that you save in one MATLAB release to a new release.

View Page Locations

To identify the location of a page in the Help browser to share with someone else, right-click within
the page, and then select Get Page Address.

The Help Page Location dialog box provides two ways to access the page:

• A web command to run from the command line that opens the page from the installed
documentation. This command is subject to change between releases, so it is not always accurate
for someone running a different version of MATLAB.

• A URL for the page corresponding to your product version at the MathWorks website. This
documentation is available to anyone, even if they do not have MathWorks products. However, to
access archived documentation from previous releases, as well as translated documentation, you
must sign in with a MathWorks Account.
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Note  If you are running a prerelease version, the URL is invalid because the documentation does
not yet exist on the website.
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Contact Technical Support
If you are using a MathWorks product and experience technical issues, you can contact MathWorks
technical support to report a bug or request help. Access to technical support requires a valid license
number and a Software Maintenance Service subscription.

To contact technical support directly from MATLAB, follow these steps. This method requires an
internet connection.

1 On the Home tab, in the Resources section, click  Request Support.
2 When requested, sign in using your MathWorks Account email address and password. If you do

not have a MathWorks Account, create one.

3 Provide information to help technical support reproduce your issue, such as a description of the
steps you followed or a code excerpt. Optionally, you can attach up to five files to your request,
where each file is no larger than 5 MB.
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4 Specify the product that is related to the issue.
5 Submit the request.

Alternatively, you can request support on the MathWorks Support page. For more information, see
Contact Support.

There are also many resources available on the MathWorks Support page. Some of the resources on
the page include documentation for MathWorks products, MATLAB Answers, and installation help.

See Also

External Websites
• MathWorks Support Page
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Help Preferences

To set Help preferences:

1 On the Home tab, in the Environment section, click  Preferences. Select MATLAB > Help.
2 Adjust the preference options as described in the table.

Preference Usage
Documentation Location Specify whether to view the documentation on the web at https://

www.mathworks.com/help (recommended) or the documentation
installed locally on your system. Viewing the web documentation requires
an internet connection.

The documentation is not installed as part of a MATLAB or other product
installation. If you set the documentation location to Installed locally
and MathWorks documentation is not installed on your system, you can
install it by clicking Install Documentation. If you run MATLAB on a
system with no internet connection (permanently offline), you can
download the documentation on a computer connected to the internet
and then install it on your system. For more information, see “Install
Documentation”.

If the Help browser is already open, changes to this preference apply only
to new Help browser tabs.

Selected Products Select the products to include for viewing and searching documentation
in the Help browser or Function Browser.

If your Documentation Location is set to view documentation on the
web, then you can select Show products that are not installed to
select and access documentation for all MathWorks products.

If the Help browser is already open, changes to this preference apply only
to new Help browser tabs.

Quick Help Display Specify whether help links display content in the Help browser or in a
small window. This preference applies to reference pages or program
help that you access using:

• Help on Selection in context menus or F1
• Function hints or the Function Browser
• Links in error messages

Language (selected non-English
systems only)

Specify whether documentation in the Help browser and context-sensitive
help appears in your system language or in English.

This option is available for selected non-English systems only. For more
information, see “Translated Documentation” on page 4-13.

To adjust the font size in the Help browser, use the Ctrl+Plus (+) and Ctrl+Minus (-) keyboard
shortcuts. On macOS systems, use the Command key instead of the Ctrl key.
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See Also

More About
• “Install Documentation”
• “Translated Documentation” on page 4-13
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Translated Documentation
Many MathWorks products have translated documentation in Japanese. In addition, some features of
MATLAB have translated documentation in Korean, simplified Chinese, Spanish, French, Italian, and
German. If you install documentation locally, a product with translated documentation usually installs
the translated documentation from the previous version and the English documentation for the
current version.

For information about documentation in other languages, contact your MathWorks Sales and Service
office.

Set Documentation Language in MATLAB
If the locale setting for your system (or display language on Windows 10) is set to Japanese, Korean,
Chinese, Spanish, French, Italian, or German, you can choose whether to view the documentation in
your system language or in English. If the documentation for a product is not translated, the Help
browser displays the English documentation.

To change the documentation language:

1 Go to the Home tab, and in the Environment section, click  Preferences.
2 Select MATLAB > Help.
3 Select a Language option. For example, to view the English documentation, select English.

Note The Language preference appears only when your system language is set to Japanese,
Korean, Chinese, Spanish, French, Italian, or German.

The Language preference changes the language only in the Help browser and context-sensitive help.
To change the language of the text in the MATLAB desktop, see “Change the MATLAB Desktop
Language” on page 9-14.

If the locale setting for your system (or display language on Windows 10) is set to Japanese, Korean,
or Chinese, you also can choose whether to view the installed documentation in your system language
or in English. Documentation in Spanish, French, Italian, and German is available only on the web.

To use the installed documentation and set its language:

1 Go to the Home tab, and in the Environment section, click  Preferences.
2 Select MATLAB > Help.
3 Set the Documentation Location to Installed locally.
4 Install the English documentation or the documentation for your system language.
5 Select a Language option.

Set Documentation Language on MathWorks Help Center Website
To change the language of the documentation on the MathWorks Help Center website:

1 Open the MathWorks Help Center website, https://www.mathworks.com/help.
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2 Click the country selection button at the bottom of the webpage, and select a country based on
the language in which you want to view the documentation.

See Also

Related Examples
• “Change the MATLAB Desktop Language” on page 9-14
• “Help Preferences” on page 4-11
• “Set Locale on Microsoft Windows Platforms” on page 9-5
• “Set Locale on Linux Platforms” on page 9-8
• “Set Locale on macOS Platforms” on page 9-7
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Information About Your Installation
MATLAB software can tell you what products are installed, their versions, and other information
about your license and platform. This information is important to have in the event you contact
technical support on page 4-9.

Type of Information You
Want

To Get the Information

Version and license for
Installed product

From the product, select Help > About Product Name.

Or use functions:

• license — for the license number
• ver — for version numbers for MATLAB and libraries
• version — for version numbers for MathWorks products

MATLAB platform In MATLAB, select Help > About MATLAB. The About MATLAB
dialog box shows 32-bit or 64-bit.

arch value used to locate
library files for the mex
function and standalone
applications

In MATLAB, select Help > About MATLAB. The About MATLAB
dialog box shows the arch value, for example win64.

Or use the computer function.
Passcodes and licenses From any desktop tool, select Help > Licensing > Manage Licenses.
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Install Documentation
By default, when using MATLAB, you access product documentation on the web. This reduces the
installation footprint.

To use documentation when your computer is not connected to the internet—either temporarily or
permanently — you can install the documentation on your machine.

To install the documentation, on a computer connected to the internet, follow the procedure in
“Install Documentation”.
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Workspace Browser and Variable Editor

• “Create and Edit Variables” on page 5-2
• “Display Statistics in the Workspace Browser” on page 5-10
• “Save and Load Workspace Variables” on page 5-12
• “Workspace and Variable Preferences” on page 5-14
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Create and Edit Variables

Create Variables
The MATLAB workspace consists of the variables you create and store in memory during a MATLAB
session. You can create new variables in the workspace by running MATLAB code or using existing
variables.

To create a new variable, enter the variable name in the Command Window, followed by an equal sign
(=) and the value you want to assign to the variable. For example, if you run these statements,
MATLAB adds the four variables x, A, I, and C to the workspace:

x = 5.71;
A = [1 2 3; 4 5 6; 7 8 9];
I = besseli(x,A);
C = {A A A};

You do not have to declare variables before assigning values to them.

If you do not end the assignment statement with a semicolon (;), MATLAB displays the result in the
Command Window. For example,

x = 5.71

x =
    5.7100

If you do not explicitly assign the output of a statement to a variable, MATLAB generally assigns the
result to the reserved word ans. The value of ans changes with every statement that returns an
output value that is not assigned to a variable. For example,

sin(1)

ans =
    0.8415

To view and edit variables, use the Workspace browser and Variables editor. (Some editing options
are not available in MATLAB Online.)

View Workspace Contents
To view a list of variables in your workspace, use the Workspace browser.

5 Workspace Browser and Variable Editor
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To open the Workspace browser if it is not currently visible, do either of the following:

• On the Home tab, in the Environment section, click Layout. Then, under Show, select
Workspace.

• Type workspace in the Command Window.

By default, the Workspace browser displays the base workspace. You also can view function
workspaces if MATLAB is in debug mode. For more information, see “Base and Function
Workspaces”.

To display additional columns such as size and range, on the Workspace browser title bar, click the
Show Workspace Actions button , and then click Choose Columns. In MATLAB Online, to select
which columns to display, right-click a column name in the Workspace panel and select or clear the
desired column names.

You also can use the who command in the Command Window to view a list of variables. To list
information about size and class, use the whos command. For example, if you have the variables x, A,
and I in your workspace, you can run the who and whos commands to view your workspace contents:

who

Your variables are:

A  C  I  x

whos

  Name      Size            Bytes  Class     Attributes

  A         3x3                72  double
  C         1x3               528  cell
  I         3x3                72  double
  x         1x1                 8  double

View Variable Contents
You can view the contents of a variable in several ways:

• Command Window — Type the variable name at the command prompt. For example:

x

x =
    5.7100

• Variables editor — In the Workspace browser, double-click a variable name. The Variables editor
opens for that variable.
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Some variables open a viewer or other tool appropriate for their type. For details, see the
documentation for that data or object type.

A Protected Property  or Private Property  icon next to a variable property in the
Variables editor indicates that the property is protected or private, respectively.

To change how the Variables editor displays variables, go to the View tab, and in the Format
section, select a number display format. The display format does not affect how values are
displayed in the Command Window or Workspace browser, or how the variables are saved.

Note The maximum number of elements in a variable that you can open in the Variables editor
depends on your operating system and the amount of physical memory installed on your system.

Edit Variable Contents
You can edit the contents of scalar (1-by-1) variables in the Workspace browser. To edit the contents,
click the variable value to select it and then enter a new value.

To edit other variables, open them in the Variables editor. For example, suppose that you create a cell
array, C, by running these commands in the Command Window:

A = magic(4);
C = {A A A};

In the Workspace browser, double-click the variable name C to open it in the Variables editor.
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To edit an element of a variable, double-click the element. The element opens in a new document
within the Variables editor. For example, if you double-click element C{1,1} in the Variables editor,
the contents of that cell open in a new tab. You can edit the value of a variable element by clicking
the element and typing a new value. Press Enter or click another element to save the change.

To return to the parent cell array or structure of an element, go to the View tab and click the Go Up
button.

Changes you make in the Variables editor are automatically saved in the workspace. Changes you
make to variables via the Command Window or other operations automatically update the information
for those variables in the Workspace browser and Variables editor.

Note

• You cannot edit elements or subsets of multidimensional arrays in the Variables editor.
• You cannot edit tall arrays in the Variables editor.
• When editing strings in the Workspace browser or as part of a structure in the Variables editor,

you must use double quotes to surround the string value.

Edit Table and Structure Array Variables

Tables (including timetables) and structure arrays support additional editing actions.
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Action Procedure
Modify column or row name Double-click the name and enter the new text.

Reorder variables Hover over the left side of a variable until a four-headed arrow
appears. Then, click and drag the column to a new location.

Modify units and description of
variables

Click the arrow that appears to the right of a variable name. Then,
enter new text in the Units and Description fields.

5 Workspace Browser and Variable Editor
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Action Procedure
Sort variable data Click the arrow that appears to the right of a variable name and

select Ascending or Descending.

Note The contents of a table are only visible and modifiable when the number of variables is fewer
than 5000. When the number of variables equals or exceeds 5000, you can only view the table
properties.

Changes made to certain variable types in the Variables editor also appear in the Command Window.
For example, suppose you have a table T that contains three columns, A, B, and C. If you delete
column A in the Variables editor, the line T(:,'A') = []; displays in the Command Window. To
suppress code display in the Command Window, on the View tab, clear the Show MATLAB Code
check box.

Resize or Reshape Variables
To modify the size, shape, and order of variable elements in the Variable editor, use one of these
procedures.

Action Procedure
Delete row, column, or variable
elements

Right-click the desired row header, column header, or selected
elements and select Delete Row or Delete Column.

Insert new row or column Right-click the desired row header, column header, or element and
select Insert Row Above, Insert Row Below, Insert Column to
the Left, or Insert Column to the Right. You can also add rows
or columns simply by entering a value in an empty row or column.
For example, to add a row and column to the array in C{1,1},
enter a value in element (5,5).
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Action Procedure
Cut variable elements Right-click the desired row header, column header, or selected

elements and select Cut. The cut values move to the clipboard and
are replaced by the default value for empty elements. For more
information, see “Empty Elements” on page 5-8.

Copy variable elements Right-click the desired row header, column header, or selected
elements and select Copy.

Paste variable elements Right-click the row header, column header, or element where you
want the insertion to begin and select Paste.

Paste cells from Microsoft Excel
spreadsheet

Right-click the element where you want the insertion to begin, and
then select Paste Excel Data.

Empty Elements

Empty elements in variables are assigned default values. Default assignments are:

• 0 for numeric arrays
• [] for cell arrays and structure arrays
• <undefined> for categorical variables

Copy, Rename, and Delete Variables
You can copy and paste, duplicate, rename, and delete variables within the Workspace browser.

Action Procedure
Copy variable to and from
clipboard

Select the variables, right-click, and then select Copy. Then, you
can paste the names, for example, into the Command Window or
an external application. Multiple variables are comma-separated.

Duplicate variable Select the variables, right-click, and then select Duplicate.
MATLAB creates a copy of the selected variables.

Rename a workspace variable Right-click the variable name, and then select Rename. Type the
new variable name and press Enter.

Delete all variables in
workspace

On the Home tab, in the Variable section, click Clear
Workspace.

You also can use the clear function in the Command Window.
Delete selected variables from
workspace

Select the variables in the Workspace browser, right-click, and
then select Delete.

You can also use the clear function in the Command Window. For
example, to clear variables A and B, use the command clear A B.

To preserve specified variables, but delete others, use the
clearvars function with the -except option. For example, to
clear all variables except variable A, use the command clearvars
-except A.
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To create a new workspace variable from an existing variable, in the Variables editor, select an
element, data range, row, or column in an array, and then in the Variable tab, select New from
Selection.

You can change the character that delimits decimals in the data when you cut and paste values from
the Variables editor into text files or other applications. You might do this, for instance, if you provide
data to a locale that uses a character other than the period (.). To change the delimiter character,
specify a Decimal separator for exporting numeric data via system clipboard in the “Variables
Preferences” on page 5-15.

Navigate Variable Contents
When editing variables in the Variables editor, some variables can contain large amounts of data,
making it difficult to navigate between elements. Use these keyboard shortcuts to move easily
between variable elements in the Variables editor. You cannot modify these keyboard shortcuts.

Action Keyboard Shortcut
Commit changes to element and move to next element.

“Variables Preferences” on page 5-15 enable you to specify what
the next element is. The default is to move down.

Enter

Move right.

Within a selection, Tab also moves from the last column in one row
to the first column in the next row.

Tab

Move in opposite direction of Enter or Tab. Shift+Enter or Shift+Tab
Move up m rows, where m is the number of visible rows. Page Up
Move down m rows, where m is the number of visible rows. Page Down
Move to column 1. Home
Move to row 1, column 1. Ctrl+Home
Edit current element, positioning cursor at the end of the element. F2 (Ctrl+U on Apple Macintosh

platforms)

See Also
openvar | Workspace Browser

More About
• “Variable Names”
• “Display Statistics in the Workspace Browser” on page 5-10
• “Workspace and Variable Preferences” on page 5-14
• “Save and Load Workspace Variables” on page 5-12
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Display Statistics in the Workspace Browser
For each variable or object, the Workspace browser can display statistics such as the Min, Max, and
Mean, when relevant. MATLAB performs these calculations using the min, max, and mean functions,
and updates the results automatically.

To display statistics, on the Workspace browser title bar, click the Show Workspace Actions 
button, and then select Choose Columns. Select the statistics you want MATLAB to calculate. In
MATLAB Online, to select which columns to display, right-click a column name in the Workspace
panel and select or clear the desired column names.

Improve Workspace Browser Performance During Statistical
Calculations
If you show statistical columns in the Workspace browser, and you work with very large arrays, you
might experience performance issues when the data changes as MATLAB updates the statistical
results. To improve performance, consider one or both of the following:

• Show only the statistics of interest to you.

On the Workspace browser title bar, click the Show Workspace Actions  button, and then
select Choose Columns. Clear the statistics that you do not want MATLAB to calculate. In
MATLAB Online, to change which statistics display, right-click a column name in the Workspace
panel and clear the statistics that you do not want MATLAB to calculate.

• Exclude large arrays from statistical calculations.

On the Home tab, in the Environment section, click the Specify preferences  button. Select
MATLAB > Workspace, and then use the arrow buttons under Statistical calculations to
change the maximum array size for which the Workspace browser performs statistical
calculations. Any variable exceeding the maximum array size reports <Too many elements> in
Workspace browser statistics columns instead of statistical results.

Include or Exclude NaN Values in Statistical Calculations
If your data includes NaNs (Not-a-Number values), you can specify that the Workspace browser
statistical calculations consider or ignore the NaNs. On the Home tab, in the Environment section,
click the Specify preferences  button. Select MATLAB > Workspace, and then select one of the
following:

• Use NaNs when calculating statistics

If a variable includes a NaN, and you select this option, the values for Min, Max, Var, and several
other statistics appear as NaN. However, Mode and several other statistics show a numeric result.

• Ignore NaNs whenever possible

If a variable includes a NaN, and you select this option, numeric results appear for most statistics
including Min, Max, and Mode. However, Var still appears as NaN.
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See Also

More About
• “Infinity and NaN”
• “Workspace and Variable Preferences” on page 5-14
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Save and Load Workspace Variables

The workspace is not maintained across sessions of MATLAB. When you quit MATLAB, the workspace
clears. However, you can save any or all the variables in the current workspace to a MAT-file (.mat).
You can then reuse the workspace variables later during the current MATLAB session or during
another session by loading the saved MAT-file.

Save Workspace Variables
There are several ways to save workspace variables interactively:

• To save all workspace variables to a MAT-file, on the Home tab, in the Variable section, click
Save Workspace.

• To save a subset of your workspace variables to a MAT-file, select the variables in the Workspace
browser, right-click, and then select Save As. You also can drag the selected variables from the
Workspace browser to the Current Folder browser.

• To save variables to a MATLAB script, click the Save Workspace button or select the Save As
option, and in the Save As window, set the Save as type option to MATLAB Script. Variables
that cannot be saved to a script are saved to a MAT-file with the same name as that of the script.

You also can save workspace variables programmatically using the save function. For example, to
save all current workspace variables to the file june10.mat, use the command

save('june10')

To save only variables A and B to the file june10.mat, use the command

save('june10','A','B')

To store fields of a scalar structure as individual variables, use the save function with the -struct
option. This can be useful if you previously loaded variables from a MAT-File into a structure using
the syntax S = load(filename) and want to keep the original variable structure when saving to a
new MAT-File.

To save part of a variable, use the matfile function. This can be useful if you are working with very
large data sets that are otherwise too large to fit in memory. For more information, see “Save and
Load Parts of Variables in MAT-Files”.

In MATLAB Online, variables persist between sessions. Saving allows you to clear the workspace and
load variables at a later time. To save variables, use the save or matfile functions.

Load Workspace Variables
To load saved variables from a MAT-file into your workspace, double-click the MAT-file in the Current
Folder browser.

To load a subset of variables from a MAT-file on the Home tab, in the Variable section, click Import
Data. Select the MAT-file you want to load and click Open. You also can drag the desired variables
from the Current Folder browser Details panel of the selected MAT-file to the Workspace browser. In
MATLAB Online, you also can click the Preview button  to the right of the MAT-file in the Files
browser and drag the desired variables from the preview to the Workspace panel.
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To load variables saved to a MATLAB script into the workspace, simply run the script.

You also can load saved variables programmatically, use the load function. For example, load all
variables from the file durer.mat

load('durer')

To load variables X and map from the file durer.mat

load('durer','X','map')

To load part of a variable, use the matfile function. This is useful if you are working with very large
data sets that are otherwise too large to fit in memory. For more information, see “Save and Load
Parts of Variables in MAT-Files”.

Caution When you load data into the MATLAB workspace, the new variables you create overwrite
any existing variables in the workspace that have the same name. To avoid overwriting existing
variables, use the load function to load the variables into a structure. For example, S =
load('durer') loads all the variables from the file durer.mat into the structure S.

View Contents of MAT-File
To see the variables in a MAT-file before loading the file into your workspace, click the file name in
the Current Folder browser. Information about the variables appears in the Details pane.

Alternatively, use the command whos -file filename. This function returns the name, dimensions,
size, and class of all variables in the specified MAT-file. For example, you can view the contents of the
example file durer.mat.

whos -file durer.mat

 Name           Size               Bytes  Class     Attributes

  X            648x509            2638656  double              
  caption        2x28                 112  char                
  map          128x3                 3072  double              

The byte counts represent the number of bytes that the data occupies in memory when loaded into
the MATLAB workspace. Because of compression, data encoding, and metadata, the space occupied
in the file by a variable may be different from the in-memory size. MATLAB compresses data in
Version 7 or higher MAT-files. For more information, see “MAT-File Versions”.

See Also
save | load

More About
• “MAT-File Versions”
• “Save and Load Parts of Variables in MAT-Files”
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Workspace and Variable Preferences

In this section...
“Workspace Preferences” on page 5-14
“Variables Preferences” on page 5-15

Workspace Preferences

Workspace preferences enable you to configure options for saving workspace variables to MATLAB
scripts. They also enable you to restrict the size of arrays on which MATLAB performs calculations,
and to specify if you want those calculations to include or ignore NaNs.

To open Workspace preferences, on the Home tab, in the Environment section, click 
Preferences. Select MATLAB > Workspace.

Preference Usage
Threshold for saving variables to MATLAB
script

Specify Maximum array size to limit the
number of elements of arrays saved to a MATLAB
script.
Specify Maximum struct/object nesting levels
to limit the nesting level of structures, arrays, or
objects saved to a MATLAB script.

Multidimensional array formatting Specify how multidimensional arrays are
formatted when saved to a MATLAB script.

To create a compact script, select Row vector
with reshape (compactness and efficiency).

To retain array representation, select As 2-D
pages (readability). Specify the dimensions of a
2-D slice as positive integers less than or equal to
the dimensions of the n-D array. The second
integer must be greater than the first.

File formatting Set the character width at which text in the
MATLAB script is wrapped by specifying
Maximum characters per line.

Statistical calculations Set the maximum array size to display statistics
for in the Workspace browser using the element
and smaller arrays show statistics option.
Excluding large arrays from statistical
calculations improves Workspace browser
performance.

For more information, see “Display Statistics in
the Workspace Browser” on page 5-10.
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Preference Usage
Specify whether NaN values are included or
excluded from calculations for the statistics
displayed in the Workspace browser.

Select Use NaNs when calculating statistics
to include NaN values or Ignore NaNs when
calculating statistics to exclude NaN values.

For more information, see “Display Statistics in
the Workspace Browser” on page 5-10.

MATLAB array size limit By default, MATLAB can use up to 100% of the
size of RAM (not including virtual memory) of
your computer to allocate memory for each
MATLAB array. To change this limit to a smaller
percentage, select the Limit the maximum
array size to a percentage of RAM check box.
Then move the slider to adjust the percentage of
RAM.

To allow MATLAB to use both RAM and virtual
memory when creating an array, clear the Limit
the maximum array size to a percentage of
RAM check box. If MATLAB attempts to allocate
memory that exceeds the resources available on
the computer, your system might become
nonresponsive.

This limit applies to the size of each array, not the
total size of all MATLAB arrays.

Variables Preferences

When working in the Variables editor, Variables preferences enable you to specify array formatting,
cursor movement, and the decimal separator for exporting data using the system clipboard.

To open Variables preferences, on the Home tab, in the Environment section, click  Preferences.
Select MATLAB > Variables.

Preference Usage
Format Select an option from the Default array format to specify the

default array output format of numeric values displayed in the
Variables editor. This format preference affects only how numbers
display, not how MATLAB computes or saves them. For
information on formatting options, see the reference page for the
format function.
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Preference Usage
Editing Specify where the cursor moves to after you type an element and

press Enter.

To keep the cursor in the element where you typed, clear the
Move selection after Enter check box.

To move the cursor to another element, select the Move
selection after Enter check box. In the Direction field, specify
how you want the cursor to move.

International number
handling

In the Decimal separator for exporting numeric data via
system clipboard field, specify the decimal separator for
numbers you cut or copy from the Variables editor and then paste
into text files or other applications.

This preference has no effect on numeric data copied from and
pasted into MATLAB. Within MATLAB, decimal separators are
always periods.

Some Variables preferences are not available in MATLAB Online. To show generated code in the
Command Window when performing operations in the MATLAB Online Variables Editor, select Show
MATLAB code for operations.

See Also

More About
• “Create and Edit Variables” on page 5-2
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Managing Files in MATLAB

• “Find Files” on page 6-2
• “Compare Files and Folders and Merge Files” on page 6-6
• “Compare and Merge Live Scripts and Functions” on page 6-17
• “Compare and Merge Apps” on page 6-21
• “Compare and Merge MAT-Files” on page 6-25
• “Compare XML Files” on page 6-29
• “Manage Files and Folders” on page 6-34
• “Files and Folders that MATLAB Accesses” on page 6-37
• “Current Folder Browser Preferences” on page 6-39
• “Specify File Names” on page 6-41
• “Create and Extract from Zip Archives” on page 6-44
• “What Is the MATLAB Search Path?” on page 6-46
• “Change Folders on Search Path” on page 6-50
• “Use Search Path with Different MATLAB Installations” on page 6-54
• “Add Folders to the MATLAB Search Path at Startup” on page 6-55
• “Assign userpath as Startup Folder (Macintosh or UNIX)” on page 6-57
• “Path Unsuccessfully Set at Startup” on page 6-58
• “Errors When Updating Folders on Search Path” on page 6-60
• “Troubleshoot Invalid or Unresponsive Windows Change Notification Handles” on page 6-61
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Find Files
In this section...
“Simple Search for File Names” on page 6-2
“Advanced Search for Files” on page 6-2
“Advanced Search in MATLAB Online” on page 6-4

Simple Search for File Names
If you know the name of the file you want to find, begin typing the first characters of the name in the
Current Folder browser. As you type, the Current Folder browser searches downward from the top of
the window, looking through all expanded folders. To open the Current Folder browser if it is not
open, on the Home tab, in the Environment section, click Layout. Then, under Show, select
Current Folder.

Alternatively, to search for a series of characters anywhere in the name of a file:

1 Click the search button  in the current folder toolbar. The address bar becomes a search field.
2 Type a portion of a file name. The asterisk character (*) is a wildcard. For example, to show only

file names that begin with coll and have a .m extension, type coll*.m.
3 Press Enter.

MATLAB displays all files within the current folder (including its subfolders) that match that file
name. If you typed the full path to a folder, that folder becomes the current folder.

To clear the results and show all items in the current folder, press the Esc key.

In MATLAB Online, to search for files in the current folder or in the current project, go to the Home

tab and click the  Go to File button.

Advanced Search for Files

To perform an advanced search for files, you can use the Find Files tool. Use the Find Files tool to:

• Search for specific text in file names and within files
• Include or exclude specified file types from your search
• Search in specified folders
• Exclude large files from your search

To open the Find Files tool, on the Home tab, in the File section, click  Find Files. Enter your
search criteria in the dialog box that opens.
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Use the Look in menu to specify the folders you want to search. Select Entire MATLAB Path to
search all folders on the MATLAB search path. Alternatively, you can browse for a folder by selecting
Browse... or you can enter the full path for one or more folders. Separate each path with a semicolon
(;).

Click Find to begin the search. Search results appear in the right pane of the dialog box, with a
summary at the bottom. For text searches, results include the line number and line of code. To see file
locations, select Show full path names.

Open one or more files by right-clicking the files and selecting one of the Open options.

Include or Exclude File Types

You can search for files with only a specified extension, by selecting an option in the Include only
file type(s) menu. For example, select *.m, *.mlx to limit the search to MATLAB program files.

To exclude some file types from the search:

1 In the Include only file type(s) menu, select All files (*).
2 Under More options, select the Skip file type(s) box and click Edit. The Edit Skipped File

Extensions dialog box opens.
3 Select the State check box for the file types to exclude from your search.
4 Click OK to accept your changes.

You can remove any file extension from the list by selecting the extension to highlight it. Then, click
Remove.

Search Within File

Under More options, you can choose to search file contents for a partial word. From the Search
type menu, select Contains text. To find an exact full-word match, select Matches whole word.
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Searching within large files can be time consuming. To speed up your search, specify a file size in the
Skip files over field. The Find Files tool ignores files larger than the size you specify.

Troubleshooting

If the Find Files tool does not find the file you want, try the following:

• When searching for file names, use the asterisk character (*) as a wildcard character to expand
your search. For example, to show file names that begin with coll and have a .m extension, type
coll*.m.

• Select the Include Subfolders check box if the file might be in a subfolder.
• If you select the Skip file type(s) check box, ensure that you do not exclude relevant file types

from your search. Click Edit and review the Edit Skipped File Extensions dialog box. Ensure that
relevant file types do not have the State check box selected.

Advanced Search in MATLAB Online

In MATLAB Online, to perform an advanced search for files, click the Find Files icon  in the
sidebar. If the Find Files icon is not in the left or right sidebar, go to the Home tab, and in the File
section, click  Find Files.

Select a search option to change how the Find Files tool searches for text:

•  Match case – Search only for text with the precise case of the search text.
•  Match whole word – Search only for exact full-word matches.

You also can use the Filters button  to specify whether to search for file names or file content, what
folder to search in, and what file types to include in the results.

See Also
dir | exist | what | which

More About
• “Find Functions to Use” on page 3-4
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• “What Is the MATLAB Search Path?” on page 6-46
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Compare Files and Folders and Merge Files

You can use the Comparison Tool to display the differences between selected pairs of files or folders.
For some file types, you also can merge changes from one file to the other.

Comparison Process
The comparison process involves three steps:

1 Select the files or folders to compare.
2 Choose a comparison type.
3 Explore the comparison report.

Select the Files or Folders to Compare

You can select files and folders to compare using any of these methods:

•
MATLAB desktop — Go to the Home tab, and in the File section, click Compare. Click the 
button to select items to compare, or drag and drop files from your file browser into the First file
or folder or Second file or folder fields.

• Current Folder browser — Select a file or folder, right-click, and select Compare Against. Click

the  button to select a second item to compare, or drag and drop a file from your file browser
into the Second file or folder field. To select two files or subfolders to compare, Ctrl-click the file
names. Then right-click and select Compare Selected Files/Folders.

• Editor or Live Editor — Go to the Editor or Live Editor tab, and in the File section, click
Compare. The Comparison Tool includes the currently open file in the First file or folder field.

Click the  button to select a second item to compare, or drag and drop a file from your file
browser into the Second file or folder field.

To compare a file with the autosave version or the saved version on disk, go to the Editor tab and
click Compare  and select Compare with Version on Disk or Save and Compare with
Autosave. If your file is modified, the Editor saves the file before comparing. The Compare with
Version on Disk and Save and Compare with Autosave options are only available if the option
for automatically saving changes to a file is disabled. To disable the option, go to the Home tab,
and in the Environment section, click Preferences. Then, select Editor/Debugger and clear
Save changes upon clicking away from a file. This option is not available in the Live Editor.

• Command Window — Use the visdiff function. For example, to compare the two files
lengthofline.m and lengthofline2.m using the visdiff function and the default text
comparison, type visdiff('lengthofline.m','lengthofline2.m'). MATLAB opens the
Comparison Tool and displays the resulting comparison report.

Tip When selecting folders to compare, select Include subfolders to include subfolder content in
the comparison.

Choose a Comparison Type

The Comparison Tool compares selected items using the default comparison type defined for the
selected items. For some item types, you can select a different comparison type from the default. For

6 Managing Files in MATLAB

6-6



example, you can choose from a text, binary, file list, or XML comparison. To change the comparison
type, select the files or folders to compare. Then, select from the available Comparison type options.
The Comparison Tool displays only the valid options for the selected item types.

You cannot change the comparison type for an existing comparison report. To change the comparison
type, start a new comparison.

If you specify two files or folders to compare using either the Current Folder browser or the visdiff
function, then the Comparison Tool automatically performs the default comparison type. For example,
from the Current Folder browser, if you select two XML files to compare, the tool uses the default text
comparison. To change the comparison type to a hierarchical comparison instead, create a new
comparison using the Comparison Tool.

Explore the Comparison Report

After selecting the comparison type, click the Compare button. The comparison report opens. You
can explore the comparison report in different ways depending on the items being compared. For
more information, see the details described for each comparison type below.

Compare Folders and Zip Files

You can compare any combination of folders and ZIP files using the Comparison Tool. For example,
you can compare the contents of a folder to the contents of a ZIP file. The Comparison Tool performs
a file list comparison of the selected items.

Create a folder comparison report to:

• Identify common files.
• Determine whether files or folders with identical names have identical content. If such files or

folders exist, you can open a detailed comparison report for the items directly from the report.

When you perform a file list comparison, a new window opens and displays the contents of the
specified lists side by side. For example, suppose that you have two folders, curvefittings and
curvefittings2, with several differences. When you compare the two folders, the Comparison Tool
displays the resulting report.
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The Comparison Tool highlights files and subfolders that do not match using the colors listed in this
table.

Highlight Color Description
Purple The contents of the files or folders differ. Click

the compare link to investigate.
Blue The file or folder only exists in the right list.
Yellow The file or folder only exists in the left list.
None The files or folders are identical.

You further can explore the results using several methods:

• To sort the results by name, type, size, or last modified timestamp, click the corresponding column
header. For example, click the Type column header to sort by folder and file type.

• To open a detailed comparison report for items with differing content, click the compare link next
to the item.

• To open a file in the Editor, click the open link next to a file name. If the file is present in both
folders, you can click links to open the left or right version of the file.

• If subfolders are very large and contain many files, analysis continues in the background. The tool
displays the number of items still to be compared at the top of the report. You can click Skip
Current to skip the current item or Cancel All to stop further analysis.
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• To save time when reviewing differences, especially when comparing many subfolders, you can
filter the report. To apply a filter, on the View tab, select Filter > "filterName".

To create a new filter, on the View tab, select Filter > Add/Remove Filter. You can specify filters
to ignore certain files and folders, such as backup files or files created by a revision control
system. For example, to ignore all files and folders in a folder named CVS, type CVS/. To ignore all
files in a folder named CVS, but not ignore subfolders, type CVS/*.

To edit existing filters, double click the filter.

For information about how to further configure the comparison report, see “Additional Comparison
Tools” on page 6-15.

Compare MATLAB Projects in MATLAB Online

In MATLAB Online, you can compare project definition files. When you compare folders, MATLAB
detects whether they are project root folders. MATLAB looks for and compares the project definition
files stored in the resources or .SimulinkProject folder. Project definition files contain
information about the project path, project settings, shortcuts, labels, and referenced projects.

To compare project definition files, select the PRJ files or the project root folders, right-click your
selection and select Compare Selected Files/Folders. When you select a node in the results report,
the Comparison Tool shows more details in the bottom pane.
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This example comparison shows that:

• AnalogControl.slx (purple) is modified.
• f14_airframe.slx (yellow) is replaced by f14_airframe.mdl (blue) in the project.
• LinearActuator.slx is modified (purple) and the model has a new label associated to it (blue).
• A new label classification category named Release Branch is added.
• The reference to the Signal Multiplier project is deleted.
• The F14 Model shortcut is deleted.
• Project settings such as project details, path, and dependency settings are modified. For example,

in the Details section of Project Settings, the project description is modified.
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You can compare project definition files only in MATLAB Online.

Compare Text Files
You can compare and merge lines in two text files using the Comparison Tool. When you perform a
text comparison, a new window opens and displays the two files side by side.

Compare Files

A user made some changes to lengthofline.m and saved the resulting file as lengthofline2.m.

Use visdiff to compare the lengthofline.m and lengthofline2.m files.

visdiff("lengthofline.m","lengthofline2.m")

The Comparison Tool displays the resulting report.
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Understand Comparison Results

The Comparison Tool displays the total number of differences in the bottom-right corner of the
comparison report and highlights the lines that have changed with the colors listed in this table.

Highlight Color Description
Purple The line contains differences.
Dark Purple The highlighted characters are different.
Blue The line exists only in the right file. This can happen when the

line is inserted in the right file, or when it is deleted from the
left file. The corresponding line in the left file is highlighted
using a gray striped pattern.
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Highlight Color Description
Yellow The line exists only in the left file. This can happen when the

line is inserted in the left file, or when it is deleted from the
right file. The corresponding line in the right file is
highlighted using a gray striped pattern.

The Comparison Tool attempts to match lines and detects text that is added, deleted, or changed. For
example, in the text comparison of lengthofline.m and lengthofline2.m, the tool determines
that lengthofline2.m has a line of code that does not exist in lengthofline.m and highlights it
(line 22) in blue. Also, the tool takes the additional line into account and determines that the line
containing the end statement in each file matches, even though the end statement does not occur on
the same line number in both files.

You further can explore and configure the results using several methods:

• Ignore white space differences — To help distinguish between functional changes and changes to
indentation, you can hide white space differences. To hide differences that only involve white
space characters, click Filter, and select Ignore White Space.

•
Show compared files details — To show the file details, click the expand arrow  next to the file
name.

• Save comparison report — To save a copy of the comparison report, select Publish > Publish to
HTML, Publish to Word, or Publish to PDF.

For information about how to further configure the comparison report, see “Additional Comparison
Tools” on page 6-15.

To step through the results one difference at a time, use the  Next and  Previous buttons.

By default, XML files are compared using a text comparison. To compare XML files with a
hierarchical comparison instead, see “Compare XML Files” on page 6-29.

Merge Text Files
When comparing text files, you can merge changes from one file to the other. Merging changes can
be useful when resolving conflicts between different versions of files. When merging changes, you
only can merge from left to right. If you want to merge into the left file, click the  Swap Sides
button before you start merging. Clicking the  Swap Sides button reverts any merges already
made and creates a new comparison report for the original files.

To begin merging, on the Comparison tab, click the  Merge Mode button. Then, to replace
content from the right pane with content from the left pane, click the  button located next to the
line you want to merge. You also can select a difference and, in the Comparison tab, click the 
Replace Content button.

The right pane contains the merged result. An asterisk next to the merged file name in the right pane
(lengthofline2.m *) indicates that the file contains unsaved changes.

To undo a replacement, click the  button between the modified lines or on the Comparison tab. To
revert all merges and start again, click the  Refresh button. You also can click the  Refresh

 Compare Files and Folders and Merge Files

6-13



button to update the comparison report after making changes to and saving the files. Refreshing
discards all unsaved merged changes.

To save your changes and return to the comparison report, click the  Save Result button. To

return to the comparison report without saving changes, click the  Return to Comparison
button.

Compare Binary Files

You can compare two binary files, such as DLL files or MEX files, using the Comparison Tool. You also
can perform a binary comparison on any two selected files, instead of the default comparison.

To compare any two files using a binary comparison, in the Comparison type menu, select Binary
comparison. When you perform a binary comparison, a new window opens and indicates whether
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the two files are identical or different. If the files are different, click the Show Details link to view
the binary files and the byte offset of the first difference.

Compare Other File Types
You can use the Comparison Tool to compare other file types:

• Live Code — Compare and merge the code and text in two live code files. For more information,
see “Compare and Merge Live Scripts and Functions” on page 6-17.

• Apps — Compare and merge the code in two apps. For more information, see “Compare and
Merge Apps” on page 6-21.

• MAT-Files — Compare and merge variables in two MAT-files. For more information, see “Compare
and Merge MAT-Files” on page 6-25.

• XML Files — Compare two XML files using a text comparison or a hierarchical XML comparison.
For more information, see “Compare XML Files” on page 6-29.

• Simulink Models — If you have Simulink, you can compare and merge Simulink models. For
information, see “Model Comparison” (Simulink).

Additional Comparison Tools
You can further explore and configure a comparison report using these available tools:

• Swap Sides button — Switch the left side file or folder with the right side file or folder.
• Refresh button — Update the results in the Comparison Tool after making changes to and saving

the files in the Editor.
• Find button — Find a phrase in the current display. For more information, see “Find Text in

Command Window or History” on page 3-11.

Comparison Preferences

You can customize the Comparison Tool using Comparison preferences. To change the Comparison
preferences, on the Home tab, in the Environment section, click  Preferences. Then, select
MATLAB > Comparison.

Color Preferences

You can change the colors that the Comparison Tool uses to highlight lines that have changed. Color
preferences apply to all comparison types.

To change the color preferences, in the Comparison preferences Colors section, change the colors for
differences, modified lines, modified content, and merged lines. The Sample area shows a preview of
the selected colors. After changing comparison colors, you must refresh any open comparison reports
to see the updated colors.

To save the modified color preferences for use in future MATLAB sessions, click Save As and enter a
name for your color settings profile. After saving a color profile, you can select the profile in the
Active Settings list. To restore the default color profile, click Reset.

 Compare Files and Folders and Merge Files

6-15



External Source Control Integration Preferences

You can use the Comparison Tool to compare and merge files and folders in external source control
tools. To enable external source control tools to reuse open MATLAB sessions, in the Comparison
preferences External Source Control Integration section, select the Allow external source
control tools to use open MATLAB sessions for diffs and merges option. When you configure
your source control tool to use the MATLAB Comparison Tool, the Comparison Tool prompts you to
select this option.

For more information, see “Customize External Source Control to Use MATLAB for Diff and Merge”
(Simulink).

See Also
visdiff

Related Examples
• “Customize External Source Control to Use MATLAB for Diff and Merge”

External Websites
• Programming: Structuring Code (MathWorks Teaching Resources)
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Compare and Merge Live Scripts and Functions

You can compare two live code files and merge changes between one file and another using the
Comparison Tool. The Comparison Tool highlights differences in code, text, and text formatting.

Select Files to Compare
There are multiple ways to select two files and start the Comparison Tool:

• Live Editor — Go to the Live Editor tab and, in the File section, click Compare. The Comparison

Tool includes the currently open file in the First file or folder field. Click the  button to select
a second item to compare, or drag and drop a file from your file browser into the Second file or
folder field.

•
Current Folder browser — Select a file, right-click, and select Compare Against. Click the 
button to select a second item to compare, or drag and drop a file from your file browser into the
Second file or folder field. To select two files or subfolders to compare, Ctrl-click the file names.
Then right-click and select Compare Selected Files/Folders.

• Command Window — Use the visdiff function. For example, to compare the two files
averageweight.mlx and averageweight2.mlx using the visdiff function and the default
text comparison, type visdiff('averageweight.mlx','averageweight2.mlx'). MATLAB
opens the Comparison Tool and displays the resulting comparison report.

Explore Differences
When you perform a live code comparison, a new window opens and displays the two files side by
side. For example, suppose that you have two files, averageweight.mlx and
averageweight2.mlx, with several differences. When you compare the two files, the Comparison
Tool displays the resulting report.
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When comparing live code files, the Comparison Tool highlights differences in code, text, and text
formatting. The Comparison Tool ignores output, even if the file contains saved output. If the tool
detects a difference within an equation, image, or control, the entire item is highlighted. The
Comparison Tool displays the total number of differences in the bottom-right corner of the
comparison report, and highlights the lines that do not match using the colors listed in this table.

Highlight Color Description
Purple The line contains differences.
Dark Purple The highlighted characters are different.
Blue The line exists only in right file. This can happen

when the line is inserted in the right file, or when
it is deleted from the left file. The corresponding
line in the left file is highlighted using a gray
striped pattern.

Yellow The line exists only in left file. This can happen
when the line is inserted in the left file, or when it
is deleted from the right file. The corresponding
line in the right file is highlighted using a gray
striped pattern.
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The Comparison Tool attempts to match lines and detects code and text that is added, deleted, or
changed. For example, in the live code comparison of averageweight.mlx and
averageweight2.mlx, the tool determines that averageweight.mlx has two lines of code that do
not exist in averageweight2.mlx and highlights them (line 5 and line 7) in yellow. Also, the tool
takes the additional lines into account and determines that the line containing the disp statement in
each file matches, even though the disp statement does not occur on the same line number.

To step through the results one difference at a time, use the  Previous and  Next buttons.

For information about how to configure the comparison report, see “Compare Files and Folders and
Merge Files” on page 6-6.

Merge Changes
When comparing live code files, you can merge changes from one file to the other. Merging changes
can be useful when resolving conflicts between different versions of files. You only can merge from
left to right. If you want to merge into the left file, click the  Swap Sides button before you start
merging. Clicking the  Swap Sides button reverts any merges already made and creates a new
comparison report for the original files.

To begin merging, on the Comparison tab, click the  Merge Mode button. Then, to replace
content from the right pane with content from the left pane, click the  button located next to the
line you want to merge. You also can select a difference and, in the Comparison tab, click the 
Replace Content button.

The right pane contains the merged result. An asterisk next to the merged file name in the right pane
(averageweight2.mlx *) indicates that the file contains unsaved changes.
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To undo a replacement, click the  button between the modified lines or on the Comparison tab. To
revert all merges and start again, click the  Refresh button. You also can click the  Refresh
button to update the comparison report after making changes to and saving the files in the Live
Editor. Refreshing discards all unsaved merged changes.

To save your changes and return to the comparison report, click the  Save Result button. To

return to the comparison report without saving changes, click the  Return to Comparison
button.

See Also
visdiff

More About
• “Compare Files and Folders and Merge Files” on page 6-6
• “Customize External Source Control to Use MATLAB for Diff and Merge”
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Compare and Merge Apps
You can compare two apps and merge changes between one file and another using the Comparison
Tool. The Comparison Tool highlights differences in the code of two apps.

Select Files to Compare
There are multiple ways to select two files and start the Comparison Tool:

• App Designer — Go to the Designer or Editor tab and, in the File section, click Compare. The

Comparison Tool includes the currently open file in the First file or folder field. Click the 
button to select a second item to compare, or drag and drop a file from your file browser into the
Second file or folder field.

•
Current Folder browser — Select a file, right-click, and select Compare Against. Click the 
button to select a second item to compare, or drag and drop a file from your file browser into the
Second file or folder field. To select two files or subfolders to compare, Ctrl-click the file names.
Then right-click and select Compare Selected Files/Folders.

• Command Window — Use the visdiff function. For example, to compare the two files
ExplorerE.mlapp and ExplorerF.mlapp using the visdiff function and the default text
comparison, type visdiff('ExplorerE.mlapp','ExplorerF.mlapp'). MATLAB opens the
Comparison Tool and displays the resulting comparison report.

Explore Differences
When you perform an app comparison, a new window opens and displays the two files side by side.
For example, suppose that you have two files ExplorerE.mlapp and ExplorerF.mlapp with
several differences. When you compare the two files, the Comparison Tool displays the resulting
report.
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When comparing apps, the Comparison Tool attempts to match lines and detects code that is added,
deleted, or changed. The Comparison Tool displays the total number of differences in the bottom-right
corner of the comparison report and highlights the lines that do not match using the colors listed in
this table.

Highlight Color Description
Purple The line contains differences.
Dark Purple The highlighted characters are different.
Blue The line exists only in the right file. This can

happen when the line is inserted in the right file,
or when it is deleted from the left file. The
corresponding line in the left file is highlighted
using a gray striped pattern.

Yellow The line exists only in the left file. This can
happen when the line is inserted in the left file, or
when it is deleted from the right file. The
corresponding line in the right file is highlighted
using a gray striped pattern.

To step through the results one difference at a time, use the  Next and  Previous buttons.
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For information about how to configure the comparison report, see “Compare Files and Folders and
Merge Files” on page 6-6.

Merge Changes
When comparing apps, you can merge changes from one app to the other. Merging changes can be
useful when resolving conflicts between different versions of an app.

To begin merging, on the Comparison tab, click the  Merge Mode button. Then, to replace
content from the right pane with content from the left pane, click the  button located next to the
line you want to merge. You also can select a difference and, in the Comparison tab, click the 
Replace Content button.

The right pane contains the merged result. An asterisk next to the merged file name in the right pane
(ExplorerF.mlapp*) indicates that the file contains unsaved changes.

To undo a replacement, click the  button between the modified lines or on the Comparison tab. To
revert all merges and start again, click the  Refresh button. You also can click the  Refresh
button to update the comparison report after making changes to and saving the files in the Live
Editor. Refreshing discards all merged changes.

To save your changes and return to the comparison report, click the  Save Result button. To

return to the comparison report without saving changes, click the  Return to Comparison
button.

Tips for Successful Merging
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You can merge changes only in editable code. Sections of code with a white background are editable.
Examples of editable sections include the body of functions that you define (such as callbacks and
helper functions) and the definitions of custom properties. Sections with a gray background contain
non-editable generated code and therefore cannot be merged. If a change spans both an editable and
a non-editable section, you cannot merge it.

You can merge changes only from left to right. This makes the order of the files in the Comparison
Tool important.

If neither app contains changes in the generated code, place the file containing the changes that you
want to merge in the left pane. You can merge only from left to right. To swap a file from the left pane
to the right pane, click the  Swap Sides button before you start merging. Clicking the  Swap
Sides button reverts any merges already made and creates a new comparison report for the original
files.

If one of the apps contains changes in the generated code, place the file containing the generated
code that you want in the merged result in the right pane of the Comparison Tool. To swap a file from
the left pane to the right pane, click the  Swap Sides button before you start merging.

If both apps contain changes in the generated code, those lines of code cannot be merged in the
Comparison Tool. To merge the files, use App Designer to interactively apply the desired changes to
the app

See Also
visdiff

More About
• “Compare Files and Folders and Merge Files” on page 6-6
• “Customize External Source Control to Use MATLAB for Diff and Merge”
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Compare and Merge MAT-Files

You can use the Comparison Tool to compare two MAT-files. Compare two MAT-files to:

• Determine which variables are common to both files and which appear in only one file.
• Identify differences between individual variables. For example, you can determine which fields of

a structure are different or which elements of an array differ.

Select Files to Compare
There are multiple ways to select two files and start the Comparison Tool:

• MATLAB desktop — Go to the Home tab and, in the File section, click Compare. Click the

Browse to select File or Folder  button to select items to compare, or drag and drop files
from your file browser into the First file or folder or Second file or folder fields.

• Current Folder browser — Select a file, right-click, and select Compare Against > Choose....

Click the Browse to select File or Folder  button to select a second item to compare, or drag
and drop a file from your file browser into the Second file or folder field. To select two files or
subfolders to compare, Ctrl-click the file names. Then right-click and select Compare Selected
Files/Folders.

• Command Window — Use the visdiff function. For example, to compare the two files
data1.mat and data2.mat using the visdiff function, type
visdiff('data1.mat','data2.mat'). MATLAB opens the Comparison Tool and displays the
resulting comparison report.

Explore Differences
When you perform a MAT-file comparison, a new window opens and displays the two files side by side.
For example, suppose that you have two MAT-files, data1.mat and data2.mat. When you compare
the two files, the Comparison Tool displays the resulting report.
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The Comparison Tool highlights changes in variables. If the variables in both files are equivalent but
the files are not identical, the Comparison Tool displays a message. Possible causes of the differences
between the files include file formats, file timestamps, the order in which the variables are stored, or
variables that contain ignored differences. The Comparison Tool uses these colors to highlight
differences.

Highlighting Description
Purple Values of the variable differ between the two files. Click the compare link

to investigate.
Blue The variable only exists in the right file.
Yellow The variable only exists in the left file.
None The variables in both files are equivalent. The tool ignores differences in

NaN patterns, field ordering in structs, and the difference between
negative zero or positive zero.

Purple (only in Class
columns)

The variable data class changed. Click the compare link to investigate.

You can further explore the results in the report using several methods:
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• Sort results — To sort the results by name, size, class, or difference summary, click the
corresponding column header. For example, click the Class column header to sort by class type.

• Load variable — To load the contents of a variable into the Variable Editor, click the name of that
variable.

• Load MAT-file — To load one of the MAT-files into the workspace, click the corresponding Load
link at the bottom of the report.

• Save HTML report — To save a copy of the report as an HTML file, go to the Comparison tab and
click Save As > HTML.

For information about how to further configure the comparison report, see “Compare Files and
Folders and Merge Files” on page 6-6.

Compare Variables

To investigate differences between instances of a variable in both files, click the compare link in the
Difference Summary column of the comparison report table. The Comparison Tool displays a report
for the specified variable. To further investigate differences in individual array elements or fields of a
structure, double-click a highlighted row.

Merge Changes
When comparing MAT-files, you can merge changes from one file to the other. There are no undo
capabilities when merging MAT-files, so merge with caution.

To copy modified variables from one file to the other, on the Comparison tab, in the Merge section,
click either the Copy the right variable to the left file  or the Copy the left variable to the
right file  button, as applicable.
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Limitations
In MATLAB Online, the File Comparison Tool does not support variable comparison.

See Also
visdiff

More About
• “Compare Files and Folders and Merge Files” on page 6-6
• “Customize External Source Control to Use MATLAB for Diff and Merge”
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Compare XML Files

In this section...
“Choose XML Files to Compare” on page 6-29
“Change Comparison Type” on page 6-30
“Navigate the XML Comparison Report” on page 6-30
“Save Comparison Log Files in a Zip File” on page 6-31
“Export Results to the Workspace” on page 6-32

You can use the Comparison Tool to compare a pair of XML text files. The tool processes the results
into a report that you can use to explore the file differences. You can compare XML files with a text
comparison or a hierarchical XML comparison.

You can access the XML Comparison Tool from the Current Folder browser, the Comparison Tool, or
programmatically using the visdiff function.

The XML comparison compares the files using the “Chawathe” algorithm, as described in this paper:
Change Detection in Hierarchically Structured Information, Sudarshan Chawathe, Anand Rajaraman,
and Jennifer Widom; SIGMOD Conference, Montreal, Canada, June 1996, pp. 493-504.

This conference paper is based on work published in 1995: see http://
dbpubs.stanford.edu:8090/pub/1995-45.

XML comparison reports display in the Comparison Tool. For more information about the Comparison
Tool, see “Compare Files and Folders and Merge Files” on page 6-6.

The XML comparison report shows a hierarchical view of the portions of the two XML files that differ.
The report does not show sections of the files that are identical.

If the files are identical, you see a message reporting there are no differences.

Note It might not be possible for the analysis to detect matches between previously corresponding
sections of files that have diverged too much.

Change detection in the Chawathe analysis is based on a scoring algorithm. Items match if their
Chawathe score is above a threshold. The implementation of Chawathe's algorithm uses a comparison
pattern that defines the thresholds.

Choose XML Files to Compare
From the Current Folder Browser

To compare two files from the Current Folder browser:

• For two files in the same folder, select the files, right-click and select Compare Selected Files/
Folders.

• To compare files in different folders:
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1 Select a file, right-click, and select Compare Against
2 Select the second file to compare in the Select Files or Folders for Comparison dialog box.
3 Select the Comparison type XML text comparison.
4 Click Compare.

The XML Comparison Tool performs an analysis on the files and displays a report in the Comparison
Tool. The file you right-click to open the XML Comparison Tool displays on the right side of the report.

For more information about comparisons of other file types with the Comparison Tool, such as text,
MAT, or binary, see “Compare Files and Folders and Merge Files” on page 6-6.

Compare from the Comparison Tool

To compare files using the Comparison Tool, from the MATLAB toolstrip, in the File section, select
the Compare button. In the dialog box, select files to compare.

If the files you select to compare are XML files and you select an XML text comparison, the XML
Comparison Tool performs a Chawathe analysis of the XML files, and generates a report.

Compare from the Command Line

To compare XML files from the command line, enter

visdiff(filename1, filename2, 'xml')

where filename1 and filename1 are XML files.

Change Comparison Type
If you specify two XML files to compare using either the Current Folder Browser or the visdiff
function, then the Comparison Tool performs the default comparison type for the selected files. You
can compare XML files with a text comparison or a hierarchical XML comparison.

To change comparison type, either create a new comparison from the Comparison Tool, or use the
Compare Against option from the Current Folder browser. You can change comparison type in the
Select Files or Folders for Comparison dialog box. Select XML text comparison before clicking
Compare.

Navigate the XML Comparison Report
The XML comparison report shows changes only. The report is a hierarchical view of the differences
between two XML text files, and is not a hierarchical view of the original XML data.

To step through differences, use the Comparison tab on the toolstrip. To move to the next or
previous group of differences, on the Comparison tab, in the Navigate section, click the arrow
buttons to go to the previous or next difference.

You can also click to select items in the hierarchical trees.

• Selected items appear highlighted in a box.
• If the selected item is part of a matched pair, it is highlighted in a box in both left and right trees.

Report item highlighting indicates the nature of each difference as follows:
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Type of report
item

Highlighting Notes

Modified Purple Modified items are matched pairs that differ between the two files.
When you select a modified item it is highlighted in a box in both
trees.
Changed parameters for the selected pair are displayed
underneath.

Inserted Blue When you select an unmatched item it is highlighted in a box in
one tree only.Deleted Yellow

Container None Rows with no highlighting indicate a container item that contains
other modified or unmatched items.

Use the Comparison tab for the following functions:

• Refresh — Run Chawathe analysis again to refresh the comparison report.
• Swap Sides — Swap sides and rerun comparison. Runs the Chawathe analysis again.
• Save As > HTML — Opens the Save dialog box, where you can choose to save a printable version

of the XML comparison report. The report is a noninteractive HTML document of the differences
detected by the Chawathe algorithm for printing or archiving a record of the comparison.

• Save As > Workspace Variable — Export XML comparison results to workspace.
• In the Navigate section, click the arrow buttons (or press Up or Down keys) to go to the previous
difference or go to the next difference.

• Compare Selected Parameter — Open a new report for the currently selected pair of
parameters. Use this when the report cannot display all the details in the Parameters pane, e.g.,
long character vectors or a script.

Use the View tab controls on the toolstrip for the following functions:

• Expand All — Expands every item in the tree.

Tip Right-click to expand or collapse the hierarchy within the selected tree node.
• Collapse All — Collapses all items in the tree to the most compact view possible.

Note It may not be possible for the analysis to detect matches between previously corresponding
sections of files that have diverged too much.

Save Comparison Log Files in a Zip File
Temporary XML comparison files accumulate in tempdir/MatlabComparisons/
XMLComparisons/TempDirs/. These temporary files are deleted when you close the related
comparison report.

You can zip the temporary files (such as log files) created during XML comparisons, for sharing or
archiving. While the comparison report is open, enter:

xmlcomp.zipTempFiles('c:\work\myexportfolder')

The destination folder must exist. The output reports the zip file name:
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Created the zipfile "c:\work\myexportfolder\20080915T065514w.zip"

To view the log file for the last comparison in the MATLAB Editor, enter:

xmlcomp.showLogFile

Export Results to the Workspace
To export the XML comparison results to the MATLAB base workspace,

1 On the Comparison tab, in the Comparison section, select Save As > Workspace variable.

The Input Variable Name dialog box appears.
2 Specify a name for the export object in the dialog box and click OK. This action exports the

results of the XML comparison to an xmlcomp.Edits object in the workspace.

The xmlcomp.Edits object contains information about the XML comparison including file names,
filters applied, and hierarchical nodes that differ between the two XML files.

To create an xmlcomp.Edits object at the command line without opening the Comparison Tool,
enter:

Edits = xmlcomp.compare(a.xml,b.xml) 

Property of xmlcomp.Edits Description
Filters Array of filter structure arrays. Each structure

has two fields, Name and Value.
LeftFileName File name of left file exported to XML.
LeftRoot xmlcomp.Node object that references the root of

the left tree.
RightFileName File name of right file exported to XML.
RightRoot xmlcomp.Node object that references the root of

the right tree.
TimeSaved Time when results exported to the workspace.
Version MathWorks release-specific version number of

xmlcomp.Edits object.

Property of xmlcomp.Node Description
Children Array of xmlcomp.Node references to child

nodes, if any.
Edited Boolean — If Edited = true then the node is

either inserted or part of a modified matched
pair.

Name Name of node.
Parameters Array of parameter structure arrays. Each

structure has two fields, Name and Value.
Parent xmlcomp.Node reference to parent node, if any.
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Property of xmlcomp.Node Description
Partner If matched, Partner is an xmlcomp.Node

reference to the matched partner node in the
other tree. Otherwise empty [].

See Also

Related Examples
• “Compare Files and Folders and Merge Files” on page 6-6
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Manage Files and Folders

This table shows how to create, open, move, and rename files and folders on local and network
drives. If you have MATLAB Drive Connector installed on your system, you also can access files and
folders in MATLAB Drive from MATLAB.

Action Tools Workflow Function Alternative
Create a new folder In the Current Folder browser, right-

click in white space, and then select
New > Folder.

MATLAB creates and selects a folder
named New Folder in the current
folder.

Use the mkdir function. For example,
create a subfolder named newdir in a
parent folder named parentFolder:

mkdir('parentFolder','newdir');

Move a file or folder In the Current Folder browser, click
and drag the item.

You cannot move a folder while it is on
the search path.

Use the movefile function. For
example, move the file named
myfile.m in the current folder to the
folder, d:/work:

movefile('myfile.m','d:/work');

Rename a file or
folder

In the Current Folder browser, right-
click the item and select Rename.

File names must start with a letter,
and can contain letters, digits, or
underscores.

Use the movefile function. For
example, in the current folder, rename
myfile.m to oldfile.m:

movefile('myfile.m','oldfile.m');

Open a file in
MATLAB

On the Home tab, in the File section,

click Open , and then select a file
to open.

You also can double-click the file in
the Current Folder browser.

To open a file in the Editor as a text
file, even if the file type is associated
with another application or tool right-
click the file in the Current Folder
browser and select Open as Text.

Use the open function. The file opens
in MATLAB or in an external
application, depending on the file
extension.

Open a file in
another program

In the Current Folder browser, right-
click the file and select Open Outside
MATLAB. The file opens in the
application or tool that the operating
system associates with the file type.
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Action Tools Workflow Function Alternative
Preview file contents
without opening the
file

In the Current Folder browser, right-
click the file and select Show Details.
The Details Panel expands.

Not supported for live scripts and
functions.

none

Delete a file or folder In the Current Folder browser, select
the file or folder and press Delete.

By default, MATLAB deletes or
recycles files and folders according to
your operating system preferences. To
permanently remove the selection
when the system preference is set to
recycle, press Shift+Delete.

On Linux systems, you can request
that MATLAB move deleted files to a
temporary folder by setting the
Deleting files preference. Access this
preference on the Home tab, in the
Environment section, by clicking 
Preferences. Select MATLAB >
General.

To delete a file, use the delete
function. For example, delete a file
named myfile.m in the current
folder:

delete('myfile.m');

By default, files are permanently
removed. To move deleted files to a
temporary folder instead, use the
recycle function or set the Deleting
files preference.

To delete a folder, use the rmdir
function.

Note You cannot recover folders
deleted using rmdir.

View MATLAB Drive
recent activity

In the Current Folder browser, right-
click any MATLAB Drive file or folder
and select MATLAB Drive > View
Recent Activity....

none

Open MATLAB Drive
online

In the Current Folder browser, right-
click any MATLAB Drive file or folder
and select MATLAB Drive > Go to
MATLAB Drive Online....

none

To open the Current Folder browser if it is not visible, go to the Home tab, and in the Environment
section, click Layout. Then, under Show, select Current Folder. Double-clicking a subfolder
displays its contents, and makes that folder the current folder.

Manage Files and Folders in MATLAB Online
MATLAB Online provides access to MATLAB from a standard web browser. In MATLAB Online, you
only have access to the files and folders in your MATLAB Drive, and some file actions are not
supported.

For more information about how to access files in MATLAB Online, see “Access Files in MATLAB
Online” on page 10-2.

See Also
edit | mkdir | open | movefile | rmdir | delete | recycle
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More About
• “Save and Back Up Code”
• “Save and Load Workspace Variables” on page 5-12
• “Errors When Updating Folders on Search Path” on page 6-60
• “Access Files in MATLAB Online” on page 10-2
• “Share Folders Using MATLAB Drive” on page 12-11
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Files and Folders that MATLAB Accesses

In this section...
“Where Does MATLAB Look for Files?” on page 6-37
“Files and Folders You Should Add to the Search Path” on page 6-37
“When Multiple Files Have the Same Name” on page 6-37
“Locations of MathWorks Products” on page 6-38

Where Does MATLAB Look for Files?
When you do not specify a path to a file, MATLAB looks for the file in the current folder or on the
search path. Functions in the current folder take precedence over functions with the same file name
that reside anywhere on the search path. To identify the current folder, type pwd in the Command
Window.

To make files accessible to MATLAB, do one of the following:

• Change the current folder to the folder that contains the files. Use the cd function or browse to a
different folder in the Current Folder toolbar:

• Add the folder that contains the files to the search path. Changes you make to the search path
apply to the current MATLAB session. To reuse the modified search path in future MATLAB
sessions, save your changes.

• Store individual files in the userpath MATLAB folder, which is on the search path. To determine
the location of this folder, run the userpath function.

Files and Folders You Should Add to the Search Path
The MATLAB search path should include:

• Folders containing files that you run.
• Folders containing files that are called by files you run.
• Subfolders containing files that you run. Making a folder accessible does not make its subfolders

accessible.

For files in @ (class) and + (package) folders, make the parent folder accessible. For details, see
“Folders Containing Class Definitions”.

If files call other files that are in multiple folders, determine the location of all the called files by
performing a dependency analysis on your files. For more information, see “Dependencies Within a
Folder”

When Multiple Files Have the Same Name
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Name conflicts arise when MATLAB has access to multiple files with the same name, and when a file
has the same name as a variable in the base workspace or a built-in function for a MathWorks
product.

When there are name conflicts, MATLAB follows these precedence rules:

• “Function Precedence Order”
• “Class Precedence and MATLAB Path”

The file that MATLAB does not use is called a shadowed file. In some cases, MATLAB warns you that a
shadowed file exists.

Locations of MathWorks Products
Files and folders for products provided by MathWorks are in matlabroot/toolbox. The files and
folders under matlabroot are important to your installation. In particular:

• Do not store your personal files and folders in matlabroot/toolbox.
• Do not change files, folders, and subfolders in matlabroot/toolbox. The exception is the

pathdef.m file, which you can update and save in its default location, matlabroot/toolbox/
local.

To see a list of all toolbox folder names supplied with MathWorks products, run:

dir(fullfile(matlabroot,'toolbox'))

See Also
userpath | cd | pwd

More About
• “What Is the MATLAB Search Path?” on page 6-46
• “MATLAB Startup Folder” on page 1-14
• “Toolbox Path Caching in MATLAB” on page 1-21
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Current Folder Browser Preferences

You can specify the number of files that display in the Current Folder browser, and customize their
appearance.

On the Home tab, in the Environment section, click  Preferences. Then, select MATLAB >
Current Folder.

Some Current Folder Browser preferences are not available in MATLAB Online.

Preference Usage
History Specify the number of recently used folders maintained in the Current

Folder toolbar drop-down list.
Refresh Specify how frequently the Current Folder browser updates to reflect

changes to files made from programs and tools other than MATLAB.

When you access files on a network, frequent refreshing of the Current
Folder browser can slow performance in MATLAB. If this seems to be a
problem, try increasing the value for Number of seconds between
auto-refresh. Alternatively, clear the Auto-refresh view from file
system selection to disable automatic refresh.

To manually refresh the view at any time, right-click in the Current
Folder browser and select Refresh.

Path indication Control the appearance of folders and files that are inaccessible to
MATLAB, and whether to display tooltips describing their status.
MATLAB cannot access files if they are not on the search path or, in
some cases, if they are in a private folder.

Select the Indicate inaccessible files check box to dim the display of
files and folders inaccessible to MATLAB. Move the Text and icon
transparency slider to adjust the level of dimming.

Select the Show tooltip explaining why files are inaccessible check
box to display a tooltip that provides information on why a dimmed file
is inaccessible, when you hover over it.

If you do not select the Indicate inaccessible files check box, then the
Current Folder browser displays all files and folders as undimmed and
provides no tooltips.

Toolbar Use the Toolbar preferences to adjust the layout and controls of the
Current Folder toolbar. For more information about how to access
Toolbar preferences, see “Customize MATLAB Toolbars” on page 2-12.

Initial working folder Use the General Preferences options in the Preferences Window to
specify the current folder in MATLAB at startup. For more information
about General Preferences options, see Preferences.
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Preference Usage
Hidden Files Specify whether the Current Folder browser displays files and folders

that the operating system hides from system file browsers and file-
listing commands.

This preference does not apply to Microsoft Windows platforms. On
Windows platforms, the Current Folder browser follows the Windows
preference for showing hidden files. To set or change the Windows
preference, access the Folder Options, and then select an option for
viewing Hidden files and folders.

To change how dates display in the Current Folder browser, change the short date format for your
operating system. Then, refresh the date display: Right-click in the Current Folder browser and select
Refresh. MATLAB uses your operating system's short date format to display dates in both the
Current Folder browser and the Command History.

See Also
Preferences

More About
• “Manage Files and Folders” on page 6-34
• “Customize MATLAB Toolbars” on page 2-12
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Specify File Names
In this section...
“Construct Valid Path and File Names” on page 6-41
“Case Sensitivity of File Names” on page 6-43

Construct Valid Path and File Names
Specify Path Names

A path name specifies file locations, for example, C:\work\my_data (on Microsoft Windows
platforms) or /usr/work/my_data (on Linux or Mac platforms). If you do not specify a path name
when accessing a file, MATLAB first searches in the current folder. To indicate a file in a particular
location, specify a path name.

Path name specifications differ, depending on the platform on which you are running MATLAB. Use
the fullfile function to construct path names in statements that work on any platform. This
function is particularly useful when you provide code to someone using it on a platform other than
your own.

fullfile inserts platform-specific file separators where necessary. The file separator character is
the symbol that distinguishes one folder level from another in a path name. A forward slash (/) is a
valid separator on any platform. A backward slash (\) is valid only on Microsoft Windows platforms. In
the full path to a folder, the final slash is optional. Type filesep in the Command Window to
determine the correct file separator character to use on your platform.

To identify the platform on which MATLAB is currently running, use the ismac, ispc, and isunix
functions.

Characters Within File and Folder Names

File names must start with a letter, and can contain letters, digits, or underscores.

Avoid using accent characters such as umlauts or circumflexes in path names. MATLAB might not
recognize the path. In addition, attempts to save a file to such a path might result in unpredictable
behavior.

If a path or file name contains spaces, enclose the input in single quotes. For example:

load 'filename with space.mat'

or

load('filename with space.mat')

Absolute and Relative Path Names

MATLAB always accepts absolute path names (also called full path names), such as I:/Documents/
My_Files or /users/myuserid/Homework/myfile.m. An absolute path name can start with any
of the following:

• UNC path '\\'.
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• Drive letter, on Microsoft Windows platforms, such as C:\.
• '/' character on Linux platforms.

Some MATLAB functions also support relative path names. Unless otherwise noted, the path name is
relative to the current folder. For example:

• myfile.m refers to the myfile.m file in the current folder.
• myfolder refers to the myfolder folder in the current folder.
• ../myfolder/myfile.m refers to the myfile.m file in the myfolder folder, where myfolder is

at same level as the current folder. Each repetition of ../ at the beginning of the path moves up
an additional folder level.

Tip If multiple documents are open and docked in the Editor, you can copy the absolute path of any
of these documents to the clipboard. This practice is useful if you need to specify the absolute path in
another MATLAB tool or an external application. Right-click the document tab, and then select Copy
Full Path to Clipboard.

Partial Path Names in MATLAB

A partial path name is the last portion of a full path name for a location on the MATLAB search path.
Some functions accept partial path names.

Examples of partial path names are: matfun/trace, private/cancel, and demos/clown.mat.

Use a partial path name to:

• Specify a location independent of where MATLAB is installed.
• Locate a function in a specific toolbox when multiple toolboxes contain functions with that name.

For example, to open the file for the set function in the Database Toolbox™ product, type:

open database/set
• Locate method files. For example, to check if a plot method exists for the time series object, type:

exist timeseries/plot

Specifying the at sign character (@) in method folder names is optional.
• Locate private and method files, which sometimes are hidden.

Be sure to specify enough of the path name to make the partial path name unique.

Maximum Length of Path Names in MATLAB

The maximum length allowed for a path name depends on your platform.

For example, on Microsoft Windows platforms:

• The maximum length is known as MAX_PATH.
• You cannot use an absolute path name that exceeds 260 characters.
• For a relative path name, you might need to use fewer than 260 characters. When the Windows

operating system processes a relative path name, it can produce a longer absolute path name,
possibly exceeding the maximum length.
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If you get unexpected results when working with long path names, use absolute instead of relative
path names. Alternatively, use shorter names for folders and files.

Case Sensitivity of File Names
In general, it is best to specify path and case precisely when specifying a file name.

Case Sensitivity When Calling Functions

You call function files by specifying the file name without the file extension. MATLAB returns an error
if it cannot find a case-sensitive match on the search path. By default, MATLAB suggests a function
with the correct case.

When multiple files have the same name, MATLAB follows precedence rules to determine which to
call. For more information, see “Function Precedence Order”.

Case Sensitivity When Loading and Saving Files

Linux platforms — File names are case sensitive.

• When loading or reading from a file, specify the file name using the correct case.
• When saving or writing to a file, MATLAB saves the file in the case you specify. Two files with the

same name, but different cases can exist in the same folder.

Windows platforms — File names are case insensitive. The Windows operating system considers
two files with the same name to be the same file, regardless of case. Therefore, you cannot have two
file names that differ only by case in the same folder.

• When loading or reading from a file, MATLAB accesses the file with the specified name that is
higher on the search path, regardless of case. For example, if you attempt to load MYFILE and
myfile.mat is higher on the search path than MYFILE.MAT, then MATLAB loads myfile.mat
without warning that there is a case mismatch.

• When saving or writing to a file, if you specify a file name that already exists in the folder,
MATLAB accesses the existing file without warning. For example, if you save data to a file named
myfile using the save function, and MYFILE.mat already exists in the folder, the data replaces
the contents of MYFILE.mat. However, the file name remains MYFILE.mat.

See Also
filesep | fullfile | which | ismac | ispc | isunix

More About
• “What Is the MATLAB Search Path?” on page 6-46

 Specify File Names

6-43



Create and Extract from Zip Archives
In this section...
“Create a Zip Archive” on page 6-44
“Add Files to a Zip Archive” on page 6-44
“Extract Files from a Zip Archive” on page 6-44
“Compare Zip Archive to Unzipped Files” on page 6-45

Create a Zip Archive
Create archives using zip files to back up files, conserve file storage space, or to share collections of
files with others. You can either create an empty archive, or select files and folders to create an initial
archive. In either case, you can add more files later.

Create zip archives interactively using the Current Folder browser:

• To create an empty zip file, right-click white space, and then select New > Zip File.
• To create a populated zip file from selected files and folders, select the folders and files you want

to archive, right-click, and then select Create Zip File.

MATLAB creates an archive with a default name of Untitledn.zip, where n is an integer. Type over
the default file name to specify a descriptive name.

You also can create zip archives programmatically using the zip function. For example, to zip all files
with a .m and .mat extension in the current folder to a zip file archive named backup.zip, call:

zip('backup',{'*.m','*.mat'});

Add Files to a Zip Archive
To add files and folders to a zip file archive in the Current Folder browser, do one of the following:

• Select, and then drag the file that you want to add onto the archive.
• Copy the file that you want to add to the archive. Then, select the archive to which you want to

add the file and paste the file into the archive.

Extract Files from a Zip Archive
To extract a single file from within a zip file archive in the Current Folder browser:

1 Expand the zip file archive to view the archive contents, by clicking the associated + (expand)
button. By default, files within a zip file archive appear dimmed to indicate that they are not on
the MATLAB path.

2 Drag the file into a folder in the Current Folder browser.

MATLAB extracts the file and saves it to the folder where you dragged or pasted it.

To extract all the contents of a zip file, double-click the zip file in the Current Folder browser.
MATLAB creates a folder with the same name as the zip file, and extracts the entire contents of the
zip file into this folder.
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To extract the contents of a zip file programmatically, use the unzip function. unzip also allows you
to specify a target folder. For example, to unzip the file, examples.zip, to a folder named
myfolder, call:

unzip('examples.zip','myfolder')

Note Archives created outside of MATLAB can be encrypted or password-protected. You cannot add
files to, or extract files from, protected archives from within MATLAB.

Compare Zip Archive to Unzipped Files
To determine differences between archived and unarchived files, use the Comparison Tool from
within the Current Folder browser as you would for any other files and folders.

• Right-click a zip archive, and then from the context menu select Compare Against and specify
the folder to which you want to compare the contents of the zip archive.

• Expand a zip archive, right-click a file within it, and then from the context menu select Compare
Against. Specify the file to which you want to compare the archived file.

See Also
unzip | zip

More About
• “Compare Files and Folders and Merge Files” on page 6-6
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What Is the MATLAB Search Path?
The MATLAB search path is a subset of all the folders in the file system. MATLAB uses the search
path to locate files used with MathWorks products efficiently.

The order of folders on the search path is important. When files with the same name appear in
multiple folders on the search path, MATLAB uses the one found in the folder nearest to the top of
the search path.

By default, the search path includes

• The MATLAB userpath folder, which is added to the search path at startup, and is the default
location for storing user files

• The folders defined as part of the MATLABPATH environment variable
• The folders provided with MATLAB and other MathWorks products, which are under

matlabroot/toolbox, where matlabroot is the folder displayed when you run matlabroot in
the Command Window

Class, package, private, and resources folders are special folders that cannot be specified
explicitly as part of the search path. A special folder is added to the search path implicitly when its
parent folder is specified as part of the path. To access the files and folders within a special folder,
you must add its parent folder to the path.

You can explicitly add folders to the search path for the files you run. For more information about
adding files to the search path, see “Change Folders on Search Path” on page 6-50.

userpath Folder on the Search Path
The userpath folder is first on the search path. By default, MATLAB adds the userpath folder to
the search path at startup. This folder is a convenient place for storing files that you use with
MATLAB.

The default userpath folder is platform-specific.

• Windows platforms — %USERPROFILE%/Documents/MATLAB.
• Mac platforms — $home/Documents/MATLAB.
• Linux platforms — $home/Documents/MATLAB if $home/Documents exists.
• MATLAB Online — /users/youruserid.

Alternatively, to determine or change the current userpath folder, call userpath.

By default, the userpath folder is also the startup folder when you start MATLAB by double-clicking
either the MATLAB shortcut on Windows systems or the MATLAB application on Mac systems.

MATLABPATH Environment Variable
The MATLABPATH environment variable can contain a list of additional folders to be added to the
MATLAB search path at startup. These folders are placed after the userpath folder, but ahead of the
folders supplied by MathWorks. By default, the MATLABPATH environment variable is not set. For
more information on how to set the MATLABPATH environment variable, see “Set the MATLABPATH
Environment Variable” on page 6-55.
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Determine If Files and Folders Are on the Search Path
There are several ways to determine if files and folders are on the search path. You can either check
whether an individual file or folder is on the search path, or you can view the entire search path.

Check Whether File or Folder on Search Path

To determine whether a file is on the search path, run which filename. If the file is on the search
path, MATLAB returns the full path to the file.

To determine whether a file or folder is on the search path, use the Current Folder browser. Files and
folders not on the path are dimmed. To ensure that the Current Folder browser is set to indicate
whether a file or folder in on the search path, right-click any file or folder, and select the Indicate
Files Not on Path option.

Hover the pointer over any dimmed file or folder in the Current Folder browser to find out why it is
dimmed. A tooltip opens with an explanation. Frequently, the tooltip indicates that the file or folder is
not on the MATLAB path. If a tooltip does not appear, it may be disabled. To enable it, go the Home
tab and in the Environment section, click  Preferences. Then, select MATLAB > Current
Folder. Select Show tooltip explaining why files are inaccessible to display the tooltip.

View Entire Search Path

Run the path command to view all the folders on the MATLAB search path.

Alternatively, use the Set Path dialog box to view the entire MATLAB search path. On the Home tab,
in the Environment section, click Set Path. The Set Path dialog box opens, listing all folders on the
search path. For more information on using the Set Path dialog box, see “Change Folders on Search
Path” on page 6-50.
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The Search Path Is Not the System Path
The search path is not the same as the system path. Furthermore, there is no explicit relationship
between the MATLAB search path and the system path. However, both paths help in locating files, as
follows:

• MATLAB uses the search path to locate MATLAB files efficiently.
• The operating system uses a system path to locate operating system files efficiently.

How MATLAB Stores the Search Path

MATLAB saves search path information in the pathdef.m file. This file contains a series of full path
names, one for each folder on the search path.

By default, pathdef.m is in matlabroot/toolbox/local.

When you change the search path, MATLAB uses it in the current session, but does not update
pathdef.m. To use the modified search path in the current and future sessions, save the changes
using savepath or the Save button in the Set Path dialog box. This updates pathdef.m.

In MATLAB Online, all changes to the search path are automatically saved.

See Also
userpath
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More About
• “Add Folders to the MATLAB Search Path at Startup” on page 6-55
• “Change Folders on Search Path” on page 6-50
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Change Folders on Search Path

In this section...
“Add or Remove Folders on the Search Path Programmatically” on page 6-50
“Change Folders on Search Path Interactively” on page 6-50
“Change Folders Using Current Folder Browser” on page 6-52
“Change Folders on Search Path Using MATLAB Editor” on page 6-53

You can programmatically and interactively add or remove folders and change the order of MATLAB
folders on the search path, for the current session and future sessions. When files with the same
name appear in multiple folders on the search path, MATLAB uses the one in the folder nearest to the
top of the search path.

Add or Remove Folders on the Search Path Programmatically
You can programmatically add one or more folders on the path using the addpath function. This
example adds the folder to the top of the search path. See addpath for other options.

addpath("c:\matlab\MyFolder")

You can remove one or more folders from the path using the rmpath function.

rmpath("c:\matlab\MyFolder")

To save changes to the search path across MATLAB sessions, use the savepath function. This
function also saves changes that you make interactively with the Set Path dialog box, from the
Current Folder browser, or in the MATLAB Editor.

In MATLAB Online, changes to the path are automatically saved. Therefore, calling savepath is not
necessary.

Change Folders on Search Path Interactively
Use the Set Path dialog box to interactively make changes to the search path.

1 On the Home tab, in the Environment section, click Set Path. The Set Path dialog box appears.

Alternatively, you can access this dialog box using the pathtool function.
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2 Use the Add Folder or Add Folder with Subfolders button to add new folders to MATLAB
search path.

3 Use the Move Down and Move Up buttons to change the order of files on the search path. Files
contained in folders at the top of the search path have precedence over those in folders farther
down. For more information, see “Function Precedence Order”.

4 Apply or cancel the search path changes:

• To use the newly modified search path only in the current session, click Close.
• To reuse the newly modified search path in the current session and future sessions, click

Save, and then Close.
• To undo your changes, click Revert, and then Close.
• To restore the default search path, click Default, and then Close. The default search path

contains only folders provided by MathWorks.

Note The MATLAB (userpath) folder automatically moves to the top of the search path the next time
you start MATLAB. For more information about the userpath folder, see “userpath Folder on the
Search Path” on page 6-46.
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In MATLAB Online, you can use the buttons at the top of the Set Path dialog box to change the folders
on the search path. To search for folders on the path, use the search field at the top of the Set Path
dialog box.

Change Folders Using Current Folder Browser
You can add or remove folders on the search path from the Current Folder browser. Folders that are
not on the path appear transparent, while those on the path appear solid.

1 From the Current Folder browser, right-click the folder or select and then right-click multiple
folders to add or remove.

2 From the context menu, select Add to Path or Remove from Path, and then select an option:

• Selected Folders
• Selected Folders and Subfolders

Changes to the search path using this method do not persist in future MATLAB sessions. To save
these changes, use savepath.
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Change Folders on Search Path Using MATLAB Editor
In the MATLAB Editor, you also can add or remove the folder that contains a script on the search
path. Right-click the document tab, and then select an option to add or remove the folder from the
search path.

Changes to the search path using this method do not persist in future MATLAB sessions. To save
these changes, use savepath.

See Also
addpath | rmpath | savepath

More About
• “What Is the MATLAB Search Path?” on page 6-46
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Use Search Path with Different MATLAB Installations
The default search path changes for each MATLAB version because the default folders that come with
the products change. Different MATLAB versions cannot use the same pathdef.m file.

To use your files with a new MATLAB version or with multiple versions, do one of the following:

• For each version, add the folders containing your files to the search path. Save the search path
(that is, save the pathdef.m file) where that version of MATLAB can access it.

• Include addpath statements in the startup.m file. Use the same startup.m file with the
multiple versions of MATLAB.

Including addpath statements in the startup.m file also allows you to use your files with MATLAB
on different platforms.

See Also
addpath

More About
• “Startup Options in MATLAB Startup File” on page 1-19
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Add Folders to the MATLAB Search Path at Startup
There are two ways to add folders to the MATLAB search path at startup. You can either use a
startup.m file or you can set the MATLABPATH environment variable.

Use a startup.m File
The startup.m file is for specifying startup options. You can add folders to the search path by
including addpath statements in a startup.m file. For example, to add the specified folder, /home/
username/mytools to the search path at startup, include this statement in a startup.m file:

addpath /home/username/mytools

For more information on creating a startup.m file with addpath statements, see “Startup Options
in MATLAB Startup File” on page 1-19.

Set the MATLABPATH Environment Variable
You can also add folders to the search path at startup by setting the MATLABPATH environment
variable. :

Windows

To set the MATLABPATH environment variable in Windows, from the Windows Control Panel, go to
System and select Advanced system settings. Click the Environment Variables... button. Click
New... or Edit... to create or edit the MATLABPATH environment variable. In the dialog box that
appears, set the variable name to MATLABPATH and the variable value to a semicolon-separated list of
folders you want to add to the search path. For example, to add two folders, c:\matlab_files
\myfolder1 and c:\matlab_files\myfolder2, to the MATLABPATH environment variable, enter
c:\matlab_files\myfolder1;c:\matlab_files\myfolder2 as the variable value. Click OK to
set the variable and exit the dialog box. Restart MATLAB for the new settings to take effect.

To set the environment variable from a command window, run the command set
MATLABPATH=folders, where folders is a semicolon-separated list of folders. For example,
suppose that you want to add two folders, c:\matlab_files\myfolder1 and c:\matlab_files
\myfolder2, to the MATLABPATH environment variable. Run the command
set MATLABPATH=c:\matlab_files\myfolder1;c:\matlab_files\myfolder2

Once the environment variable is set, you must start MATLAB from the same command window for
the settings to take effect. The environment variable persists only as long as the command window is
open.

UNIX and Mac

To set the MATLABPATH environment variable in UNIX and Mac, in a terminal, run the command
export MATLABPATH=folders, where folders is a colon-separated list of folders.

For example, suppose that you want to add two folders, /home/j/Documents/MATLAB/mine and /
home/j/Documents/MATLAB/research, to the MATLABPATH environment variable on a UNIX
platform. Run the command
export MATLABPATH=/home/j/Documents/MATLAB/mine:/home/j/Documents/MATLAB/research
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Once the environment variable is set, you must start MATLAB from the same shell for the settings to
take effect. The environment variable persists only as long as the shell remains open.

Note If you are using a C shell (csh or tcsh), the command for setting the MATLABPATH
environment variable is setenv MATLABPATH folders.

To add the folders for all future MATLAB sessions, set the MATLABPATH environment variable as part
of your shell configuration script.

See Also

More About
• “What Is the MATLAB Search Path?” on page 6-46
• “Change Folders on Search Path” on page 6-50

6 Managing Files in MATLAB

6-56



Assign userpath as Startup Folder (Macintosh or UNIX)
This example shows how to assign the userpath folder as the startup folder on a Macintosh
platform. The procedure is similar for UNIX platforms. Assume that userpath is set to the default
value on a Macintosh platform where smith is the home folder.

Using a bash shell, set the MATLAB_USE_USERWORK environment variable so that userpath will be
used as the startup folder.

export MATLAB_USE_USERWORK=1

From that shell, start MATLAB. Next, verify the current folder in MATLAB.

pwd

/Users/smith/Documents/MATLAB

Confirm that this is the same as the folder defined for userpath.

userpath

/Users/smith/Documents/MATLAB;

Confirm that the userpath is at the top of the search path.

path

/Users/smith/Documents/MATLAB
/Users/smith/Applications/MATLAB/R2009a/toolbox/matlab/general
/Users/smith/Applications/MATLAB/R2009a/toolbox/matlab/ops

...
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Path Unsuccessfully Set at Startup

When there is a problem with the search path, you cannot use MATLAB successfully.

Search path problems occur when:

• You save the search path on a Windows platform, and then try to use the same pathdef.m file on
a Linux platform.

• The pathdef.m file becomes corrupt, invalid, renamed, or deleted.
• MATLAB cannot locate the pathdef.m file.

When MATLAB starts, if there is a problem with the search path, a message such as the following
appears:

Warning: MATLAB did not appear to successfully set the search 
path...

For problems with the search path, try these recovery steps. Proceed from one step to the next only
as necessary.

1 Ensure MATLAB is using the pathdef.m file you expect:

a Run

which pathdef
b If you want MATLAB to use the pathdef.m file at another location, make corrections. For

example, delete the incorrect pathdef.m file and ensure the correct pathdef.m file is in a
location that MATLAB can access.

2 Look for and correct problems with the pathdef.m and startup.m files:

a Open pathdef.m and startup.m in a text editor. Depending on the problem, you might not
be able to open the pathdef.m file.

b Look for obvious problems, such as invalid characters or path names.
c Make corrections and save the files.
d Restart MATLAB to ensure that the problem does not recur.

3 Try to correct the problem using the Set Path dialog box:

a Restore the default search path and save it. See “Change Folders on Search Path” on page 6-
50. Depending on the problem, you might not be able to open the dialog box.

b Restart MATLAB to ensure that the problem does not recur.
4 Restore the default search path using functions:

a Run restoredefaultpath, which sets the search path to the default and stores it in
matlabroot/toolbox/local.

b If restoredefaultpath seems to correct the problem, run savepath.
c Restart MATLAB to ensure that the problem does not recur.

Depending on the problem, a message such as the following could appear:
The path may be bad. Please save your work (if desired), and quit.

5 Correct the search path problems encountered during startup:

a Run

restoredefaultpath; matlabrc
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Wait a few minutes until it completes.
b If there is a pathdef.m file in the startup folder, it caused the problem. Either remove the

bad pathdef.m file or replace it with a good pathdef.m file. For example, run:

savepath('path_to_your_startup_folder/pathdef.m')

See “MATLAB Startup Folder” on page 1-14.
c Restart MATLAB to ensure that the problem does not recur.

After correcting problems with the search path, make any changes to run your files. For example, add
the userpath folder or other folders to the search path.

 Path Unsuccessfully Set at Startup

6-59



Errors When Updating Folders on Search Path
You can encounter errors or unexpected behavior when you try to delete, rename, or move folders
that:

• Are on the search path
• Contain subfolders that are on the search path

The behavior varies by platform because it depends on the behavior of similar features in the
operating system.

If your task fails and the error message indicates it is because the folder is on the search path, then
do the following:

1 Remove the folder from the search path.
2 Delete, rename, or move the folder.
3 Add the folder to the search path.
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Troubleshoot Invalid or Unresponsive Windows Change
Notification Handles

MATLAB uses a Windows operating system feature called change notification handles to detect when
files in an associated folder are modified. Under certain circumstances, Windows fails to provide
MATLAB with a valid or responsive Change Notification Handle. The three most common causes for
invalid or unresponsive change notification handles are:

• Windows has exhausted its supply of notification handles.
• The specified folder resides on a file system that does not support change notification. (Syntax

TAS file server, SAMBA file server, and many NFS file servers are known to have this limitation.)
• Network or file server latency delays the arrival of the change notification so that changes are not

detected on a timely basis.

When MATLAB is unable to obtain a valid or responsive Change Notification Handle, it cannot
automatically detect changes to files and folders. For example, new functions added to an affected
folder might not be visible, and changed functions in memory might not be reloaded.

Control How MATLAB Detects Changes in Files and Folders
If MATLAB is unable to detect changes to your files and folders due to invalid or unresponsive change
notification handles, you can control how MATLAB detects changes in folders.

If your file system updates folder timestamps when files are added to folders, you can set your system
remote path policy to detect changes by testing the timestamps of folders. To do so, include these
commands in a startup.m file. For more information on creating a startup.m file, see “Startup
Options in MATLAB Startup File” on page 1-19.

system_dependent('RemotePathPolicy', 'TimecheckDir');
rehash path;

You might notice a performance degradation due to the time required to check the timestamps.

If your file system does not update folder timestamps (such as an NT file system), you can set your
system remote path policy to detect changes by rereading the affected folders at frequent intervals.
To do so, include these commands in a startup.m file.

system_dependent('RemotePathPolicy', 'Reload');
rehash path;

You might notice a significant performance degradation due to the time required to reread the
folders.

To determine how MATLAB detects changes in folders, use this command:

system_dependent('RemotePathPolicy', 'Status');

In some cases, detecting new files or changed files in folders affected by the invalid or unresponsive
change notification handles is not necessary. If detecting changes is not necessary, to provide
maximum performance, you can disable your system remote path policy. To do so, include these
commands in a startup.m file.

system_dependent('RemotePathPolicy', 'None');
rehash path;
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Clear Functions from Memory
Sometimes, changing your system remote path policy is not effective in preventing problems related
to remote file system caching or network latency. If MATLAB is still unable to detect the changes that
you have made to a function, you can clear the old copy of the function from memory using the clear
function. MATLAB reads the updated function the next time it is called.

Configure Change Notification Handle Warnings
To analyze which folders are affected by invalid or unresponsive Windows change notification
handles, you can configure the number of warning messages issued by Windows. To do so, include
one of these commands in a startup.m file. For more information on creating a startup.m file, see
“Startup Options in MATLAB Startup File” on page 1-19.

• Show warning messages for all invalid or unresponsive change notification handles.

system_dependent('DirChangeHandleWarn', 'Always');
• Only show the first warning message about invalid or unresponsive change notification handles.

system_dependent('DirChangeHandleWarn', 'Once');
• Never show warning messages about invalid or unresponsive change notification handles.

system_dependent('DirChangeHandleWarn', 'Never');

To determine when Windows warns about invalid or unresponsive change notification handles, use
this command.

system_dependent('DirChangeHandleWarn', 'Status');

See Also
addpath | rehash

More About
• “What Is the MATLAB Search Path?” on page 6-46
• “Startup Options in MATLAB Startup File” on page 1-19
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Editor Preferences

• “Editor/Debugger Preferences” on page 7-2
• “Code Analyzer Preferences” on page 7-14
• “Configure Code Analyzer” on page 7-18
• “Index of Code Analyzer Checks” on page 7-22
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Editor/Debugger Preferences
In this section...
“General Preferences for the Editor/Debugger” on page 7-2
“Editor/Debugger Display Preferences” on page 7-3
“Editor/Debugger Tab Preferences” on page 7-4
“Editor/Debugger Language Preferences” on page 7-5
“Editor/Debugger Code Folding Preferences” on page 7-7
“Editor/Debugger Backup Files Preferences” on page 7-8
“Editor/Debugger Autoformatting Preferences” on page 7-9
“Editor/Debugger Automatic Completions Preferences” on page 7-10
“Editor/Debugger Saving Preferences” on page 7-13

You can customize the visual display and functionality of the Editor, Live Editor, and Debugger using
Editor/Debugger preferences.

General Preferences for the Editor/Debugger

You can specify which editor MATLAB uses, as well as how the MATLAB Editor and Live Editor
behave under various circumstances.

On the Home tab, in the Environment section, click  Preferences. Select Editor/Debugger, and
then adjust preference options as described in the table below.

Some general preferences are not available in MATLAB Online.

Preference Usage
Editor Select which editor you want the MATLAB desktop to

use when you edit a file:

• MATLAB Editor
• Text editor

If you select Text editor, specify the full path for the
editor application you want to use, such as Emacs or
vi. For example, c:/Applications/Emacs.exe.

This preference applies only to plain text files such as
files with a .m or .txt extension.

Most recently used file list In the Number of entries field, type the number of
files that you want to appear in the list of recently used
files at the bottom of the File menu.

Opening files in editor Select On restart reopen files from previous
MATLAB sessions if you want the Editor and the files
it contained during your last MATLAB session to
reopen when you restart MATLAB.
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Preference Usage
Select Automatically open files when MATLAB
reaches a breakpoint to open a running program file
when MATLAB encounters a breakpoint in that file.

Automatic file changes Select Save changes upon clicking away from a
file if you want the Editor and Live Editor to
automatically save changes to a file when you click
away from the file. For the changes to be automatically
saved upon clicking away, you must have already saved
the file at least once.

In MATLAB Online, this preference is located under
MATLAB > Editor/Debugger > Saving.
Select Reload unedited files that have been
externally modified if you want the Editor to
automatically reload the version of a file that you
opened and edited outside of MATLAB when the file
currently open in the Editor has no unsaved changes.
Select Add line termination at end of file to have
MATLAB add a new empty line (sometimes referred to
as a <CR>) to the end of a file automatically if the last
line in the file is not empty.

This preference applies only to plain text files such as
files with a .m or .txt extension.

Debugging Specify when to show the inline Step in button using
the Show inline Step in buttons option.

• Select Always to show the button for all functions
and scripts.

• Select For user-defined functions to show the
button only for user-defined functions and scripts.

• Select Never to never show the button.

Editor/Debugger Display Preferences

You can change the appearance of the Editor and Live Editor.

On the Home tab, in the Environment section, click  Preferences. Select Editor/Debugger >
Display, and then adjust preference options as described in the table below.

Preference Usage
General display options Select Highlight Current Line and select a color to

highlight the row with the cursor (also called the
caret).

This preference does not apply in the Live Editor.
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Preference Usage
Select Show line numbers to display line numbers
along the left edge of the Editor and Live Editor
window.
Select Enable data tips in edit mode to display data
tips when you are editing a MATLAB code file. (Data
tips are always enabled in debug mode.)

For details, see “View Variable Value”.

This preference does not apply in the Live Editor.
Select an option from Live Editor default view to
specify the default location of output when creating
new live scripts:

• Output on right — Output displays to the right of
the code. Each output displays with the line that
creates it. This option is ideal when writing code.

To disable the alignment of output to code when
output is on the right, right-click the output section
and select Disable Synchronous Scrolling.

• Output inline — Output displays inline with the
code. Each output displays underneath the line that
creates it. This option is ideal for sharing.

Select Display the Open as a Live Script banner if
you want the Open as a Live Script banner to appear
at the top of documents in the Editor.

Right-hand text limit Select Show line to display a vertical line with the
specified Color at the specified column (Placement)
in the Editor.

For details, see “Change the Right-Side Text Limit
Indicator”.

This preference does not apply in the Live Editor.

Editor/Debugger Tab Preferences

You can specify the size of tabs and indents and details about how tabs behave in the Editor and Live
Editor.
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On the Home tab, in the Environment section, click  Preferences. Select Editor/Debugger >
Tab, and then adjust preference options as described in the table below.

Option Usage
Tab size Specify the amount of space inserted when you press

the Tab key.

When you change the Tab size, it changes the tab size
for existing lines in that file, unless you also select Tab
key inserts spaces.

Indent size Specify the indent size for automatic indenting. To set
automatic indenting preferences, see “Editor/
Debugger Language Preferences” on page 7-5.

Tab key inserts spaces Select to insert a series of spaces when you press the
Tab key. Otherwise, a tab acts as one space whose
length is equal to the Tab size.

Emacs-style Tab key smart indenting Specifies an indenting style similar to the style that the
Emacs editor uses.

Lines indent according to automatic indenting
preferences when you position the cursor in a line or
select a group of lines, and then press the Tab key. To
set automatic indenting preferences, see “Editor/
Debugger Language Preferences” on page 7-5.

If you select this preference, you cannot insert tabs
within a line.

Editor/Debugger Language Preferences

You can specify how various languages appear in the Editor and Live Editor. MATLAB applies
language preferences based on the file extension of the file that is open.

On the Home tab, in the Environment section, click  Preferences. Select Editor/Debugger >
Language, and then adjust preference options as described in the table below. In MATLAB Online, to
set language preferences, select Editor/Debugger > MATLAB Language or Editor/Debugger >
Other Languages.

Not all preferences are available for all languages.

Preference Usage
Language Select the language for which you want to set preferences.
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Preference Usage
Syntax highlighting Select Enable syntax highlighting to have the Editor and

Live Editor use different colors for different language
constructs. Then, adjust the colors you want to use for each
language element.

To change the MATLAB syntax highlighting colors, click Set
syntax colors. For more information, see “Syntax
Highlighting” on page 3-20.

To change syntax highlighting colors for all other languages,
select from the options under Enable syntax highlighting.

Variable and function renaming

MATLAB Language only

Select Enable automatic variable and function renaming
to have MATLAB prompt you to rename all instances of a
function or variable in a file when you rename a function or
variable.

For details on when MATLAB prompts you, see “Automatically
Rename All Variables or Functions in a File”.

Comment formatting

MATLAB Language only

In the Maximum column width field, enter the maximum
number of characters you want to allow in a line of
comments, and then select where you want counting to begin.

Consider selecting:

• Start from beginning of line when the absolute width of
the comments is important. For example, set 75 columns
from the start of the line to match the width that fits on a
printed page when you use the default font for the Editor.

• Start from beginning of comment when comments are
indented, and you want each block of comments to have a
consistent indent and width.

Select Wrap comments automatically while typing to
automatically wrap comments at the Maximum column
width value when you type comments in an Editor or Live
Editor document.

If you clear this option, you can still wrap comments
manually, as described in “Add Comments to Code”.
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Preference Usage
Indenting Select Apply smart indenting while typing to

automatically:

• Indent the body of loops within the start and end of the
loop statement.

• Align subsequent lines with lines you indent using tabs or
spaces.

• Indent functions as specified with the Function
indenting format option.

You also can manually apply automatic indenting after you
type the code. For more information, see “Indent Code”.
Select an option from Function Indenting Format
(MATLAB Language only) to specify how functions indent in
the Editor and Live Editor, as follows:

• Classic — The Editor and Live Editor align the function
code with the function declaration.

• Indent nested functions — The Editor and Live Editor
indent the function code within a nested function.

• Indent all functions — The Editor and Live Editor indent
the function code for both main and nested functions.

For more information and examples of each indenting format,
see “Indent Code”.

File extensions Add one or more file extensions to associate with the
Language. The preferences you set for that language apply
to all files with the listed extensions.

Editor/Debugger Code Folding Preferences

Code folding enables you to expand and collapse blocks of MATLAB code that you want to hide when
you are not currently working on them.

On the Home tab, in the Environment section, click  Preferences. Select Editor/Debugger >
Code Folding, and then adjust preference options as described in the table below.

For examples and detailed information about code folding, see “Fold Code”.

Code folding preferences do not apply in the Live Editor.

Option Usage
Enable Code Folding Specifies whether you want code folding enabled for

the programming constructs that have their
corresponding Enable check box selected.
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Option Usage
Enable Specifies whether you want code folding enabled for

the corresponding Programming Construct.

If you select this option for any construct, but clear the
Enable Code Folding option, the construct will not
have code folding enabled.

Fold Initially Specifies whether the corresponding Programming
Construct displays collapsed (folded) the first time
that you open a MATLAB file.

Editor/Debugger Backup Files Preferences

You can specify if, when, and how you want MATLAB to automatically back up files that are open in
the Editor.

On the Home tab, in the Environment section, click  Preferences. Select Editor/Debugger >
Backup Files, and then adjust preference options as described in the table below.

Backup files preferences do not apply in the Live Editor and are not available in MATLAB Online.

Preference Usage
Automatically create backup files while working
in the MATLAB Editor

Select to have MATLAB automatically save a copy of
the files you are currently editing.

Save options Save the backup every: n minutes specifies how
often you want MATLAB to save a copy of the file you
are editing.
Save untitled files saves a copy of new, untitled, files
to Untitled.asv.

When there is more than one untitled file, each
additional file is saved to Untitledn.asv (where n is
an integer value).

Close options Automatically delete backup files when the Editor
closes directs MATLAB to delete the backup file when
you close the source file in the Editor.

To ensure clear and current backup-to-file
relationships if you disable this option, when you
rename or remove a file, consider deleting or renaming
the corresponding backup file.

File name Select the naming convention that you want MATLAB
to use for autosave files. For example:

• If you specify Replace extension with: asv, the
backup file for filename.m is filename.asv

• If you specify Append file name with: ~, the
backup file for filename.m is filename.m~
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Preference Usage
Location Source file directories specifies that you want

backup files stored in the same folder as the files being
edited.

Single directory specifies that you want autosave
files stored in a single folder. Specify the full path to
that folder and be sure you have write permissions for
it.

If you edit a file in a read-only folder and the back up
Location is Source file directories, then the Editor
does not create a backup copy of the file.

For more information about automatically creating backup copies of modified files in the Editor, see
“Save and Back Up Code”.

Editor/Debugger Autoformatting Preferences

You can quickly format live scripts and functions using autoformatting markup in the Live Editor. You
can enable and disable autoformatting as a whole, or as individual options.

On the Home tab, in the Environment section, click  Preferences. Select Editor/Debugger >
Autoformatting, and then adjust preference options as described in this table.

Autoformatting preferences do not apply in the Editor.

Preference Usage
Enable autoformatting in Live Editor Select to enable autoformatting options in the Live

Editor. Once enabled, options can then be enabled or
disabled individually.

Text format Select *italic*, **bold** to enable bold and italic
formatting using asterisks (*).
Select _italic_, __bold__ to enable bold and italic
formatting using underscores (_).
Select `monospace`, |monospace| to enable
monospace autoformatting.

Section break Select %%, ***, or --- for section break to enable
inserting section breaks by entering %%, ***, or ---
and then Enter.
Select %% text for section break and heading to
enable inserting section breaks with heading 1 style
headings by entering %%text and then Enter.

Insert Options Select $LaTeX$ for LaTeX equation to enable
converting LaTeX expressions into equations using the
format $LaTeX$.
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Preference Usage
Select URL for hyperlink to enable converting
internet paths automatically to hyperlinks.
Select <URL> for hyperlink to enable converting
internet paths to hyperlinks using the format <URL>.
Select [Label](URL) for labeled hyperlink to enable
converting internet paths to labeled hyperlinks using
the format [Label](URL).
Select (TM), (SM), (R), and (C) for trademark,
service mark, and copyright symbols to enable
inserting trademark and copyright symbols (™, ℠, ®,
and ©) using the format (TM), (SM), (R), and (C).

Text Style Select #text for title to enable inserting titles using
the format #text.
Select ##text, ###text, or ####text for heading
to enable inserting headings using the format ##text
for heading 1, ###text for heading 2, or ####text
for heading 3.
Select Automatic bulleted lists (*, +, or -) to enable
creating bulleted lists by entering *, +, or - followed
by a space.
Select Automatic numbered lists (1., 2., etc.) to
enable creating numbered lists by entering 1., 2., and
so on, followed by a space.

For more information about autoformatting in the Live Editor, see “Autoformatting”.

Editor/Debugger Automatic Completions Preferences

You can change how MATLAB suggests and completes names in the Editor, Live Editor, and App
Designer. You also can change whether MATLAB automatically completes block endings, parentheses,
quotes, comments, character vectors, and strings in the Editor, Live Editor, and App Designer.

On the Home tab, in the Environment section, click  Preferences. Select Editor/Debugger >
Automatic Completions, and then adjust preference options as described in this table.

Preference Usage
Suggestions and completions Select Show suggestions automatically to

automatically show suggestions as you type in the
Editor, Live Editor, and App Designer. Clear Show
suggestions automatically to show suggestions only
when you press Ctrl+Space or press the Tab key.

For more information, see “Check Syntax as You Type”
on page 3-20.
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Preference Usage
Select Use tab to show suggestions (in addition to
ctrl+space) to show suggestions when you press the
Tab key in the Editor, Live Editor, and App Designer.
Clear Use tab to show suggestions (in addition to
ctrl+space) to show suggestions only when you press
Ctrl+Space.

For more information, see “Check Syntax as You Type”
on page 3-20.
Select Use right arrow to accept suggestions (in
addition to tab and enter) to accept suggestions
using the Right Arrow key in the Editor, Live Editor,
and App Designer. Clear Use right arrow to accept
suggestions (in addition to tab and enter) to
accept suggestions using the Tab and Enter keys.

For more information, see “Check Syntax as You Type”
on page 3-20.

Autocoding options Select Enable autocoding to enable autocoding
options in the Editor, Live Editor, and App Designer.
Once enabled, options can be enabled or disabled
individually.
Autocomplete pairs

• Select Parentheses ( ) to autocomplete
parentheses.

• Select Curly braces { } to autocomplete curly
braces.

• Select Square brackets [ ] to autocomplete
square brackets.

• Select Single quotes (' ') to autocomplete single
quotes.

• Select Double quotes (" ") to autocomplete
double quotes.
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Preference Usage
Autocomplete on new line

• Select Comments (%) to automatically split
comments when you press Enter. For example,
place your cursor after the first period in the
comment below and press Enter.

% This is my first comment. This is my second comment.

The text after the cursor moves to a new line and
the Editor adds a percent (%) symbol to the
beginning of the new line.

% This is my first comment.
% This is my second comment.

• Select Character vectors (' ') to automatically
split character vectors when you press Enter. For
example, place your cursor after the word Random
in the character vector below and press Enter.

title('Mean of Random Uniform Data')

The Editor splits the character vector into two
character vectors across two lines.

title(['Mean of Random' ...
    ' Uniform Data'])

• Select Strings (" ") to automatically split strings
when you press Enter. For example, place your
cursor after the word long in the string below and
press Enter.

exist("exceptionally_long_file_name.txt")

The Editor splits the string into two strings on two
lines.

exist("exceptionally_long" + ...
    "_file_name.txt")

• Select Parentheses () to automatically split
parentheses when you press Enter. For example,
place your cursor after the number 10 and the
comma in the command below and press Enter.

plot(x,y,'--gs','LineWidth',2,'MarkerSize',10,'MarkerEdgeColor','b')

The Editor splits the command onto two lines.

plot(x,y,'--gs','LineWidth',2,'MarkerSize',10, ...
    'MarkerEdgeColor','b')
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Preference Usage
Autocomplete block endings

• Select Control flow statements (if, for, etc.) to
autocomplete control flow statements. To
autocomplete a statement, enter the statement and
press Enter. For a list of control flow statements,
see “Loops and Conditional Statements”.

• Select Function and class definitions to
autocomplete function and class definitions. To
autocomplete a definition, enter either function
or class and press Enter.

Editor/Debugger Saving Preferences

You can specify if and when MATLAB Online saves files automatically.

On the Home tab, in the Environment section, click  Preferences. Select Editor/Debugger >
Saving, and then adjust preference options as described in this table.

Saving preferences are not available in an installed version of MATLAB.

Preference Usage
Autosave options Select Save files periodically to have MATLAB Online

periodically save the files you are currently editing.
In the Every: n minutes field, specify how often you
want MATLAB to save the files you are editing. By
default, MATLAB saves files every 1 minute.
Select Save changes upon clicking away from a
file if you want the Editor and Live Editor to
automatically save changes to a file when you click
away from the file. For the changes to be automatically
saved upon clicking away, you must have already saved
the file at least once.

In an installed version of MATLAB, this preference is
located under MATLAB > Editor/Debugger.
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Code Analyzer Preferences

In this section...
“Code Analyzer Preferences” on page 7-14
“Search for Messages in the Code Analyzer Preferences” on page 7-15

Code Analyzer Preferences
You can change how Code Analyzer messages appear in the Editor and Live Editor. With a few
exceptions, these preferences apply to messages in the Editor, Live Editor, MATLAB Function Block
Editor (if your products use that tool), and Code Analyzer Report.

On the Home tab, in the Environment section, click  Preferences. Select Code Analyzer, and
then adjust preference options as described in the table below.

Option Usage
Enabled Integrated Warning and Error Messages Specify whether you want to display Code Analyzer

message indicators, such as the underlining of code
and the message indicator bar, for documents open in
the Editor.

For more information, see “Check Code for Errors and
Warnings Using the Code Analyzer”.

Underlining Specify the type of coding issues that you want to have
underlined.

Regardless of the underlining menu option you choose,
the Editor marks errors and warnings in the message
indicator bar.

Autofix Provides a link to a preference panel that enables you
to adjust the color highlighting errors and warnings
that MATLAB can autofix. You trigger autofix by
clicking the Fix button in a Code Analyzer message.

Active Settings Select the set of message settings to use. Click the
down arrow to select or browse to a previously saved
settings file.

Actions button Click to open a menu that enables you to select:

• Save as — Saves the current Code Analyzer
message settings to a file.

The default location for settings is the MATLAB
preferences folder (the folder returned when you
run prefdir).

• Restore Defaults — Restores default Code
Analyzer message settings.
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Option Usage
Search field Searches the list of Code Analyzer messages that

display below the search field. For details, see “Search
for Messages in the Code Analyzer Preferences” on
page 7-15.

Code Analyzer message settings Select or clear messages to enable or suppress their
appearance in your Editor documents.

To expand or collapse all categories in the list, right-
click anywhere in the list and select Expand All or
Collapse All.

To suppress a message on a line-by-line or file-by-file
basis, see “Adjust Code Analyzer Message Indicators
and Messages”.

Search for Messages in the Code Analyzer Preferences
You can search the list of Code Analyzer messages in the Code Analyzer preferences to display only
those messages that are currently of interest to you. Use any combination of the methods that the
following table presents.

Note If you do not have the MATLAB Compiler™ installed, the Code Analyzer preferences pane does
not display the MATLAB Compiler (deployment) messages category.

To See a List of
Messages ...

Perform this action... Example Scenario

Containing specified text in
the:

• Short message
• Extended message
• Message category
• Message ID

In MATLAB Online, the
extended message is not
included in the search.

Type the text in the search field. You recall seeing a message containing
some text that you want to review, but
you cannot remember the exact
message text.

For example, type com in the search
field to display those messages that
contain that text in the short message,
extended message, or message ID.
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To See a List of
Messages ...

Perform this action... Example Scenario

Corresponding to a given
message ID

Type msgid: followed by a space and
the message ID in the search field.

You are reviewing the code that
someone else wrote and you want to
see the message that corresponds to a
suppressed one using the
%#ok<AGROW> directive.

Type msgid: agrow in the search
field. Messages IDs containing AGROW
display as links. Click each link for
more information about the message.

Not all Code Analyzer messages have
additional information. These messages
do not appear as links.

That you can set using Code
Analyzer preferences

Click the down arrow to the right of the
search field, and then click Show All.

You want to see the complete list of
messages after you have searched the
messages for some text or a given
search menu option.

Different from the default
setting (of enabled or
disabled)

Click the down arrow to the right of the
search field, and then click Show
Messages Modified from Default.

A gray dot precedes a message with a
setting different from the default. For
example:

A coworker gave you a settings file and
you want to review each message that
the coworker changed from its default
setting.

In a given category Click the down arrow to the right of the
search field, click Show Messages in
Category, and then click the category
you want.

You want to review messages that
describe coding practices that make it
difficult for others to use your code.

Click the down arrow to the right of the
search field, select Show Messages in
Category, and then select Aesthetics
and Readability.

Click the messages that appear as links
for more information. Not all messages
appear as links.

That are warnings Click the down arrow to the right of the
search field, and then select Show All
Warnings. An exclamation point in a
yellow triangle  indicates a warning
message.

You recall previous warnings that your
code generated, but you cannot
remember enough details to use the
search field to find it. You want to skim
all the warning messages to find a
particular one of interest.
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To See a List of
Messages ...

Perform this action... Example Scenario

Are errors Click the down arrow to the right of the
search field, and then select Show All
Errors. By default, an X in a red dot
indicates an error message, .

You want to find a message elicited by a
script you worked on previously. All you
can recall is that it was an error and it
involved parfor.

Click the down arrow to the right of the
search field, and then select Show All
Errors. Then, type a space and parfor
in the search field.

The Code Analyzer preference pane
displays only error messages that
contain the word parfor.

Are disabled Click the down arrow to the right of the
search field, and then select Show
Disabled Messages.

You want to see the messages that are
disabled by default or you have
previously disabled.

Example of Searching Messages

To display Code Analyzer error messages that contain the word variable and are disabled:

1 Click the down arrow in the search field, and then select Show All Errors.

The search field contains severity:error.
2 At the end of the text severity:error, press the Space key, and then type variable.
3 Click the down arrow in the search field and select Show Disabled Messages.

The search field now contains severity:error variable enabled:false. Only the messages
that fulfill those requirements appear in the Preferences pane. To restore the list of all messages,
click the clear search button .

The Show All Errors and Show Disabled Messages options are not available in MATLAB Online.

See Also

More About
• “Check Code for Errors and Warnings Using the Code Analyzer”
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Configure Code Analyzer
The Code Analyzer checks code and provides information about errors and warnings. To configure the
Code Analyzer, place a file named codeAnalyzerConfiguration.json in a resources folder. In
this configuration file, you can add custom checks and modify existing checks of the Code Analyzer.

This file configures the Code Analyzer checks performed for the resources folder's parent folder
and its subfolders. The configuration is cached at the start of a MATLAB session. The MATLAB Editor
does not automatically get the latest configuration when you add a new configuration file to a
resources folder or update an existing file during a MATLAB session. To refresh the cache, call
matlab.codeanalysis.refreshConfiguration.

Verify that the file is a valid JSON file using the matlab.codeanalysis.validateConfiguration
function.

Sample Configuration File
This code shows the contents of a sample configuration file. The
codeAnalyzerConfiguration.json file uses JSON format, and // designates the text that follows
as a comment.

{
// Configuration File Information

    "name": "Acme Corp Guideline",
    "description": "Internal MATLAB Coding Guideline",
    "author" : "Alex",
    "schemaVersion" : "1.0.0",
    "guidelineVersion" : "1.0.0",

// Base Configuration Settings
  
    "baseConfiguration" : "closestParentFolder",
   

// New and Modified Checks

    "checks": 
    {
        "MyOwnCheck" : 
        {
           "rule": 
            {
               "template": "functionCall",
               "functionNames" : "evalin" 
            },
           "severity" : "error",
           "messageText" : "Do not use evalin.",
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           "enabled" : true
        },
        "FCNIL" : 
        { 
           "severity" : "error", 
           "limit" : 10, 
           "enabled": true 
        }, 
        "FCNOL" : 
        { 
           "severity" : "error",
           "messageText": "Too many outputs."  
           "limit" : 15, 
           "enabled": true, 
        },
        "AGROW" : 
        {
           "severity" : "info",
           "messageText" : "Growing array in a loop is not recommended",
           "enabled" : false
        }
    }
}

Configuration File Information
You can optionally include the following properties in the configuration file. These properties do not
affect the configuration. Each property accepts a string containing the relevant information.

• "name" — Name of the configuration file
• "description" — Description of the configuration file
• "author" - Author name
• "schemaVersion" — Schema version in the format "1.2.3"
• "guidelineVersion" — Guideline version in the format "1.2.3"

Base Configuration Settings
A configuration file can inherit the rules of a configuration file contained in the resources folder of a
parent folder. The property, "baseConfiguration" specifies what base configuration should be
used and accepts these values:

• "closestParentFolder" (default) — Use the configuration file found in the closest parent
folder. If "baseConfiguration" is not defined, then the "closestParentFolder" setting is
used.

• "factory" — Use the standard MATLAB Code Analyzer configuration.

Add Custom Checks for Functions
You can configure the Code Analyzer to display a check when specific functions are used. To create a
new check, you must assign a check ID that is a valid MATLAB identifier. For example, define
"MyOwnCheck" to check for an evalin function call.

The "MyOwnCheck" check has these properties:
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Property Name Example Description
"rule" "rule": { "template" :

"functionCall",
"functionNames" :
"evalin" }

Define the rules for the custom
check. The "rule" field
contains a JSON array
containing these fields:

• "template" — Define the
template that triggers the
message. Currently,
"functionCall" is the only
accepted template, and the
message is generated when
the function is called.

• "functionNames — Define
the names of the functions
that trigger the custom
check. Specify a string or
string array containing the
function names.

"messageText" (optional) "messageText" : "Do not
use evalin."

Specify the text displayed in the
Code Analyzer message.

"severity" (optional) "severity" : "error" Specify the check severity as
"warning", "error", or
"info".

"enabled" (optional) "enabled": true Specify whether this check is
enabled in the MATLAB Editor.

Configure Maximum Input and Output Arguments
You can configure the Code Analyzer to limit the number of input and output arguments for a
function. Use the check ID "FCNIL" to specify the maximum number of input arguments for a
function. Use the check ID "FCNOL" to specify the maximum number of output arguments.

The "FCNIL" and "FCNOL" checks have these properties:

Property Name Example Description
"messageText" (optional) "messageText" : "Too

many outputs."
Specify the text displayed in the
Code Analyzer message.

"severity" (optional) "severity" : "error" Specify the check severity as
"warning", "error", or
"info".

"limit" (optional) "limit" : 10 Specify the maximum number of
arguments.

"enabled" (optional) "enabled": true Specify whether this check is
enabled in the MATLAB Editor.
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Modify Existing Code Analyzer Checks
You can use the configuration file to modify existing Code Analyzer checks. Use the check ID you
want to modify as the check name. Then, specify the properties you want to modify and their new
values. For example, to disable a check in the editor, specify: "enabled" : false.

To identify the check ID for checks in a given file, use codeIssues. For a full list of configurable
checks, see “Index of Code Analyzer Checks” on page 7-22.

The built-in Code Analyzer checks have these properties:

Property Name Example Description
"messageText" (optional) "messageText" : "Growing

array in a loop is not
recommended"

Specify the text displayed in the
Code Analyzer message

"severity" (optional) "severity" : "info" Specify the check severity as
"warning", "error", or
"info".

"enabled" (optional) "enabled" : true Specify whether this check is
enabled in the MATLAB Editor.

See Also
Apps
Code Analyzer

Objects
codeIssues

Functions
matlab.codeanalysis.validateConfiguration |
matlab.codeanalysis.refreshConfiguration

Related Examples
• “Check Code for Errors and Warnings Using the Code Analyzer”
• “MATLAB Code Analyzer Report”
• “Index of Code Analyzer Checks” on page 7-22
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Index of Code Analyzer Checks
This topic describes Code Analyzer checks available in MATLAB. You can enable, disable, or configure
these checks in addition to writing new checks to meet your set of coding standards. See “Configure
Code Analyzer” on page 7-18 for more information.

Incomplete Analysis
Check ID Severity Message Can Be Disabled?
TMMSG Error More than 10,000 Code Analyzer

messages were generated, leading to
some being deleted.

false

TMSMS Error More than 1,000 parse error messages
were generated, leading to some being
deleted.

false

MXASET Error The file is too complex to analyze.
Simplify the code to improve code
maintainability. For example, reduce
the number of operations in
expressions.

false

QUIT Error Code analysis did not complete. Code
Analyzer encountered an error.

false

NOSPC Error The file is too complex to analyze.
Refactor the code to improve code
maintainability. For example, reduce
the nesting level of conditions or
functions.

false

MBIG Error Code analysis did not complete. File
VAR_FILE is too large.

false

NOFIL Error Unable to open file VAR_FILE. File is
not found.

false

MDOTM Error Unable to run code analysis. VAR_FILE
has an invalid file extension.

false

BDCFG Error Unable to run code analysis due to
invalid Code Analyzer configuration
file. Run
matlab.codeanalysis.validateConfigurat
ion(VAR_NAME) to identify specific
issues.

false

BDFIL Error Unable to run code analysis due to
invalid MATLAB file name. MATLAB file
names must start with a letter and
contain only letters, numbers or
underscores.

false

RDERR Error Unable to read file VAR_FILE. false
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Check ID Severity Message Can Be Disabled?
EOFER Error Code analysis did not complete. File

contains too many syntax errors.
false

EOFMI Error Invalid syntax at end of file. File is
incomplete.

false

MDEEP Error Parentheses, brackets, and braces are
nested too deeply.

false

DEEPC Error Block comments are nested too deeply. false
DEEPN Error Functions are nested too deeply. false
DEEPS Error Statements are nested too deeply. false
TEXTL Error Text is too long for MATLAB to parse. false

Syntax Errors

Check ID Severity Message Can Be Disabled?
NOLHS Error Left side of an assignment is empty. true
BADCH Error Invalid text character(s). true
BADCT Error Unicode explicit directional formatting

characters are not supported.
true

BADFP Error Invalid floating-point constant. true
BADHBH Error Invalid digit in hexadecimal literal.

Supported hexadecimal digits are 0-9
and A-F. Supported type suffixes are
u8, u16, u32, u64, and s8, s16, s32,
s64.

true

BADHBB Error Invalid digit in binary literal. Supported
binary digits are 0 and 1. Supported
type suffixes are u8, u16, u32, u64, and
s8, s16, s32, s64.

true

BADHBHT Error Hexadecimal literal has too many digits
for specified type suffix.

true

BADHBBT Error Binary literal has too many digits for
specified type suffix.

true

BADSP Error Invalid text character(s). The text
contains an unsupported non-ASCII
whitespace character.

true

HEXTOOLONG Error Hexadecimal literal has too many
digits.

true

BINARYTOOLONG Error Binary literal has too many digits. true
BADOT Error Use of two dots (..) is an invalid

MATLAB construction.
true

BADNE Error 'Not Equals' is spelled ~= in MATLAB,
not !=.

true
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Check ID Severity Message Can Be Disabled?
DOUQT Error A double quoted string is

unterminated.
true

STRIN Error A quoted character vector is
unterminated.

true

INBLK Error A block comment is unterminated at
the end of the file.

true

RESWD Error Invalid use of a reserved word. true
REDEF Error The current use of VAR_NAME is

inconsistent with its previous use or
definition (line VAR_NUMBER).

true

UNSET Error Invalid use of VAR_OPERATOR on the
left side of an assignment.

true

LHROW Error The left side of an assignment cannot
have multiple rows (';').

true

NOPAR Error A VAR_NAME might be missing a
closing VAR_NAME, causing invalid
syntax at VAR_NAME.

true

NOPAR2 Error A VAR_NAME might be missing a
closing VAR_NAME, causing invalid
syntax at VAR_NAME on line
VAR_NUMBER.

true

EOLPAR Error A VAR_NAME might be missing a
closing VAR_NAME, causing invalid
syntax at end of line.

true

TWOCM Error A comma cannot immediately follow
another comma.

true

FNDOT Error Function name can only contain dots if
it is a class method.

true

ENDCT Error An END might be missing, possibly
matching VAR_RESERVED_WORD.

true

ENDCT2 Error An END might be missing (after line
VAR_RESERVED_WORD), possibly
matching VAR_NUMBER.

true

ENDCT3 Error An END might be missing (before
VAR_RESERVED_WORD on line
VAR_NUMBER), possibly matching
VAR_RESERVED_WORD.

true

ENDCT4 Error A METHODS block or END might be
missing before the function definition.
This might be causing additional error
messages.

true

SYNER Error Parse error at VAR_RESERVED_WORD:
usage might be invalid MATLAB syntax.

true

7 Editor Preferences

7-24



Check ID Severity Message Can Be Disabled?
MCPLD Error Invalid property syntax at

VAR_RESERVED_WORD.
true

SBTMP Error Invalid array indexing or function call.
Chaining outputs after parenthesis is
not supported.

true

BADNOT Error Using ~ to ignore a value is not
permitted in this context.

true

BADNOTLHS Error Invalid use of logical not operator (~)
on left side of an assignment. To use ~
to ignore function outputs, separate
output variables with commas.

true

ENDPAR Error A VAR_NAME might be missing a
closing VAR_NAME, causing invalid
syntax at end of file.

true

SEPEXR Error Use a newline, semicolon, or comma
before this statement.

true

FISST Error Function definitions in a script must
appear at the end of the file. Move
statements to before the function
definitions.

true

VTPOD Error Specify validation in the following
order: size, then class, then functions.

true

FNSWA Error Function name must start with
alphabetic character.

true

SYNEND Error Invalid use for END operator. true
CLTWO Error Only one class definition is allowed per

file, and it must come at the head of the
file.

true

FVACI Error Use of name-value arguments in cell
indexing is not supported.

true

FVACS Error Using a character vector or string as a
name in name=value syntax is not
supported. Remove the quotes around
the name.

true

FVAMI Error Name in name-value argument syntax
must be a valid MATLAB identifier.

true

FVNST Error Arguments blocks in nested function
declarations are not supported.

true

FVSYN Error Invalid function argument syntax at
VAR_RESERVED_WORD.

true
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Language Specification Errors
Check ID Severity Message Can Be Disabled?
MCDIR Error Class name VAR_NAME and @directory

name do not agree: VAR_FILE.
true

MCFIL Error Class name VAR_NAME and file name
do not agree: VAR_FILE. Update the
class name and constructor, if defined,
or change the file name to match the
class name.

true

FCONV Error Unable to define variable VAR_NAME
because it has the same name as the
script.

true

FCONF Error Unable to define local function
VAR_NAME because it has the same
name as the file.

true

VTPEAL Error Specify at least one input argument for
validator.

true

VTPCON Error For properties, validation functions
must only use the property being
validated or literals.

true

VTPIN Error Validation function must use the
property as an input.

true

ROWLN Error All matrix rows must be the same
length.

true

GPFST Error A GLOBAL or PERSISTENT declaration
must precede first use.

true

GPNES Error A GLOBAL or PERSISTENT declaration
must be in the outermost function
where it is used.

true

NPERS Error A PERSISTENT declaration is not valid
in scripts.

true

PFRNG Error The range of a PARFOR statement must
be increasing consecutive integers.

true

PFNST Error PARFOR or SPMD cannot be used
inside another PARFOR loop.

true

PFDF Error FOR with DRANGE (old PARFOR)
becomes a conventional FOR when
used inside a PARFOR loop.

true

PFBR Error BREAK and RETURN statements
cannot be used inside a PARFOR loop.

true

PFLD Error To avoid a transparency violation,
assign the output of LOAD to a variable
in PARFOR loops.

true
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Check ID Severity Message Can Be Disabled?
PFSV Error SAVE cannot be called in a PARFOR

loop.
true

PFEVC Error EVALIN('caller') and
ASSIGNIN('caller') are invalid inside of
a PARFOR loop.

true

PFNAIO Error VAR_NAME with zero input arguments
should not be used inside a PARFOR
loop.

true

PFNACK Error VAR_NAME should not be used inside a
PARFOR loop.

true

PFUNK Error The PARFOR loop cannot run due to
the way variable VAR_NAME is used.

true

PFPIE Error Valid indices for VAR_NAME are
restricted in PARFOR loops.

true

PFSAME Error In a PARFOR loop, variable VAR_NAME
is indexed in different ways, potentially
causing dependencies between
iterations.

true

PFTIN Error The temporary variable VAR_NAME
must be set inside the PARFOR-loop
before it is used.

true

PFNF Error The nested function VAR_NAME cannot
be called from within a PARFOR loop.

true

PFRFH Error The PARFOR reduction function
VAR_NAME must either be a function
name or a broadcast variable.

true

PFXST Error Changing the loop index VAR_NAME is
invalid inside a PARFOR loop.

true

SPDEC Error The bounds on the number of workers
an SPMD block can use must be a
positive integer.

true

SPDEC3 Error An SPMD block can only specify a
lower and upper bound for the number
of workers to use.

true

SPNST Error PARFOR or SPMD cannot be used
inside an SPMD block.

true

SPRET Error VAR_RESERVED_WORD statement
cannot be used inside an SPMD block.

true

SPBRK Error The loop containing the BREAK or
CONTINUE must be completely
contained in the SPMD block.

true

SPLD Error To avoid a transparency violation,
assign the output of LOAD to a variable
in SPMD blocks.

true
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Check ID Severity Message Can Be Disabled?
SPSV Error SAVE cannot be called in an SPMD

block.
true

SPGP Error Setting the GLOBAL or PERSISTENT
variable VAR_NAME in an SPMD block
might fail because the set happens on a
worker machine.

true

SPEVC Error EVALIN('caller') and
ASSIGNIN('caller') are invalid inside of
an SPMD block.

true

SPBFN Error The function VAR_NAME inside an
SPMD block might not access the
desired workspace.

true

SPIFN Error The function VAR_NAME might make
an invalid workspace access inside the
SPMD block.

true

SPNF Error The nested function VAR_NAME cannot
be called from within an SPMD block.

true

SPWHOS Error The VAR_NAME function cannot be
called from within an SPMD block.

true

IDXCOLND Error The END operator must be used within
an array index expression.

true

CTOINE Error Use of constructed object as input to
constructor is not supported.

true

CTORO Error Class constructors must be declared
with at least one output argument.

true

ATLAB Error Attribute 'Input' and 'Output' must not
be assigned a value or negated.

true

ATPPP Error The attribute value is unexpected. Use
'public', 'private', 'protected', or a cell
array of meta-classes instead.

true

ATPPI Error The attribute value is unexpected. Use
'public', 'private', 'protected',
'immutable', or a cell array of meta-
classes instead.

true

ATNPP Error Set attribute to 'public', 'private',
'protected', or a cell array of meta-
classes instead.

true

ATNPI Error Set attribute to 'public', 'private',
'protected', 'immutable', or a cell array
of meta-classes instead.

true

ATAS Error The attribute value is unexpected. Use
a single meta-class object or a cell
array of meta-class objects.

true
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Check ID Severity Message Can Be Disabled?
ATNAS Error Set attribute to a single meta-class

object or a cell array of meta-class
objects.

true

ATUNK Error Unknown attribute name. true
ATVIZE Error The 'Visible' attribute is invalid for

classes and events. Use the '~Hidden'
attribute instead or omit the attribute
since 'Hidden' is false by default.

true

CLSAT Error Specify class attributes before the
name of the class.

true

CLSUNK Error This class, or one of its superclasses,
could not be found on MATLAB's path.

true

NOPRV Error A class definition cannot be inside a
private directory.

true

MCEB Error Events can be defined only in a handle
class.

true

MCSGP Error The method VAR_NAME does not refer
to a valid property name.

true

MCSGA Error Set or get method must be defined in a
METHODS block with no attributes.

true

MCS2I Error Set Methods must have exactly two
inputs.

true

MCS1O Error Set Methods must have at most one
output.

true

MCG1I Error Get methods must have exactly one
input.

true

MCG1O Error Get methods must have exactly one
output.

true

MCGSA Error Method VAR_NAME tries to set or get
an abstract property.

true

MCSCN Error Method VAR_NAME tries to set a
constant property.

true

MCANI Error Abstract property VAR_NAME cannot
be initialized.

true

MCASC Error Abstract property VAR_NAME cannot
be used in a Sealed class.

true

MCRED Error Property, event, or enumeration names
must be different from the name of the
class VAR_NAME.

true

MCCBD Error Constructor must be fully defined in
the class definition file.

true

MCPSG Error Set or get method must be fully defined
in the class definition file.

true
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Check ID Severity Message Can Be Disabled?
MCSCT Error Superclass constructor call must not be

conditionalized or be part of another
expression.

true

MCSCO Error A superclass constructor must be
called using the first constructor output
argument.

true

MCSCF Error A superclass constructor must be
assigned to the first constructor output
argument.

true

MCCBS Error A superclass constructor is being
called, but VAR_NAME is not a
declared superclass name.

true

MCCBU Error This superclass constructor is called
after a use of the constructed object.

true

MCCMC Error Constructor for superclass can only be
called once.

true

MCSCC Error To call the superclass constructor, the
name of the subclass constructor
VAR_NAME must match the name of
the subclass VAR_NAME.

true

MCSCM Error To call a superclass method, the
method name VAR_NAME must match
the name of the subclass method
VAR_NAME.

true

MCCSOP Error Unable to modify Constant property
VAR_NAME.

true

MTMAT Error Attribute can only be set once. true
MTAGS3 Error Cannot use the Access attribute when

using the SetAccess or GetAccess
attribute.

true

MCAPP Error Private property cannot be Abstract. true
MABSEAC Error Instance properties and methods are

illegal in classes that are both Sealed
and Abstract.

true

MABSEAM Error A method cannot be both Abstract and
Sealed.

true

MCMIO Error Method has too many inputs or
outputs.

true

MCMSP Error Private method cannot be Abstract. true
MCMTP Error TestParameterDefinition methods must

be Static, so that they can be called at
test suite creation time to set test
parameter values.

true
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Check ID Severity Message Can Be Disabled?
MHERIT Error Deriving from the built-in MATLAB

VAR_NAME class is not supported.
true

MCSWA Error A sealed class cannot specify allowed
subclasses.

true

MCPIN Error Unable to initialize class property to an
instance of the class itself.

true

MWKREF Error Specifying both WeakReference and
Dependent attributes is invalid. A
dependent property does not store a
reference.

true

NCHKOS Error NARGINCHK does not return any
values.

true

ERTXT Error Specify an error message with the
message identifier.

true

WTXT Error Specify a warning message with the
message identifier.

true

PFCEL Error The function VAR_NAME does not
support cell arrays (argument
VAR_NUMBER).

true

BRKFOR Error BREAK statement can only be used in a
FOR or WHILE loop.

true

CONTFOR Error CONTINUE statement can only be used
in a FOR or WHILE loop.

true

FVAPN Error Move name-value arguments that use
the name=value syntax to the end of
the argument list.

true

FVATF Error Attribute values in arguments blocks
must be logical constants.

true

FVIOA Error Specifying both 'Input' and 'Output'
attributes on the same arguments block
is not supported.

true

FVBTN Error Use of this function is not supported in
arguments blocks.

true

FVDAN Error Using the same name as both a name-
value argument structure and as a
positional argument is not supported.

true

FVDAP Error Positional argument can only be
declared once.

true

FVDNF Error Name-value argument can only be
declared once.

true

FVDREP Error Multiple Repeating arguments blocks
are not supported.

true
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Check ID Severity Message Can Be Disabled?
FVMCL Error Specifying multiple name-value

structures using .? syntax and a class
name is not supported.

true

FVNDE Error When specifying name-value
arguments using a class name, it is
illegal to specify default values for the
arguments.

true

FVIDV Error Specifying validation or default value
for ignored arguments is not
supported.

true

FVNIV Error This variable is not an input to the
function and cannot be used in an
arguments block.

true

FVNREP Error Name-value arguments are not
supported in a Repeating arguments
block.

true

FVOND Error Use of name-value arguments in
default values is not supported.

true

FVORDI Error Ignored input arguments are not
allowed after a Repeating arguments
block or name-value arguments.

true

FVORDN Error Positional arguments must be defined
before name-value arguments.

true

FVORDO Error Repeating output arguments must be
defined after required output
arguments.

true

FVORDP Error Positional arguments must be defined
in the following order: required,
optional, and repeating.

true

FVONV Error Use of name-value arguments without
dotted name in the validation is not
supported.

true

FVREPD Error Default values are not supported in a
Repeating arguments block.

true

FVREPO Error Repeating input arguments block
containing varargin must not have
other arguments.

true

FVNSC Error Calling nested functions is not
supported in arguments blocks.

true

FVNVL Error When specifying name-value
arguments using a class name, it is
illegal to specify validation for the
arguments.

true
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Check ID Severity Message Can Be Disabled?
FVSOR Error Input arguments block declarations

and the function line must contain the
same input arguments in the same
order, including ignored arguments.

true

FVSORO Error Output arguments block declarations
and the function line must contain the
same output arguments in the same
order.

true

FVUBD Error Argument is referenced before it is
declared in the arguments block.

true

FVVCON Error For input arguments, validation
functions must only use previously
declared positional arguments, the
argument being validated, or literals.

true

FVOCON Error For output arguments, validation
functions must only use the argument
being validated or literals.

true

FVVIN Error Validation function must use the
argument as an input.

true

FVVREP Error varargin can only be used inside
repeating input arguments block.

true

TTOOFEWDIMS Error Specify at least two dimensions for
size.

true

TINVALDIM Error Each dimension must be a nonnegative
integer number or a colon.

true

MCSMO Error Returning multiple outputs from a
superclass object initialization is not
supported.

true

FVOBI Error Declare all input argument blocks
before all output arguments blocks.

true

FVOOD Error Specifying a default value for an output
argument is not supported.

true

FVOON Error Using name-value argument as output
argument is not supported.

true

FVOVREP Error Output argument varargout can only be
used inside a Repeating output
arguments block.

true

FVOOI Error Use of ignored arguments in output
arguments block is not supported.

true

FVORM Error Declaring multiple repeating output
arguments is not supported.

true
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Bugs
Check ID Severity Message Can Be Disabled?
IFBDUP Error This condition has no effect because all

blocks in this if statement are identical.
Remove the condition or change the
code blocks.

true

IFCDUP Error The statements under this
VAR_RESERVED_WORD condition
cannot be reached because it is a
duplicate of the
VAR_RESERVED_WORD condition on
line VAR_NUMBER. Remove or change
the condition.

true

PFUIXE Error The index variable VAR_NAME might
be used after the PARFOR loop on line
VAR_NUMBER, but it is unavailable
after the loop.

true

PFBFN Error The function VAR_NAME inside a
PARFOR loop might not access the
correct workspace.

true

PFIFN Error The function VAR_NAME might make
an invalid workspace access inside the
PARFOR loop.

true

PFTUSE Error The temporary variable VAR_NAME is
used after the PARFOR loop on line
VAR_NUMBER, but its value is not
available after the loop.

true

PFRNC Error The variable VAR_NAME is used like a
PARFOR reduction variable, but it has
additional (invalid) uses.

true

RHSFN Error The expression cannot be assigned to
multiple values.

true

FNAN Error Use ISNAN when comparing values to
NaN.

true

FUNFUN Error The first input argument must be a
function handle. Did you mean
'@VAR_NAME'?

true

MOCUP Error The variable VAR_NAME is an uplevel
variable, invalid in a function called by
onCleanup.

true

MDUPC Error The case value VAR_NAME is a
duplicate of one on line VAR_NUMBER.

true

MNANC Error NaN never compares equal to any
value, so this case will never be
matched.

true
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DUPNAMEARG Error This named argument will override a

previous one. Remove one of the
duplicated named arguments.

true

MULCC Error This case cannot be matched due to a
call to UPPER or LOWER on the
SWITCH value.

true

STCUL Error The comparison will likely fail due to
case mismatch.

true

NOPRC Error A line break terminates the statement
so it may be incomplete. Use ellipsis
(...) to continue the statement. Or add a
semicolon to hide the output.

true

SHOCIRT Error The VAR_NAME operator is unexpected
because VAR_NAME(A VAR_NAME B)
always returns true.

true

SHOCIRF Error The VAR_NAME operator is unexpected
because VAR_NAME(A VAR_NAME B)
always returns false.

true

CTRUE Error This logical comparison always returns
true. Did you mean to use VAR_NAME
to evaluate function argument:
VAR_NAME(...VAR_NAME...)?

true

CFALSE Error This logical comparison always returns
false. Did you mean to use VAR_NAME
to evaluate function argument:
VAR_NAME(...VAR_NAME...)?

true

DEFSIZE Error Do not overload 'size' for fundamental
data types.

true

VARARG Error Initialize VARARGOUT with a CELL. true
SUBSASGN Error Output of SUBSASGN must be

assigned to a variable.
true

MEXCEP Error To pass MException properties to the
warning function, use a format
specifier. For example,
warning(E.identifier, '%s', E.message).

true

ASSRT Error The first input argument to 'assert'
must be a condition. To always throw
an error, use 'error(msg)' instead.

true

FWFORP Error 'fwrite' is writing to a file that is
opened with read permission only.
Open a file using 'fopen(...,'W',...)'
instead.

true
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Check ID Severity Message Can Be Disabled?
FPFORP Error 'fprintf' is writing to a file that is

opened with read permission only.
Open a file using 'fopen(...,'W',...)'
instead.

true

LBODUP Error Since both operands are identical, the
second operand has no effect on the
VAR_RESERVED_WORD operation.
Change one of the operands or remove
the VAR_RESERVED_WORD operation.

true

INCR Error ++x operation does not increment the
value of x. To increase the value by 1,
use x = x + 1.

true

DECR Error --x operation does not decrement the
value of x. To decrease the value by 1,
use x = x - 1.

true

CMDAND Error Use 'A && B' or 'A & B' to test whether
A and B are both true in MATLAB.

true

CMDOR Error Use 'A || B' or 'A | B' to test whether
either A or B is true in MATLAB.

true

Custom Checks
Check ID Severity Message Can Be Disabled?
FCNIL Warning Function has more than VAR_NUMBER

input arguments. This makes the
function difficult to understand and
maintain.

true

FCNOL Warning Function has more than VAR_NUMBER
output arguments. This makes the
function difficult to understand and
maintain.

true

FCNLL Warning Function has more than VAR_NUMBER
lines. This makes the function difficult
to understand and maintain.

true

LLMNC Warning Line has more than VAR_NUMBER
characters (including whitespaces).
This makes the line difficult to
understand and maintain.

true

MNCSN Warning This control statement is deeply nested
(nesting level = VAR_NUMBER) and
might have more deeply nested control
statements. This makes the code
difficult to understand and maintain.

true
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Check ID Severity Message Can Be Disabled?
DAFTC Warning Use of try/catch statement is

disallowed by custom code analyzer
configuration.

true

DAFPV Warning Use of persistent variable is disallowed
by custom code analyzer configuration.

true

DAFCO Warning Use of continue statement is disallowed
by custom code analyzer configuration.

true

DAFBR Warning Use of break statement is disallowed by
custom code analyzer configuration.

true

DAFRT Warning Use of return statement is disallowed
by custom code analyzer configuration.

true

DAFSC Warning Use of a script is disallowed by custom
code analyzer configuration.

true

DAFNF Warning Use of a nested function is disallowed
by custom code analyzer configuration.

true

DAFCF Warning Use of command syntax to call a
function is disallowed by custom code
analyzer configuration.

true

DAFAF Warning Use of an anonymous function is
disallowed by custom code analyzer
configuration.

true

Compatibility Considerations
Check ID Severity Message Can Be Disabled?
IMPORTDYN Warning In a future release, IMPORT will not

accept variable names, function calls,
or operators. Use literal char vectors
instead.

true

REDEFGI Warning Declaring an input or output variable to
be global might not be supported in a
future release.

true

REDEFGG Warning Declaring a variable to be global more
than once might not be supported in a
future release.

true

MCPDC Error Specifying both the 'Constant' and
'Dependent' attributes on the same
property is not supported.

true

NOV6 Warning 'v6' will be removed in a future release.
There is no simple replacement for this.

true

LEGINTPAR Error Using integers to specify location not
supported. Use the location parameter
name and value pair instead.

true
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Check ID Severity Message Can Be Disabled?
V6ON Warning USEV6PLOTAPI('on') will be removed

in a future release. There is no simple
replacement for this.

true

PSTAT Error The 'Static' attribute on properties has
been removed. Use the 'Constant'
attribute instead.

true

FGREN Warning 'Renderer' will be removed in a future
release. There is no simple
replacement for this.

true

FGREM Warning 'RendererMode' will be removed in a
future release. There is no simple
replacement for this.

true

FROPT Error '-dill' has been removed. Use
Encapsulated PostScript instead.

true

FROPTX Error '-adobecset' has been removed. There
is no simple replacement for this.

true

DPSD Error 'psd' has been removed. Use
'periodogram' or 'pwelch' instead.

true

DSPDF Error 'dsp.DigitalFilter' has been removed.
Use 'dsp.FIRFilter', 'dsp.BiquadFilter',
'dsp.IIRFilter', or 'dsp.AllpoleFilter'
instead.

true

DSPIDF Error The property 'DirectFeedthrough' has
been removed.

true

DSPFDF Error The property 'DirectFeedthrough' has
been removed.

true

DMSSPEC Warning 'dspdata.msspectrum' will be removed
in a future release. Use 'periodogram'
or 'pwelch' instead.

true

DPSPEC Warning 'dspdata.pseudospectrum' will be
removed in a future release. Use
'pmusic' or 'peig' instead.

true

DPPSD Warning 'dspdata.psd' will be removed in a
future release. Use 'pburg', 'pcov',
'peig', 'pmcov', 'pmtm', 'periodogram',
or 'pwelch' instead.

true

DINLN Warning INLINE will be removed in a future
release. Use anonymous functions
instead.

true

DFCNCHK Warning FCNCHK will be removed in a future
release. Use anonymous functions
instead.

true

MSYSTEM Error matlab.system.System has been
removed. Use matlab.System instead.

true
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Check ID Severity Message Can Be Disabled?
ATVIZW Error The 'Visible' attribute has been

removed. Use the '~Hidden' attribute
instead or omit the attribute since
'Hidden' is false by default.

true

MCGCP Error Defining a get method for a constant
property is not supported.

true

MCATP Error Using an @ sign to specify a class
property restriction is unsupported and
has been removed. Use property
validation syntax instead.

true

NCHKNO Warning NARGOUTCHK using more than two
inputs will be removed in a future
release. There is no simple
replacement for this.

true

HESST Error 'InitialHessType' has been removed.
There is no simple replacement for this.

true

HESSM Error 'InitialHessMatrix' has been removed.
There is no simple replacement for this.

true

BUFSIZE Error Option 'Bufsize' has been removed.
Manual buffering in 'textscan' is no
longer needed.

true

FEGLO Error 'global' has been removed. There is no
simple replacement for this.

true

MATPOOL Error 'matlabpool' has been removed. Use
'pool' instead.

true

LINPROGS Error 'simplex' has been removed. Use
'interior-point' or 'dual-simplex'
instead.

true

LINPROGA Error 'active-set' has been removed. Use
'interior-point' or 'dual-simplex'
instead.

true

SMPLMODE Error The property 'FrameBasedProcessing'
has been removed.

true

COEFFS Error The property 'FilterSpecification' has
been removed.

true

COEFF1 Error The property 'FirstFilterCoefficients'
has been removed.

true

COEFF2 Error The property 'SecondFilterCoefficients'
has been removed.

true

COEFF3 Error The property 'ThirdFilterCoefficients'
has been removed.

true

COEFFD1 Error The property
'FirstFilterCoefficientsDataType' has
been removed.

true
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Check ID Severity Message Can Be Disabled?
COEFFD2 Error The property

'SecondFilterCoefficientsDataType' has
been removed.

true

COEFFD3 Error The property
'ThirdFilterCoefficientsDataType' has
been removed.

true

COEFFC1 Error The property
'CustomFirstFilterCoefficientsDataType
' has been removed.

true

COEFFC2 Error The property
'CustomSecondFilterCoefficientsDataT
ype' has been removed.

true

COEFFC3 Error The property
'CustomThirdFilterCoefficientsDataTyp
e' has been removed.

true

READSZK Error The property 'KeyValueLimit' has been
removed.

true

READSZR Error The property 'RowsPerRead' has been
removed.

true

RESOU Error 'resources' is a reserved folder.
Running MATLAB files located in a
folder named 'resources' is not
supported.

true

TREEDISP Error TREEDISP has been removed. Use
ClassificationTree or RegressionTree
VIEW methods instead.

true

TREEPRUNE Error TREEPRUNE has been removed. Use
ClassificationTree or RegressionTree
PRUNE methods instead.

true

TREETEST Error 'treetest' has been removed. Use
ClassificationTree or RegressionTree
methods instead.

true

TREEVAL Error TREEVAL has been removed. Use
ClassificationTree or RegressionTree
PREDICT methods instead.

true

TREEFIT Error TREEFIT has been removed. Use
fitctree or fitrtree instead.

true

TTSMP Error 'SamplingRate' has been removed. Use
'SampleRate' instead.

true

FINSI Error Support for 'inputname' in a script has
been removed.

true

FINSNI Error Support for 'nargin' in a script has
been removed.

true
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Check ID Severity Message Can Be Disabled?
FINSNO Error Support for 'nargout' in a script has

been removed.
true

DISGVER Error 'matlab.graphics.internal.isGraphicsVer
sion1' has been removed. Use
'verLessThan('matlab','8.4.0')' instead.

true

DFEATUREPARAM1 Error 'UseHG2' has been removed. Use
'~verLessThan('matlab','8.4.0')'
instead.

true

DFEATUREPARAM2 Error 'HGUsingMATLABClasses' has been
removed. Use
'~verLessThan('matlab','8.4.0')'
instead.

true

DNDLA Error 'discard' has been removed. There is no
simple replacement for this.

true

GETERR Error The 'ErrorMessage' property has been
removed. At the command line, use
'MException.last' instead.

true

SETERR Error The 'ErrorMessage' property has been
removed. There is no simple
replacement for this.

true

OBJMPOOL Error 'MATLABPOOL' has been removed. Use
'PARPOOL' instead.

true

QAMDEPM Error 'qammod' no longer accepts the initial
phase of a signal.

true

QAMDEPD Error 'qamdemod' no longer accepts the
initial phase of a signal.

true

JAPIMATHWORKS Warning 'com.mathworks' package and
subpackages will be removed in a
future release. There is no simple
replacement for this.

true

JAVCM Warning 'javacomponent' is undocumented and
will be removed in a future release.
There is no simple replacement for this.

true

JAVCT Warning 'JavaContainer' is undocumented and
will be removed in a future release.
There is no simple replacement for this.

true

JAVFM Warning 'JavaFrame' is undocumented and will
be removed in a future release. There
is no simple replacement for this.

true

FISGET Warning 'getfis' will be removed in a future
release. Use FIS object instead.

true

FISM2M Warning 'mf2mf' will be removed in a future
release. To change membership
function type, change Type property.

true
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Check ID Severity Message Can Be Disabled?
FISSET Warning 'setfis' will be removed in a future

release. Use FIS object instead.
true

FISSHW Warning 'showfis' will be removed in a future
release. Use FIS object instead.

true

WLGC Error 'wlanGeneratorConfig' has been
removed. Use the name-value pair
syntax of 'wlanWaveformGenerator'
instead.

true

OPTMOPT Error solve(PROBLEM, OPTIONS) has been
removed. Use solve(PROBLEM,
'Options', OPTIONS) instead.

true

OPTMSLV Error solve(PROBLEM, SOLVER) has been
removed. Use solve(PROBLEM,
'Solver', SOLVER) instead.

true

OPTMNVP Error solve(PROBLEM, SOLVER, OPTIONS)
has been removed. Use
solve(PROBLEM, 'Solver', SOLVER,
'Options', OPTIONS) instead.

true

SMTHC Error 'smithchart' has been removed. Use
'smithplot' instead.

true

POLYREP Error Use 'MergedReporting' instead of
'Reporting' for polyspace.Options.

true

POLYCS Error Use 'MergedComputingSettings'
instead of 'ComputingSettings' for
polyspace.Options.

true

ADTPATH Warning 'path' will be removed in a future
release. Use 'trajectory' instead.

true

COMMERRATE Error 'commtest.ErrorRate' has been
removed. Use 'comm.ErrorRate' or
BERTool instead.

true

TCRESULT Error 'testconsole.Results' has been removed.
Use 'comm.ErrorRate' or BERTool
instead.

true

FPRENAME Warning Input argument 'fixpoint' will be
removed in a future release. Use
'fixedpoint' instead.

true

XPCRENAME Warning Input argument 'xpc' will be removed
in a future release. Use 'slrealtime'
instead.

true

SLRTRENAME Warning Input argument 'slrt' will be removed in
a future release. Use 'slrealtime'
instead.

true
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Check ID Severity Message Can Be Disabled?
PSRENAME Warning Input argument 'powersys' will be

removed in a future release. Use 'sps'
instead.

true

DCRENAME Warning Input argument 'distcomp' will be
removed in a future release. Use
'parallel' instead.

true

SERENAME Warning Input argument 'simevents' will be
removed in a future release. Use 'slde'
instead.

true

WEBREMOVE Warning The 'web' function does not return a
handle or URL for pages that open in
the system browser. Use 'stat =
web(___, '-browser')' instead.

true

IMCLASS Warning In a future release, 'ismethod' will treat
a string or character vector in its first
input as a 'string' or 'char' class object.
Pass an object to 'ismethod' or use
any(strcmp('methodName',
methods('ClassName'))) instead.

true

WLRC Error 'wlanRecoveryConfig' has been
removed. Instead, parameterize the
function that accepts the
'wlanRecoveryConfig' object by using
the name-value pair syntax.

true

SESSION Warning 'Session' class will be removed in a
future release. Use 'daq' instead, which
is a direct replacement.

true

SESSIONADIC Warning 'addAudioInputChannel' method of
'Session' class will be removed in a
future release. Use 'addinput' of
'DataAcquisition' class instead, which is
a direct replacement.

true

SESSIONAIC Warning 'addAnalogInputChannel' method of
'Session' class will be removed in a
future release. Use 'addinput' of
'DataAcquisition' class instead.

true

SESSIONAOC Warning 'addAnalogOutputChannel' method of
'Session' class will be removed in a
future release. Use 'addoutput' of
'DataAcquisition' class instead, which is
a direct replacement.

true

SESSIONADOC Warning 'addAudioOutputChannel' method of
'Session' class will be removed in a
future release. Use 'addoutput' of
'DataAcquisition' class instead, which is
a direct replacement.

true
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Check ID Severity Message Can Be Disabled?
SESSIONCOC Warning 'addCounterOutputChannel' method of

'Session' class will be removed in a
future release. Use 'addoutput' of
'DataAcquisition' class instead, which is
a direct replacement.

true

SESSIONFGC Warning 'addFunctionGeneratorChannel'
method of 'Session' class will be
removed in a future release. Use
'addoutput' of 'DataAcquisition' class
instead, which is a direct replacement.

true

SESSIONRC Warning 'removeChannel' method of 'Session'
class will be removed in a future
release. Use 'removechannel' of
'DataAcquisition' class instead, which is
a direct replacement.

true

SESSIONQOD Warning 'queueOutputData' method of 'Session'
class will be removed in a future
release. Use 'write' of 'DataAcquisition'
class instead, which is a direct
replacement.

true

SESSIONRSC Warning 'resetCounters' method of 'Session'
class will be removed in a future
release. Use 'resetcounters' of
'DataAcquisition' class instead, which is
a direct replacement.

true

SESSIONCIC Warning 'addCounterInputChannel' method of
'Session' class will be removed in a
future release. Use 'addinput' of
'DataAcquisition' class instead, which is
a direct replacement.

true

SESSIONDIS Warning 'DurationInSeconds' property of
'Session' class will be removed in a
future release. Specify 'Duration' as
argument to 'read' or 'start' instead.

true

SESSIONNOS Warning 'NumberOfScans' property of 'Session'
class will be removed in a future
release. Specify 'NumScans' as
argument to 'read' or 'start' instead.

true

SESSIONADC Warning 'addDigitalChannel' method of 'Session'
class will be removed in a future
release. With appropriate code
changes, use 'addinput' or 'addoutput'
of 'DataAcquisition' class instead.

true
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SESSIONACC Warning 'addClockConnection' method of

'Session' class will be removed in a
future release. With appropriate code
changes, use 'addclock' of
'DataAcquisition' class instead.

true

SESSIONATC Warning 'addTriggerConnection' method of
'Session' class will be removed in a
future release. With appropriate code
changes, use 'addtrigger' of
'DataAcquisition' class instead.

true

SESSIONRCON Warning 'removeConnection' method of 'Session'
class will be removed in a future
release. With appropriate code
changes, use 'removeclock' or
'removetrigger' of 'DataAcquisition'
class instead.

true

SESSIONISS Warning 'inputSingleScan' method of 'Session'
class will be removed in a future
release. With appropriate code
changes, use 'read' of 'DataAcquisition'
class instead.

true

SESSIONOSS Warning 'outputSingleScan' method of 'Session'
class will be removed in a future
release. With appropriate code
changes, use 'write' of
'DataAcquisition' class instead.

true

SESSIONSB Warning 'startBackground' method of 'Session'
class will be removed in a future
release. With appropriate code
changes, use 'start' of 'DataAcquisition'
class instead.

true

SESSIONSF Warning 'startForeground' method of 'Session'
class will be removed in a future
release. With appropriate code
changes, use 'write' of
'DataAcquisition' class instead.

true

SESSIONAL Warning 'addlistener' method of 'Session' class
will be removed in a future release.
Use the DataAcquisition interface and
its callback properties instead.

true

RTWHWDR Error 'RTW.HWDeviceRegistry' is
unsupported and has been removed.
The replacement strategy can be found
in MATLAB documentation.

true
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Check ID Severity Message Can Be Disabled?
HHCNA Error Input argument 'North America' has

been removed. Use 'hrn:here:data::olp-
here-had:here-hdlm-protobuf-na-2'
instead.

true

HHCWE Error Input argument 'Western Europe' has
been removed. Use 'hrn:here:data::olp-
here-had:here-hdlm-protobuf-weu-2'
instead.

true

TCPC Warning 'tcpip' with 'client' as a 'NetworkRole'
will be removed in a future release.
With appropriate code changes, use
'tcpclient' instead.

true

INSTHWB Warning 'instrhwinfo('bluetooth',...)' will be
removed in a future release. With
appropriate code changes, use
'bluetoothlist' instead.

true

INSTHWT Warning 'instrhwinfo('tcpip')' will be removed in
a future release. There is no simple
replacement for this.

true

INSTHWU Warning 'instrhwinfo('udp')' will be removed in a
future release. There is no simple
replacement for this.

true

EITYCN Warning 'EightyColumns' is unsupported and
will be removed in a future release.
With appropriate code changes, use
'settings' object instead.

true

REPUDD Warning Classes defined using schema.m files
are unsupported and will be removed
in a future release. Use MATLAB
Classes defined using the classdef
keyword instead.

true

CNNCGD Error 'cnncodegen' with default 'targetlib' as
'cudnn' has been removed. With
appropriate code changes, use
'codegen' instead.

true

CNNCGA Error 'cnncodegen' with 'targetlib' as 'arm-
compute' has been removed. With
appropriate code changes, use
'codegen' instead.

true

CNNCGT Error 'cnncodegen' with 'targetlib' as
'tensorrt' has been removed. With
appropriate code changes, use
'codegen' instead.

true

CNNCGC Error 'cnncodegen' with 'targetlib' as 'cudnn'
has been removed. With appropriate
code changes, use 'codegen' instead.

true
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CNNCGM Error 'cnncodegen' with 'targetlib' as

'mkldnn' has been removed. With
appropriate code changes, use
'codegen' instead.

true

COMMSCOPEED Error 'commscope.eyediagram' has been
removed. For line plotting, use the
eyediagram function. There is no
simple replacement for histogram
plotting and measurement analysis.

true

COMMED Error 'comm.EyeDiagram' has been removed.
For line plotting, use the eyediagram
function. There is no simple
replacement for histogram plotting and
measurement analysis.

true

MKRMT Warning 'makerefmat' will be removed in a
future release. With appropriate code
changes, construct a raster reference
object using 'georefcells',
'georefpostings', 'georasterref',
'maprefcells', 'maprefpostings' or
'maprasterref' instead.

true

WFMRM Warning 'worldFileMatrixToRefmat' will be
removed in a future release. With
appropriate code changes, construct a
raster reference object using
'georasterref' or 'maprasterref' instead.

true

RV2MAT Warning 'refvec2mat' will be removed in a
future release. With appropriate code
changes, construct a geographic raster
reference object using
'refvecToGeoRasterReference' instead.

true

RM2VEC Warning 'refmat2vec' will be removed in a
future release. With appropriate code
changes, construct a geographic raster
reference object using
'refvecToGeoRasterReference' instead.

true

SIZEM Warning 'sizem' will be removed in a future
release. With appropriate code
changes, use 'rastersize' property of a
map raster reference object instead.

true

LIMIM Warning 'limitm' will be removed in a future
release. With appropriate code
changes, use 'LatitudeLimits' and
'LongitudeLimits' properties of a
geographic raster reference object
instead.

true
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Check ID Severity Message Can Be Disabled?
MAOUTL Warning 'mapoutline' with referencing matrix

will be removed in a future release.
With appropriate code changes, use a
geographic or map raster reference
object as input instead.

true

MAWFW Warning 'worldfilewrite' with referencing matrix
will be removed in a future release.
With appropriate code changes, use a
geographic or map raster reference
object as input instead.

true

MAARMT Warning 'areamat' with referencing matrix or
referencing vector will be removed in a
future release. With appropriate code
changes, use a geographic or map
raster reference object as input
instead.

true

MAFDM Warning 'findm' with referencing matrix or
referencing vector will be removed in a
future release. With appropriate code
changes, use a geographic or map
raster reference object as input
instead.

true

MAPFIL Warning 'mapprofile' with referencing matrix or
referencing vector will be removed in a
future release. With appropriate code
changes, use a geographic or map
raster reference object as input
instead.

true

MAGRDNT Warning 'gradientm' with referencing matrix or
referencing vector will be removed in a
future release. With appropriate code
changes, use a geographic or map
raster reference object as input
instead.

true

MALOS2 Warning 'los2' with referencing matrix or
referencing vector will be removed in a
future release. With appropriate code
changes, use a geographic or map
raster reference object as input
instead.

true

MAVWSH Warning 'viewshed' with referencing matrix or
referencing vector will be removed in a
future release. With appropriate code
changes, use a geographic or map
raster reference object as input
instead.

true
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MANORG Warning 'neworig' with referencing matrix or

referencing vector will be removed in a
future release. With appropriate code
changes, use a geographic or map
raster reference object as input
instead.

true

MACTRM Warning 'contourm' with referencing matrix or
referencing vector will be removed in a
future release. With appropriate code
changes, use a geographic or map
raster reference object as input
instead.

true

MACTFM Warning 'contourfm' with referencing matrix or
referencing vector will be removed in a
future release. With appropriate code
changes, use a geographic or map
raster reference object as input
instead.

true

MACT3M Warning 'contour3m' with referencing matrix or
referencing vector will be removed in a
future release. With appropriate code
changes, use a geographic or map
raster reference object as input
instead.

true

MASHM Warning 'meshm' with referencing matrix or
referencing vector will be removed in a
future release. With appropriate code
changes, use a geographic or map
raster reference object as input
instead.

true

MASHL Warning 'meshlsrm' with referencing matrix or
referencing vector will be removed in a
future release. With appropriate code
changes, use a geographic or map
raster reference object as input
instead.

true

MAGTFW Warning 'geotiffwrite' with referencing matrix or
referencing vector will be removed in a
future release. With appropriate code
changes, use a geographic or map
raster reference object as input
instead.

true
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MAFLTM Warning 'filterm' with referencing matrix or

referencing vector will be removed in a
future release. With appropriate code
changes, use a geographic or map
raster reference object as input
instead.

true

MAVC2MX Warning 'vec2mtx' with referencing matrix or
referencing vector will be removed in a
future release. With appropriate code
changes, use a geographic or map
raster reference object as input
instead.

true

MAIMBED Warning 'imbedm' with referencing matrix or
referencing vector will be removed in a
future release. With appropriate code
changes, use a geographic or map
raster reference object as input
instead.

true

MAPBX Warning 'mapbbox' will be removed in a future
release. With appropriate code
changes, use 'XWorldLimits' and
'YWorldLimits' properties of a map
raster reference object instead.

true

WFLRD Warning 'worldfileread(worldFileName)' will be
removed in a future release. With
appropriate code changes, use
'worldfileread(worldFileName,
coordinateSystemType, rasterSize)'
instead.

true

EGMGD Warning 'egm96geoid(SAMPLEFACTOR,...)' will
be removed in a future release. With
appropriate code changes, use
'egm96geoid(R)' instead, where R is a
geographic raster reference object.

true

TCPS Warning 'tcpip' with 'server' as a 'NetworkRole'
will be removed in a future release.
With appropriate code changes, use
'tcpserver' instead.

true

INSTHWS Warning 'instrhwinfo('serial')' will be removed in
a future release. With appropriate code
changes, use 'serialportlist' instead.

true

INSTHWSP Warning 'instrhwinfo('serialport')' will be
removed in a future release. With
appropriate code changes, use
'serialportlist' instead.

true
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INSTHWV Warning 'instrhwinfo('visa')' will be removed in a

future release. With appropriate code
changes, use 'visadevlist' instead.

true

OPGLI Warning 'opengl('info')' will be removed in a
future release. With appropriate code
changes, use 'rendererinfo' instead.

true

OPGLD Warning 'opengl('data')' will be removed in a
future release. With appropriate code
changes, use 'rendererinfo' instead.

true

OPGLO Warning 'opengl' will be removed in a future
release. There is no simple
replacement for this.

true

PMRTM1 Error 'propagationModel('raytracing-image-
method')' syntax has been removed.
With appropriate code changes, use
'propagationModel('raytracing',
'image', 'method')' syntax instead.

true

PMRTM2 Error 'propagationModel('raytracing-
imagemethod')' syntax has been
removed. With appropriate code
changes, use
'propagationModel('raytracing',
'image', 'method')' syntax instead.

true

PMRTM3 Error 'propagationModel('raytracingimage-
method')' syntax has been removed.
With appropriate code changes, use
'propagationModel('raytracing',
'image', 'method')' syntax instead.

true

PMRTM4 Error 'propagationModel('raytracingimageme
thod')' syntax has been removed. With
appropriate code changes, use
'propagationModel('raytracing',
'image', 'method')' syntax instead.

true

INSTHWG Warning 'instrhwinfo('gpib')' will be removed in
a future release. With appropriate code
changes, use 'visadevlist' instead.

true

RAYNR Error Input argument 'NumReflections' has
been removed. Use
'MaxNumReflections' property of a ray
tracing propagation model object
instead.

true

LSRET Error 'LaserReturns' has been removed. Use
'LaserReturn' instead, which is a direct
replacement.

true
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BLFOP Warning 'fopen' method of 'bluetooth' class will

be removed in a future release. With
appropriate code changes, use
'bluetooth' constructor instead.

true

SPFOP Warning 'fopen' method of 'serialport' class will
be removed in a future release. With
appropriate code changes, use
'serialport' constructor instead.

true

TCFOP Warning 'fopen' method of 'tcpclient' class will
be removed in a future release. With
appropriate code changes, use
'tcpclient' constructor instead.

true

TSFOP Warning 'fopen' method of 'tcpserver' class will
be removed in a future release. With
appropriate code changes, use
'tcpserver' constructor instead.

true

UDFOP Warning 'fopen' method of 'udpport' class will be
removed in a future release. With
appropriate code changes, use
'udpport' constructor instead.

true

VSFOP Warning 'fopen' method of 'visadev' class will be
removed in a future release. With
appropriate code changes, use 'visadev'
constructor instead.

true

SPFWR Warning 'fwrite' method of 'serialport' class will
be removed in a future release. With
appropriate code changes, use 'write'
method of 'serialport' class instead.

true

TCFWR Warning 'fwrite' method of 'tcpclient' class will
be removed in a future release. With
appropriate code changes, use 'write'
method of 'tcpclient' class instead.

true

TSFWR Warning 'fwrite' method of 'tcpserver' class will
be removed in a future release. With
appropriate code changes, use 'write'
method of 'tcpserver' class instead.

true

UDFWR Warning 'fwrite' method of 'udpport' class will
be removed in a future release. With
appropriate code changes, use 'write'
method of 'udpport' class instead.

true

VSFWR Warning 'fwrite' method of 'visadev' class will be
removed in a future release. With
appropriate code changes, use 'write'
method of 'visadev' class instead.

true
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BLFRD Warning 'fread' method of 'bluetooth' class will

be removed in a future release. With
appropriate code changes, use 'read'
method of 'bluetooth' class instead.

true

SPFRD Warning 'fread' method of 'serialport' class will
be removed in a future release. With
appropriate code changes, use 'read'
method of 'serialport' class instead.

true

TCFRD Warning 'fread' method of 'tcpclient' class will
be removed in a future release. With
appropriate code changes, use 'read'
method of 'tcpclient' class instead.

true

TSFRD Warning 'fread' method of 'tcpserver' class will
be removed in a future release. With
appropriate code changes, use 'read'
method of 'tcpserver' class instead.

true

UDFRD Warning 'fread' method of 'udpport' class will be
removed in a future release. With
appropriate code changes, use 'read'
method of 'udpport' class instead.

true

VSFRD Warning 'fread' method of 'visadev' class will be
removed in a future release. With
appropriate code changes, use 'read'
method of 'visadev' class instead.

true

BLFPR Warning 'fprintf' method of 'bluetooth' class will
be removed in a future release. With
appropriate code changes, use
'writeline' method of 'bluetooth' class
instead.

true

SPFPR Warning 'fprintf' method of 'serialport' class will
be removed in a future release. With
appropriate code changes, use
'writeline' method of 'serialport' class
instead.

true

TCFPR Warning 'fprintf' method of 'tcpclient' class will
be removed in a future release. With
appropriate code changes, use
'writeline' method of 'tcpclient' class
instead.

true

TSFPR Warning 'fprintf' method of 'tcpserver' class will
be removed in a future release. With
appropriate code changes, use
'writeline' method of 'tcpserver' class
instead.

true
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UDFPR Warning 'fprintf' method of 'udpport' class will

be removed in a future release. With
appropriate code changes, use
'writeline' method of 'udpport' class
instead.

true

VSFPR Warning 'fprintf' method of 'visadev' class will
be removed in a future release. With
appropriate code changes, use
'writeline' method of 'visadev' class
instead.

true

BLFSF Warning 'fscanf' method of 'bluetooth' class will
be removed in a future release. With
appropriate code changes, use
'readline' method of 'bluetooth' class
instead.

true

SPFSF Warning 'fscanf' method of 'serialport' class will
be removed in a future release. With
appropriate code changes, use
'readline' method of 'serialport' class
instead.

true

TCFSF Warning 'fscanf' method of 'tcpclient' class will
be removed in a future release. With
appropriate code changes, use
'readline' method of 'tcpclient' class
instead.

true

TSFSF Warning 'fscanf' method of 'tcpserver' class will
be removed in a future release. With
appropriate code changes, use
'readline' method of 'tcpserver' class
instead.

true

UDFSF Warning 'fscanf' method of 'udpport' class will
be removed in a future release. With
appropriate code changes, use
'readline' method of 'udpport' class
instead.

true

VSFSF Warning 'fscanf' method of 'visadev' class will be
removed in a future release. With
appropriate code changes, use
'readline' method of 'visadev' class
instead.

true

BLFGL Warning 'fgetl' method of 'bluetooth' class will
be removed in a future release. With
appropriate code changes, use
'readline' method of 'bluetooth' class
instead.

true
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SPFGL Warning 'fgetl' method of 'serialport' class will

be removed in a future release. With
appropriate code changes, use
'readline' method of 'serialport' class
instead.

true

TCFGL Warning 'fgetl' method of 'tcpclient' class will be
removed in a future release. With
appropriate code changes, use
'readline' method of 'tcpclient' class
instead.

true

TSFGL Warning 'fgetl' method of 'tcpserver' class will
be removed in a future release. With
appropriate code changes, use
'readline' method of 'tcpserver' class
instead.

true

UDFGL Warning 'fgetl' method of 'udpport' class will be
removed in a future release. With
appropriate code changes, use
'readline' method of 'udpport' class
instead.

true

VSFGL Warning 'fgetl' method of 'visadev' class will be
removed in a future release. With
appropriate code changes, use
'readline' method of 'visadev' class
instead.

true

BLFGT Warning 'fgets' method of 'bluetooth' class will
be removed in a future release. With
appropriate code changes, use
'readline' method of 'bluetooth' class
instead.

true

SPFGT Warning 'fgets' method of 'serialport' class will
be removed in a future release. With
appropriate code changes, use
'readline' method of 'serialport' class
instead.

true

TCFGT Warning 'fgets' method of 'tcpclient' class will be
removed in a future release. With
appropriate code changes, use
'readline' method of 'tcpclient' class
instead.

true

TSFGT Warning 'fgets' method of 'tcpserver' class will
be removed in a future release. With
appropriate code changes, use
'readline' method of 'tcpserver' class
instead.

true
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UDFGT Warning 'fgets' method of 'udpport' class will be

removed in a future release. With
appropriate code changes, use
'readline' method of 'udpport' class
instead.

true

VSFGT Warning 'fgets' method of 'visadev' class will be
removed in a future release. With
appropriate code changes, use
'readline' method of 'visadev' class
instead.

true

BLFLI Warning 'flushinput' method of 'bluetooth' class
will be removed in a future release.
With appropriate code changes, use
'flush' method of 'bluetooth' class
instead.

true

SPFLI Warning 'flushinput' method of 'serialport' class
will be removed in a future release.
With appropriate code changes, use
'flush' method of 'serialport' class
instead.

true

TCFLI Warning 'flushinput' method of 'tcpclient' class
will be removed in a future release.
With appropriate code changes, use
'flush' method of 'tcpclient' class
instead.

true

TSFLI Warning 'flushinput' method of 'tcpserver' class
will be removed in a future release.
With appropriate code changes, use
'flush' method of 'tcpserver' class
instead.

true

UDFLI Warning 'flushinput' method of 'udpport' class
will be removed in a future release.
With appropriate code changes, use
'flush' method of 'udpport' class
instead.

true

VSFLI Warning 'flushinput' method of 'visadev' class
will be removed in a future release.
With appropriate code changes, use
'flush' method of 'visadev' class instead.

true

BLFCS Warning 'fclose' method of 'bluetooth' class will
be removed in a future release. There
is no simple replacement for this.

true

SPFCS Warning 'fclose' method of 'serialport' class will
be removed in a future release. There
is no simple replacement for this.

true
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TCFCS Warning 'fclose' method of 'tcpclient' class will

be removed in a future release. There
is no simple replacement for this.

true

TSFCS Warning 'fclose' method of 'tcpserver' class will
be removed in a future release. There
is no simple replacement for this.

true

UDFCS Warning 'fclose' method of 'udpport' class will
be removed in a future release. There
is no simple replacement for this.

true

VSFCS Warning 'fclose' method of 'visadev' class will be
removed in a future release. There is
no simple replacement for this.

true

SPBBW Warning 'binblockwrite' method of 'serialport'
class will be removed in a future
release. With appropriate code
changes, use 'writebinblock' method of
'serialport' class instead.

true

TCBBW Warning 'binblockwrite' method of 'tcpclient'
class will be removed in a future
release. With appropriate code
changes, use 'writebinblock' method of
'tcpclient' class instead.

true

TSBBW Warning 'binblockwrite' method of 'tcpserver'
class will be removed in a future
release. With appropriate code
changes, use 'writebinblock' method of
'tcpserver' class instead.

true

VSBBW Warning 'binblockwrite' method of 'visadev'
class will be removed in a future
release. With appropriate code
changes, use 'writebinblock' method of
'visadev' class instead.

true

SPBBR Warning 'binblockread' method of 'serialport'
class will be removed in a future
release. With appropriate code
changes, use 'readbinblock' method of
'serialport' class instead.

true

TCBBR Warning 'binblockread' method of 'tcpclient'
class will be removed in a future
release. With appropriate code
changes, use 'readbinblock' method of
'tcpclient' class instead.

true
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TSBBR Warning 'binblockread' method of 'tcpserver'

class will be removed in a future
release. With appropriate code
changes, use 'readbinblock' method of
'tcpserver' class instead.

true

VSBBR Warning 'binblockread' method of 'visadev' class
will be removed in a future release.
With appropriate code changes, use
'readbinblock' method of 'visadev' class
instead.

true

TCQRY Warning 'query' method of 'tcpclient' class will
be removed in a future release. With
appropriate code changes, use
'writeread' method of 'tcpclient' class
instead.

true

VSQRY Warning 'query' method of 'visadev' class will be
removed in a future release. With
appropriate code changes, use
'writeread' method of 'visadev' class
instead.

true

VSCRD Warning 'clrdevice' method of 'visadev' class will
be removed in a future release. With
appropriate code changes, use 'flush'
method of 'visadev' class instead.

true

VSSPL Warning 'spoll' method of 'visadev' class will be
removed in a future release. With
appropriate code changes, use
'visastatus' method of 'visadev' class
instead.

true

VSTGR Warning 'trigger' method of 'visadev' class will
be removed in a future release. With
appropriate code changes, use
'visatrigger' method of 'visadev' class
instead.

true

SPBAF Warning 'BytesAvailableFcnCount' property of
'serialport' class will be removed in a
future release. With appropriate code
changes, use 'configureCallback'
method of 'serialport' class instead.

true

TCBAF Warning 'BytesAvailableFcnCount' property of
'tcpclient' class will be removed in a
future release. With appropriate code
changes, use 'configureCallback'
method of 'tcpclient' class instead.

true
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TSBAF Warning 'BytesAvailableFcnCount' property of

'tcpserver' class will be removed in a
future release. With appropriate code
changes, use 'configureCallback'
method of 'tcpserver' class instead.

true

UDBAF Warning 'BytesAvailableFcnCount' property of
'udpport' class will be removed in a
future release. With appropriate code
changes, use 'configureCallback'
method of 'udpport' class instead.

true

BLBAN Warning 'BytesAvailableFcn' property of
'bluetooth' class will be removed in a
future release. With appropriate code
changes, use 'configureCallback'
method of 'bluetooth' class instead.

true

SPBAN Warning 'BytesAvailableFcn' property of
'serialport' class will be removed in a
future release. With appropriate code
changes, use 'configureCallback'
method of 'serialport' class instead.

true

TCBAN Warning 'BytesAvailableFcn' property of
'tcpclient' class will be removed in a
future release. With appropriate code
changes, use 'configureCallback'
method of 'tcpclient' class instead.

true

TSBAN Warning 'BytesAvailableFcn' property of
'tcpserver' class will be removed in a
future release. With appropriate code
changes, use 'configureCallback'
method of 'tcpserver' class instead.

true

UDBAN Warning 'BytesAvailableFcn' property of
'udpport' class will be removed in a
future release. With appropriate code
changes, use 'configureCallback'
method of 'udpport' class instead.

true

BLBAM Warning 'BytesAvailableFcnMode' property of
'bluetooth' class will be removed in a
future release. With appropriate code
changes, use 'configureCallback'
method of 'bluetooth' class instead.

true

SPBAM Warning 'BytesAvailableFcnMode' property of
'serialport' class will be removed in a
future release. With appropriate code
changes, use 'configureCallback'
method of 'serialport' class instead.

true
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TCBAM Warning 'BytesAvailableFcnMode' property of

'tcpclient' class will be removed in a
future release. With appropriate code
changes, use 'configureCallback'
method of 'tcpclient' class instead.

true

TSBAM Warning 'BytesAvailableFcnMode' property of
'tcpserver' class will be removed in a
future release. With appropriate code
changes, use 'configureCallback'
method of 'tcpserver' class instead.

true

UDBAM Warning 'BytesAvailableFcnMode' property of
'udpport' class will be removed in a
future release. With appropriate code
changes, use 'configureCallback'
method of 'udpport' class instead.

true

BLBAB Warning 'BytesAvailable' property of 'bluetooth'
class will be removed in a future
release. With appropriate code
changes, use 'NumBytesAvailable'
property of 'bluetooth' class instead.

true

SPBAB Warning 'BytesAvailable' property of 'serialport'
class will be removed in a future
release. With appropriate code
changes, use 'NumBytesAvailable'
property of 'serialport' class instead.

true

TCBAB Warning 'BytesAvailable' property of 'tcpclient'
class will be removed in a future
release. With appropriate code
changes, use 'NumBytesAvailable'
property of 'tcpclient' class instead.

true

TSBAB Warning 'BytesAvailable' property of 'tcpserver'
class will be removed in a future
release. With appropriate code
changes, use 'NumBytesAvailable'
property of 'tcpserver' class instead.

true

UDBAB Warning 'BytesAvailable' property of 'udpport'
class will be removed in a future
release. With appropriate code
changes, use 'NumBytesAvailable'
property of 'udpport' class instead.

true

BLEFN Warning 'ErrorFcn' property of 'bluetooth' class
will be removed in a future release.
With appropriate code changes, use
'ErrorOccurredFcn' property of
'bluetooth' class instead.

true
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SPEFN Warning 'ErrorFcn' property of 'serialport' class

will be removed in a future release.
With appropriate code changes, use
'ErrorOccurredFcn' property of
'serialport' class instead.

true

TCEFN Warning 'ErrorFcn' property of 'tcpclient' class
will be removed in a future release.
With appropriate code changes, use
'ErrorOccurredFcn' property of
'tcpclient' class instead.

true

TSEFN Warning 'ErrorFcn' property of 'tcpserver' class
will be removed in a future release.
With appropriate code changes, use
'ErrorOccurredFcn' property of
'tcpserver' class instead.

true

UDEFN Warning 'ErrorFcn' property of 'udpport' class
will be removed in a future release.
With appropriate code changes, use
'ErrorOccurredFcn' property of
'udpport' class instead.

true

VSEFN Warning 'ErrorFcn' property of 'visadev' class
will be removed in a future release.
With appropriate code changes, use
'ErrorOccurredFcn' property of
'visadev' class instead.

true

BLREN Warning 'RemoteName' property of 'bluetooth'
class will be removed in a future
release. With appropriate code
changes, use 'Name' property of
'bluetooth' class instead.

true

BLRID Warning 'RemoteID' property of 'bluetooth' class
will be removed in a future release.
With appropriate code changes, use
'Address' property of 'bluetooth' class
instead.

true

SPPSS Warning 'PinStatus' property of 'serialport' class
will be removed in a future release.
With appropriate code changes, use
'getpinstatus' method of 'serialport'
class instead.

true

VSPSS Warning 'PinStatus' property of 'visadev' class
will be removed in a future release.
With appropriate code changes, use
'getpinstatus' method of 'visadev' class
instead.

true
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SPDTR Warning 'DataTerminalReady' property of

'serialport' class will be removed in a
future release. With appropriate code
changes, use 'setDTR' method of
'serialport' class instead.

true

VSDTR Warning 'DataTerminalReady' property of
'visadev' class will be removed in a
future release. With appropriate code
changes, use 'setDTR' method of
'visadev' class instead.

true

SPRTS Warning 'RequestToSend' property of 'serialport'
class will be removed in a future
release. With appropriate code
changes, use 'setRTS' method of
'serialport' class instead.

true

VSRTS Warning 'RequestToSend' property of 'visadev'
class will be removed in a future
release. With appropriate code
changes, use 'setRTS' method of
'visadev' class instead.

true

TCNTR Warning 'NetworkRole' property of 'tcpclient'
class will be removed in a future
release. With appropriate code
changes, use 'tcpclient' constructor
instead.

true

TSNTR Warning 'NetworkRole' property of 'tcpserver'
class will be removed in a future
release. With appropriate code
changes, use 'tcpserver' constructor
instead.

true

TCTDY Warning 'TransferDelay' property of 'tcpclient'
class will be removed in a future
release. With appropriate code
changes, use 'EnableTransferDelay'
property of 'tcpclient' class instead.

true

TCRPT Warning 'RemotePort' property of 'tcpclient'
class will be removed in a future
release. With appropriate code
changes, use 'Port' property of
'tcpclient' class instead.

true

TSRPT Warning 'RemotePort' property of 'tcpserver'
class will be removed in a future
release. With appropriate code
changes, use 'ServerPort' property of
'tcpserver' class instead.

true

7 Editor Preferences

7-62



Check ID Severity Message Can Be Disabled?
TCRHT Warning 'RemoteHost' property of 'tcpclient'

class will be removed in a future
release. With appropriate code
changes, use 'Address' property of
'tcpclient' class instead.

true

TSRHT Warning 'RemoteHost' property of 'tcpserver'
class will be removed in a future
release. With appropriate code
changes, use 'ClientAddress' property
of 'tcpserver' class instead.

true

TSLHT Warning 'LocalHost' property of 'tcpserver' class
will be removed in a future release.
With appropriate code changes, use
'ServerAddress' property of 'tcpserver'
class instead.

true

TSLPM Warning 'LocalPortMode' property of 'tcpserver'
class will be removed in a future
release. With appropriate code
changes, use 'ServerAddress' property
of 'tcpserver' class instead.

true

TSLPT Warning 'LocalPort' property of 'tcpserver' class
will be removed in a future release.
With appropriate code changes, use
'ServerAddress' property of 'tcpserver'
class instead.

true

UDDTM Warning 'DatagramTerminateMode' property of
'udpport' class will be removed in a
future release. With appropriate code
changes, use 'udpport' constructor
instead.

true

UDODP Warning 'OutputDatagramPacketSize' property
of 'udpport' class will be removed in a
future release. With appropriate code
changes, use 'OutputDatagramSize'
property of 'udpport' class instead.

true

VSEMD Warning 'EOSMode' property of 'visadev' class
will be removed in a future release.
With appropriate code changes, use
'configureTerminator' method and
'EOIMode' property of 'visadev' class
instead.

true

VSECC Warning 'EOSCharCode' property of 'visadev'
class will be removed in a future
release. With appropriate code
changes, use 'configureTerminator'
method of 'visadev' class instead.

true
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VSMID Warning 'ManufacturerID' property of 'visadev'

class will be removed in a future
release. With appropriate code
changes, use 'VendorID' property of
'visadev' class instead.

true

VSMLC Warning 'ModelCode' property of 'visadev' class
will be removed in a future release.
With appropriate code changes, use
'ProductID' property of 'visadev' class
instead.

true

BLFLO Warning 'flushoutput' method of 'bluetooth'
class will be removed in a future
release. With appropriate code
changes, use 'flush' method of
'bluetooth' class instead.

true

SPFLO Warning 'flushoutput' method of 'serialport'
class will be removed in a future
release. With appropriate code
changes, use 'flush' method of
'serialport' class instead.

true

TCFLO Warning 'flushoutput' method of 'tcpclient' class
will be removed in a future release.
With appropriate code changes, use
'flush' method of 'tcpclient' class
instead.

true

TSFLO Warning 'flushoutput' method of 'tcpserver' class
will be removed in a future release.
With appropriate code changes, use
'flush' method of 'tcpserver' class
instead.

true

UDFLO Warning 'flushoutput' method of 'udpport' class
will be removed in a future release.
With appropriate code changes, use
'flush' method of 'udpport' class
instead.

true

VSFLO Warning 'flushoutput' method of 'visadev' class
will be removed in a future release.
With appropriate code changes, use
'flush' method of 'visadev' class instead.

true

UDDRF Warning 'DatagramReceivedFcn' property of
'udpport' class will be removed in a
future release. With appropriate code
changes, use 'configureCallback'
method of 'udpport' class instead.

true
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VSRSN Warning 'RsrcName' property of 'visadev' class

will be removed in a future release.
With appropriate code changes, use
'ResourceName' property of 'visadev'
class instead.

true

H5PGET Error 'H5P.get_dxpl_multi' has been removed.
There is no simple replacement for this.

true

H5PSET Error 'H5P.set_dxpl_multi' has been removed.
There is no simple replacement for this.

true

DCSHELP Warning 'cshelp' will be removed in a future
release. There is no simple
replacement for this.

true

DFIGFLAG Warning 'figflag' will be removed in a future
release. There is no simple
replacement for this.

true

DGETST Warning 'getstatus' will be removed in a future
release. There is no simple
replacement for this.

true

DMENUL Warning 'menulabel' will be removed in a future
release. There is no simple
replacement for this.

true

DPOPUP Warning 'popupstr' will be removed in a future
release. There is no simple
replacement for this.

true

DUIGET Warning 'uigettoolbar' will be removed in a
future release. There is no simple
replacement for this.

true

ACTXC Warning 'actxcontrol' will be removed in a
future release. There is no simple
replacement for this.

true

ACTXL Warning 'actxcontrollist' will be removed in a
future release. There is no simple
replacement for this.

true

ACTXS Warning 'actxcontrolselect' will be removed in a
future release. There is no simple
replacement for this.

true

DAVIINF Warning 'aviinfo' will be removed in a future
release. With appropriate code
changes, use 'VideoReader' instead.

true

DAFINF Warning 'avifinfo' will be removed in a future
release. With appropriate code
changes, use 'VideoReader' instead.

true

DBITMAX Error 'bitmax' has been removed. With
appropriate code changes, use
'flintmax' instead.

true
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Check ID Severity Message Can Be Disabled?
COMMBI Error 'comm.BitToInteger' has been removed.

With appropriate code changes, use
'bit2int' instead.

true

COMMIB Error 'comm.IntegerToBit' has been removed.
With appropriate code changes, use
'int2bit' instead.

true

COMMSCOPESP Error 'commscope.ScatterPlot' has been
removed. With appropriate code
changes, use
'comm.ConstellationDiagram' instead.

true

COMMBSC Error 'comm.BinarySymmetricChannel' has
been removed. With appropriate code
changes, use 'BSC' instead.

true

RLCHN Error 'rayleighchan' has been removed. With
appropriate code changes, use
'comm.RayleighChannel' instead.

true

RICHN Error 'ricianchan' has been removed. With
appropriate code changes, use
'comm.RicianChannel' instead.

true

LEGCHN Error 'legacychannelsim' has been removed.
There is no simple replacement for this.

true

DOPJKS Error 'doppler.jakes' has been removed. With
appropriate code changes, use
'doppler' instead.

true

DOPRJKS Error 'doppler.rjakes' has been removed.
With appropriate code changes, use
'doppler' instead.

true

DOPAJKS Error 'doppler.ajakes' has been removed.
With appropriate code changes, use
'doppler' instead.

true

DOPFLT Error 'doppler.flat' has been removed. With
appropriate code changes, use
'doppler' instead.

true

DOPBLL Error 'doppler.bell' has been removed. With
appropriate code changes, use
'doppler' instead.

true

DOPRNDD Error 'doppler.rounded' has been removed.
With appropriate code changes, use
'doppler' instead.

true

DOPGSS Error 'doppler.gaussian' has been removed.
With appropriate code changes, use
'doppler' instead.

true

DOPBGSS Error 'doppler.bigaussian' has been removed.
With appropriate code changes, use
'doppler' instead.

true
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Check ID Severity Message Can Be Disabled?
COMMPSKC Error 'comm.PSKCoarseFrequencyEstimator'

has been removed. With appropriate
code changes, use
'comm.CoarseFrequencyCompensator'
instead.

true

COMMQAMC Error 'comm.QAMCoarseFrequencyEstimator
' has been removed. With appropriate
code changes, use
'comm.CoarseFrequencyCompensator'
instead.

true

DEVM Error 'commmeasure.EVM' has been
removed. With appropriate code
changes, use 'comm.EVM' instead.

true

DMER Error 'commmeasure.MER' has been
removed. With appropriate code
changes, use 'comm.MER' instead.

true

DACPR Error 'commmeasure.ACPR' has been
removed. With appropriate code
changes, use 'comm.ACPR' instead.

true

CRCGE Warning 'crc.generator' will be removed in a
future release. With appropriate code
changes, use 'comm.CRCGenerator'
instead.

true

CRCDE Warning 'crc.detector' will be removed in a
future release. With appropriate code
changes, use 'comm.CRCDetector'
instead.

true

CMDFE Error 'dfe' has been removed. With
appropriate code changes, use
'comm.DecisionFeedbackEqualizer'
instead.

true

CMDFEEQ Error 'equalizer.dfe' has been removed. With
appropriate code changes, use
'comm.DecisionFeedbackEqualizer'
instead.

true

CMLRQ Error 'lineareq' has been removed. With
appropriate code changes, use
'comm.LinearEqualizer' instead.

true

CMLRQEQ Error 'equalizer.lineareq' has been removed.
With appropriate code changes, use
'comm.LinearEqualizer' instead.

true

CMLMSAD Error 'adaptalg.lms' has been removed. With
appropriate code changes, use
'comm.LinearEqualizer' or
'comm.DecisionFeedbackEqualizer'
instead.

true

 Index of Code Analyzer Checks

7-67



Check ID Severity Message Can Be Disabled?
CMRLSAD Error 'adaptalg.rls' has been removed. With

appropriate code changes, use
'comm.LinearEqualizer' or
'comm.DecisionFeedbackEqualizer'
instead.

true

CMCMAAD Error 'adaptalg.cma' has been removed. With
appropriate code changes, use
'comm.LinearEqualizer' or
'comm.DecisionFeedbackEqualizer'
instead.

true

CMSLMSAD Error 'adaptalg.signlms' has been removed.
With appropriate code changes, use
'comm.LinearEqualizer' or
'comm.DecisionFeedbackEqualizer'
instead.

true

CMVLMSAD Error 'adaptalg.varlms' has been removed.
With appropriate code changes, use
'comm.LinearEqualizer' or
'comm.DecisionFeedbackEqualizer'
instead.

true

CMNLMSAD Error 'adaptalg.normlms' has been removed.
With appropriate code changes, use
'comm.LinearEqualizer' or
'comm.DecisionFeedbackEqualizer'
instead.

true

CMLMS Error 'lms' has been removed. With
appropriate code changes, use
'comm.LinearEqualizer' or
'comm.DecisionFeedbackEqualizer'
instead.

true

CMRLS Error 'rls' has been removed. With
appropriate code changes, use
'comm.LinearEqualizer' or
'comm.DecisionFeedbackEqualizer'
instead.

true

CMCMA Error 'cma' has been removed. With
appropriate code changes, use
'comm.LinearEqualizer' or
'comm.DecisionFeedbackEqualizer'
instead.

true

CMSLMS Error 'signlms' has been removed. With
appropriate code changes, use
'comm.LinearEqualizer' or
'comm.DecisionFeedbackEqualizer'
instead.

true
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CMVLMS Error 'varlms' has been removed. With

appropriate code changes, use
'comm.LinearEqualizer' or
'comm.DecisionFeedbackEqualizer'
instead.

true

CMNLMS Error 'normlms' has been removed. With
appropriate code changes, use
'comm.LinearEqualizer' or
'comm.DecisionFeedbackEqualizer'
instead.

true

CMEQU Error 'equalize' has been removed. With
appropriate code changes, use
'comm.LinearEqualizer' or
'comm.DecisionFeedbackEqualizer'
instead.

true

EYESCOPE Error 'eyescope' has been removed. There is
no simple replacement for this.

true

DLDPCENC Error 'fec.ldpcenc' has been removed. With
appropriate code changes, use
'comm.LDPCEncoder' instead.

true

DLDPCDEC Error 'fec.ldpcdec' has been removed. With
appropriate code changes, use
'comm.LDPCDecoder' instead.

true

DBHENC Error 'fec.bchenc' has been removed. With
appropriate code changes, use
'comm.BCHEncoder' instead.

true

DBCHDEC Error 'fec.bchdec' has been removed. With
appropriate code changes, use
'comm.BCHDecoder' instead.

true

DRSENC Error 'fec.rsenc' has been removed. With
appropriate code changes, use
'comm.RSEncoder' instead.

true

DRSDEC Error 'fec.rsdec' has been removed. With
appropriate code changes, use
'comm.RSDecoder' instead.

true

LDPCE Warning 'commm.LDPCEncoder' will be
removed in a future release. With
appropriate code changes, use
'ldpcEncode' instead.

true

LDPCD Warning 'commm.LDPCDecoder' will be
removed in a future release. With
appropriate code changes, use
'ldpcDecode' instead.

true
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Check ID Severity Message Can Be Disabled?
COMMLMC Error 'comm.LTEMIMOChannel' has been

removed. With appropriate code
changes, use 'comm.MIMOChannel'
instead.

true

QMOD Error 'modem.qammod' has been removed.
With appropriate code changes, use
'qammod' instead.

true

QDEMOD Error 'modem.qamdemod' has been removed.
With appropriate code changes, use
'qamdemod' instead.

true

DMOD Error 'modem.dpskmod' has been removed.
With appropriate code changes, use
'comm.DPSKModulator' instead.

true

DDEMOD Error 'modem.dpskdemod' has been
removed. With appropriate code
changes, use
'comm.DPSKDemodulator' instead.

true

OMOD Error 'modem.oqpskmod' has been removed.
With appropriate code changes, use
'comm.OQPSKModulator' instead.

true

ODEMOD Error 'modem.oqpskdemod' has been
removed. With appropriate code
changes, use
'comm.OQPSKDemodulator' instead.

true

PAMOD Error 'modem.pammod' has been removed.
With appropriate code changes, use
'pammod' instead.

true

PADEMOD Error 'modem.pamdemod' has been removed.
With appropriate code changes, use
'pamdemod' instead.

true

MMOD Error 'modem.mskmod' has been removed.
With appropriate code changes, use
'comm.MSKModulator' or 'mskmod'
instead.

true

MDEMOD Error 'modem.mskdemod' has been removed.
With appropriate code changes, use
'comm.MSKDemodulator' or
'mskdemod' instead.

true

GMOD Error 'modem.genqammod' has been
removed. With appropriate code
changes, use 'genqammod' or
'comm.GeneralQAMModulator' instead.

true
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GDEMOD Error 'modem.genqamdemod' has been

removed. With appropriate code
changes, use 'genqamdemod' or
'comm.GeneralQAMDemodulator'
instead.

true

PSMOD Error 'modem.pskmod' has been removed.
With appropriate code changes, use
'pskmod' or 'comm.PSKModulator'
instead.

true

PSDEMOD Error 'modem.pskdemod' has been removed.
With appropriate code changes, use
'pskdemod' or 'comm.PSKDemodulator'
instead.

true

OQPMOD Error 'oqpskmod' has been removed. With
appropriate code changes, use
'comm.OQPSKModulator' instead.

true

OQPDEM Error 'oqpskdemod' has been removed. With
appropriate code changes, use
'comm.OQPSKDemodulator' instead.

true

COMMPSKMSO Warning 'comm.PSKModulator' will be removed
in a future release. With appropriate
code changes, use 'pskmod' instead.

true

COMMPSKDSO Warning 'comm.PSKDemodulator' will be
removed in a future release. With
appropriate code changes, use
'pskdemod' instead.

true

COMMBPSKMSO Warning 'comm.BPSKModulator' will be
removed in a future release. With
appropriate code changes, use
'pskmod' instead.

true

COMMBPSKDSO Warning 'comm.BPSKDemodulator' will be
removed in a future release. With
appropriate code changes, use
'pskdemod' instead.

true

COMMQPSKMSO Warning 'comm.QPSKModulator' will be
removed in a future release. With
appropriate code changes, use
'pskmod' instead.

true

COMMQPSKDSO Warning 'comm.QPSKDemodulator' will be
removed in a future release. With
appropriate code changes, use
'pskdemod' instead.

true

CMPSKCPS Error 'comm.PSKCarrierPhaseSynchronizer'
has been removed. With appropriate
code changes, use
'comm.CarrierSynchronizer' instead.

true
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Check ID Severity Message Can Be Disabled?
RANDSD Error 'randseed' has been removed. With

appropriate code changes, use 'rng'
instead.

true

COMMQAMM Warning 'comm.RectangularQAMModulator' will
be removed in a future release. With
appropriate code changes, use
'qammod' instead.

true

COMMQAMD Warning 'comm.RectangularQAMDemodulator'
will be removed in a future release.
With appropriate code changes, use
'qamdemod' instead.

true

CMELGTS Error 'comm.EarlyLateGateTimingSynchroniz
er' has been removed. With appropriate
code changes, use
'comm.SymbolSynchronizer' instead.

true

CMGTS Error 'comm.GardnerTimingSynchronizer'
has been removed. With appropriate
code changes, use
'comm.SymbolSynchronizer' instead.

true

CMMMTS Error 'comm.MuellerMullerTimingSynchroniz
er' has been removed. With appropriate
code changes, use
'comm.SymbolSynchronizer' instead.

true

ALDEINT Error 'comm.AlgebraicDeinterleaver' has
been removed. With appropriate code
changes, use 'algdeintrlv' instead.

true

ALINT Error 'comm.AlgebraicInterleaver' has been
removed. With appropriate code
changes, use 'algintrlv' instead.

true

BLKDEINT Error 'comm.BlockDeinterleaver' has been
removed. With appropriate code
changes, use 'deintrlv' instead.

true

BLKINT Error 'comm.BlockInterleaver' has been
removed. With appropriate code
changes, use 'intrlv' instead.

true

MATDEINT Error 'comm.MatrixDeinterleaver' has been
removed. With appropriate code
changes, use 'matdeintrlv' instead.

true

MATINT Error 'comm.MatrixInterleaver' has been
removed. With appropriate code
changes, use 'matintrlv' instead.

true

MATHSDEINT Error 'comm.MatrixHelicalScanDeinterleaver
' has been removed. With appropriate
code changes, use 'helscandeintrlv'
instead.

true
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MATHSINT Error 'comm.MatrixHelicalScanInterleaver'

has been removed. With appropriate
code changes, use 'helscanintrlv'
instead.

true

ZADOF Error 'lteZadoffChuSeq' has been removed.
Use 'zadoffChuSeq' instead, which is a
direct replacement.

true

CMCPMCPS Error 'comm.CPMCarrierPhaseSynchronizer'
has been removed. With appropriate
code changes, use
'comm.CarrierSynchronizer' instead.

true

SESSIONR Warning 'daq.reset' will be removed in a future
release. Use 'daqreset' instead, which
is a direct replacement.

true

SESSIONGD Warning 'daq.getDevices' will be removed in a
future release. Use 'daqlist' instead,
which is a direct replacement.

true

SESSIONGV Warning 'daq.getVendors' will be removed in a
future release. Use 'daqvendorlist'
instead, which is a direct replacement.

true

AFBLMSFFT Error 'adaptfilt.blmsfft' has been removed.
There is no simple replacement for this.

true

AFADJLMS Error 'adaptfilt.adjlms' has been removed.
There is no simple replacement for this.

true

AFDLMS Error 'adaptfilt.dlms' has been removed.
There is no simple replacement for this.

true

AFPBFDAF Error 'adaptfilt.pbfdaf' has been removed.
There is no simple replacement for this.

true

AFPBUFDAF Error 'adaptfilt.pbufdaf' has been removed.
There is no simple replacement for this.

true

AFTDAFDCT Error 'adaptfilt.tdafdct' has been removed.
There is no simple replacement for this.

true

AFTFAFDFT Error 'adaptfilt.tfafdft' has been removed.
There is no simple replacement for this.

true

AFLMS Error 'adaptfilt.lms' has been removed. With
appropriate code changes, use
'dsp.LMSFilter' instead.

true

AFNLMS Error 'adaptfilt.nlms' has been removed. With
appropriate code changes, use
'dsp.LMSFilter' instead.

true

AFSE Error 'adaptfilt.se' has been removed. With
appropriate code changes, use
'dsp.LMSFilter' instead.

true
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AFSD Error 'adaptfilt.sd' has been removed. With

appropriate code changes, use
'dsp.LMSFilter' instead.

true

AFSS Error 'adaptfilt.ss' has been removed. With
appropriate code changes, use
'dsp.LMSFilter' instead.

true

AFBLMS Error 'adaptfilt.blms' has been removed. With
appropriate code changes, use
'dsp.BlockLMSFilter' instead.

true

AFRLS Error 'adaptfilt.rls' has been removed. With
appropriate code changes, use
'dsp.RLSFilter' instead.

true

AFQRDRLS Error 'adaptfilt.qrdrls' has been removed.
With appropriate code changes, use
'dsp.RLSFilter' instead.

true

AFSWRLS Error 'adaptfilt.swrls' has been removed.
With appropriate code changes, use
'dsp.RLSFilter' instead.

true

AFHRLS Error 'adaptfilt.hrls' has been removed. With
appropriate code changes, use
'dsp.RLSFilter' instead.

true

AFHSWRLS Error 'adaptfilt.hswrls' has been removed.
With appropriate code changes, use
'dsp.RLSFilter' instead.

true

AFSWFTF Error 'adaptfilt.swftf' has been removed. With
appropriate code changes, use
'dsp.FastTransversalFilter' instead.

true

AFFTF Error 'adaptfilt.ftf' has been removed. With
appropriate code changes, use
'dsp.FastTransversalFilter' instead.

true

AFAP Error 'adaptfilt.ap' has been removed. With
appropriate code changes, use
'dsp.AffineProjectionFilter' instead.

true

AFAPRU Error 'adaptfilt.apru' has been removed. With
appropriate code changes, use
'dsp.AffineProjectionFilter' instead.

true

AFBAP Error 'adaptfilt.bap' has been removed. With
appropriate code changes, use
'dsp.AffineProjectionFilter' instead.

true

AFGAL Error 'adaptfilt.gal' has been removed. With
appropriate code changes, use
'dsp.AdaptiveLatticeFilter' instead.

true

AFLSL Error 'adaptfilt.lsl' has been removed. With
appropriate code changes, use
'dsp.AdaptiveLatticeFilter' instead.

true
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AFQRDLSL Error 'adaptfilt.qrdlsl' has been removed.

With appropriate code changes, use
'dsp.AdaptiveLatticeFilter' instead.

true

AFFILTXLMS Error 'adaptfilt.filtxlms' has been removed.
With appropriate code changes, use
'dsp.FilteredXLMSFilter' instead.

true

AFFDAF Error 'adaptfilt.fdaf' has been removed. With
appropriate code changes, use
'dsp.FrequencyDomainAdaptiveFilter'
instead.

true

AFUFDAF Error 'adaptfilt.ufdaf' has been removed.
With appropriate code changes, use
'dsp.FrequencyDomainAdaptiveFilter'
instead.

true

MCASCADE Warning 'mfilt.cascade' will be removed in a
future release. With appropriate code
changes, use 'dsp.FilterCascade'
instead.

true

MCDECIM Warning 'mfilt.cicdecim' will be removed in a
future release. With appropriate code
changes, use 'dsp.CICDecimator'
instead.

true

MCINTERP Error 'mfilt.cicinterp' has been removed.
With appropriate code changes, use
'dsp.CICInterpolator' instead.

true

MFARROW Error 'mfilt.farrowsrc' has been removed.
With appropriate code changes, use
'dsp.FarrowRateConverter' instead.

true

MFDECIM Warning 'mfilt.firdecim' will be removed in a
future release. With appropriate code
changes, use 'dsp.FIRDecimator'
instead.

true

MFTDECIM Warning 'mfilt.firtdecim' will be removed in a
future release. With appropriate code
changes, use 'dsp.FIRDecimator'
instead.

true

MFINTERP Error 'mfilt.firinterp' has been removed. With
appropriate code changes, use
'dsp.FIRInterpolator' instead.

true

MFSRC Warning 'mfilt.firsrc' will be removed in a future
release. With appropriate code
changes, use 'dsp.FIRRateConverter'
instead.

true
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MFFTFINTERP Error 'mfilt.fftfirinterp' has been removed.

With appropriate code changes, use
'dsp.FIRInterpolator' instead.

true

MHINTERP Error 'mfilt.holdinterp' has been removed.
With appropriate code changes, use
'dsp.CICInterpolator' instead.

true

MIDECIM Warning 'mfilt.iirdecim' will be removed in a
future release. With appropriate code
changes, use
'dsp.IIRHalfbandDecimator' instead.

true

MIINTERP Error 'mfilt.iirinterp' has been removed. With
appropriate code changes, use
'dsp.IIRHalfbandInterpolator' instead.

true

MIWDFDECIM Warning 'mfilt.iirwdfdecim' will be removed in a
future release. With appropriate code
changes, use
'dsp.IIRHalfbandDecimator' instead.

true

MIWDFINTERP Warning 'mfilt.iirwdfinterp' will be removed in a
future release. With appropriate code
changes, use
'dsp.IIRHalfbandInterpolator' instead.

true

MLINTERP Error 'mfilt.linearinterp' has been removed.
With appropriate code changes, use
'dsp.CICInterpolator' instead.

true

MFFDCM Error 'mfilt.firfracdecim' has been removed.
With appropriate code changes, use
'dsp.FIRRateConverter' instead.

true

MFFINTRP Error 'mfilt.firfracinterp' has been removed.
With appropriate code changes, use
'dsp.FIRRateConverter' instead.

true

DEMLC Error 'emlc' has been removed. With
appropriate code changes, use
'codegen' instead.

true

DEMLMEX Error 'emlmex' has been removed. With
appropriate code changes, use
'codegen' instead.

true

DEXIFRD Error 'exifread' has been removed. With
appropriate code changes, use 'imfinfo'
instead.

true

FAFD Error 'farrow.fd' has been removed. With
appropriate code changes, use
'dfilt.farrowfd' instead.

true

FALFD Error 'farrow.linearfd' has been removed.
With appropriate code changes, use
'dfilt.farrowlinearfd' instead.

true
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FISNEW Warning 'newfis' will be removed in a future

release. With appropriate code
changes, use 'mamfis' or 'sugfis'
instead.

true

FISADV Warning 'addvar' will be removed in a future
release. With appropriate code
changes, use 'addInput' or 'addOutput'
instead.

true

FISRMV Warning 'rmvar' will be removed in a future
release. With appropriate code
changes, use 'removeInput' or
'removeOutput' instead.

true

FISRMF Warning 'rmmf' will be removed in a future
release. With appropriate code
changes, use 'removeMF' instead.

true

FISM2S Warning 'mam2sug' will be removed in a future
release. Use 'convertToSugeno' instead,
which is a direct replacement.

true

FISPSR Warning 'parsrule' will be removed in a future
release. With appropriate code
changes, use 'addRule' or 'fisrule'
instead.

true

GPIB Warning 'gpib' will be removed in a future
release. With appropriate code
changes, use 'visadev' instead.

true

DGRAPHICSVER Error 'graphicsversion' has been removed.
With appropriate code changes, use
'verLessThan('matlab','8.4.0')' instead.

true

HANK2SYS Warning 'hank2sys' will be removed in a future
release. There is no simple
replacement for this.

true

HDFGD Error 'hdfgd' has been removed. With
appropriate code changes, use
'matlab.io.hdfeos.gd' instead.

true

HDFSD Error 'hdfsd' has been removed. With
appropriate code changes, use
'matlab.io.hdfeos.sd' instead.

true

HDFSW Error 'hdfsw' has been removed. With
appropriate code changes, use
'matlab.io.hdfeos.sw' instead.

true

HDFTL Error 'hdftool' has been removed. There is no
simple replacement for this.

true

HILBIIR Error 'hilbiir' has been removed. With
appropriate code changes, use
'fdesign.hilbert' or 'hilbert' instead.

true
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BLUTH Warning 'Bluetooth' will be removed in a future

release. With appropriate code
changes, use 'bluetooth' instead.

true

IVIDC Warning 'instrument.ivic.IviDCPwr' will be
removed in a future release. With
appropriate code changes, use 'ividev'
instead.

true

IVIDM Warning 'instrument.ivic.IviDmm' will be
removed in a future release. With
appropriate code changes, use 'ividev'
instead.

true

IVIFG Warning 'instrument.ivic.IviFgen' will be
removed in a future release. With
appropriate code changes, use 'ividev'
instead.

true

IVIPW Warning 'instrument.ivic.IviPwrMeter' will be
removed in a future release. With
appropriate code changes, use 'ividev'
instead.

true

IVIRF Warning 'instrument.ivic.IviRFSigGen' will be
removed in a future release. With
appropriate code changes, use 'ividev'
instead.

true

IVISP Warning 'instrument.ivic.IviSpecAn' will be
removed in a future release. With
appropriate code changes, use 'ividev'
instead.

true

IVISW Warning 'instrument.ivic.IviSwtch' will be
removed in a future release. With
appropriate code changes, use 'ividev'
instead.

true

IVISC Warning 'instrument.ivic.IviScope' will be
removed in a future release. With
appropriate code changes, use 'ividev'
instead.

true

INSTRR Warning 'instrreset' will be removed in a future
release. With appropriate code
changes, use 'clear' instead.

true

INSTRH Warning 'instrhelp' will be removed in a future
release. Use 'help' instead, which is a
direct replacement.

true

INSTRF Warning 'instrfind' will be removed in a future
release. There is no simple
replacement for this.

true
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INSTFA Warning 'instrfindall' will be removed in a future

release. There is no simple
replacement for this.

true

INSTCA Warning 'instrcallback' will be removed in a
future release. There is no simple
replacement for this.

true

INSTRN Warning 'instrnotify' will be removed in a future
release. There is no simple
replacement for this.

true

MKMID Warning 'makemid' will be removed in a future
release. There is no simple
replacement for this.

true

MIEIT Warning 'midedit' will be removed in a future
release. There is no simple
replacement for this.

true

MIDTT Warning 'midtest' will be removed in a future
release. There is no simple
replacement for this.

true

TMTL Warning 'tmtool' will be removed in a future
release. Use 'serialExplorer',
'tcpipExplorer', 'udpExplorer' or
'visaExplorer' instead.

true

UDPP Warning 'udp' will be removed in a future
release. With appropriate code
changes, use 'udpport' instead.

true

VISA Warning 'visa' will be removed in a future
release. With appropriate code
changes, use 'visadev' instead.

true

IMJAV Warning 'im2java2d' will be removed in a future
release. There is no simple
replacement for this.

true

IMJAVA Warning 'im2java' will be removed in a future
release. There is no simple
replacement for this.

true

DILEVAL Warning 'inlineeval' will be removed in a future
release. There is no simple
replacement for this.

true

ISGLOB Error 'isglobal' has been removed. There is
no simple replacement for this.

true

LABELVOL Warning 'labelvolshow' will be removed in a
future release. With appropriate code
changes, use 'volshow' instead.

true
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Check ID Severity Message Can Be Disabled?
COMPATVOL Warning 'images.compatibility.volshow.R2022a.v

olshow' will be removed in a future
release. With appropriate code
changes, use 'volshow' instead.

true

NPI2PI Error 'npi2pi' has been removed. With
appropriate code changes, use
'wrapTo180' or 'wrapToPi' instead.

true

NPI22PI Error 'zero22pi' has been removed. With
appropriate code changes, use
'wrapTo360' or 'wrapTo2Pi' instead.

true

ECF2LV Error 'ecef2lv' has been removed. With
appropriate code changes, use
'ecef2enu' instead.

true

LV2ECF Error 'lv2ecef' has been removed. With
appropriate code changes, use
'enu2ecef' instead.

true

ELEVT Error 'elevation' has been removed. With
appropriate code changes, use
'geodetic2aer' instead.

true

EPSM Error 'epsm' has been removed. With
appropriate code changes, use '1.0E-6'
or 'deg2rad(1.0E-6)' instead.

true

RDFLDS Error 'readfields' has been removed. With
appropriate code changes, use
'readmatrix', 'readtable', or a different
file import function instead.

true

RDMTX Error 'readmtx' has been removed. With
appropriate code changes, use
'readmatrix', 'readtable', or a different
file import function instead.

true

RDFK5 Error 'readfk5' has been removed. There is
no simple replacement for this.

true

SPCRD Error 'spcread' has been removed. With
appropriate code changes, use
'readmatrix' instead.

true

COLORM Error 'colorm' has been removed. There is no
simple replacement for this.

true

GTSEED Error 'getseeds' has been removed. There is
no simple replacement for this.

true

MKMAP Error 'makemapped' has been removed.
There is no simple replacement for this.

true

MOBJS Error 'mobjects' has been removed. There is
no simple replacement for this.

true
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SEEDM Error 'seedm' has been removed. There is no

simple replacement for this.
true

PRJET Error 'project' has been removed. With
appropriate code changes, use
'projfwd' instead.

true

LKBLNK Error 'leadblnk' has been removed. With
appropriate code changes, use 'strtrim'
instead.

true

SFTSPC Error 'shiftspc' has been removed. With
appropriate code changes, use 'strjust'
instead.

true

GTR2GLT Error 'geocentric2geodeticLat' has been
removed. With appropriate code
changes, use
'geodeticLatitudeFromGeocentric'
instead.

true

GLT2GTR Error 'geodetic2geocentricLat' has been
removed. With appropriate code
changes, use 'geocentricLatitude'
instead.

true

MEXTM Error 'extractm' has been removed. With
appropriate code changes, use
geospatial tables instead.

true

QRYDT Error 'qrydata' has been removed. There is
no simple replacement for this.

true

PNZOM Error 'panzoom' has been removed. With
appropriate code changes, use 'zoom'
instead.

true

CMBNT Error 'combntns' has been removed. Use
'nchoosek' instead, which is a direct
replacement.

true

FPSNM Error 'fipsname' has been removed. With
appropriate code changes, use
'readgeotable' instead.

true

GREPF Error 'grepfields' has been removed. With
appropriate code changes, use
'textscan' instead.

true

TRGLN Error 'tgrline' has been removed. With
appropriate code changes, use
'readgeotable' instead.

true

CLRUI Error 'colorui' has been removed. With
appropriate code changes, use
'uisetcolor' instead.

true
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COMET Error 'cometm' has been removed. With

appropriate code changes, use 'comet'
instead.

true

COMET3 Error 'comet3m' has been removed. With
appropriate code changes, use 'comet3'
instead.

true

MLYER Error 'mlayers' has been removed. There is
no simple replacement for this.

true

RSTCK Error 'restack' has been removed. With
appropriate code changes, use 'uistack'
instead.

true

RTLYR Error 'rootlayr' has been removed. There is
no simple replacement for this.

true

EASTF Error 'eastof' has been removed. With
appropriate code changes, use 'mod'
instead.

true

WESTF Error 'westof' has been removed. With
appropriate code changes, use 'mod'
instead.

true

AT2GD Error 'aut2geod' has been removed. With
appropriate code changes, use
'map.geodesy.AuthalicLatitudeConverte
r' instead.

true

CN2GD Error 'cen2geod' has been removed. With
appropriate code changes, use
'geodeticLatitudeFromGeocentric'
instead.

true

CF2GD Error 'cnf2geod' has been removed. With
appropriate code changes, use
'map.geodesy.ConformalLatitudeConve
rter' instead.

true

IS2GD Error 'iso2geod' has been removed. With
appropriate code changes, use
'map.geodesy.IsometricLatitudeConvert
er' instead.

true

PR2GD Error 'par2geod' has been removed. With
appropriate code changes, use
'geodeticLatitudeFromParametric'
instead.

true

RC2GD Error 'rec2geod' has been removed. With
appropriate code changes, use
'map.geodesy.RectifyingLatitudeConver
ter' instead.

true
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GD2AT Error 'geod2aut' has been removed. With

appropriate code changes, use
'map.geodesy.AuthalicLatitudeConverte
r' instead.

true

GD2CN Error 'geod2cen' has been removed. With
appropriate code changes, use
'geocentricLatitude' instead.

true

GD2CF Error 'geod2cnf' has been removed. With
appropriate code changes, use
'map.geodesy.ConformalLatitudeConve
rter' instead.

true

GD2IS Error 'geod2iso' has been removed. With
appropriate code changes, use
'map.geodesy.IsometricLatitudeConvert
er' instead.

true

GD2PR Error 'geod2par' has been removed. With
appropriate code changes, use
'parametricLatitude' instead.

true

GD2RC Error 'geod2rec' has been removed. With
appropriate code changes, use
'map.geodesy.RectifyingLatitudeConver
ter' instead.

true

DCWDT Error 'dcwdata' has been removed. With
appropriate code changes, use
'vmap0data' instead.

true

DCWGZ Error 'dcwgaz' has been removed. With
appropriate code changes, use
'vmap0ui' instead.

true

DCWRD Error 'dcwread' has been removed. With
appropriate code changes, use
'vmap0read' instead.

true

DCWHD Error 'dcwrhead' has been removed. With
appropriate code changes, use
'vmap0rhead' instead.

true

SYMBM Error 'symbolm' has been removed. With
appropriate code changes, use
'scatterm' instead.

true

TRACKUI Warning 'trackui' will be removed in a future
release. With appropriate code
changes, use 'trackg' instead.

true

SCIRCLUI Warning 'scirclui' will be removed in a future
release. With appropriate code
changes, use 'scircleg' instead.

true
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MAPTOOL Warning 'maptool' will be removed in a future

release. There is no simple
replacement for this.

true

ORIGINUI Warning 'originui' will be removed in a future
release. With appropriate code
changes, use 'setm' instead.

true

PARALLELUI Warning 'parallelui' will be removed in a future
release. With appropriate code
changes, use 'setm' instead.

true

SECTORG Warning 'sectorg' will be removed in a future
release. With appropriate code
changes, use 'scircle1' instead.

true

CLRMENU Warning 'clrmenu' will be removed in a future
release. With appropriate code
changes, use 'colormapeditor' instead.

true

MAPTRIM Warning 'maptrim' will be removed in a future
release. With appropriate code
changes, use 'geocrop' or 'geoclip'
instead.

true

SURFDIST Warning 'surfdist' will be removed in a future
release. With appropriate code
changes, use 'distance' instead.

true

DEMDATAUI Warning 'demdataui' will be removed in a future
release. With appropriate code
changes, use 'readgeoraster' instead.

true

VMAP0UI Warning 'vmap0ui' will be removed in a future
release. With appropriate code
changes, use 'vmap0read' instead.

true

MFWDT Warning 'mfwdtran' will be removed in a future
release. With appropriate code
changes, use 'projfwd' instead.

true

MINVT Warning 'minvtran' will be removed in a future
release. With appropriate code
changes, use 'projinv' instead.

true

LATLON2PIX Warning 'latlon2pix' will be removed in a future
release. With appropriate code
changes, use 'geographicToIntrinsic'
instead.

true

LTLNV Warning 'ltln2val' will be removed in a future
release. With appropriate code
changes, use 'geointerp' instead.

true

MAP2PIX Warning 'map2pix' will be removed in a future
release. With appropriate code
changes, use 'worldToIntrinsic' instead.

true
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MAPTM Warning 'maptrims' will be removed in a future

release. With appropriate code
changes, use 'geocrop' instead.

true

MESHGRAT Warning 'meshgrat' will be removed in a future
release. With appropriate code
changes, use 'geographicGrid',
'linspace' or 'ndgrid' instead.

true

NANM Warning 'nanm' will be removed in a future
release. With appropriate code
changes, use 'nan' instead.

true

ONEM Warning 'onem' will be removed in a future
release. With appropriate code
changes, use 'ones' instead.

true

PIX2LATLON Warning 'pix2latlon' will be removed in a future
release. With appropriate code
changes, use 'intrinsicToGeographic'
instead.

true

PIX2MAP Warning 'pix2map' will be removed in a future
release. With appropriate code
changes, use 'intrinsicToWorld' instead.

true

PIXCENTERS Warning 'pixcenters' will be removed in a future
release. With appropriate code
changes, use 'worldGrid' or
'geographicGrid' instead.

true

RESZM Warning 'resizem' will be removed in a future
release. With appropriate code
changes, use 'georesize' or 'imresize'
instead.

true

SETLTLN Warning 'setltln' will be removed in a future
release. With appropriate code
changes, use 'intrinsicToGeographic'
instead.

true

SETPOSTN Warning 'setpostn' will be removed in a future
release. With appropriate code
changes, use 'geographicToDiscrete'
instead.

true

SPZER Warning 'spzerom' will be removed in a future
release. With appropriate code
changes, use 'sparse' instead.

true

ZEROM Warning 'zerom' will be removed in a future
release. With appropriate code
changes, use 'zeros' instead.

true

MDTED Warning 'dted' will be removed in a future
release. With appropriate code
changes, use 'readgeoraster' instead.

true
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ETOPO Warning 'etopo' will be removed in a future

release. With appropriate code
changes, use 'readgeoraster' instead.

true

GLDEM Warning 'globedem' will be removed in a future
release. With appropriate code
changes, use 'readgeoraster' instead.

true

GTOPO Warning 'gtopo30' will be removed in a future
release. With appropriate code
changes, use 'readgeoraster' instead.

true

SBATH Warning 'satbath' will be removed in a future
release. With appropriate code
changes, use 'readgeoraster' instead.

true

SDTRD Warning 'sdtsdemread' will be removed in a
future release. With appropriate code
changes, use 'readgeoraster' instead.

true

TBASE Warning 'tbase' will be removed in a future
release. With appropriate code
changes, use 'readgeoraster' instead.

true

USGDM Warning 'usgsdem' will be removed in a future
release. With appropriate code
changes, use 'readgeoraster' instead.

true

USGKD Warning 'usgs24kdem' will be removed in a
future release. With appropriate code
changes, use 'readgeoraster' instead.

true

MAPVW Error 'mapview' has been removed. With
appropriate code changes, use
'mapshow' instead.

true

DMCHN Error 'mimochan' has been removed. With
appropriate code changes, use
'comm.MIMOChannel' instead.

true

MOVIE2 Error 'movie2avi' has been removed. With
appropriate code changes, use
'VideoWriter' instead.

true

NDWT Error 'ndwt' has been removed. With
appropriate code changes, use 'modwt'
instead.

true

INDWT Error 'indwt' has been removed. With
appropriate code changes, use 'imodwt'
instead.

true

NDWT2 Error 'ndwt2' has been removed. With
appropriate code changes, use 'swt2'
instead.

true

INDWT2 Error 'indwt2' has been removed. With
appropriate code changes, use 'iswt2'
instead.

true
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DNOANI Error 'noanimate' has been removed. There is

no simple replacement for this.
true

DPGUPDLG Warning 'pagesetupdlg' will be removed in a
future release. With appropriate code
changes, use 'printpreview' instead.

true

DPOOL Error 'matlabpool' has been removed. With
appropriate code changes, use
'parpool' instead.

true

MTHDPOOL Error 'parcluster.matlabpool' has been
removed. With appropriate code
changes, use 'parpool' instead.

true

PDECT Warning 'pdecont' will be removed in a future
release. With appropriate code
changes, use 'pdeplot' instead.

true

PDESF Warning 'pdesurf' will be removed in a future
release. With appropriate code
changes, use 'pdeplot' instead.

true

RNG2BW Warning 'range2bw' will be removed in a future
release. Use 'rangeres2bw' instead,
which is a direct replacement.

true

BW2RNG Warning 'bw2range' will be removed in a future
release. Use 'bw2rangeres' instead,
which is a direct replacement.

true

POLYCPO Error 'polyspace.CodeProverOptions' has
been removed. With appropriate code
changes, use 'polyspace.Options'
instead.

true

POLYBFO Error 'polyspace.BugFinderOptions' has been
removed. With appropriate code
changes, use 'polyspace.Options'
instead.

true

RWA Warning 'radarWaveformAnalyzer' will be
removed in a future release. Use
'pulseWaveformAnalyzer' instead,
which is a direct replacement.

true

DRNDINT Error 'randint' has been removed. With
appropriate code changes, use 'randi'
instead.

true

RCSIIR Warning 'rcosiir' is unsupported and will be
removed in a future release. There is
no simple replacement for this.

true

RCSFIR Warning 'rcosfir' is unsupported and will be
removed in a future release. With
appropriate code changes, use
'rcosdesign' instead.

true
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RCSFLT Warning 'rcosflt' is unsupported and will be

removed in a future release. With
appropriate code changes, use
'rcosdesign' instead.

true

RCSINE Warning 'rcosine' is unsupported and will be
removed in a future release. With
appropriate code changes, use
'rcosdesign' instead.

true

SERIAL Warning 'serial' will be removed in a future
release. With appropriate code
changes, use 'serialport' instead.

true

SERLL Warning 'seriallist' will be removed in a future
release. Use 'serialportlist' instead,
which is a direct replacement.

true

G2B Error 'gray2bin' has been removed. Use the
appropriate modulation object or
function to remap constellation points
instead.

true

B2G Error 'bin2gray' has been removed. Use the
appropriate modulation object or
function to remap constellation points
instead.

true

SLLWARN Warning 'sllastwarning' will be removed in a
future release. With appropriate code
changes, use 'lastwarn' instead.

true

SLLERR1 Warning 'sllasterror' will be removed in a future
release. Use an identifier on the
CATCH block instead.

true

SLLERR2 Warning 'sllastdiagnostic' will be removed in a
future release. Use an identifier on the
CATCH block instead.

true

SLRTBNCH Error 'slrtbench' has been removed. With
appropriate code changes, use
'SimulinkRealTime.utils.minimumSamp
leTime' instead.

true

SOAPM Error 'createSoapMessage' has been
removed. With appropriate code
changes, use
'matlab.wsdl.createWSDLClient'
instead.

true

SOAPS Error 'callSoapService' has been removed.
With appropriate code changes, use
'matlab.wsdl.createWSDLClient'
instead.

true
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SOAPR Error 'parseSoapResponse' has been

removed. With appropriate code
changes, use
'matlab.wsdl.createWSDLClient'
instead.

true

SOAPC Error 'createClassFromWsdl' has been
removed. Use
'matlab.wsdl.createWSDLClient'
instead, which is a direct replacement.

true

SPTL Error 'sptool' has been removed. Use
'signalAnalyzer' or 'filterDesigner'
instead.

true

CAPABLE Error 'capable' has been removed. With
appropriate code changes, use
'capability' instead.

true

EWMAPLOT Error 'ewmaplot' has been removed. With
appropriate code changes, use
'controlchart' instead.

true

FITNAIVEBAYES Error 'fitNaiveBayes' has been removed. With
appropriate code changes, use 'fitcnb'
instead.

true

PROBDIST Error 'ProbDist' has been removed. With
appropriate code changes, use
'prob.ProbabilityDistribution' instead.

true

PROBDISTPARAME
TRIC

Error 'ProbDistParametric' has been
removed. With appropriate code
changes, use
'prob.ProbabilityDistribution' instead.

true

PROBDISTKERNEL Error 'ProbDistKernel' has been removed.
With appropriate code changes, use
'prob.ProbabilityDistribution' instead.

true

PROBDISTUNIVKE
RNEL

Error 'ProbDistUnivKernel' has been
removed. With appropriate code
changes, use 'makedist' instead.

true

PROBDISTUNIVPA
RAM

Error 'ProbDistUnivParam' has been
removed. With appropriate code
changes, use 'makedist' instead.

true

SCHART Error 'schart' has been removed. With
appropriate code changes, use
'controlchart' instead.

true

XBARPLOT Error 'xbarplot' has been removed. With
appropriate code changes, use
'controlchart' instead.

true
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CMLLD Error 'loadCompactModel' has been removed.

Use 'loadLearnerForCoder' instead,
which is a direct replacement.

true

CMLSV Error 'saveCompactModel' has been
removed. Use 'saveLearnerForCoder'
instead, which is a direct replacement.

true

PRINCOMP Error 'princomp' has been removed. With
appropriate code changes, use 'pca'
instead.

true

SVMCLASSIFY Error 'svmclassify' has been removed. With
appropriate code changes, use
'ClassificationSVM' instead.

true

SVMTRAIN Error 'svmtrain' has been removed. With
appropriate code changes, use 'fitcsvm'
instead.

true

CLASSREGTREE Error 'classregtree' has been removed. With
appropriate code changes, use 'fitctree'
or 'fitrtree' instead.

true

DDTRD Warning 'dataread' will be removed in a future
release. With appropriate code
changes, use 'textscan' instead.

true

MUPAD Error 'mupad' has been removed. With
appropriate code changes, use 'Live
Editor' instead.

true

DWVRD Error 'wavread' has been removed. With
appropriate code changes, use
'audioread' instead.

true

DWVWR Error 'wavwrite' has been removed. With
appropriate code changes, use
'audiowrite' instead.

true

DWVFINF Error 'wavfinfo' has been removed. With
appropriate code changes, use
'audioinfo' instead.

true

FBUILDER Warning 'filterbuilder' will be removed in a
future release. Use 'filterBuilder'
instead, which is a direct replacement.

true

FDATOOL Warning 'fdatool' will be removed in a future
release. Use 'filterDesigner' instead,
which is a direct replacement.

true

WAVMENU Warning 'wavemenu' will be removed in a future
release. Use 'waveletAnalyzer' instead,
which is a direct replacement.

true

WINTOOL Warning 'wintool' will be removed in a future
release. Use 'windowDesigner' instead,
which is a direct replacement.

true
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BETALIK1 Error 'betalik1' has been removed. With

appropriate code changes, use
'betalike' instead.

true

SVMSMOSET Error 'svmsmoset' has been removed. With
appropriate code changes, use 'fitcsvm'
instead.

true

WEIBCDF Error 'weibcdf' has been removed. With
appropriate code changes, use 'wblcdf'
instead.

true

WEIBFIT Error 'weibfit' has been removed. With
appropriate code changes, use 'wblfit'
instead.

true

WEIBINV Error 'weibinv' has been removed. With
appropriate code changes, use 'wblinv'
instead.

true

WEIBLIKE Error 'weiblike' has been removed. With
appropriate code changes, use 'wbllike'
instead.

true

WEIBPDF Error 'weibpdf' has been removed. With
appropriate code changes, use 'wblpdf'
instead.

true

WEIBPLOT Error 'weibplot' has been removed. With
appropriate code changes, use 'wblplot'
instead.

true

WEIBRND Error 'weibrnd' has been removed. With
appropriate code changes, use 'wblrnd'
instead.

true

WEIBSTAT Error 'weibstat' has been removed. With
appropriate code changes, use 'wblstat'
instead.

true

LTEFS Error 'ltehdlFramesToSamples' has been
removed. Use 'whdlFramesToSamples'
instead, which is a direct replacement.

true

LTESF Error 'ltehdlSamplesToFrames' has been
removed. Use 'whdlSamplesToFrames'
instead, which is a direct replacement.

true

YOLOV Warning 'yolov2ReorgLayer' will be removed in
a future release. With appropriate code
changes, use 'spaceToDepthLayer'
instead.

true

BLBAF Warning 'BytesAvailableFcnCount' property of
'bluetooth' class will be removed in a
future release. With appropriate code
changes, use 'configureCallback'
method of 'bluetooth' class instead.

true
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Check ID Severity Message Can Be Disabled?
BLTMT Warning 'Terminator' property of 'bluetooth'

class will be removed in a future
release. With appropriate code
changes, use 'configureTerminator'
method of 'bluetooth' class instead.

true

BLIBS Warning 'InputBufferSize' property of 'bluetooth'
class will be removed in a future
release. There is no simple
replacement for this.

true

SPTMT Warning 'Terminator' property of 'serialport'
class will be removed in a future
release. With appropriate code
changes, use 'configureTerminator'
method of 'serialport' class instead.

true

SPIBS Warning 'InputBufferSize' property of
'serialport' class will be removed in a
future release. There is no simple
replacement for this.

true

TCTMT Warning 'Terminator' property of 'tcpclient'
class will be removed in a future
release. With appropriate code
changes, use 'configureTerminator'
method of 'tcpclient' class instead.

true

TCIBS Warning 'InputBufferSize' property of 'tcpclient'
class will be removed in a future
release. There is no simple
replacement for this.

true

TSTMT Warning 'Terminator' property of 'tcpserver'
class will be removed in a future
release. With appropriate code
changes, use 'configureTerminator'
method of 'tcpserver' class instead.

true

TSIBS Warning 'InputBufferSize' property of 'tcpserver'
class will be removed in a future
release. There is no simple
replacement for this.

true

UDTMT Warning 'Terminator' property of 'udpport' class
will be removed in a future release.
With appropriate code changes, use
'configureTerminator' method of
'udpport' class instead.

true

UDIBS Warning 'InputBufferSize' property of 'udpport'
class will be removed in a future
release. There is no simple
replacement for this.

true
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VSTMT Warning 'Terminator' property of 'visadev' class

will be removed in a future release.
With appropriate code changes, use
'configureTerminator' method of
'visadev' class instead.

true

VSIBS Warning 'InputBufferSize' property of 'visadev'
class will be removed in a future
release. There is no simple
replacement for this.

true

VSBYA Warning 'BytesAvailable' property of 'visadev'
class will be removed in a future
release. There is no simple
replacement for this.

true

VLSBC Error 'BackgroundColor' property has been
removed. With appropriate code
changes, use 'BackgroundColor'
property of the parent 'Viewer3D' class
instead.

true

VLSCP Error 'CameraPosition' property has been
removed. With appropriate code
changes, use 'CameraPosition' property
of the parent 'Viewer3D' class instead.

true

VLSCT Error 'CameraTarget' property has been
removed. With appropriate code
changes, use 'CameraTarget' property
of the parent 'Viewer3D' class instead.

true

VLSCU Error 'CameraUpVector' property has been
removed. With appropriate code
changes, use 'CameraUpVector'
property of the parent 'Viewer3D' class
instead.

true

VLSCV Error 'CameraViewAngle' property has been
removed. There is no simple
replacement for this.

true

VLSIE Error 'InteractionsEnabled' property has
been removed. With appropriate code
changes, use 'Interactions' property of
the parent 'Viewer3D' class instead.

true

VLSLT Error 'Lighting' property has been removed.
With appropriate code changes, use
'Lighting' property of the parent
'Viewer3D' class instead.

true

VLSRD Error 'Renderer' property has been removed.
With appropriate code changes, use
'RenderingStyle' property instead.

true

 Index of Code Analyzer Checks

7-93



Check ID Severity Message Can Be Disabled?
VLSIC Error 'IsosurfaceColor' property has been

removed. With appropriate code
changes, use 'Colormap' property
instead.

true

VLSSF Error 'ScaleFactors' property has been
removed. With appropriate code
changes, use 'Transformation' property
instead.

true

VLSIV Error 'Isovalue' property has been removed.
With appropriate code changes, use
'IsosurfaceValue' property instead.

true

BLFWR Warning 'fwrite' method of 'bluetooth' class will
be removed in a future release. With
appropriate code changes, use 'write'
method of 'bluetooth' class instead.

true

BLSTR Warning 'scanstr' method of 'bluetooth' class
will be removed in a future release.
With appropriate code changes, use
'readline' method of 'bluetooth' class
instead.

true

SPSTR Warning 'scanstr' method of 'serialport' class
will be removed in a future release.
With appropriate code changes, use
'readline' method of 'serialport' class
instead.

true

TCSTR Warning 'scanstr' method of 'tcpclient' class will
be removed in a future release. With
appropriate code changes, use
'readline' method of 'tcpclient' class
instead.

true

TSSTR Warning 'scanstr' method of 'tcpserver' class
will be removed in a future release.
With appropriate code changes, use
'readline' method of 'tcpserver' class
instead.

true

UDSTR Warning 'scanstr' method of 'udpport' class will
be removed in a future release. With
appropriate code changes, use
'readline' method of 'udpport' class
instead.

true

VSSTR Warning 'scanstr' method of 'visadev' class will
be removed in a future release. With
appropriate code changes, use
'readline' method of 'visadev' class
instead.

true
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Good Practices
Check ID Severity Message Can Be Disabled?
VTFIN Warning VAR_NAME must be the first input

argument to the VAR_NAME function.
true

TLEV Warning VAR_NAME could be very inefficient
unless it is a top-level statement in its
function.

true

SHVAU Warning Confusing usage of name VAR_NAME
on lines VAR_NUMBER and
VAR_NUMBER. Initialize VAR_NAME
before line VAR_NUMBER to make it a
shared variable or rename VAR_NAME
on line VAR_NUMBER to disambiguate.

true

PFRNI Warning Do not specify the increment explicitly.
The parfor loop can only use an
increment of one.

true

PFGP Warning Avoid assigning to GLOBAL or
PERSISTENT variable VAR_NAME
inside a PARFOR loop.

true

PFGV Warning Avoid using GLOBAL variable
VAR_NAME in a PARFOR loop.

true

PFEVB Warning Using EVALIN('base') or
ASSIGNIN('base') inside a PARFOR
loop refers to the worker machines'
base workspaces.

true

PFUIXW Warning The index variable VAR_NAME might
be used after the PARFOR loop on line
VAR_NUMBER. The value set on this
line is not available after the loop.

true

PFOUS Warning The output variable VAR_NAME might
not be used after the PARFOR loop.

true

PFIIN Warning The input variable VAR_NAME should
be initialized before the PARFOR loop.

true

PFRIN Warning The reduction variable VAR_NAME
might not be set before the PARFOR
loop.

true

PFRUS Warning The reduction variable VAR_NAME
might not be used after the PARFOR
loop.

true

PFTUSW Warning The temporary variable VAR_NAME
might be used after the PARFOR loop
on line VAR_NUMBER. The value set on
this line is not available after the loop.

true
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Check ID Severity Message Can Be Disabled?
SPGV Warning Using the GLOBAL or PERSISTENT

variable VAR_NAME in an SPMD block
might fail because it is accessed on a
worker machine.

true

SPEVB Warning Using EVALIN('base') or
ASSIGNIN('base') inside an SPMD
block refers to the worker machines'
base workspaces.

true

DSPMDA Warning Distributed array must be created
outside of an SPMD block.

true

NOANS Warning Using ANS as a variable is not
recommended as ANS is frequently
overwritten by MATLAB.

true

FCNANS Warning Using ANS as a function or method
name is not recommended as ANS is
frequently overwritten by MATLAB.

true

VALST Warning VAR_NAME must be the last argument
in the argument list.

true

FVAL Warning Calling functions using 'feval' is usually
not necessary. Call the function directly
instead.

true

FNCOLND Warning Consider explicitly defining the array,
and then using the END operator to
index into it.

true

COMNC Warning Comment with percent (%) following
comma acts as a row separator.
Replace the comma with a semicolon to
make the row separation clearer.
Alternatively, replace the percent (%)
with an ellipsis (...) to add a comment
inside a row.

true

FXSET Warning Loop index VAR_NAME is changed
inside of a FOR loop.

true

FXUP Warning Outer loop index VAR_NAME is set
inside a nested function.

true

SIMPT Warning This import statement runs before any
other code in function VAR_NAME.
Consider placing it at the top of the
function body.

true

STRSZ Warning Use STRCMP to compare character
vectors that can have different sizes.

true

M3COL Warning Using three colons (a:b:c:d) in an
expression is probably unintended.

true

BDLOG Warning Operator VAR_OPERATOR is seldom
used in a logical context.

true
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Check ID Severity Message Can Be Disabled?
BDSCA Warning Unexpected use of VAR_OPERATOR in

a scalar context.
true

BDLGI Warning Variable might be set by a nonlogical
operator.

true

BDSCI Warning Variable might be set by a nonscalar
operator.

true

DUALC Warning Command might be prematurely ended
by comma.

true

LTARG Warning Function might be called with too few
arguments.

true

GTARG Warning Function might be called with too many
arguments.

true

CTPCT Warning The format might not agree with the
argument count.

true

SEMFS Warning This semicolon makes the file a script.
Therefore, all functions in the file are
local functions.

true

COMFS Warning This comma makes the file a script.
Therefore, all functions in the file are
local functions.

true

TRYNC Warning TRY statement should have a CATCH
statement to check for unexpected
errors.

true

FNDEF Warning Function name VAR_NAME is known to
MATLAB by its file name: VAR_FILE.

true

CTCH Warning Best practice is for CATCH to be
followed by an identifier that gets the
error information.

true

CTOINW Warning Use of constructed object as input to
constructor is not necessary.

true

NOIN Warning Method VAR_NAME should either be a
static method or have at least one input
argument.

true

MHERM Warning Parenthesize the multiplication of
VAR_NAME and its transpose to ensure
the result is Hermitian.

true

MNUML Warning To create a square matrix, use
VAR_NAME(numel(...), numel(...)).
Alternatively, use VAR_NAME(size(...))
to create an array with same size as
input array.

true

RMWRN Warning The warning with tag VAR_NAME has
been removed from MATLAB, so this
statement has no effect.

true
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Check ID Severity Message Can Be Disabled?
UNONC Warning Assign the onCleanup output argument

to a variable. Do not use the tilde
operator (~) in place of a variable.

true

ATTF Warning The Code Analyzer is unable to
determine if the expression assigned to
the VAR_NAME attribute evaluates to
true or false.

true

ATTOF Warning Setting the class attribute Abstract to
false is not recommended.

true

MCHDP Warning A property default value that is a
handle will cause all instances to share
the same object data. To avoid sharing,
create the property value in the
constructor. For intentional sharing,
consider using a Constant property.

true

MCVM Warning Value class method that modifies the
object must return the modified object.

true

MCPO Warning VAR_NAME property has no effect in a
value class.

true

MDEPIN Warning Default values should not be assigned
to dependent properties because
dependent properties do not store the
values.

true

MCCPI Warning Initialize the Constant property or
make it an Abstract Constant property.

true

MCSNOV Warning Set function in value class must return
the modified object.

true

MCSOH Warning Set function in handle class does not
need to return the modified object.

true

MCNPN Warning VAR_NAME is referenced but is not a
property, method, or event name
defined in this class.

true

MCNPR Warning VAR_NAME is not a property, but is the
target of an assignment.

true

MCCPE Warning Attempting to call a property or event
VAR_NAME as a function.

true

MCSUP Warning The set method for the property
VAR_NAME should not access another
property (VAR_NAME).

true

MCCSPS Warning Constant property VAR_NAME is not
modified. 'VAR_NAME.VAR_NAME'
creates a struct named VAR_NAME
with a field named VAR_NAME.

true
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Check ID Severity Message Can Be Disabled?
MCSAC Warning SetAccess cannot be set on Constant

properties.
true

MOBSRV Warning Using SetObservable or GetObservable
on a Constant property has no effect.

true

WLAST Warning WARNING('') does not reset the
warning state. Use LASTWARN('')
instead.

true

WNTAG Warning The first argument of WARNING should
be a message identifier. Using a
message identifier allows users better
control over the message.

true

ERTAG Warning The first argument of ERROR should be
a message identifier.

true

STCMP Warning Use STRCMP instead of == or ~= to
compare character vectors.

true

STISA Warning Consider using ISA instead of
comparing the class name.

true

STRNU Warning This variable, apparently a structure, is
changed but the value might be
unused.

true

ITERS Warning The Code Analyzer type analysis may
be incorrect here.

true

ELARLOG Warning The VAR_NAME operator in the
expression VAR_NAME(A VAR_NAME
B) is unexpected. Should this be
VAR_NAME(A) VAR_NAME B?

true

SZARLOG Warning The VAR_NAME operator in the
expression VAR_NAME(A VAR_NAME
B) is unexpected. Should this be
VAR_NAME(A) VAR_NAME B?

true

MIPC1 Warning Calling the computer function with
'arch' returns 'win64', 'glnxa64', or
'maci64'.

true

STFLD Warning SETFIELD output must be assigned
back to the structure.

true

RMFLD Warning RMFIELD output must be assigned
back to the structure.

true

NBRAK1 Warning If you intend to specify expression
precedence, use parentheses () instead
of brackets [].

true

ALIGN Warning This keyword might not be aligned with
its matching END on line
VAR_NUMBER.

true
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Check ID Severity Message Can Be Disabled?
LNGNM Warning Names longer than 63 characters are

not supported. This name has been
truncated to 63 characters.

true

CHAIN Warning Expressions like a VAR_NAME b
VAR_NAME c are interpreted as (a
VAR_NAME b) VAR_NAME c. Typically,
to test a VAR_NAME b VAR_NAME c
mathematically, if all arguments are
numeric scalars, use (a VAR_NAME b)
&& (b VAR_NAME c), otherwise use (a
VAR_NAME b) & (b VAR_NAME c).

true

DISPLAY Warning Overloading DISPLAY is not
recommended.

true

SHOCIRAA Warning Using the VAR_NAME operator in the
expression VAR_NAME(A VAR_NAME
B) is probably unintended.

true

COMPNOP Warning This logical comparison simplifies to
VAR_NAME(...). Did you mean to use
VAR_NAME to evaluate function
argument:
VAR_NAME(...VAR_NAME...)?

true

COMPNOT Warning This logical comparison simplifies to
~VAR_NAME(...). Did you mean to use
VAR_NAME to evaluate function
argument:
VAR_NAME(...VAR_NAME...)?

true

SUBSINDEX Warning Do not overload 'subsindex' for
fundamental data types.

true

STRCMPCSTR Error Use a string array instead of a cell
array of string scalars when using
'strcmp'.

true

UNRPWR Warning Consider using parentheses to
explicitly specify operator precedence.

true

LOAD Warning To avoid conflicts with functions on the
path, specify variables to load from file.

true

ADAPPREF Warning Use app as the first argument for
VAR_NAME.

true

ADMTHDINV Warning Use VAR_NAME(app, ...) to call this
function.

true

ADPROP Warning Use app.VAR_NAME to refer to this
property.

true

ADPROPLC Warning Use app.VAR_NAME to reference a
property of app.

true
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Check ID Severity Message Can Be Disabled?
MCHDT Warning Declaring the value of a property as a

handle might cause all instances to
share the same default handle. To avoid
sharing, create the handle for this
property in the constructor. To express
that sharing is intentional, use the
Constant property attribute.

true

EVLCS Warning 'eval' is inefficient and makes code less
clear. Call the statement directly.

true

GVMIS Warning Global variables are inefficient and
make errors difficult to diagnose. Use a
function with input variables instead.

true

EVLDOT Warning 'eval' is inefficient and makes code less
clear. Use dynamic field names to
access structure fields or object
properties instead.

true

EVLEQ Warning 'eval' is inefficient and makes code less
clear. Assign to the variable directly.

true

Unset Variables

Check ID Severity Message Can Be Disabled?
PSET Warning Persistent variable is used, but might

be unset.
true

USENS Warning Explicitly initialize this variable to
avoid a potential uninitialized variable,
or use a valid syntax for function call
on line VAR_NUMBER.

true

SVNODEF Warning Variable might be used before it is
defined.

true

USESWNS Error Variable must be explicitly defined
before first use.

true

SUSENS Warning Variable is used, but might be unset
(within a script).

true

NODEF Warning Variable might be used before it is
defined.

true

STOUT Warning Function return value might be unset. true

Unused Constructions

Check ID Severity Message Can Be Disabled?
NOEFF Warning The operation or expression

VAR_OPERATOR has no evident effect.
true
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Check ID Severity Message Can Be Disabled?
NUSED Warning Global or persistent variable might be

unused or unset in this function or
script.

true

EQEFF Warning To assign values to variables, use =.
The == operator compares equality of
values.

true

PUSE Warning Persistent variable might be unused. true
SETNU Warning Variable is set, but might be unused. true
ASGLU Warning Value assigned to variable might be

unused. Consider replacing the
variable with ~ instead.

true

NASGU Warning Value assigned to variable might be
unused.

true

PREALL Warning The preallocated value assigned to
variable might be unused.

true

INUSA Warning Input argument might be unused after
the function arguments block(s).

true

INUSD Warning Input argument might be unused.
Consider replacing the argument with
~ instead.

true

VANUS Warning Input argument 'varargin' might be
unused.

true

DEFNU Warning Function might be unused. true
UNRCH Warning This statement (and possibly following

ones) cannot be reached.
true

PROP Warning There is a property named VAR_NAME.
Did you mean to reference it?

true

PROPLC Warning There is a property named VAR_NAME.
Maybe this is a reference to it?

true

CPROP Warning Confusing function call. Did you mean
to reference property VAR_NAME?

true

CPROPLC Warning Confusing function call. Maybe this is a
reference to property VAR_NAME?

true

MANU Warning Argument VAR_NAME is unused.
Should this method be Static?

true

VUNUS Warning VAR_OPERATOR produces a value that
might be unused.

true

MSNU Info A Code Analyzer message was once
suppressed here, but the message is no
longer generated.

true

MSNE Info No Code Analyzer check is found for
this check ID.

true
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Suggested Improvements
Check ID Severity Message Can Be Disabled?
LERR Info LASTERR and LASTERROR are not

recommended. Use an identifier on the
CATCH block instead.

true

EVLC Info Using 'evalc' with two arguments is not
recommended. Use try/catch
statements instead to make code more
clear and efficient.

true

RAND Info RAND or RANDN with the 'seed',
'state', or 'twister' inputs is not
recommended. Use RNG instead.

true

HOUGH Info HOUGH(BW,'ThetaResolution',VAL) is
not recommended. Use
HOUGH(BW,'Theta',-90:VAL:(90-VAL) )
instead.

true

THOUR Info 'hour' with serial date number or text
inputs is not recommended. With
appropriate code changes, use
'datetime' as input instead.

true

TMNTH Info 'month' with serial date number or text
inputs is not recommended. With
appropriate code changes, use
'datetime' as input instead.

true

TMNUT Info 'minute' with serial date number or text
inputs is not recommended. With
appropriate code changes, use
'datetime' as input instead.

true

TNDAY Info 'day' with serial date number or text
inputs is not recommended. With
appropriate code changes, use
'datetime' as input instead.

true

TSCND Info 'second' with serial date number or text
inputs is not recommended. With
appropriate code changes, use
'datetime' as input instead.

true

TQURT Info 'quarter' with serial date number or
text inputs is not recommended. With
appropriate code changes, use
'datetime' as input instead.

true

TYEAR Info 'year' with serial date number or text
inputs is not recommended. With
appropriate code changes, use
'datetime' as input instead.

true
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Check ID Severity Message Can Be Disabled?
TDTVEC Info 'datevec' with serial date number or

text inputs is not recommended. With
appropriate code changes, use
'datetime' instead.

true

TNOW1 Info 'now' is not recommended. With
appropriate code changes, use
'datetime("now")' instead.

true

TNOW2 Info 'datetime(now, 'ConvertFrom',
'datenum')' is not recommended. Use
'datetime("now")' instead, which is a
direct replacement.

true

TTDAY1 Info 'today' is not recommended. With
appropriate code changes, use
'datetime("today")' instead.

true

TTDAY2 Info 'datetime(today, 'ConvertFrom',
'datenum')' is not recommended. Use
'datetime("today")' instead, which is a
direct replacement.

true

MATCH2 Info STRMATCH is not recommended. Use
STRNCMP or VALIDATESTRING
instead.

true

IMGDT Info Using 'DataAugmentation' in function
'imageInputLayer' is not recommended.
Use function
'augmentedImageDatastore' instead.

true

MATCH3 Info STRMATCH is not recommended. Use
STRCMP instead.

true

MTFA1 Info MAKETFORM('AFFINE',A) is not
recommended. Use AFFINE2D or
AFFINE3D instead.

true

MTFA2 Info MAKETFORM('AFFINE',U,X) is not
recommended. Use FITGEOTRANS
instead.

true

MTFP1 Info MAKETFORM('PROJECTIVE',A) is not
recommended. Use PROJECTIVE2D
instead.

true

MTFP2 Info MAKETFORM('PROJECTIVE',U,X) is
not recommended. Use FITGEOTRANS
instead.

true

MTFB Info MAKETFORM('BOX',...) is not
recommended. Use IMREF2D or
IMREF3D instead.

true

PMTMCONF Info When using PMTM with three output
arguments, the 'ConfidenceLevel' input
argument is recommended.

true
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Check ID Severity Message Can Be Disabled?
NCHKI Info NARGCHK is not recommended. Use

NARGINCHK instead.
true

NCHKO Info Using NARGCHK with NARGOUT is not
recommended. Use NARGOUTCHK
instead.

true

NCHKN Info NARGCHK is not recommended. Use
NARGINCHK without ERROR instead.

true

NCHKM Info NARGCHK is not recommended. Use
NARGOUTCHK without ERROR
instead.

true

ISCLSTR Info To support string in addition to cellstr,
include a call to 'isstring'.

true

EMTAG Info The compilation directive (or pragma)
EML is not recommended. Use
CODEGEN instead.

true

EMXTR Info The EML package is not recommended.
Use CODER instead.

true

NVREPLA Info 'addParamValue' is not recommended.
Use 'addParameter' instead.

true

NVREPLM Info 'MidPctRef' is not recommended. Use
'MidPercentReferenceLevel' instead.

true

NVREPLP Info 'PctRefLevels' is not recommended.
Use 'PercentReferenceLevels' instead.

true

VIDREAD Info 'NumberOfFrames' is not
recommended. Use 'NumFrames'
instead.

true

CRNR Info CORNER is not recommended. Use
detectHarrisFeatures or
detectMinEigenFeatures in Computer
Vision Toolbox instead.

true

CRNRM Info CORNERMETRIC is not recommended.
Use detectHarrisFeatures or
detectMinEigenFeatures and the
cornerPoints class in Computer Vision
Toolbox instead.

true

MDFLT1 Info BLKSZ is required for backward
compatibility and is ignored. Use []
instead.

true

INTRPP Info 'pp' is not recommended. Use the
griddedInterpolant class instead.

true

DISPLAYPROG Info Programmatic use of DISPLAY is not
recommended. Use DISP or FPRINTF
instead.

true
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Check ID Severity Message Can Be Disabled?
HGSTGT Info hgsetget is not recommended. Use

matlab.mixin.SetGet or
matlab.mixin.SetGetExactNames
instead.

true

LEGACYMD Info Setting LegacyMode to true is not
recommended. Set LegacyMode to
false instead.

true

LEGACYTRD Info 'DetectorMethod' is applicable only
when LegacyMode is set to true.
However, setting LegacyMode to true is
not recommended.

true

LEGACYTRL Info 'LoopMethod' is applicable only when
LegacyMode is set to true. However,
setting LegacyMode to true is not
recommended.

true

LEGACYTRU Info 'UpdatePeriod' is applicable only when
LegacyMode is set to true. However,
setting LegacyMode to true is not
recommended.

true

LEGACYTRS Info 'StepSize' is applicable only when
LegacyMode is set to true. However,
setting LegacyMode to true is not
recommended.

true

LEGACYTRG Info 'GainOutputPort' is applicable only
when LegacyMode is set to true.
However, setting LegacyMode to true is
not recommended.

true

EZPLT Info EZPLOT is not recommended. Use
FPLOT or FIMPLICIT instead.

true

EZGRPH3 Info EZGRAPH3 is not recommended. Use
FCONTOUR, FMESH, FPLOT, FPLOT3
or FSURF instead.

true

EZCNTRF Info EZCONTOURF is not recommended.
Use FCONTOUR instead, and set the
'Fill' value to 'on'.

true

EZMSHC Info EZMESHC is not recommended. Use
FMESH instead, and set the
'ShowContours' value to 'on'.

true

EZSRFC Info EZSURFC is not recommended. Use
FSURF instead, and set the
'ShowContours' value to 'on'.

true

FISADR Info 'addrule' is not recommended. Use
'addRule' instead.

true

STRQUOT Info string('...') is not recommended. Use
"..." instead.

true
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Check ID Severity Message Can Be Disabled?
STRCLQT Info 'string({'str1', 'str2'})' is not

recommended. Use '["str1", "str2"]'
instead.

true

SIM Info 'sim' in parfor loop is not
recommended. Replace the parfor loop
with 'parsim'.

true

NUMCH Info 'NumberOfChannels' is not
recommended. Use 'NumChannels'
instead.

true

GTRED Info 'geotiffread' is not recommended,
except when reading a GeoTIFF file
from a URL. With appropriate code
changes, use 'readgeoraster' instead.

true

GETFSP Info Using get for retrieving values of line
spacing is not recommended. With
appropriate code changes, use
'settings' object instead.

true

SETFMT Info Using set for assigning values of
numeric display format is not
recommended. With appropriate code
changes, use 'settings' object instead.

true

SETFSP Info Using set for assigning values of line
spacing is not recommended. With
appropriate code changes, use
'settings' object instead.

true

GETFMT Info Using get for retrieving values of
numeric display format is not
recommended. With appropriate code
changes, use 'settings' object instead.

true

EV2IN Info Using 'eval' with two arguments is not
recommended. Use try/catch
statements instead to make code more
clear and efficient.

true

EV3IN Info Using 'evalin' with three arguments is
not recommended. Use try/catch
statements instead to make code more
clear and efficient.

true

PRTOG Info '-opengl' is not recommended. Use '-
image' instead, which is a direct
replacement.

true

PRTPT Info '-painters' is not recommended. Use '-
vector' instead, which is a direct
replacement.

true
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Check ID Severity Message Can Be Disabled?
FORMATNOI Warning 'format' with no input or output

arguments is not recommended. Use
'format("default")' instead.

true

INSTHWI Info 'instrhwinfo('ivi')' is not recommended.
With appropriate code changes, use
'ividriverlist' or 'ividevlist' instead.

true

INWVX Info 'instrhwinfo('vxipnp')' is not
recommended. With appropriate code
changes, use 'ividriverlist' or 'ividevlist'
instead.

true

DTRIREP Info 'TriRep' is not recommended. With
appropriate code changes, use
'triangulation' instead.

true

DDELTRI Info 'DelaunayTri' is not recommended.
With appropriate code changes, use
'delaunayTriangulation' instead.

true

DTRIINT Info 'TriScatteredInterp' is not
recommended. With appropriate code
changes, use 'scatteredInterpolant'
instead.

true

DAPPLUT Info 'applylut' is not recommended. With
appropriate code changes, use
'bwlookup' instead.

true

DBLKPRC Info 'blkproc' is not recommended. With
appropriate code changes, use
'blockproc' instead.

true

CAXIS Info 'caxis' is not recommended. Use 'clim'
instead, which is a direct replacement.

true

COMMPAMM Info 'comm.PAMModulator' is not
recommended. With appropriate code
changes, use 'pammod' instead.

true

COMMPAMD Info 'comm.PAMDemodulator' is not
recommended. With appropriate code
changes, use 'pamdemod' instead.

true

COMMSRC Info 'commsrc.pn' is not recommended.
With appropriate code changes, use
'comm.PNSequence' instead.

true

DCPTF Info 'cp2tform' is not recommended. With
appropriate code changes, use
'fitgeotrans' instead.

true

DATNM Info 'datenum' is not recommended. With
appropriate code changes, use
'datetime' instead.

true
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Check ID Severity Message Can Be Disabled?
DATST Info 'datestr' is not recommended. With

appropriate code changes, use
'datetime' instead.

true

DETIM Info 'etime' is not recommended. With
appropriate code changes, use
'datetime' and the minus operator
instead.

true

DATOD Info 'addtodate' is not recommended. With
appropriate code changes, use
'datetime', 'duration', and the plus
operator instead.

true

CLOCK Info 'clock' is not recommended. With
appropriate code changes, use
'datetime("now")' instead.

true

DATE Info 'date' is not recommended. With
appropriate code changes, use
'datetime("today")' instead.

true

WKNUM Info 'weeknum' is not recommended. With
appropriate code changes, use 'week'
with a 'datetime' input instead.

true

EMDATE Info 'eomdate' is not recommended. With
appropriate code changes, use
'dateshift' with a 'datetime' input
instead.

true

XMDATE Info 'x2mdate' is not recommended. With
appropriate code changes, use
'datetime(..., "ConvertFrom", "excel")'
instead.

true

MXDATE Info 'm2xdate' is not recommended. With
appropriate code changes, use
'exceltime' with a 'datetime' input
instead.

true

MNTHS Info 'months' is not recommended. With
appropriate code changes, use
'between' with a 'datetime' input
instead.

true

DGTORD Info 'degtorad' is not recommended. Use
'deg2rad' instead, which is a direct
replacement.

true

RDTODG Info 'radtodeg' is not recommended. Use
'rad2deg' instead, which is a direct
replacement.

true

EZCONTR Info 'ezcontour' is not recommended. With
appropriate code changes, use
'fcontour' instead.

true
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Check ID Severity Message Can Be Disabled?
EZMESH Info 'ezmesh' is not recommended. With

appropriate code changes, use 'fmesh'
instead.

true

EZPLT3 Info 'ezplot3' is not recommended. With
appropriate code changes, use 'fplot3'
instead.

true

EZSURF Info 'ezsurf' is not recommended. With
appropriate code changes, use 'fsurf'
instead.

true

DFLIPDIM Info 'flipdim' is not recommended. With
appropriate code changes, use 'flip'
instead.

true

DSTRMT Info 'str2mat' is not recommended. With
appropriate code changes, use 'char'
instead.

true

DSTSTR Info 'setstr' is not recommended. With
appropriate code changes, use 'char'
instead.

true

DSTRVCT Info 'strvcat' is not recommended. With
appropriate code changes, use 'char'
instead.

true

DISSTR Info 'isstr' is not recommended. With
appropriate code changes, use 'ischar'
instead.

true

DFTSMTX Info 'fts2mtx' is not recommended. With
appropriate code changes, use
'fts2mat' instead.

true

FISWRT Info 'writefis' is not recommended. Use
'writeFIS' instead, which is a direct
replacement.

true

FISADM Info 'addmf' is not recommended. With
appropriate code changes, use 'addMF'
instead.

true

HIST Info 'hist' is not recommended. With
appropriate code changes, use
'histogram' instead.

true

HISTC Info 'histc' is not recommended. With
appropriate code changes, use
'histcounts' instead.

true

ROSE Info 'rose' is not recommended. With
appropriate code changes, use
'polarhistogram' instead.

true

COLORDEF Info 'colordef' is not recommended. There is
no simple replacement for this.

true
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Check ID Severity Message Can Be Disabled?
GRAYMON Info 'graymon' is not recommended. There

is no simple replacement for this.
true

WHITEBG Info 'whitebg' is not recommended. There is
no simple replacement for this.

true

HDFI Info 'hdf5info' is not recommended. With
appropriate code changes, use 'h5info'
instead.

true

HDFW Info 'hdf5write' is not recommended. With
appropriate code changes, use
'h5write' instead.

true

HDFR Info 'hdf5read' is not recommended. With
appropriate code changes, use 'h5read'
instead.

true

IM2BW Info 'im2bw' is not recommended. With
appropriate code changes, use
'imbinarize' instead.

true

ISPIX Info 'pixelLabelImageSource' is not
recommended. Use
'pixelLabelImageDatastore' instead,
which is a direct replacement.

true

ISAUG Info 'augmentedImageSource' is not
recommended. Use
'augmentedImageDatastore' instead,
which is a direct replacement.

true

ISDNS Info 'denoisingImageSource' is not
recommended. Use
'denoisingImageDatastore' instead,
which is a direct replacement.

true

IMFREEH Info 'imfreehand' is not recommended. With
appropriate code changes, use
'drawfreehand' instead.

true

IMRECT Info 'imrect' is not recommended. With
appropriate code changes, use
'drawrectangle' instead.

true

IMLINE Info 'imline' is not recommended. With
appropriate code changes, use
'drawline' instead.

true

IMPNT Info 'impoint' is not recommended. With
appropriate code changes, use
'drawpoint' instead.

true

IMPOLY Info 'impoly' is not recommended. With
appropriate code changes, use
'drawpolygon' or 'drawpolyline'
instead.

true
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Check ID Severity Message Can Be Disabled?
IMELLPS Info 'imellipse' is not recommended. With

appropriate code changes, use
'drawellipse' or 'drawcircle' instead.

true

DIMTRNS Info 'imtransform' is not recommended.
With appropriate code changes, use
'imwarp' instead.

true

CSVRD Info 'csvread' is not recommended. With
appropriate code changes, use
'readtable' or 'readmatrix' instead.

true

DLMRD Info 'dlmread' is not recommended. With
appropriate code changes, use
'readtable' or 'readmatrix' instead.

true

CSVWT Info 'csvwrite' is not recommended. With
appropriate code changes, use
'writematrix' instead.

true

DLMWT Info 'dlmwrite' is not recommended. With
appropriate code changes, use
'writematrix' instead.

true

XLSRD Info 'xlsread' is not recommended. With
appropriate code changes, use
'readtable', 'readmatrix' or 'readcell'
instead.

true

XLSWT Info 'xlswrite' is not recommended. With
appropriate code changes, use
'writematrix' or 'writecell' instead.

true

ISDIR Info 'isdir' is not recommended. Use
'isfolder' instead, which is a direct
replacement.

true

DISEQN Info 'isequalwithequalnans' is not
recommended. With appropriate code
changes, use 'isequaln' instead.

true

DGCAT Info 'gcat' is not recommended. Use
'spmdCat' instead, which is a direct
replacement.

true

DGOP Info 'gop' is not recommended. Use
'spmdReduce' instead, which is a direct
replacement.

true

DGPLUS Info 'gplus' is not recommended. Use
'spmdPlus' instead, which is a direct
replacement.

true

DLABBARRIER Info 'labBarrier' is not recommended. Use
'spmdBarrier' instead, which is a direct
replacement.

true
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Check ID Severity Message Can Be Disabled?
DLABBROADCAST Info 'labBroadcast' is not recommended.

Use 'spmdBroadcast' instead, which is
a direct replacement.

true

DLABINDEX Info 'labindex' is not recommended. Use
'spmdIndex' instead, which is a direct
replacement.

true

DLABPROBE Info 'labProbe' is not recommended. Use
'spmdProbe' instead, which is a direct
replacement.

true

DLABRECEIVE Info 'labReceive' is not recommended. Use
'spmdReceive' instead, which is a
direct replacement.

true

DLABSEND Info 'labSend' is not recommended. Use
'spmdSend' instead, which is a direct
replacement.

true

DLABSENDRECEIV
E

Info 'labSendReceive' is not recommended.
Use 'spmdSendReceive' instead, which
is a direct replacement.

true

DNUMLABS Info 'numlabs' is not recommended. Use
'spmdSize' instead, which is a direct
replacement.

true

AGRED Info 'arcgridread' is not recommended. With
appropriate code changes, use
'readgeoraster' instead.

true

DDBMEX Info 'mexdebug' is not recommended. With
appropriate code changes, use 'dbmex'
instead.

true

MLNT Info 'mlint' is not recommended. Use
'checkcode' instead, which is a direct
replacement.

true

DEPNOE Info 'numberofelements' is not
recommended. With appropriate code
changes, use 'numel' instead.

true

GAOPT Info 'gaoptimset' is not recommended. With
appropriate code changes, use
'optimoptions' instead.

true

PSOPT Info 'psoptimset' is not recommended. With
appropriate code changes, use
'optimoptions' instead.

true

SAOPT Info 'saoptimset' is not recommended. With
appropriate code changes, use
'optimoptions' instead.

true

PLOTYY Info 'plotyy' is not recommended. With
appropriate code changes, use 'yyaxis'
instead.

true
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Check ID Severity Message Can Be Disabled?
POLAR Info 'polar' (MATLAB) is not recommended.

Use 'polarplot' instead.
true

PLBL Info 'polybool' is not recommended. With
appropriate code changes, use
'polyshape' instead.

true

PYVER Info 'pyversion' is not recommended. With
appropriate code changes, use 'pyenv'
instead.

true

DQUAD Info 'quad' is not recommended. With
appropriate code changes, use
'integral' instead.

true

DQUADL Info 'quadl' is not recommended. With
appropriate code changes, use
'integral' instead.

true

DQUADV Info 'quadv' is not recommended. With
appropriate code changes, use
'integral' instead.

true

DDBLQD Info 'dblquad' is not recommended. With
appropriate code changes, use
'integral2' instead.

true

DTRIQD Info 'triplequad' is not recommended. With
appropriate code changes, use
'integral3' instead.

true

DFIRRCOS Info 'firrcos' is not recommended. With
appropriate code changes, use
'rcosdesign' instead.

true

DFIRGAUSS Info 'firgauss' is not recommended. With
appropriate code changes, use
'gaussdesign' instead.

true

DGAUSSFIR Info 'gaussfir' is not recommended. With
appropriate code changes, use
'gaussdesign' instead.

true

ROIFILL Info 'roifill' is not recommended. With
appropriate code changes, use
'regionfill' instead.

true

DEPBART Info 'sigwin.barthannwin' is not
recommended. With appropriate code
changes, use 'barthannwin' instead.

true

DEPLETT Info 'sigwin.bartlett' is not recommended.
With appropriate code changes, use
'bartlett' instead.

true

DBLKMN Info 'sigwin.blackman' is not recommended.
With appropriate code changes, use
'blackman' instead.

true
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Check ID Severity Message Can Be Disabled?
DBHRRS Info 'sigwin.blackmanharris' is not

recommended. With appropriate code
changes, use 'blackmanharris' instead.

true

DBHMNWN Info 'sigwin.bohmanwin' is not
recommended. With appropriate code
changes, use 'bohmanwin' instead.

true

DCHBWN Info 'sigwin.chebwin' is not recommended.
With appropriate code changes, use
'chebwin' instead.

true

DFLTTPWN Info 'sigwin.flattopwin' is not recommended.
With appropriate code changes, use
'flattopwin' instead.

true

DGSWIN Info 'sigwin.gausswin' is not recommended.
With appropriate code changes, use
'gausswin' instead.

true

DHMMNG Info 'sigwin.hamming' is not recommended.
With appropriate code changes, use
'hamming' instead.

true

DHANN Info 'sigwin.hann' is not recommended.
With appropriate code changes, use
'hann' instead.

true

DKSER Info 'sigwin.kaiser' is not recommended.
With appropriate code changes, use
'kaiser' instead.

true

DNLWN Info 'sigwin.nuttallwin' is not recommended.
With appropriate code changes, use
'nuttallwin' instead.

true

DPNWN Info 'sigwin.parzenwin' is not
recommended. With appropriate code
changes, use 'parzenwin' instead.

true

DRCTWN Info 'sigwin.rectwin' is not recommended.
With appropriate code changes, use
'rectwin' instead.

true

DTYLRWN Info 'sigwin.taylorwin' is not recommended.
With appropriate code changes, use
'taylorwin' instead.

true

DTRNG Info 'sigwin.triang' is not recommended.
With appropriate code changes, use
'triang' instead.

true

DTKYWN Info 'sigwin.tukeywin' is not recommended.
With appropriate code changes, use
'tukeywin' instead.

true

DBURG Info 'spectrum.burg' is not recommended.
With appropriate code changes, use
'pburg' instead.

true
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Check ID Severity Message Can Be Disabled?
DCOV Info 'spectrum.cov' is not recommended.

With appropriate code changes, use
'pcov' instead.

true

DEVCTR Info 'spectrum.eigenvector' is not
recommended. With appropriate code
changes, use 'peig' instead.

true

DMCOV Info 'spectrum.mcov' is not recommended.
With appropriate code changes, use
'pmcov' instead.

true

DMTM Info 'spectrum.mtm' is not recommended.
With appropriate code changes, use
'pmtm' instead.

true

DMUSIC Info 'spectrum.music' is not recommended.
With appropriate code changes, use
'pmusic' instead.

true

DPRDGRM Info 'spectrum.periodogram' is not
recommended. With appropriate code
changes, use 'periodogram' instead.

true

DWELCH Info 'spectrum.welch' is not recommended.
With appropriate code changes, use
'pwelch' instead.

true

DYULEAR Info 'spectrum.yulear' is not recommended.
With appropriate code changes, use
'pyulear' instead.

true

COMBNK Info 'combnk' is not recommended. With
appropriate code changes, use
'nchoosek' instead.

true

NANMEAN Info 'nanmean' is not recommended. With
appropriate code changes, use 'mean'
instead.

true

NANMEDIAN Info 'nanmedian' is not recommended. With
appropriate code changes, use 'median'
instead.

true

NANMAX Info 'nanmax' is not recommended. With
appropriate code changes, use 'max'
instead.

true

NANMIN Info 'nanmin' is not recommended. With
appropriate code changes, use 'min'
instead.

true

NANSTD Info 'nanstd' is not recommended. With
appropriate code changes, use 'std'
instead.

true

NANVAR Info 'nanvar' is not recommended. With
appropriate code changes, use 'var'
instead.

true
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Check ID Severity Message Can Be Disabled?
NANCOV Info 'nancov' is not recommended. With

appropriate code changes, use 'cov'
instead.

true

NANSUM Info 'nansum' is not recommended. With
appropriate code changes, use 'sum'
instead.

true

CELLDTSET Info 'cell2dataset' is not recommended.
With appropriate code changes, use
'cell2table' instead.

true

DTSET Info 'dataset' is not recommended. With
appropriate code changes, use 'table'
instead.

true

MATDTSET Info 'mat2dataset' is not recommended.
With appropriate code changes, use
'array2table' instead.

true

STRUCTDTSET Info 'struct2dataset' is not recommended.
With appropriate code changes, use
'struct2table' instead.

true

FSTR Info 'findstr' is not recommended. With
appropriate code changes, use 'strfind'
instead.

true

DSTRRD Info 'strread' is not recommended. With
appropriate code changes, use
'textscan' instead.

true

DTXTRD Info 'textread' is not recommended. With
appropriate code changes, use
'textscan' instead.

true

SUBIMGNR Info 'subimage' is not recommended. With
appropriate code changes, use
'imshow' instead.

true

URLWR Info 'urlwrite' is not recommended. With
appropriate code changes, use
'websave' instead.

true

URLRD Info 'urlread' is not recommended. With
appropriate code changes, use
'webread' or 'webwrite' instead.

true

VEMAT Info 'vec2mat' is not recommended. With
appropriate code changes, use
'reshape' instead.

true
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Readability Improvements
Check ID Severity Message Can Be Disabled?
ASGSL Info Assignment to variable might be

unnecessary.
true

COMNL Info Newline following comma acts as a row
separator. Replace the comma with a
semicolon to make the row separation
clearer. Alternatively, use an ellipsis
(...) to continue the current row on the
next line.

true

SPERR Info ERROR takes SPRINTF-like arguments
directly.

true

SPWRN Info WARNING takes SPRINTF-like
arguments directly.

true

NCHKE Info Use NARGOUTCHK without ERROR. true
DSPSP Info 'disp(sprintf(...))' can usually be

replaced by 'fprintf(...\n)'.
true

DSPSY Info 'display(sprintf(...))' can usually be
replaced by 'fprintf(...\n)'.

true

STLOW Info In this comparison the call to UPPER/
LOWER is unnecessary.

true

FLUDLR Info For readability, consider using
rot90(x,2) instead of flipud(fliplr(x)) or
fliplr(flipud(x)).

true

RPMT1 Info For readability, consider using
'ones(x,y)' instead of 'repmat(1,x,y)'.

true

RPMT0 Info For readability, consider using
'zeros(x,y)' instead of 'repmat(0,x,y)'.

true

RPMTT Info For readability, consider using
'true(x,y)' instead of 'repmat(true,x,y)'.

true

RPMTF Info For readability, consider using
'false(x,y)' instead of 'repmat(false,x,y)'.

true

RPMTI Info For readability, consider using 'Inf(x,y)'
instead of 'repmat(Inf,x,y)'.

true

RPMTN Info For readability, consider using
'NaN(x,y)' instead of 'repmat(NaN,x,y)'.

true

PSIZE Info NUMEL(x) is usually faster than
PROD(SIZE(x)).

true

LOGL Info Use 'true' or 'false' instead of
'logical(1)' or 'logical(0)'.

true

ISCHR Info Use ISCHAR instead of comparing the
class to 'char'.

true
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Check ID Severity Message Can Be Disabled?
ISSTR Info Use ISSTRUCT instead of comparing

the class to 'struct'.
true

ISLOG Info Use ISLOGICAL instead of comparing
the class to 'logical'.

true

ISCEL Info Use ISCELL instead of comparing the
class to 'cell'.

true

IJCL Warning For improved robustness, consider
replacing i and j by 1i.

true

ISMAT Info When checking if a variable is a matrix
consider using ISMATRIX.

true

ISROW Info When checking if a variable is a row
vector consider using ISROW.

true

ISCOL Info When checking if a variable is a column
vector consider using ISCOLUMN.

true

SEPEX Warning Consider using newline, semicolon, or
comma before this statement for
readability.

true

NBRAK2 Info Use of brackets [] is unnecessary. true
MFAMB Warning Code Analyzer cannot determine

whether VAR_NAME is a variable or a
function, and assumes it is a function.

true

FVINR Info For readability, add Input attribute to
the input arguments block.

true

STREMP Info For readability, use '~contains(str1,
str2)' instead of 'isempty(strfind(str1,
str2))'.

true

STRCL1 Info For readability, use '~contains(str1,
str2)' instead of 'cellfun('isempty',
strfind(str1, str2))'.

true

STRCLFH Info For readability, use '~contains(str1,
str2)' instead of 'cellfun(@isempty,
strfind(str1, str2))'.

true

STRIFCND Info For readability, use 'contains(str1,
str2)' instead of 'strfind(str1, str2)'.

true

CHARTEN Info For readability, consider using 'newline'
instead of 'char(10)'.

true

SPRINTFN Info For readability, consider using the
'newline' function instead of
'sprintf('\n')'.

true
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Formatting Suggestions

Check ID Severity Message Can Be Disabled?
NOSEMI Info Extra semicolon is unnecessary. true
NOCOMMA Info Extra comma is unnecessary. true
NO4LP Info Parentheses are not needed in a FOR

statement.
true

NOPTS Info Add a semicolon after the statement to
hide the output (in a script).

true

NOPRT Info Add a semicolon after the statement to
hide the output (in a function).

true

PRTCAL Info Add a semicolon after the function call
to hide the output.

true

NCOMMA Info Best practice is to separate output
variables with commas.

true

Performance Improvements

Check ID Severity Message Can Be Disabled?
PFBNS Info The entire array or structure

VAR_NAME is a broadcast variable.
This might result in unnecessary
communication overhead.

true

FORFLG Info Problems would result if this FOR
keyword were replaced by PARFOR.

true

FORPF Info This FOR loop might be a candidate for
conversion to a PARFOR loop.

true

RGXP1 Info Using REGEXP(str, pattern, 'ONCE') is
faster in this case.

true

TRIM1 Info Use STRTRIM(str) instead of nesting
FLIPLR and DEBLANK calls.

true

STTOK Info Use one call to 'split' instead of calling
'strtok' in a loop.

true

TRIM2 Info Use STRTRIM(str) instead of
DEBLANK(STRJUST(str,'left')).

true

STCI Warning Use STRCMPI(str1,str2) instead of
using UPPER/LOWER in a call to
STRCMP.

true

STNCI Info Use STRNCMPI(str1,str2) instead of
using UPPER/LOWER in a call to
STRNCMP.

true

STCCS Info It appears that STRCMPI/STRNCMPI
can be replaced by a faster, case
sensitive compare.

true
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Check ID Severity Message Can Be Disabled?
FNDSB Info For array or cell array, performance

can be improved using logical indexing
instead of 'find'.

true

SFLD Info Use dynamic fieldnames with
structures instead of SETFIELD.

true

GFLD Info Use dynamic fieldnames with
structures instead of GETFIELD.

true

CCAT Info For improved performance,
concatenate cell arrays using [] instead
of extracting cell arrays and
reconstructing them.

true

AGROW Info Variable appears to change size on
every loop iteration. Consider
preallocating for speed.

true

SAGROW Info Variable appears to change size on
every loop iteration (within a script).
Consider preallocating for speed.

true

ISMT Info Using ISEMPTY is usually faster than
comparing LENGTH to 0.

true

ST2NM Info If you are operating on scalar values,
consider using STR2DOUBLE for faster
performance.

true

FLPST Info For better performance in some cases,
use SORT with the 'descend' option.

true

MXFND Info Use FIND with the 'first' or 'last'
option.

true

EFIND Info To improve performance, replace
ISEMPTY(FIND(X)) with
ISEMPTY(FIND( X, 1 )).

true

EXIST Info EXIST with two input arguments is
generally faster and clearer than with
one input argument.

true

UDIM Info Instead of using transpose (' or .'),
consider using a different DIMENSION
input argument to VAR_NAME.

true

FREAD Info FREAD(FID,...,'*char') is more efficient
than CHAR(FREAD(...)).

true

N2UNI Info Instead of using 'native2unicode' with
'fread', specify the character encoding
scheme in the call to 'fopen'.

true

TNMLP Info Move the toolbox function out of the
loop for better performance.

true
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Check ID Severity Message Can Be Disabled?
MINV Info INV(A)*b can be slower and less

accurate than A\b. Consider using A\b
for INV(A)*b or b/A for b*INV(A).

true

LAXES Info Calling AXES(h) in a loop can be slow.
Consider moving the call to AXES
outside the loop.

true

MMTC Info This use of MAT2CELL should probably
be replaced by a simpler, faster call to
NUM2CELL.

true

MRPBW Info To use less memory, replace
BWLABEL(bw) by LOGICAL(bw) in a
call of REGIONPROPS.

true

SPRIX Info This sparse indexing expression is
likely to be slow.

true

TRSRT Info Transposing the input to 'sort' is often
unnecessary.

true

CCAT1 Info { A{I} } can usually be replaced by
A(I) or A(I)', which can be much faster.

true

GRIDD Info Consider replacing GRIDDATA with
SCATTEREDINTERPOLANT for better
performance.

true

AND2 Info When both arguments are numeric
scalars, consider replacing & with &&
for performance.

true

OR2 Info When both arguments are numeric
scalars, consider replacing | with || for
performance.

true

CLALL Info Using 'clear' with the 'all' option
usually decreases code performance
and is often unnecessary.

true

CLCLS Info Using 'clear' with the 'classes' option
will decrease code performance and is
often unnecessary.

true

CLFUNC Info Using 'clear' with the 'functions' option
usually decreases code performance
and is often unnecessary.

true

CLJAVA Info Using 'clear' with the 'java' option
usually decreases code performance
and is often unnecessary.

true

CLMEX Info Using 'clear' with the 'mex' option
usually decreases code performance
and is often unnecessary.

true

RGXPI Info Using REGEXPI(str, pattern, 'ONCE') is
faster in this case.

true
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MATLAB for Code Generation Messages
Check ID Severity Message Can Be Disabled?
EMLOAD Error The output of a call to LOAD is not

assigned to a variable. For code
generation, assign the output of LOAD
to a variable without subscripting.

true

EMVDF Error Code generation requires a variable to
be fully defined through assignment
before subscripting it.

true

EMGRO Error Code generation only supports growing
the size of an array through 'end + 1'
indexing.

true

EMNODEF Error Variable might be used before it is
defined.

true

EMS2N Error Code generation does not support
'str2num'. Use 'str2double' instead.

true

PRMNOIN Error For code generation, specify a
binaryOccupancyMap object in the
constructor of the mobileRobotPRM
object.

true

EMCEL Error Fixed-point conversion does not
support cell arrays.

true

EMTC Error TRY/CATCH is unsupported for code
generation.

true

EMIMP Error Code generation does not support
import statements.

true

EMNST Error Fixed-point conversion does not
support nested functions.

true

EMSCR Error Code generation does not support
scripts.

true

EMBRK Error HDL code generation does not support
break statements.

true

EMCNT Error HDL code generation does not support
continue statements.

true

EMPFR Error HDL code generation does not support
parfor statements.

true

EMRTN Error HDL code generation does not support
return statements inside of loops.

true

EMWHL Error HDL code generation does not support
while statements.

true

EMNVFAV Error Code generation does not support
name-value input argument validation.

true

 Index of Code Analyzer Checks

7-123



Check ID Severity Message Can Be Disabled?
EMRIFAV Error Code generation does not support

repeating input argument validation.
true

MATLAB Compiler (Deployment) Messages
Check ID Severity Message Can Be Disabled?
MCCD Warning MCC use of the CD function is

problematic.
true

MCPRD Error MCC allows only one argument in the
PRINTDLG function.

true

MCHLP Error MCC does not permit the HELP
function.

true

MCKBD Error MCC does not permit the KEYBOARD
function.

true

MCSVP Error MCC does not permit the SAVEPATH
function.

true

MCMLR Warning MCC use of the MATLABROOT function
is problematic.

true

MCABF Warning MCC use of absolute file names is likely
to fail.

true

MCMFL Warning MCC allows writing .m files, but they
cannot be executed by the deployed
application.

true

MCTBX Warning MCC use of toolbox folder file names is
likely to fail.

true

MCLL Warning MCC does not allow C++ files to be
read directly using LOADLIBRARY.

true

System Objects
Check ID Severity Message Can Be Disabled?
SONUMIN Error If 'stepImpl' accepts variable number of

inputs, then you must define a
'getNumInputsImpl' method.

true

SONUMOUT Error If 'stepImpl' returns variable number of
outputs, then you must define a
'getNumOutputsImpl' method.

true

SODEPPROP Warning Dependent properties are not
supported for MATLAB System blocks.
VAR_NAME property is not included on
System block.

true
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Check ID Severity Message Can Be Disabled?
SOINITPROP Warning Initialize DiscreteState property

VAR_NAME within a 'resetImpl'
method.

true

SODFLTVAL Error Invalid initialization of DiscreteState
property VAR_NAME. Initialize
property within a 'resetImpl' method.

true

SORSRVDNM Warning VAR_NAME property is a reserved
name.

true

SOTUNPROP1 Warning Logical attribute not supported for
tunable properties on MATLAB System
blocks. VAR_NAME property is made
Nontunable on System block.

true

SOTUNPROP3 Warning Tunable properties on MATLAB System
blocks must be numeric. VAR_NAME
property is made Nontunable on
System block because it is a char.

true

SOTUNPROP4 Warning Tunable properties on MATLAB System
blocks must be numeric. VAR_NAME
property is made Nontunable on
System block because it is a string.

true

Unsupported Features
Check ID Severity Message Can Be Disabled?
MCADE Warning Using Description as an attribute is

unsupported and might have been
changed without notice or might be
removed without notice. There is no
simple replacement for this.

true

AWTIUD Warning 'awtinvoke' is unsupported and might
have been changed without notice or
might be removed without notice. With
appropriate code changes, use
javaMethodEDT instead.

true

AXCHUD Warning 'axescheck' is unsupported and might
have been changed without notice or
might be removed without notice.
There is no simple replacement for this.

true

FEATUD Warning 'feature' and flags passed to it are
unsupported and might have been
changed without notice or might be
removed without notice. There is no
simple replacement for this.

true
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Check ID Severity Message Can Be Disabled?
FNDPUD Warning 'findpackage' is unsupported and might

have been changed without notice or
might be removed without notice.
There is no simple replacement for this.

true

HGCNUD Warning 'hgconvertunits' is unsupported and
might have been changed without
notice or might be removed without
notice. There is no simple replacement
for this.

true

IMPKG Warning Functions in internal.matlab package
are unsupported and might have been
changed without notice or might be
removed without notice. There is no
simple replacement for this.

true

ISMBUD Warning 'ismembc' is unsupported and might
have been changed without notice or
might be removed without notice.
There is no simple replacement for this.

true

MIPKG Warning Functions in MATLAB's internal
packages are unsupported and might
have been changed without notice or
might be removed without notice.
There is no simple replacement for this.

true

SEPTUD Warning 'setptr' is unsupported and might have
been changed without notice or might
be removed without notice. There is no
simple replacement for this.

true

SYDEUD Warning 'system_dependent' is unsupported and
might have been changed without
notice or might be removed without
notice. There is no simple replacement
for this.

true

UIRSUD Warning 'uirestore' is unsupported and might
have been changed without notice or
might be removed without notice.
There is no simple replacement for this.

true

UISUUD Warning 'uisuspend' is unsupported and might
have been changed without notice or
might be removed without notice.
There is no simple replacement for this.

true
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Behavior Changes
Check ID Severity Message Can Be Disabled?
SHVAI Warning Explicitly define shared variables in the

parent function before calling the
nested function. MATLAB does not
share uninitialized variables between a
nested function and the parent
function.

true

LENEMP Warning Passing in text with no characters will
omit the object from appearing in the
legend. To revert to the old behavior,
use a whitespace character instead of
text with no characters.

true

INTRPC Warning 'interp1(...,'cubic')' changed in R2020b
to perform cubic convolution. To
continue using shape-preserving
piecewise cubic interpolation, use
'interp1(...,'pchip')' instead.

true

IDISVARHIGH Warning Variable must be explicitly defined
before first use. In some cases, the
definition was not required in previous
releases, but it is now required.

true

LEGPVPAIR Warning 'legend' has changed and might
interpret the name of an argument as a
legend property instead of a label. To
include a label with the same name as
a legend property, specify the labels
using a cell array or string array. Refer
to the documentation for a list of
affected property names.

true

Behavior Changes with Low Reliability Messages
Check ID Severity Message Can Be Disabled?
CLBGEN Warning Starting in R2020a, interfaces created

by 'clibgen.generateLibraryDefinition'
return clib.array object instead of the
equivalent MATLAB array for primitive
types. Notify your users to update their
code to use clib arrays. To revert to the
old behavior, call
'clibgen.generateLibraryDefinition'
with the 'ReturnCArrays' argument set
to false.

true

 Index of Code Analyzer Checks

7-127



Check ID Severity Message Can Be Disabled?
CLBBLD Warning Starting in R2020a, interfaces created

by 'clibgen.buildInterface' return
clib.array object instead of the
equivalent MATLAB array for primitive
types. Notify your users to update their
code to use clib arrays. To revert to the
old behavior, call
'clibgen.buildInterface' with the
'ReturnCArrays' argument set to false.

true

CLBARY Warning Starting in R2020a, clib.array object is
the default return value, instead of the
equivalent MATLAB array for primitive
types. Notify your user to update code
to use clib arrays. To revert to the old
behavior, call
'clibgen.generateLibraryDefinition' or
'clibgen.buildInterface' with the
'ReturnCArrays' argument set to false.

true

COLMP Warning In R2019a and previous releases, the
default colormap size is 64. Starting in
R2019b, colormaps have 256 colors by
default. If your code depends on a
colormap having 64 colors, specify the
number of colors when querying the
colormap. For example, parula(64)
queries the 64-color parula colormap.

true

FDTAG Warning 'findall' with 'Exploration.Pan',
'Exploration.ZoomIn',
'Exploration.ZoomOut',
'Exploration.DataCursor',
'Exploration.Brushing', or
'Exploration.Rotate' might return
empty because the data exploration
buttons have moved from the figure
toolbar to the axes toolbar. To
customize the axes interactions, use
the 'axtoolbar' and 'axtoolbarbtn'
functions.

true

PTCLO Warning Changing the axes LineStyleOrder or
ColorOrder properties of an existing
chart now affects the chart
immediately. To revert to the old
behavior, set either the axes
LineStyleOrderIndex or
ColorOrderIndex to any value (such as
its current value) before changing
LineStyleOrder or ColorOrder.

true
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Check ID Severity Message Can Be Disabled?
PTDLO Warning Specifying multiple line styles in the

axes LineStyleOrder might result in
charts that render differently than in
the previous releases. MATLAB uses a
new indexing scheme to select colors
and line styles. To revert to the old
behavior, set either the axes
LineStyleOrderIndex or
ColorOrderIndex to any value (such as
its current value) and call 'hold on'
before creating your chart.

true

NSTIMP Warning Nested functions now inherit import
statements from this parent function. If
the nested functions intend to call
functions on the path, ensure that the
imported packages do not contain
functions with the same name.

true

IDISVARLOW Warning To avoid a potential conflict with
functions on the path, explicitly define
the variable before indexing into it.

true

WEBBEHAVE Warning The 'web' function now opens external
sites in your system browser by default.
In a future release, 'web' will open all
pages using the system browser.
Consider specifying the '-browser'
option to open all pages in your system
browser.

true

GLGRI Warning Starting R2021a, the second output of
'geoloc2grid' is a geographic raster
reference object instead of a
referencing vector. Most Mapping
Toolbox functions that accept
referencing vectors as input also
accept geographic raster reference
objects, so existing code is unlikely to
be affected.

true

V2MTX Warning Starting R2021a, the second output of
'vec2mtx' is a geographic raster
reference object instead of a
referencing vector. '[Z,R] =
vec2mtx(LAT,LON,Z1,R1,...)' is an
exception, where R1 is a referencing
vector or matrix. Most Mapping
Toolbox functions that accept
referencing vectors as input also
accept geographic raster reference
objects, so existing code is unlikely to
be affected.

true
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Check ID Severity Message Can Be Disabled?
JAPIEXT4 Warning 'javax.security.auth' Java package and

subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT5 Warning 'javax.transaction.xa' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT7 Warning 'org.apache.el' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT8 Warning 'org.apache.juli' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT9 Warning 'org.apache.tomcat' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT10 Warning 'org.apache.xmlrpc' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT11 Warning 'org.jboss.netty' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT14 Warning 'org.ros.actionlib' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT15 Warning 'org.ros.address' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true
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Check ID Severity Message Can Be Disabled?
JAPIEXT16 Warning 'org.ros.concurrent' Java package and

subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT17 Warning 'org.ros.exception' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT18 Warning 'org.ros.gradle_plugins' Java package
and subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT19 Warning 'org.ros.internal' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT20 Warning 'org.ros.master' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT21 Warning 'org.ros.math' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT22 Warning 'org.ros.message' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT23 Warning 'org.ros.namespace' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT24 Warning 'org.ros.node' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true
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Check ID Severity Message Can Be Disabled?
JAPIEXT25 Warning 'org.ros.rosjava_geometry' Java

package and subpackages are not
available in MATLAB. To continue using
this package, install its JAR file and add
the JAR file to the static path in
MATLAB.

true

JAPIEXT26 Warning 'org.ros.tf2' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT27 Warning 'org.ros.time' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT28 Warning 'org.xbill.DNS' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT32 Warning 'ice.pilots.notsupported' Java package
and subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT33 Warning 'ice.pilots.mathml' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT34 Warning 'com.drew.metadata' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT37 Warning 'ice.pilots.domviewer' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT38 Warning 'org.jdom2.internal' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true
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Check ID Severity Message Can Be Disabled?
JAPIEXT44 Warning 'cryptix.provider.mode' Java package

and subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT47 Warning 'ice.pilots.pdf' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT50 Warning 'org.dom4j.swing' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT54 Warning 'opennlp.tools.dictionary' Java package
and subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT55 Warning 'ice.util.alg' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT63 Warning 'ice.util.awt' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT65 Warning 'opennlp.tools.stemmer' Java package
and subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT66 Warning 'opennlp.tools.ngram' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT67 Warning 'org.jsoup.select' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true
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Check ID Severity Message Can Be Disabled?
JAPIEXT80 Warning 'ice.pilots.jmf' Java package and

subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT82 Warning 'thredds.inventory.partition' Java
package and subpackages are not
available in MATLAB. To continue using
this package, install its JAR file and add
the JAR file to the static path in
MATLAB.

true

JAPIEXT84 Warning 'de.l3s.boilerpipe' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT85 Warning 'ice.pilots.es' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT88 Warning 'org.bouncycastle.pkix' Java package
and subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT90 Warning 'org.dom4j.xpath' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT91 Warning 'ice.pilots.text' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT92 Warning 'thredds.cataloggen.datasetenhancer'
Java package and subpackages are not
available in MATLAB. To continue using
this package, install its JAR file and add
the JAR file to the static path in
MATLAB.

true

JAPIEXT96 Warning 'ice.util.memory' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true
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Check ID Severity Message Can Be Disabled?
JAPIEXT98 Warning 'opennlp.tools.cmdline' Java package

and subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT103 Warning 'ice.scripters.js' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT111 Warning 'org.bouncycastle.operator' Java
package and subpackages are not
available in MATLAB. To continue using
this package, install its JAR file and add
the JAR file to the static path in
MATLAB.

true

JAPIEXT114 Warning 'opennlp.tools.chunker' Java package
and subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT115 Warning 'org.jsoup.safety' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT116 Warning 'org.bouncycastle.cert' Java package
and subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT120 Warning 'thredds.catalog2.xml' Java package
and subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT121 Warning 'thredds.catalog.dl' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT123 Warning 'net.jcip.annotations' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true
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Check ID Severity Message Can Be Disabled?
JAPIEXT134 Warning 'opennlp.tools.formats' Java package

and subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT135 Warning 'com.mchange.v1' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT138 Warning 'org.dom4j.io' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT145 Warning 'org.apache.jempbox' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT149 Warning 'org.jdom2.located' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT155 Warning 'org.jdom2.util' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT160 Warning 'ice.net.socks' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT170 Warning 'org.jsoup.examples' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT172 Warning 'org.jdom2.xpath' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true
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Check ID Severity Message Can Be Disabled?
JAPIEXT178 Warning 'com.mchange.util' Java package and

subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT181 Warning 'thredds.catalog2.builder' Java package
and subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT187 Warning 'com.drew.tools' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT192 Warning 'ice.util.security' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT195 Warning 'org.apache.james' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT198 Warning 'org.mozilla.universalchardet' Java
package and subpackages are not
available in MATLAB. To continue using
this package, install its JAR file and add
the JAR file to the static path in
MATLAB.

true

JAPIEXT206 Warning 'opennlp.tools.coref' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT207 Warning 'opennlp.tools.postag' Java package
and subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT209 Warning 'org.mozilla.javascript' Java package
and subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true
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Check ID Severity Message Can Be Disabled?
JAPIEXT211 Warning 'ice.dom.css' Java package and

subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT212 Warning 'org.mozilla.classfile' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT218 Warning 'org.dom4j.datatype' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT219 Warning 'ice.util.unit' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT230 Warning 'com.drew.imaging' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT231 Warning 'jj2000.j2k.codestream' Java package
and subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT235 Warning 'org.apache.tika' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT240 Warning 'opennlp.tools.tokenize' Java package
and subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT259 Warning 'jj2000.j2k.encoder' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true
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Check ID Severity Message Can Be Disabled?
JAPIEXT266 Warning 'org.bouncycastle.tsp' Java package

and subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT267 Warning 'com.cybozu.labs' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT271 Warning 'org.jdom2.input' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT274 Warning 'ice.storm.print' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT277 Warning 'org.dom4j.jaxb' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT294 Warning 'org.apache.ftpserver' Java package
and subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT301 Warning 'thredds.catalog2.simpleImpl' Java
package and subpackages are not
available in MATLAB. To continue using
this package, install its JAR file and add
the JAR file to the static path in
MATLAB.

true

JAPIEXT312 Warning 'thredds.catalog2.util' Java package
and subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT315 Warning 'com.rometools.utils' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true
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Check ID Severity Message Can Be Disabled?
JAPIEXT316 Warning 'ice.util.encoding' Java package and

subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT317 Warning 'com.mchange.lang' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT320 Warning 'ice.net.pac' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT321 Warning 'cryptix.util.core' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT326 Warning 'thredds.catalog.crawl' Java package
and subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT327 Warning 'thredds.catalog.query' Java package
and subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT331 Warning 'ice.dom.html' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT336 Warning 'ice.pilots.applet' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT343 Warning 'jj2000.j2k.wavelet' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true
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Check ID Severity Message Can Be Disabled?
JAPIEXT348 Warning 'org.bouncycastle.cms' Java package

and subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT353 Warning 'ice.net.mailto' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT358 Warning 'jj2000.j2k.util' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT360 Warning 'jj2000.j2k.quantization' Java package
and subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT364 Warning 'com.coremedia.iso' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT369 Warning 'thredds.cataloggen.catalogrefexpande
r' Java package and subpackages are
not available in MATLAB. To continue
using this package, install its JAR file
and add the JAR file to the static path
in MATLAB.

true

JAPIEXT380 Warning 'com.optimaize.langdetect' Java
package and subpackages are not
available in MATLAB. To continue using
this package, install its JAR file and add
the JAR file to the static path in
MATLAB.

true

JAPIEXT381 Warning 'net.arnx.jsonic' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true
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JAPIEXT390 Warning 'schemaorg_apache_xmlbeans.system.s

F1327CCA741569E70F9CA8C9AF9B44
B2' Java package and subpackages are
not available in MATLAB. To continue
using this package, install its JAR file
and add the JAR file to the static path
in MATLAB.

true

JAPIEXT394 Warning 'xjava.security.interfaces' Java package
and subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT398 Warning 'org.dom4j.util' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT403 Warning 'org.bouncycastle.pkcs' Java package
and subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT405 Warning 'org.bouncycastle.dvcs' Java package
and subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT408 Warning 'se.fishtank.css' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT409 Warning 'ice.net.doc' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT411 Warning 'com.adobe.xmp' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT416 Warning 'opennlp.tools.namefind' Java package
and subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true
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JAPIEXT420 Warning 'opennlp.tools.doccat' Java package and

subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT426 Warning 'thredds.cataloggen.config' Java
package and subpackages are not
available in MATLAB. To continue using
this package, install its JAR file and add
the JAR file to the static path in
MATLAB.

true

JAPIEXT428 Warning 'org.bouncycastle.mozilla' Java package
and subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT430 Warning 'opennlp.tools.util' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT442 Warning 'jj2000.j2k.roi' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT447 Warning 'org.dom4j.dom' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT449 Warning 'jj2000.j2k.entropy' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT451 Warning 'org.bouncycastle.eac' Java package
and subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT453 Warning 'org.jdom2.adapters' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true
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JAPIEXT459 Warning 'thredds.inventory.filter' Java package

and subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT466 Warning 'opennlp.maxent.io' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT467 Warning 'net.didion.jwnl' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT470 Warning 'cryptix.provider.rsa' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT477 Warning 'ice.pilots.image' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT485 Warning 'jj2000.j2k.fileformat' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT486 Warning 'org.bouncycastle.mail' Java package
and subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT487 Warning 'opennlp.tools.lang' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT495 Warning 'cryptix.provider.cipher' Java package
and subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true
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JAPIEXT502 Warning 'ice.util.net' Java package and

subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT503 Warning 'jj2000.j2k.image' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT505 Warning 'ice.util.io' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT510 Warning 'com.mchange.v2' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT511 Warning 'org.dom4j.rule' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT517 Warning 'be.frma.langguess' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT521 Warning 'cryptix.provider.key' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT523 Warning 'thredds.crawlabledataset.filter' Java
package and subpackages are not
available in MATLAB. To continue using
this package, install its JAR file and add
the JAR file to the static path in
MATLAB.

true

JAPIEXT533 Warning 'thredds.cataloggen.inserter' Java
package and subpackages are not
available in MATLAB. To continue using
this package, install its JAR file and add
the JAR file to the static path in
MATLAB.

true
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JAPIEXT535 Warning 'jj2000.j2k.decoder' Java package and

subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT536 Warning 'org.dom4j.bean' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT540 Warning 'org.bouncycastle.openssl' Java
package and subpackages are not
available in MATLAB. To continue using
this package, install its JAR file and add
the JAR file to the static path in
MATLAB.

true

JAPIEXT547 Warning 'ice.net.proxy' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT548 Warning 'org.dom4j.tree' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT556 Warning 'org.jdom2.filter' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT557 Warning 'uk.ac.rdg' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT562 Warning 'org.jdom2.output' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT563 Warning 'org.apache.sis' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true
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JAPIEXT564 Warning 'org.dom4j.xpp' Java package and

subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT590 Warning 'org.json.zip' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT598 Warning 'opennlp.tools.sentdetect' Java package
and subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT601 Warning 'com.rometools.rome' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT603 Warning 'com.drew.lang' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT604 Warning 'thredds.crawlabledataset.sorter' Java
package and subpackages are not
available in MATLAB. To continue using
this package, install its JAR file and add
the JAR file to the static path in
MATLAB.

true

JAPIEXT605 Warning 'ice.util.image' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT611 Warning 'thredds.catalog.util' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT614 Warning 'org.bouncycastle.voms' Java package
and subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true
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JAPIEXT618 Warning 'org.jsoup.helper' Java package and

subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT627 Warning 'ice.util.swing' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT635 Warning 'org.cometd.client' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT637 Warning 'ice.pilots.pdfgo' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT638 Warning 'org.json.simple' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT639 Warning 'org.jsoup.nodes' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT643 Warning 'ice.pilots.svg' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT644 Warning 'thredds.catalog.parser' Java package
and subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT647 Warning 'org.ccil.cowan' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true
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JAPIEXT655 Warning 'jj2000.j2k.io' Java package and

subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT661 Warning 'org.dom4j.dtd' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT668 Warning 'org.jdom2.transform' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT670 Warning 'cryptix.provider.md' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT671 Warning 'opennlp.tools.parser' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT683 Warning 'ice.pilots.html4' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT686 Warning 'opennlp.maxent.quasinewton' Java
package and subpackages are not
available in MATLAB. To continue using
this package, install its JAR file and add
the JAR file to the static path in
MATLAB.

true

JAPIEXT688 Warning 'org.jsoup.parser' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT697 Warning 'org.itadaki.bzip2' Java package and
subpackages are not available in
MATLAB. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true
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JAPIEXT781 Warning 'org.springframework.jms' Java

package and subpackages are not
available in MATLAB. To continue using
this package, install its JAR file and add
the JAR file to the static path in
MATLAB.

true

JAPIEXT787 Warning 'org.springframework.messaging' Java
package and subpackages are not
available in MATLAB. To continue using
this package, install its JAR file and add
the JAR file to the static path in
MATLAB.

true

JAPIEXT791 Warning 'org.springframework.oxm' Java
package and subpackages are not
available in MATLAB. To continue using
this package, install its JAR file and add
the JAR file to the static path in
MATLAB.

true

Upcoming Behavior Changes with Low Reliability Messages
Check ID Severity Message Can Be Disabled?
JAPIEXT1 Warning 'com.teamdev.jxbrowser' Java package

and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT2 Warning 'javax.annotation.security' Java
package and subpackages will not be
available in MATLAB in a future
release. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT3 Warning 'javax.annotation.sql' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT6 Warning 'javax.websocket.server' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true
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JAPIEXT12 Warning 'org.jdesktop.layout' Java package and

subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT13 Warning 'org.jdesktop.swingx' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT29 Warning 'org.jmol.quantum' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT30 Warning 'com.jidesoft.icons' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT31 Warning 'com.sun.jini' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT35 Warning 'javax.xml.namespace' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT36 Warning 'javax.xml.stream' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true
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JAPIEXT39 Warning 'org.hamcrest.collection' Java package

and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT40 Warning 'org.openxml4j.opc' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT41 Warning 'net.jini.entry' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT42 Warning 'org.apache.html' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT43 Warning 'org.eclipse.paho' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT45 Warning 'info.clearthought.layout' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT46 Warning 'org.antlr.misc' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true
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JAPIEXT48 Warning 'org.powermock.configuration' Java

package and subpackages will not be
available in MATLAB in a future
release. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT49 Warning 'javax.mail.util' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT51 Warning 'com.thaiopensource.validate' Java
package and subpackages will not be
available in MATLAB in a future
release. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT52 Warning 'org.opengis.webservice' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT53 Warning 'com.google.common' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT56 Warning 'org.jmol.multitouch' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT57 Warning 'freemarker.ext.jython' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true
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JAPIEXT58 Warning 'org.h2.store' Java package and

subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT59 Warning 'com.google.protobuf' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT60 Warning 'org.h2.util' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT61 Warning 'org.jaxen.expr' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT62 Warning 'org.jmol.minimize' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT64 Warning 'schemaorg_apache_xmlbeans.system.s
8C3F193EE11A2F798ACF65489B9E60
78' Java package and subpackages will
not be available in MATLAB in a future
release. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT68 Warning 'org.antlr.codegen' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true
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JAPIEXT69 Warning 'org.mockito.listeners' Java package

and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT70 Warning 'org.h2.result' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT71 Warning 'com.jogamp.newt' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT72 Warning 'org.mockito.mock' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT73 Warning 'org.opengis.filter' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT74 Warning 'org.drizzle.jdbc' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT75 Warning 'org.jmol.bspt' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true
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JAPIEXT76 Warning 'org.h2.constraint' Java package and

subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT77 Warning 'org.powermock.tests' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT78 Warning 'org.h2.tools' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT79 Warning 'javassist.bytecode.annotation' Java
package and subpackages will not be
available in MATLAB in a future
release. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT81 Warning 'org.h2.jdbc' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT83 Warning 'org.mockito.quality' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT86 Warning 'javax.servlet.http' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true
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JAPIEXT87 Warning 'org.geotools.event' Java package and

subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT89 Warning 'org.mockito.hamcrest' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT93 Warning 'javax.mail.event' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT94 Warning 'com.jgoodies.looks' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT95 Warning 'com.graphbuilder.math' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT97 Warning 'org.jmol.translation' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT99 Warning 'mwhtmlguitest.org.apache' Java
package and subpackages will not be
available in MATLAB in a future
release. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true
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JAPIEXT100 Warning 'javax.mail.search' Java package and

subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT101 Warning 'net.sf.cglib' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT102 Warning 'org.powermock.core' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT104 Warning 'org.geotools.resources' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT105 Warning 'org.openxml4j.samples' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT106 Warning 'org.w3c.css' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT107 Warning 'org.cef.handler' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true
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JAPIEXT108 Warning 'org.mortbay.jetty' Java package and

subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT109 Warning 'org.bouncycastle.i18n' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT110 Warning 'jogamp.nativewindow.awt' Java
package and subpackages will not be
available in MATLAB in a future
release. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT112 Warning 'schemaorg_apache_xmlbeans.system.s
XMLSCHEMA' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT113 Warning 'com.jidesoft.popup' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT117 Warning 'org.apache.batik' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT118 Warning 'org.jmol.shapespecial' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true
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JAPIEXT119 Warning 'net.jpountz.xxhash' Java package and

subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT122 Warning 'org.apache.axis2' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT124 Warning 'com.jogamp.opengl' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT125 Warning 'com.reuters.sdist' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT126 Warning 'org.jmol.adapter' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT127 Warning 'org.jaxen.dom' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT128 Warning 'org.aopalliance.intercept' Java
package and subpackages will not be
available in MATLAB in a future
release. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true
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JAPIEXT129 Warning 'org.jaxen.util' Java package and

subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT130 Warning 'jogamp.opengl.gl4' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT131 Warning 'com.thaiopensource.datatype' Java
package and subpackages will not be
available in MATLAB in a future
release. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT132 Warning 'com.jidesoft.awt' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT133 Warning 'com.graphbuilder.curve' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT136 Warning 'com.lowagie.tools' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT137 Warning 'org.jacoco.ant' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true
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JAPIEXT139 Warning 'org.objenesis.instantiator' Java

package and subpackages will not be
available in MATLAB in a future
release. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT140 Warning 'net.jini.event' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT141 Warning 'edu.uci.ics' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT142 Warning 'org.geotools.parameter' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT143 Warning 'com.googlecode.javaewah32' Java
package and subpackages will not be
available in MATLAB in a future
release. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT144 Warning 'org.jaxen.function' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT146 Warning 'com.jidesoft.spinner' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true
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JAPIEXT147 Warning 'org.mockito.exceptions' Java package

and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT148 Warning 'org.objectweb.asm' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT150 Warning 'org.mortbay.xml' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT151 Warning 'antlr.debug.misc' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT152 Warning 'javax.servlet.annotation' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT153 Warning 'net.jini.space' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT154 Warning 'org.apache.http' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true
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JAPIEXT156 Warning 'org.antlr.stringtemplate' Java package

and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT157 Warning 'com.graphbuilder.geom' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT158 Warning 'antlr.actions.python' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT159 Warning 'org.eclipse.core' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT161 Warning 'org.w3c.dom' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT162 Warning 'javassist.tools.reflect' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT163 Warning 'com.jidesoft.range' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true
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JAPIEXT164 Warning 'org.jdom.transform' Java package and

subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT165 Warning 'org.mockito.stubbing' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT166 Warning 'org.iso_relax.ant' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT167 Warning 'org.eclipse.xtend2' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT168 Warning 'jogamp.newt.event' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT169 Warning 'org.bouncycastle.x509' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT171 Warning 'jogamp.graph.font' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true
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JAPIEXT173 Warning 'org.apache.mina' Java package and

subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT174 Warning 'org.jaxen.xom' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT175 Warning 'org.geotools.factory' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT176 Warning 'javax.xml.datatype' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT177 Warning 'net.jini.lookup' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT179 Warning 'org.eclipse.osgi' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT180 Warning 'abbot.editor.recorder' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true
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JAPIEXT182 Warning 'org.h2.mvstore' Java package and

subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT183 Warning 'org.mortbay.resource' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT184 Warning 'jogamp.opengl.awt' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT185 Warning 'jogamp.opengl.x11' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT186 Warning 'org.tanukisoftware.wrapper' Java
package and subpackages will not be
available in MATLAB in a future
release. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT188 Warning 'org.geotools.map' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT189 Warning 'org.cyberneko.html' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true
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JAPIEXT190 Warning 'org.openxmlformats.schemas' Java

package and subpackages will not be
available in MATLAB in a future
release. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT191 Warning 'com.reuters.rmtes' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT193 Warning 'net.bytebuddy.utility' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT194 Warning 'freemarker.ext.jsp' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT196 Warning 'org.jmol.export' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT197 Warning 'org.jmol.symmetry' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT199 Warning 'org.mockito.plugins' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true
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JAPIEXT200 Warning 'org.mockito.verification' Java package

and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT201 Warning 'com.sun.common' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT202 Warning 'jogamp.common.jvm' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT203 Warning 'org.geotools.gml' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT204 Warning 'org.hamcrest.internal' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT205 Warning 'freemarker.ext.util' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT208 Warning 'net.jini.discovery' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true
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JAPIEXT210 Warning 'org.h2.jmx' Java package and

subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT213 Warning 'net.jini.io' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT214 Warning 'antlr.actions.csharp' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT215 Warning 'javassist.bytecode.analysis' Java
package and subpackages will not be
available in MATLAB in a future
release. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT216 Warning 'javax.xml.transform' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT217 Warning 'abbot.editor.actions' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT220 Warning 'org.jacoco.report' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true
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JAPIEXT221 Warning 'org.powermock.reflect' Java package

and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT222 Warning 'jogamp.opengl.macosx' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT223 Warning 'org.apache.xmlcommons' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT224 Warning 'org.jaxen.javabean' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT225 Warning 'net.sf.xslthl' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT226 Warning 'org.mockito.codegen' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT227 Warning 'net.jini.activation' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true
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JAPIEXT228 Warning 'net.bytebuddy.matcher' Java package

and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT229 Warning 'net.bytebuddy.dynamic' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT232 Warning 'org.jmol.popup' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT233 Warning 'org.mockito.invocation' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT234 Warning 'org.hamcrest.number' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT236 Warning 'org.openxml4j.document' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT237 Warning 'freemarker.ext.jdom' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true
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JAPIEXT238 Warning 'org.geotools.feature' Java package and

subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT239 Warning 'org.eclipse.jgit' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT241 Warning 'org.h2.server' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT242 Warning 'javolution.util.stripped' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT243 Warning 'net.jini.security' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT244 Warning 'com.jidesoft.csv' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT245 Warning 'org.tmatesoft.svn' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true
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JAPIEXT246 Warning 'freemarker.ext.xml' Java package and

subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT247 Warning 'org.antlr.grammar' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT248 Warning 'com.jidesoft.field' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT249 Warning 'jogamp.nativewindow.windows' Java
package and subpackages will not be
available in MATLAB in a future
release. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT250 Warning 'jogamp.nativewindow.macosx' Java
package and subpackages will not be
available in MATLAB in a future
release. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT251 Warning 'org.geotools.coverage' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT252 Warning 'org.h2.bnf' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true
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JAPIEXT253 Warning 'org.h2.jdbcx' Java package and

subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT254 Warning 'org.mockito.session' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT255 Warning 'org.powermock.mockpolicies' Java
package and subpackages will not be
available in MATLAB in a future
release. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT256 Warning 'jogamp.common.os' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT257 Warning 'org.apache.fontbox' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT258 Warning 'net.jini.core' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT260 Warning 'org.apache.taglibs' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true
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JAPIEXT261 Warning 'org.jacoco.agent' Java package and

subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT262 Warning 'freemarker.ext.servlet' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT263 Warning 'jogamp.opengl.gl2' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT264 Warning 'com.thaiopensource.relaxng' Java
package and subpackages will not be
available in MATLAB in a future
release. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT265 Warning 'org.h2.security' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT268 Warning 'org.geotools.measure' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT269 Warning 'org.jmol.smiles' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true
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JAPIEXT270 Warning 'org.cometd.websocket' Java package

and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT272 Warning 'com.sparshui.inputdevice' Java
package and subpackages will not be
available in MATLAB in a future
release. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT273 Warning 'abbot.editor.editors' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT275 Warning 'org.jmol.api' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT276 Warning 'org.eclipse.xtext' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT278 Warning 'org.etsi.uri' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT279 Warning 'org.opengis.spatialschema' Java
package and subpackages will not be
available in MATLAB in a future
release. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true
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JAPIEXT280 Warning 'org.opengis.feature' Java package and

subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT281 Warning 'org.jmol.console' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT282 Warning 'com.vividsolutions.jts' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT283 Warning 'org.apache.ws' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT284 Warning 'com.intel.bluetooth' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT285 Warning 'com.jidesoft.alert' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT286 Warning 'org.iso_relax.dispatcher' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true
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JAPIEXT287 Warning 'org.antlr.gunit' Java package and

subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT288 Warning 'jogamp.newt.swt' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT289 Warning 'com.jidesoft.margin' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT290 Warning 'org.geotools.data' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT291 Warning 'org.cef.browser' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT292 Warning 'com.jogamp.graph' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT293 Warning 'org.geotools.io' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true
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JAPIEXT295 Warning 'org.apache.jasper' Java package and

subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT296 Warning 'com.thoughtworks.xstream' Java
package and subpackages will not be
available in MATLAB in a future
release. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT297 Warning 'org.apache.commons' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT298 Warning 'org.h2.command' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT299 Warning 'org.geotools.geometry' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT300 Warning 'com.vladium.jcd' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT302 Warning 'org.junit.internal' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true
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JAPIEXT303 Warning 'org.powermock.api' Java package and

subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT304 Warning 'net.sf.saxon' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT305 Warning 'org.jmol.atomdata' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT306 Warning 'com.bloomberglp.blpapi' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT307 Warning 'com.reuters.io' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT308 Warning 'com.almworks.sqlite4java' Java
package and subpackages will not be
available in MATLAB in a future
release. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT309 Warning 'org.bouncycastle.crypto' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true
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JAPIEXT310 Warning 'freemarker.debug.impl' Java package

and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT311 Warning 'javax.servlet.descriptor' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT313 Warning 'com.sun.midp' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT314 Warning 'com.jidesoft.utils' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT318 Warning 'javax.mail.internet' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT319 Warning 'abbot.script.parsers' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT322 Warning 'com.vladium.logging' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true
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JAPIEXT323 Warning 'freemarker.ext.ant' Java package and

subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT324 Warning 'schemaorg_apache_xmlbeans.system.s
XMLLANG' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT325 Warning 'org.aopalliance.aop' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT328 Warning 'org.h2.message' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT329 Warning 'com.jogamp.common' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT330 Warning 'org.openscience.jmol' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT332 Warning 'javax.xml.validation' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true
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JAPIEXT333 Warning 'org.eclipse.jdt' Java package and

subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT334 Warning 'org.mortbay.start' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT335 Warning 'javax.wsdl.extensions' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT337 Warning 'org.opengis.metadata' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT338 Warning 'org.slf4j.impl' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT339 Warning 'org.h2.index' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT340 Warning 'org.jmol.modelkit' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true
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JAPIEXT341 Warning 'com.jidesoft.jdk' Java package and

subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT342 Warning 'com.jidesoft.navigation' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT344 Warning 'freemarker.ext.beans' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT345 Warning 'org.eclipse.e4' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT346 Warning 'org.junit.runner' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT347 Warning 'org.apache.xmlgraphics' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT349 Warning 'com.jidesoft.pane' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true
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JAPIEXT350 Warning 'org.hamcrest.generator' Java package

and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT351 Warning 'org.iso_relax.verifier' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT352 Warning 'org.bouncycastle.jce' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT354 Warning 'org.opengis.coverage' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT355 Warning 'org.antlr.tool' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT356 Warning 'org.mortbay.thread' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT357 Warning 'org.mortbay.naming' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true
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JAPIEXT359 Warning 'com.jidesoft.grouper' Java package

and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT361 Warning 'jogamp.opengl.windows' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT362 Warning 'org.tmatesoft.sqljet' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT363 Warning 'org.geotools.xml' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT365 Warning 'org.cef.network' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT366 Warning 'antlr.actions.cpp' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT367 Warning 'org.w3.x2000' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true
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JAPIEXT368 Warning 'net.bytebuddy.description' Java

package and subpackages will not be
available in MATLAB in a future
release. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT370 Warning 'org.cometd.server' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT371 Warning 'org.h2.value' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT372 Warning 'org.opengis.referencing' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT373 Warning 'org.antlr.analysis' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT374 Warning 'org.openxml4j.util' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT375 Warning 'com.vladium.util' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true
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JAPIEXT376 Warning 'net.jini.loader' Java package and

subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT377 Warning 'org.apache.axiom' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT378 Warning 'org.jmol.script' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT379 Warning 'org.hamcrest.integration' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT382 Warning 'com.jogamp.gluegen' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT383 Warning 'com.reuters.sticapi' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT384 Warning 'com.reuters.ansi' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true
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Check ID Severity Message Can Be Disabled?
JAPIEXT385 Warning 'org.opengis.layer' Java package and

subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT386 Warning 'org.jdom.input' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT387 Warning 'com.jidesoft.wizard' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT388 Warning 'org.easymock.cglib' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT389 Warning 'javax.microedition.io' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT391 Warning 'net.jini.jeri' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT392 Warning 'com.graphbuilder.struc' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true
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Check ID Severity Message Can Be Disabled?
JAPIEXT393 Warning 'net.jini.id' Java package and

subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT395 Warning 'com.sun.enterprise' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT396 Warning 'javassist.tools.web' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT397 Warning 'org.cometd.bayeux' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT399 Warning 'jogamp.newt.driver' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT400 Warning 'javax.xml.xquery' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT401 Warning 'org.bouncycastle.util' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true
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JAPIEXT402 Warning 'org.jdom.xpath' Java package and

subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT404 Warning 'org.xml.sax' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT406 Warning 'junit.extensions.abbot' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT407 Warning 'org.junit.matchers' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT410 Warning 'org.osgi.service' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT412 Warning 'org.mockito.configuration' Java
package and subpackages will not be
available in MATLAB in a future
release. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT413 Warning 'org.eclipse.ui' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true
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JAPIEXT414 Warning 'org.opengis.go' Java package and

subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT415 Warning 'org.opengis.sld' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT417 Warning 'javax.wsdl.factory' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT418 Warning 'jogamp.opengl.es3' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT419 Warning 'org.apache.wml' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT421 Warning 'com.sun.java' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT422 Warning 'org.geotools.catalog' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true
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JAPIEXT423 Warning 'org.mockito.runners' Java package and

subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT424 Warning 'com.ibm.oti' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT425 Warning 'antlr.collections.impl' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT427 Warning 'org.slf4j.helpers' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT429 Warning 'org.osgi.framework' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT431 Warning 'org.apache.xerces' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT432 Warning 'com.sun.appserv' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true
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Check ID Severity Message Can Be Disabled?
JAPIEXT433 Warning 'org.mockito.internal' Java package and

subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT434 Warning 'org.tartarus.snowball' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT435 Warning 'org.cometd.common' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT436 Warning 'com.trilead.ssh2' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT437 Warning 'org.hamcrest.beans' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT438 Warning 'de.regnis.q' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT439 Warning 'org.h2.fulltext' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true
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JAPIEXT440 Warning 'org.h2.upgrade' Java package and

subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT441 Warning 'org.easymock.asm' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT443 Warning 'ca.odell.glazedlists' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT444 Warning 'javax.xml.xpath' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT445 Warning 'org.bouncycastle.math' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT446 Warning 'org.apache.lucene' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT448 Warning 'javassist.compiler.ast' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

7 Editor Preferences

7-196



Check ID Severity Message Can Be Disabled?
JAPIEXT450 Warning 'com.jidesoft.hints' Java package and

subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT452 Warning 'org.h2.schema' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT454 Warning 'org.mortbay.util' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT455 Warning 'org.jmol.i18n' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT456 Warning 'jogamp.graph.curve' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT457 Warning 'com.jidesoft.chart' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT458 Warning 'com.jidesoft.grid' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true
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JAPIEXT460 Warning 'org.jaxen.saxpath' Java package and

subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT461 Warning 'org.slf4j.spi' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT462 Warning 'jogamp.opengl.util' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT463 Warning 'com.jidesoft.gauge' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT464 Warning 'com.jgoodies.forms' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT465 Warning 'com.jidesoft.shortcut' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT468 Warning 'com.icl.saxon' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true
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JAPIEXT469 Warning 'javassist.tools.rmi' Java package and

subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT471 Warning 'org.geotools.referencing' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT472 Warning 'org.opengis.temporal' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT473 Warning 'javassist.util.proxy' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT474 Warning 'org.jmol.shapebio' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT475 Warning 'org.mortbay.log' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT476 Warning 'com.google.gson' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true
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JAPIEXT478 Warning 'org.iso_relax.catalog' Java package

and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT479 Warning 'com.jidesoft.combobox' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT480 Warning 'org.opengis.parameter' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT481 Warning 'org.geotools.metadata' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT482 Warning 'jogamp.common.util' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT483 Warning 'com.googlecode.javaewah' Java
package and subpackages will not be
available in MATLAB in a future
release. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT484 Warning 'org.mockito.creation' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

7 Editor Preferences

7-200



Check ID Severity Message Can Be Disabled?
JAPIEXT488 Warning 'net.jini.config' Java package and

subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT489 Warning 'net.bytebuddy.implementation' Java
package and subpackages will not be
available in MATLAB in a future
release. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT490 Warning 'org.intellij.lang' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT491 Warning 'org.jmol.g3d' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT492 Warning 'org.objenesis.strategy' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT493 Warning 'org.eclipse.emf' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT494 Warning 'org.cef.callback' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true
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JAPIEXT496 Warning 'abbot.editor.widgets' Java package and

subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT497 Warning 'net.bytebuddy.jar' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT498 Warning 'org.eclipse.elk' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT499 Warning 'org.opengis.util' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT500 Warning 'org.jdom.filter' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT501 Warning 'net.jini.export' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT504 Warning 'org.geotools.util' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true
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JAPIEXT506 Warning 'org.h2.expression' Java package and

subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT507 Warning 'org.mortbay.servlet' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT508 Warning 'org.jmol.modelset' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT509 Warning 'org.apache.log4j' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT512 Warning 'freemarker.ext.rhino' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT513 Warning 'org.bouncycastle.pqc' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT514 Warning 'jogamp.newt.awt' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true
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JAPIEXT515 Warning 'com.google.inject' Java package and

subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT516 Warning 'org.jmol.modelsetbio' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT518 Warning 'com.jidesoft.dialog' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT519 Warning 'net.bytebuddy.build' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT520 Warning 'schemaorg_apache_xmlbeans.system.s
XMLTOOLS' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT522 Warning 'org.apache.xml' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT524 Warning 'org.antlr.runtime' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true
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JAPIEXT525 Warning 'jogamp.opengl.egl' Java package and

subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT526 Warning 'org.geotools.nature' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT527 Warning 'org.junit.runners' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT528 Warning 'com.microsoft.schemas' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT529 Warning 'org.mortbay.component' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT530 Warning 'org.apache.neethi' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT531 Warning 'org.apache.tools' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true
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JAPIEXT532 Warning 'com.reuters.rfa' Java package and

subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT534 Warning 'org.codehaus.stax2' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT537 Warning 'org.apache.xmpbox' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT538 Warning 'org.jdom.adapters' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT539 Warning 'net.jini.admin' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT541 Warning 'com.sun.jna' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT542 Warning 'net.jini.url' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true
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JAPIEXT543 Warning 'org.mortbay.io' Java package and

subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT544 Warning 'org.geotools.filter' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT545 Warning 'org.jaxen.jdom' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT546 Warning 'com.graphbuilder.org' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT549 Warning 'org.h2.engine' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT550 Warning 'org.apache.xmlbeans' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT551 Warning 'com.jidesoft.tree' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true
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JAPIEXT552 Warning 'jp.gr.xml' Java package and

subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT553 Warning 'com.lowagie.bc' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT554 Warning 'org.h2.table' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT555 Warning 'org.geotools.styling' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT558 Warning 'com.google.thirdparty' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT559 Warning 'com.jidesoft.marker' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT560 Warning 'org.junit.experimental' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true
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JAPIEXT561 Warning 'com.sun.el' Java package and

subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT565 Warning 'org.geotools.image' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT566 Warning 'org.jdom.output' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT567 Warning 'org.hamcrest.core' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT568 Warning 'javassist.bytecode.stackmap' Java
package and subpackages will not be
available in MATLAB in a future
release. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT569 Warning 'javax.wsdl.xml' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT570 Warning 'jogamp.graph.geom' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true
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JAPIEXT571 Warning 'com.sparshui.common' Java package

and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT572 Warning 'com.thaiopensource.xml' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT573 Warning 'org.openxml4j.exceptions' Java
package and subpackages will not be
available in MATLAB in a future
release. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT574 Warning 'jogamp.nativewindow.jawt' Java
package and subpackages will not be
available in MATLAB in a future
release. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT575 Warning 'org.h2.compress' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT576 Warning 'net.jini.constraint' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT577 Warning 'org.w3c.xsl' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true
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JAPIEXT578 Warning 'net.jini.iiop' Java package and

subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT579 Warning 'com.ibm.wsdl' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT580 Warning 'org.jetbrains.annotations' Java
package and subpackages will not be
available in MATLAB in a future
release. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT581 Warning 'org.geotools.math' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT582 Warning 'com.jidesoft.status' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT583 Warning 'org.easymock.internal' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT584 Warning 'com.jidesoft.swing' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

 Index of Code Analyzer Checks

7-211



Check ID Severity Message Can Be Disabled?
JAPIEXT585 Warning 'com.silveregg.wrapper' Java package

and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT586 Warning 'org.jacoco.asm' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT587 Warning 'org.apache.pdfbox' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT588 Warning 'jogamp.opengl.glu' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT589 Warning 'Acme.JPM.Encoders' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT591 Warning 'com.jidesoft.action' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT592 Warning 'org.bouncycastle.jcajce' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true
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JAPIEXT593 Warning 'com.reuters.ts1' Java package and

subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT594 Warning 'org.jaxen.pattern' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT595 Warning 'com.sparshui.server' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT596 Warning 'org.jmol.shapesurface' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT597 Warning 'org.bouncycastle.asn1' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT599 Warning 'org.jaxen.dom4j' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT600 Warning 'net.jpountz.lz4' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true
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JAPIEXT602 Warning 'org.eclipse.jetty' Java package and

subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT606 Warning 'net.bytebuddy.asm' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT607 Warning 'org.jacoco.core' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT608 Warning 'com.jcraft.jsch' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT609 Warning 'com.jidesoft.tooltip' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT610 Warning 'com.sparshui.client' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT612 Warning 'org.powermock.classloading' Java
package and subpackages will not be
available in MATLAB in a future
release. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true
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JAPIEXT613 Warning 'org.hamcrest.text' Java package and

subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT615 Warning 'com.jidesoft.validation' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT616 Warning 'com.lowagie.text' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT617 Warning 'net.jpountz.util' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT619 Warning 'org.hamcrest.xml' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT620 Warning 'org.hamcrest.object' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT621 Warning 'org.osgi.util' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true
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JAPIEXT622 Warning 'org.jmol.shape' Java package and

subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT623 Warning 'com.jidesoft.introspector' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT624 Warning 'org.mockito.junit' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT625 Warning 'com.reuters.ipc' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT626 Warning 'com.jidesoft.lucene' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT628 Warning 'org.jmol.jvxl' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT629 Warning 'javax.xml.parsers' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

7 Editor Preferences

7-216



Check ID Severity Message Can Be Disabled?
JAPIEXT630 Warning 'org.relaxng.datatype' Java package

and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT631 Warning 'com.fasterxml.jackson' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT632 Warning 'com.jidesoft.filter' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT633 Warning 'org.cef.misc' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT634 Warning 'com.jidesoft.docking' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT636 Warning 'com.sun.org' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT640 Warning 'net.bytebuddy.agent' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true
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JAPIEXT641 Warning 'com.reuters.tibmsg' Java package and

subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT642 Warning 'org.jdesktop.animation' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT645 Warning 'com.jidesoft.plaf' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT646 Warning 'com.sun.mail' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT648 Warning 'org.apache.poi' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT649 Warning 'javax.servlet.jsp' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT650 Warning 'net.jini.jrmp' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true
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JAPIEXT651 Warning 'abbot.finder.matchers' Java package

and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT652 Warning 'com.jidesoft.animation' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT653 Warning 'org.jmol.geodesic' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT654 Warning 'com.jidesoft.tipoftheday' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT656 Warning 'com.reuters.sass3j' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT657 Warning 'com.reuters.mainloop' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT658 Warning 'com.reuters.ssl' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true
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JAPIEXT659 Warning 'org.powermock.utils' Java package and

subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT660 Warning 'com.reuters.util' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT662 Warning 'jogamp.nativewindow.x11' Java
package and subpackages will not be
available in MATLAB in a future
release. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT663 Warning 'com.vladium.emma' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT664 Warning 'org.junit.rules' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT665 Warning 'com.jidesoft.comparator' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT666 Warning 'com.jidesoft.document' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true
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JAPIEXT667 Warning 'org.h2.api' Java package and

subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT669 Warning 'antlr.actions.java' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT672 Warning 'com.sparshui.gestures' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT673 Warning 'com.jidesoft.list' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT674 Warning 'org.apache.fop' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT675 Warning 'freemarker.template.utility' Java
package and subpackages will not be
available in MATLAB in a future
release. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT676 Warning 'jogamp.opengl.es1' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true
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JAPIEXT677 Warning 'org.junit.validator' Java package and

subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT678 Warning 'net.jini.lease' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT679 Warning 'com.jidesoft.converter' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT680 Warning 'org.jmol.viewer' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT681 Warning 'freemarker.ext.dom' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT682 Warning 'org.iso_relax.jaxp' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT684 Warning 'com.jogamp.nativewindow' Java
package and subpackages will not be
available in MATLAB in a future
release. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true
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JAPIEXT685 Warning 'schemaorg_apache_xmlbeans.system.s

XMLCONFIG' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT687 Warning 'com.thaiopensource.util' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT689 Warning 'com.ctc.wstx' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT690 Warning 'org.powermock.modules' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT691 Warning 'org.geotools.ows' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT692 Warning 'net.bytebuddy.pool' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT693 Warning 'com.vladium.app' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true
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JAPIEXT694 Warning 'com.jidesoft.hssf' Java package and

subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT695 Warning 'com.sun.cdc' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT696 Warning 'org.jmol.util' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT698 Warning 'com.sun.activation' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT699 Warning 'com.codahale.metrics' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT700 Warning 'com.datastax.driver' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT701 Warning 'com.googlecode.concurrentlinkedhash
map' Java package and subpackages
will not be available in MATLAB in a
future release. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true
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JAPIEXT702 Warning 'com.hp.hpl' Java package and

subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT703 Warning 'com.ibm.icu' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT704 Warning 'com.microsoft.sqlserver' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT705 Warning 'commonj.sdo.impl' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT706 Warning 'com.mysql.cj' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT707 Warning 'com.mysql.jdbc' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT708 Warning 'com.orientechnologies.common' Java
package and subpackages will not be
available in MATLAB in a future
release. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true
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JAPIEXT709 Warning 'com.orientechnologies.nio' Java

package and subpackages will not be
available in MATLAB in a future
release. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT710 Warning 'com.orientechnologies.orient' Java
package and subpackages will not be
available in MATLAB in a future
release. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT711 Warning 'com.sun.istack' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT712 Warning 'com.sun.xml' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT713 Warning 'com.terracotta.entity' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT714 Warning 'io.jsonwebtoken.impl' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT715 Warning 'io.jsonwebtoken.lang' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true
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JAPIEXT716 Warning 'io.netty.bootstrap' Java package and

subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT717 Warning 'io.netty.buffer' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT718 Warning 'io.netty.channel' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT719 Warning 'io.netty.handler' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT720 Warning 'io.netty.util' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT721 Warning 'javax.json.spi' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT722 Warning 'javax.json.stream' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true
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JAPIEXT723 Warning 'javax.persistence.criteria' Java

package and subpackages will not be
available in MATLAB in a future
release. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT724 Warning 'javax.persistence.metamodel' Java
package and subpackages will not be
available in MATLAB in a future
release. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT725 Warning 'javax.persistence.spi' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT726 Warning 'javax.ws.rs' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT727 Warning 'javax.xml.bind' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT728 Warning 'junit.extensions.jfcunit' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT729 Warning 'junit.extensions.xml' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true
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JAPIEXT730 Warning 'mssql.googlecode.cityhash' Java

package and subpackages will not be
available in MATLAB in a future
release. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT731 Warning 'mssql.googlecode.concurrentlinkedhas
hmap' Java package and subpackages
will not be available in MATLAB in a
future release. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT732 Warning 'net.oauth.client' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT733 Warning 'net.oauth.http' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT734 Warning 'net.oauth.signature' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT735 Warning 'net.sf.ehcache' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT736 Warning 'org.apache.directory' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true
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JAPIEXT737 Warning 'org.apache.geronimo' Java package

and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT738 Warning 'org.apache.jena' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT739 Warning 'org.apache.regexp' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT740 Warning 'org.apache.wink' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT741 Warning 'org.custommonkey.xmlunit' Java
package and subpackages will not be
available in MATLAB in a future
release. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT742 Warning 'org.eclipse.lyo' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT743 Warning 'org.eclipse.persistence' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true
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JAPIEXT744 Warning 'org.jdesktop.jxlayer' Java package and

subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT745 Warning 'org.joda.time' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT746 Warning 'org.neo4j.driver' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT747 Warning 'org.netbeans.jemmy' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT748 Warning 'org.postgresql.copy' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT749 Warning 'org.postgresql.core' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT750 Warning 'org.postgresql.ds' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true
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JAPIEXT751 Warning 'org.postgresql.fastpath' Java package

and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT752 Warning 'org.postgresql.geometric' Java
package and subpackages will not be
available in MATLAB in a future
release. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT753 Warning 'org.postgresql.gss' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT754 Warning 'org.postgresql.hostchooser' Java
package and subpackages will not be
available in MATLAB in a future
release. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT755 Warning 'org.postgresql.jdbc' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT756 Warning 'org.postgresql.jdbc2' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT757 Warning 'org.postgresql.jdbc3' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true
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JAPIEXT758 Warning 'org.postgresql.largeobject' Java

package and subpackages will not be
available in MATLAB in a future
release. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT759 Warning 'org.postgresql.osgi' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT760 Warning 'org.postgresql.ssl' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT761 Warning 'org.postgresql.sspi' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT762 Warning 'org.postgresql.translation' Java
package and subpackages will not be
available in MATLAB in a future
release. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT763 Warning 'org.postgresql.util' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT764 Warning 'org.postgresql.xa' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true
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JAPIEXT765 Warning 'org.springframework.aop' Java

package and subpackages will not be
available in MATLAB in a future
release. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT766 Warning 'org.springframework.asm' Java
package and subpackages will not be
available in MATLAB in a future
release. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT767 Warning 'org.springframework.beans' Java
package and subpackages will not be
available in MATLAB in a future
release. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT768 Warning 'org.springframework.boot' Java
package and subpackages will not be
available in MATLAB in a future
release. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT769 Warning 'org.springframework.cache' Java
package and subpackages will not be
available in MATLAB in a future
release. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT770 Warning 'org.springframework.cglib' Java
package and subpackages will not be
available in MATLAB in a future
release. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT771 Warning 'org.springframework.context' Java
package and subpackages will not be
available in MATLAB in a future
release. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true
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JAPIEXT772 Warning 'org.springframework.core' Java

package and subpackages will not be
available in MATLAB in a future
release. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT773 Warning 'org.springframework.dao' Java
package and subpackages will not be
available in MATLAB in a future
release. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT774 Warning 'org.springframework.ejb' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT775 Warning 'org.springframework.expression' Java
package and subpackages will not be
available in MATLAB in a future
release. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT776 Warning 'org.springframework.format' Java
package and subpackages will not be
available in MATLAB in a future
release. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT777 Warning 'org.springframework.http' Java
package and subpackages will not be
available in MATLAB in a future
release. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT778 Warning 'org.springframework.instrument' Java
package and subpackages will not be
available in MATLAB in a future
release. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true
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JAPIEXT779 Warning 'org.springframework.jca' Java package

and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT780 Warning 'org.springframework.jdbc' Java
package and subpackages will not be
available in MATLAB in a future
release. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT782 Warning 'org.springframework.jmx' Java
package and subpackages will not be
available in MATLAB in a future
release. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT783 Warning 'org.springframework.jndi' Java
package and subpackages will not be
available in MATLAB in a future
release. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT784 Warning 'org.springframework.lang' Java
package and subpackages will not be
available in MATLAB in a future
release. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT785 Warning 'org.springframework.ldap' Java
package and subpackages will not be
available in MATLAB in a future
release. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT786 Warning 'org.springframework.mail' Java
package and subpackages will not be
available in MATLAB in a future
release. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true
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JAPIEXT788 Warning 'org.springframework.mock' Java

package and subpackages will not be
available in MATLAB in a future
release. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT789 Warning 'org.springframework.objenesis' Java
package and subpackages will not be
available in MATLAB in a future
release. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT790 Warning 'org.springframework.orm' Java
package and subpackages will not be
available in MATLAB in a future
release. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT792 Warning 'org.springframework.remoting' Java
package and subpackages will not be
available in MATLAB in a future
release. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT793 Warning 'org.springframework.scheduling' Java
package and subpackages will not be
available in MATLAB in a future
release. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT794 Warning 'org.springframework.scripting' Java
package and subpackages will not be
available in MATLAB in a future
release. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT795 Warning 'org.springframework.security' Java
package and subpackages will not be
available in MATLAB in a future
release. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true
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JAPIEXT796 Warning 'org.springframework.stereotype' Java

package and subpackages will not be
available in MATLAB in a future
release. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT797 Warning 'org.springframework.test' Java
package and subpackages will not be
available in MATLAB in a future
release. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT798 Warning 'org.springframework.transaction' Java
package and subpackages will not be
available in MATLAB in a future
release. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT799 Warning 'org.springframework.ui' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT800 Warning 'org.springframework.util' Java
package and subpackages will not be
available in MATLAB in a future
release. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT801 Warning 'org.springframework.validation' Java
package and subpackages will not be
available in MATLAB in a future
release. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT802 Warning 'org.springframework.web' Java
package and subpackages will not be
available in MATLAB in a future
release. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true
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Check ID Severity Message Can Be Disabled?
JAPIEXT803 Warning 'org.sqlite.core' Java package and

subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT804 Warning 'org.sqlite.date' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT805 Warning 'org.sqlite.javax' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT806 Warning 'org.sqlite.jdbc3' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT807 Warning 'org.sqlite.jdbc4' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT808 Warning 'org.sqlite.util' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT809 Warning 'org.terracotta.context' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true
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Check ID Severity Message Can Be Disabled?
JAPIEXT810 Warning 'org.terracotta.modules' Java package

and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT811 Warning 'org.terracotta.statistics' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT812 Warning 'org.tukaani.xz' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT813 Warning 'org.xerial.snappy' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT814 Warning 'javax.help.event' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT815 Warning 'javax.help.plaf' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT816 Warning 'javax.help.resources' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true
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Check ID Severity Message Can Be Disabled?
JAPIEXT817 Warning 'javax.help.search' Java package and

subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT818 Warning 'javax.help.tagext' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT819 Warning 'org.eclipse.cdt' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT820 Warning 'org.eclipse.jface' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT821 Warning 'org.eclipse.swt' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT822 Warning 'org.eclipse.text' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT823 Warning 'com.zaxxer.sparsebits' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true
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Check ID Severity Message Can Be Disabled?
JAPIEXT824 Warning 'schemaorg_apache_xmlbeans.system.s

D023D6490046BA0250A839A9AD24C4
43' Java package and subpackages will
not be available in MATLAB in a future
release. To continue using this
package, install its JAR file and add the
JAR file to the static path in MATLAB.

true

JAPIEXT825 Warning 'org.abego.treelayout' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT826 Warning 'org.antlr.v4' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT827 Warning 'org.glassfish.json' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT828 Warning 'org.stringtemplate.v4' Java package
and subpackages will not be available
in MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT830 Warning 'org.apache.logging' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT831 Warning 'org.aspectj.internal' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true
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Check ID Severity Message Can Be Disabled?
JAPIEXT832 Warning 'org.aspectj.lang' Java package and

subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT833 Warning 'org.h2.mode' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

JAPIEXT834 Warning 'org.slf4j.event' Java package and
subpackages will not be available in
MATLAB in a future release. To
continue using this package, install its
JAR file and add the JAR file to the
static path in MATLAB.

true

See Also
Code Analyzer | codeIssues | fix | checkcode

Related Examples
• “Configure Code Analyzer” on page 7-18
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Add-Ons

• “Get and Manage Add-Ons” on page 8-2
• “Configure Add-Ons After Installation” on page 8-6
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Get and Manage Add-Ons

In this section...
“Get Add-Ons” on page 8-2
“Install Add-Ons from File” on page 8-3
“Default Add-On Installation Folder” on page 8-3
“Manage Add-Ons” on page 8-4
“Update Add-Ons” on page 8-4
“Run Apps” on page 8-4

Add-ons encompass a wide variety of resources, including products, apps, support packages, and
toolboxes. They extend the capabilities of MATLAB with functionality for additional tasks and
applications.

Get Add-Ons

To find and install add-ons, go to the Home tab and, in the Environment section, click the 
Add-Ons icon. The Add-On Explorer opens and displays the list of available add-ons.

You must have an active internet connection to get add-ons using the Add-On Explorer.
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To find add-ons, use the search bar, or browse through the available categories on the left side of the
Add-On Explorer window. Select an add-on from the list to view additional information about it, such
as what files it includes and what documentation is available

To install an add-on, select it from the list. Then, select from the available install actions. After you
install an add-on, MATLAB manages the MATLAB path for you. This lets you start using it without
adjusting your desktop environment.

For some add-ons, you also can download the files from the Add-on Explorer without installing them.
This is useful if you want to install the add-on on a system without an internet connection. To
download the add-on without installing, select Install > Download Only.

Install Add-Ons from File
You can install some add-ons manually using an installation file. This is useful in several situations:

• The add-on is not available for installation through the Add-On Explorer, for example, if you create
a custom add-on yourself or receive one from someone else.

• You downloaded the add-on from the Add-On Explorer without installing it.
• You downloaded the add-on from the File Exchange at MATLAB Central™.

Valid add-on installation files include .mltbx files (for toolboxes), .mlappinstall files (for apps),
and .mlpkginstall files (for hardware support packages). To install an add-on from one of these
files, in the MATLAB Current Folder browser, double-click the file. An installer opens to guide you
through the installation process.

Note Make sure to double-click the installation file in the MATLAB Current Folder browser. Double-
clicking to install the add-on from the system file browser is not supported on all operating systems.

You also can install some add-ons programmatically. For more information, see
matlab.addons.install.

Default Add-On Installation Folder

The install location of an add-on depends on its type. MATLAB installs MathWorks products in the
matlabroot folder and hardware support packages in the folder returned by
matlabshared.supportpkg.getSupportPackageRoot. For more information about a specific
support package install location, see the documentation for the package.

MATLAB installs all other add-ons in a default installation folder specific to the platform.

• Windows— C:\Users\username\AppData\Roaming\MathWorks\MATLAB Add-Ons
• Linux — ~/MATLAB Add-Ons.
• macOS — ~/Library/Application Support/MathWorks/MATLAB Add-Ons
• MATLAB Online — /MATLAB Add-Ons

To change the default installation folder, on the Home tab, in the Environment section, click
Preferences > MATLAB > Add-Ons. Then, in the Installation Folder field, specify a folder name
to which you have write access.
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If you change the default installation folder, add-ons installed in the previously selected folder are no
longer accessible from within MATLAB. Changing the default installation folder or customizing
installed add-ons is not supported in MATLAB Online.

Manage Add-Ons

To view and manage installed add-ons, go to the Home tab and select  Add-Ons > Manage Add-
Ons. The Add-On Manager displays all add-ons that are installed in the add-ons installation folder, as
well as MATLAB products and hardware support packages.

To manage an individual add-on, click the Options button  to the right of the add-on and select from
the available actions:

• Open Folder
• Open Documentation
• View in Add-on Explorer
• View Getting Started Guide
• Setup
• Version
• Enabled
• Uninstall

Not all actions are available for all add-ons.

To customize your MATLAB environment, use the Enabled action to enable and disable add-ons. You
also can enable or disable add-ons using the matlab.addons.enableAddon and
matlab.addons.disableAddon functions.

If an add-on has multiple versions installed, only one version can be enabled. To view the currently
enabled version, select Version. MATLAB displays a check mark next to the currently enabled
version. To enable a different version, click it. For more information about installing multiple versions
of an add-on, see matlab.addons.install.

Update Add-Ons
You can update installed add-ons as well as your current installed version of MATLAB using the Add-
On Manager. On the Home tab, click Help > Check for Updates. The Add-On Manager opens with
the Updates tab selected. View and install any available updates.

Run Apps
An app is a self-contained MATLAB program with a user interface. To view and interact with the user
interface after installing the app, run it. Go to the Apps tab and expand the apps gallery by clicking
the down arrow  on the far right. Then, navigate to your installed app and click the icon. Custom
apps that you write or receive from someone else appear in the My Apps section. You can run
multiple custom apps concurrently, including multiple instances of the same app.
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See Also
matlab.addons.install | matlab.addons.installedAddons |
matlab.addons.isAddonEnabled | matlab.addons.enableAddon

Related Examples
• “Package Apps From the MATLAB Toolstrip”
• “Create and Share Toolboxes”
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Configure Add-Ons After Installation
After installation, some add-ons require additional configuration steps.

Install Supported Compiler
Some add-ons require a supported compiler. For a list of compilers and the products and workflows
they support, see Supported and Compatible Compilers.

These add-ons require a supported compiler:

• MATLAB Coder™
• Stateflow®

• Simulink Coder
• Embedded Coder®

• Simulink Test™

These add-ons require a supported compiler for certain workflows:

• SimBiology — For computation acceleration.
• Fixed-Point Designer™ — For computation acceleration
• Simulink — For simulation acceleration, model reference, and MATLAB Function block

capabilities.
• MATLAB Compiler — For the creation of Excel add-ins (Windows only).
• MATLAB Compiler SDK™ — For the creation of C and C++ shared libraries. In addition, MATLAB

Compiler SDK requires a Java JDK for the creation of Java packages and, on Windows systems,
a .NET framework for the creation of .NET assemblies and deployable archives with Excel
integration. For more information, see the MATLAB Compiler SDK section of the Supported and
Compatible Compilers page.

Additional Configuration Steps
These add-ons require additional configuration steps:

• C2000™ Microcontroller Blockset — See “Hardware Setup for C2000 Microcontroller Blockset”
(C2000 Microcontroller Blockset).

See Also

Related Examples
• “Get and Manage Add-Ons” on page 8-2
• Supported and Compatible Compilers
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Internationalization

• “Locale Setting Concepts for Internationalization” on page 9-2
• “Limitations to International Character Support” on page 9-4
• “Set Locale on Microsoft Windows Platforms” on page 9-5
• “Set Locale on macOS Platforms” on page 9-7
• “Set Locale on Linux Platforms” on page 9-8
• “Unexpected Behavior on macOS Platforms” on page 9-9
• “Characters Incorrectly Displayed on Windows Systems” on page 9-10
• “datenum Might Not Return Correct Value” on page 9-11
• “Numbers Display Period for Decimal Point” on page 9-12
• “Script Compatibility” on page 9-13
• “Change the MATLAB Desktop Language” on page 9-14
• “X Servers and International Keyboard Layouts” on page 9-16

9



Locale Setting Concepts for Internationalization

In this section...
“Default Locale Setting” on page 9-2
“Supported Character Sets and Encodings” on page 9-2
“Platform-Specific Localized Formats for Current Folder Browser” on page 9-3

The locale setting defines the language of your user interface and the display formats for information
like time, date, and currency. MATLAB uses the user-specified locale on all platforms.

If MATLAB does not correctly display characters in your language, you might have a locale setting
problem. Locale is composed of individual settings that you can control. Each platform uses different
parameters to specify the locale setting. These terms are relevant to understanding locale settings:

• locale — Format: language_territory.codeset

For example, for the U.S. English locale setting en_US.UTF-8, en means that the display
language is English. US indicates that time and date displays use U.S. conventions. UTF-8 is the
character encoding (codeset) used to display text.

• ASCII (American Standard Code for Information Interchange) — Nearly universal character
encoding for US English and control characters.

• Unicode — A universal character set that “provides a unique number for every character, no
matter what the platform, no matter what the program, no matter what the language.”

• UTF-8 — A variable width character encoding tor Unicode that is backwards compatible with
ASCII. It has become the dominate encoding for the World Wide Web and anywhere else that
cross-platform, cross-locale interoperability is required.

• user locale setting — Setting on your computer that specifies the locale that you want to use when
running MATLAB. If your user-specified locale is not supported, MATLAB uses the default locale
en_US_POSIX.US-ASCII.

• system locale setting — Setting on Microsoft Windows platforms. The user locale and system
locale must be the same value. If these values are not the same, you might see garbled text or
incorrectly displayed characters.

• i18n — Short for the word internationalization, where 18 stands for the number of letters
between the letters i and n.

Default Locale Setting
MATLAB does not support every locale setting. If the user-specified locale is unsupported, MATLAB
uses the default locale en_US_POSIX.US-ASCII, also known as C locale.

Supported Character Sets and Encodings
MATLAB uses Unicode as its internal character set so that it can represent all letters and symbols,
regardless of platform, language, or locale. MATLAB uses UTF-8 as its default character encoding to
ensure that all Unicode code points can be correctly represented in files and byte streams. MATLAB
also supports other character encodings for backwards compatibility and interoperability.
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Platform-Specific Localized Formats for Current Folder Browser
In the Current Folder Browser, MATLAB usually uses platform-neutral localized formats and rules.
You can, however, use the operating system short date format to control the format for displaying file
date and time data.

See Also

Related Examples
• “Set Locale on Microsoft Windows Platforms” on page 9-5
• “Set Locale on macOS Platforms” on page 9-7
• “Set Locale on Linux Platforms” on page 9-8
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Limitations to International Character Support
MATLAB does not support non 7-bit ASCII characters in the following features:

• MATLAB C/C++ and Fortran engine library functions and the loadlibrary function cannot find
files located in folder names that contain non 7-bit ASCII characters.

• MATLAB C/C++ and Fortran engine library functions and the calllib function used to call C
library functions cannot convert Unicode®-compatible input arguments of type char* to MATLAB
character arrays.

• The matlab.wsdl.createWSDLClient function cannot read non 7-bit ASCII characters in Web
Services Description Language (WSDL) documents.

When you have a file containing text that has characters in a different encoding than that of your
platform, when you save or publish your file, MATLAB displays those characters as garbled text.
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Set Locale on Microsoft Windows Platforms
MATLAB reads the user locale and system locale on Windows platforms. The user locale and system
locale must be the same value. If these values are not the same, you might see garbled text or
incorrectly displayed characters.

MATLAB does not support every locale setting. If your locale is not supported, MATLAB uses the
default locale en_US_POSIX.US-ASCII, also known as C locale.

When you change the system locale, restart your system. Otherwise, you might see unexpected
behaviors.

Locale on Windows 10 Platforms
These instructions are based on Windows 10 Version 1809. Refer to your version of Windows 10
documentation for information about setting region information using the Settings app.

1 From Time & Language, select Region.
2 Under Related Settings, select Additional date, time, & regional settings.
3 Select Region to change location.
4 On the Formats tab, select a target locale from the Format drop-down list, and then click Apply.

This action sets the user locale.
5 On the Administrative tab, click Change system locale....
6 Select a target locale from the Current system locale drop-down list. This action sets the

system locale.
7 Exit each dialog box by clicking OK.
8 Restart the system.

Using UTF-8 on Windows 10 Platforms

As of Windows 10 1803, Microsoft added the ability to specify UTF-8 as the character encoding used
by Windows itself. This feature can be enabled using the instructions shown above, however, after
step 6, select the check box next to Use Unicode UTF-8 for worldwide language support. If this
setting is enabled, MATLAB uses UTF-8 as both its default and its locale-specific character encoding.

Note It is not necessary to enable this option in order to use UTF-8 with MATLAB. MATLAB uses
UTF-8 as the default encoding independent of this setting. Therefore, most users do not need to
enable this Windows option; however, MATLAB works correctly if it is enabled.

Locale on Windows 7 Platforms
User Locale

1 Select Start > Control Panel > Clock, Language, and Region > Region and Language.
2 Open the Formats tab.
3 Select a target locale from the Format drop-down list.
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System Locale

1 Select Start > Control Panel > Clock, Language, and Region > Region and Language.
2 Open Administrative tab.
3 In the Language for non-Unicode programs section, click Change system locale....
4 Select a target locale from the Current system locale drop-down list.
5 Restart the system.
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Set Locale on macOS Platforms
On the Apple macOS platform, MATLAB reads the user locale setting. MATLAB automatically chooses
a codeset for each combination of language and territory.

If you customize the locale setting, MATLAB ignores the customized portion. MATLAB ignores the
LANG environment variable and the Terminal application locale setting.

MATLAB does not support every locale setting. If your locale is not supported, MATLAB uses the
default locale en_US_POSIX.US-ASCII, also known as C locale.
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Set Locale on Linux Platforms
Use the LANG environment variable to specify the locale to be used by MATLAB.

MATLAB does not support every locale setting. If your locale is not supported, MATLAB uses the
default locale en_US_POSIX.US-ASCII, also known as C locale.

See Also

More About
• “Numbers Display Period for Decimal Point” on page 9-12
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Unexpected Behavior on macOS Platforms
If you customize the locale setting, MATLAB ignores the customized portion.

MATLAB ignores the LANG environment variable and the Terminal application locale setting.

See Also

Related Examples
• “Set Locale on macOS Platforms” on page 9-7
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Characters Incorrectly Displayed on Windows Systems
The user locale and system locale must be the same value on the Microsoft Windows platform. If
these values are not the same, you might see garbled text or incorrect characters.

See Also

Related Examples
• “Set Locale on Microsoft Windows Platforms” on page 9-5
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datenum Might Not Return Correct Value
The results of the datenum function vary depending on the locale. To ensure the correct calculation
of functions using date values associated with files and folders, replace datenum function calls with
the use of the dir function datenum field.

For example, look at the modification date of your MATLAB license_agreement.txt file:

cd(matlabroot)
f = dir('license_agreement.txt')

MATLAB displays information similar to:

f = 

       name: 'license_agreement.txt'
       date: '10-May-2015 17:48:22'
      bytes: 5124
      isdir: 0
    datenum: 7.3317e+005

If your code uses the date field of the dir command, similar to:

n = datenum(f.date);

replace it with the datenum field:

n = f.datenum;

See Also
dir
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Numbers Display Period for Decimal Point
MATLAB reads the user locale for all categories except for the numeric category (which is equivalent
with LC_NUMERIC). This category controls numeric data formatting and parsing. MATLAB always sets
LC_NUMERIC to the C locale.

MATLAB uses a period for a decimal point, regardless of the format specified by the user locale. For
example, the value of pi can be displayed as 3,1416 or 3.1416, depending on the format used by a
locale. MATLAB always displays 3.1416.

The MATLAB language reserves the use of commas to the cases described in the Symbol Reference
topic.

See Also

More About
• Symbol Reference: Comma
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Script Compatibility
As of R2020a, plain text files, such as MATLAB scripts or functions, that are encoded using UTF-8
(note that all 7-bit ASCII files are de facto UTF-8 encoded), work seamlessly across all platforms and
all locales. Plain text files created with an earlier version of MATLAB that are not UTF-8 encoded also
work if they were created in the same locale that the current MATLAB is using. Under most
circumstances, MATLAB also operates correctly with plain text files encoded in one of the locale-
specific CJK (Chinese, Japanese, or Korean) encodings.
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Change the MATLAB Desktop Language
MathWorks offers MATLAB translated into Japanese, Korean, and Chinese. If the locale setting for
your system (or display language on Windows 10) is set to Japanese, Korean, or Chinese, you can
choose whether to display text in the MATLAB desktop in your system language or in English.
Desktop items (such as dialog boxes, button names, and menu items) and error and warning
messages appear in the language that you select.

To change the desktop language:

1 On the Home tab, in the Environment section, click  Preferences and select MATLAB >
General.

2 Select an option for the Desktop language preference. If the Desktop language preference is
not displayed, then this preference is not supported for your current system configuration.

3 Restart MATLAB for the preference change to take effect.

Most desktop elements and apps use the language specified by the Desktop language preference.
However, system dialog boxes, such as file selectors or color pickers, use the operating system
display language.
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See Also
Preferences

More About
• “Translated Documentation” on page 4-13
• “Locale Setting Concepts for Internationalization” on page 9-2
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X Servers and International Keyboard Layouts
Simulink requires the XKEYBOARD extension to detect the keyboard layout that is currently active.
Some older X servers do not support this extension. If this extension is absent or disabled, then
Simulink assumes a default layout. When the default layout does not match the keyboard layout, some
keys might not produce the expected characters.

Suppose you are using a Linux based computer with a German keyboard. Without the XKEYBOARD
extension, Simulink uses the default layout, which is English, and can therefore produce incorrect
characters. MATLAB correctly recognizes the keyboard as German.

If you encounter this issue, try enabling the XKEYBOARD extension, or use an X server that supports
this extension.
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Access Files in MATLAB Online
MATLAB Online provides access to MATLAB from a standard web browser. You can access your files
in MATLAB Online by adding them to your MATLAB Drive or by uploading them to MATLAB Online
directly from your system. You also can download files from MATLAB Online to your system, preview
files, and restore previous versions of your files.

Upload and Download Files
To upload files from your system to MATLAB Online, in your system file browser, select the files that
you want to upload. Then, drag the files anywhere on the MATLAB Online desktop. MATLAB places
the files in the current folder. To upload them to a specific folder, drag them over the desired folder in
the Files browser. Alternatively, to upload files directly from the Files browser, right-click in white
space and select Upload Files or Upload Folders.

When you upload a file to MATLAB Online, it is added to your MATLAB Drive. If you add files to your
MATLAB Drive outside of MATLAB Online, you can access those files in MATLAB Online. For more
information about adding files to MATLAB Drive, see “Add Files to MATLAB Drive” on page 12-9.

To download a file from MATLAB Online to your local system, in the Files browser, right-click the file
and select Download.

Preview Files
To preview the contents of a file or folder in MATLAB Online without opening it, in the Files browser,
right-click the file and select Preview. You also can click the Preview button  to the right of the file
or folder name.

Restore Files
In MATLAB Online, each time you save a code file, MATLAB stores the contents of your file in the
version history. To recover a previous version of a file, select the File Versions tab.

The file version history appears, as shown in this figure.
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Browse for the version you want by selecting from the list, or by clicking Older or Newer. When you
find the version, click Restore as latest. MATLAB adds the restored file version to the top of your file
version history with a new timestamp and version number.

Note MATLAB Online stores previous versions of a file for 30 days. After 30 days, the previous
version of the file is permanently deleted.

See Also

Related Examples
• “Manage Files and Folders” on page 6-34
• “MATLAB Online”
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Open in MATLAB Online from GitHub
You can open Git repositories directly in MATLAB Online by creating specially formatted links. You
can create a link to a Git repository, or to a project or file within a Git repository. Clicking the link
creates a clone of the Git repository in MATLAB Online. If a project is specified, MATLAB opens and
runs the project. If a file is specified, MATLAB opens the file.

After creating the links, share them by distributing them to others directly, or by creating Open in
MATLAB Online buttons and including them in a Git README file.

Create Links
You can create links interactively or manually.

Interactively

To create the link interactively, go to Create Links for MATLAB Online.

Manually

To create the link manually, copy the link template below. Then, replace the template parameters with
the information for the repository, as described in the table below.
matlab.mathworks.com/open/github/v1?repo=<authorname>/<reponame>&file=<filename>&project=<projectname>&line=<linenumber>

To omit optional parameters, omit the parameter name and value, as well as the & character that
precedes them. For example, this link template omits the project parameter.
matlab.mathworks.com/open/github/v1?repo=<authorname>/<reponame>&file=<filename>&line=<linenumber>

Parameter Required? Summary Example
repo Yes Author and name of the Git

repository
repo=myname/myrepo

file No File to be opened after the Git
repository is cloned

file=filename.mlx

project No Project to be opened after the
Git repository is cloned

project=MyProject.prj

line No Line to navigate to when
specified file is opened

line=88

Note Concurrent access of a Git repository in cloud storage might corrupt the repository.

Share Links
After you create a link, you can distribute it to others, for example, by including it in an email. You
also can share the link by creating an Open in MATLAB Online button and including it in a Git
README file. To create the button, copy the markdown template below, replacing the link parameter
with the link that you created to open the repository in MATLAB Online.
[![Open in MATLAB Online](https://www.mathworks.com/images/responsive/global/open-in-matlab-online.svg)](<link>)

When you add the markdown to a Git README file, the file shows an Open in MATLAB Online
button, as shown below.
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See Also

Related Examples
• Create Links for MATLAB Online
• “MATLAB Online”
• “Use Git in MATLAB”
• “Clone Remote Git Repository into New Project”
• “Set Source Control Preferences”
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MATLAB Drive

• “Install MATLAB Drive Connector” on page 12-2
• “MATLAB Drive Preferences and Account Information” on page 12-4
• “Access Files in Your MATLAB Drive” on page 12-6
• “Add Files to MATLAB Drive” on page 12-9
• “Share Folders Using MATLAB Drive” on page 12-11
• “Restore Deleted Files in MATLAB Drive Online” on page 12-21
• “Manage File Conflicts and Update Issues in MATLAB Drive” on page 12-22
• “Start and Stop MATLAB Drive Connector” on page 12-23
• “View MATLAB Drive Connector Status and Notifications” on page 12-25
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Install MATLAB Drive Connector
MATLAB Drive Connector provides an easy way to manage your MATLAB Drive files on your local
computer. With the Connector, files synchronize automatically between MATLAB Drive online and
your local MATLAB Drive when you have the Connector running.

Install Instructions
To install MATLAB Drive Connector, follow these steps:

1 Start the installer using one of these methods:

• From within MATLAB — Click the MATLAB Drive button  to start the installer.

If you do not see the MATLAB Drive button  in the Current Folder toolbar, right-click the
toolbar and select Customize. Then, in the MATLAB Toolbar Preferences Controls section,
select the check box for the MATLAB Drive control and select OK. MATLAB adds the button
to the toolbar.

• From the web — Go to the Connector download page and select Install for Windows, Install
for Mac, or Install for Linux. Installing from the web does not require you to have MATLAB
installed.

2 Configure the location of your MATLAB Drive folder and your MATLAB Drive settings.

Note When setting the location of your MATLAB Drive folder, these locations are not supported:

• Folders on a network drive.
• Read-only or otherwise restricted folders.
• Folders that are already being synced by another application.

If you set the location of your MATLAB Drive folder to a folder that is already being synced,
the files in your MATLAB Drive folder might not correctly sync with the files on the cloud.

3 Click Finish to complete setup and synchronize your MATLAB Drive files between your
computers and online accounts. To change any of your selections, click Back.

When the installer finishes, MATLAB Drive is ready for use on this computer. See “Access Files in
Your MATLAB Drive” on page 12-6 for instructions on accessing MATLAB Drive.

Uninstall Instructions
Operating
System

Instructions

Windows 1 Exit MATLAB Drive Connector.
2 Go to the Control Panel, and select Programs > Uninstall a program.
3 (Optional) If you are on a shared computer, clear your cached account information by

deleting the ServiceHost folder. The default location for this folder is C:\Users
\username\AppData\Local\MathWorks\ServiceHost.
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Operating
System

Instructions

macOS 1 Exit MATLAB Drive Connector.
2 Open a Terminal window.
3 Navigate to the MATLAB Drive Connector installation folder:

cd ~/Library/Application Support/MathWorks/ServiceHost
4 Run the uninstaller:

./v<VERSION>/mci/InstallMathWorksServiceHost.app/Contents/bin/maci64/UninstallMathWorksServiceHost

VERSION is the MATLAB Drive Connector version, which you can find under Settings
in the Connector; for example, 1.8.0.8.

5 (Optional) If you are on a shared computer, clear your cached account information by
deleting the ServiceHost folder. The default location for this folder is ~/Library/
Application Support/MathWorks/ServiceHost.

Linux 1 Exit MATLAB Drive Connector.
2 Open a Terminal window.
3 Navigate to the MATLAB Drive Connector installation folder:

cd ~/.MathWorks/ServiceHost/<HOSTNAME>

HOSTNAME is the computer host name.
4 Run the uninstaller:

./v<VERSION>/mci/bin/glnxa64/UninstallMathWorksServiceHost.sh

VERSION is the MATLAB Drive Connector version, which you can find under Settings
in the Connector; for example, 1.8.0.8.

5 (Optional) If you are on a shared computer, clear your cached account information by
deleting the ~/.MathWorks/ServiceHost/<HOSTNAME> folder.

See Also

Related Examples
• “MATLAB Drive Preferences and Account Information” on page 12-4
• “Access Files in Your MATLAB Drive” on page 12-6
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MATLAB Drive Preferences and Account Information

Preferences
To set preferences for MATLAB Drive:

1 Open MATLAB Drive Connector:

•
Windows — Click the MATLAB Drive Connector icon  in the Windows system notification
area.

• macOS — Click the MATLAB Drive Connector icon  in the MAC OS X Dock.
2 Click the Show MATLAB Drive actions button , and select Preferences.
3 Select a tab and adjust the options as described in the following table.

Tab Preference
General
Settings

Select Start MATLAB Drive Connector at system startup to have
MATLAB Drive Connector start whenever you restart your computer.
Select Help improve MATLAB Drive Connector to send your experience
information to MathWorks.

MATLAB
Drive

Folder Location for MATLAB Drive. This location is specified during the
installation of MATLAB Drive Connector and cannot be changed once it is set.
Select a Show notifications option to specify what notifications MATLAB
Drive Connector should display. Options include:

• All — Display all notifications in the Windows system tray or on the macOS
menu bar. For less interruption to your work, notifications are aggregated
and shown less often.

• Recommended — Display notifications for errors and conflicts only.
• Off — Display no notifications for any sync activity.

MathWorks
Account

Your Name and E-mail address.

Changing your name and email address is not supported in the MATLAB Drive
Connector preferences. To change your name and email address, edit your
MathWorks Account profile on mathworks.com.

Storage Quota
The amount of space you have on MATLAB Drive is limited by the storage quota. Anyone with a
MathWorks Account has a 5 GB storage quota. If you have an eligible MATLAB license that is current
on Software Maintenance Service, your storage quota increases to 20 GB. For more information, see
How much storage do I have in MATLAB Drive?.

For all accounts, when you exceed your storage quota, you cannot perform the following tasks on
MATLAB Drive:

• Save files
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• Upload folders and files
• Move files or folders
• Rename files or folders
• Create folders

If you run out of storage space, delete files to create space. Items in Deleted Files do not count
toward this quota. If you want to restore an item from Deleted Files, you must have the available
storage space.

Deleted Files has its own quota that is equal in size to your MATLAB Drive quota. If your Deleted
Files exceeds this quota, the oldest items are deleted automatically to reduce the storage amount.
This deletion is permanent.

Note  If your Software Maintenance Service has lapsed and you remain over storage quota for 12
months, MathWorks reserves the right to delete some files. Additionally, if your account has been
inactive for 24 months and you are not under Software Maintenance Service, MathWorks reserves the
right to delete all your files. MathWorks may also delete files if you are in violation of the SLA or
federal or local laws. In any case, the deletion affects only the files stored in MathWorks cloud.

Your account is considered inactive if you have not signed into any MathWorks applications that use
MATLAB Drive. These applications include, but are not limited to: MATLAB Online, MATLAB
Mobile™, MATLAB Drive Connector, and MATLAB Drive online.

See Also

Related Examples
• “View MATLAB Drive Connector Status and Notifications” on page 12-25
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Access Files in Your MATLAB Drive
You can access your MATLAB Drive files and folders in MATLAB Drive online. If you have MATLAB
Drive Connector installed, you also can access your MATLAB Drive files and folders on your system.

MATLAB Drive operates like any other folder, with the significant advantage that files can be synced
with any other MATLAB Drive folder, such as in MATLAB Drive online or on another computer that
uses MATLAB Drive Connector.

Access Files in MATLAB Drive Online
You can access your files and folders in MATLAB Drive online. To open MATLAB Drive online, in your
web browser, navigate to MATLAB Drive and sign in with your MathWorks credentials. Alternatively,
you can open MATLAB Drive online from within the MATLAB Drive Connector by clicking the
MATLAB Drive online button.

This table describes several actions that you can take on your files and folders in MATLAB Drive
online.

Action Instructions
Preview a file or folder You can preview files including MATLAB code files, text files,

image files, and audio files.

To preview a file, double-click it or select the file and then click
View. To preview a file in a new tab, click View in New tab.

If the file you want to preview is too large or has a file type that is
not supported for previewing online, MATLAB Drive online
prompts you to download the file.

Open a file You can open and edit files in MATLAB Online.

To open a file, select it and then click Open in MATLAB Online.
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Action Instructions
Download a file or folder To download a file or folder from MATLAB Drive online to your

desktop, select the file or folder and then click Download.
MATLAB Drive online saves the file or folder in your system's
default downloads folder. To download multiple files at once, select
the files that you want to download and then click Download.
Downloading multiple folders or a combination of files and folders
at once is not supported.

When you download a folder, MATLAB Drive online saves it as a zip
file. If you attempt to download a large folder and the download
fails, reduce the size of the folder and then try again.

Changes made to downloaded files are not synced to your MATLAB
Drive.

Rename a file or folder To rename a file or folder, select it and then click Rename.
Move a file or folder To move a file or folder, select it and then click Move To. A dialog

box opens and prompts you to select an existing folder or create a
new folder to move the file or folder to. If no selection is made, the
file or folder is moved to the current folder.

Copy a file or folder To copy a file or folder, select it and then click Copy To. A dialog
box opens and prompts you to select an existing folder or create a
new folder to copy the file or folder to. If no selection is made, the
file or folder is copied to the current folder.

Delete a file or folder To delete a file or folder, select it and then click Delete. Deleting a
file or folder moves it to the Deleted Files folder. For more
information, see “Restore Deleted Files in MATLAB Drive Online”
on page 12-21.

Access Files on Your System
If you have MATLAB Drive Connector installed, you can access your MATLAB Drive files and folders
from your system file browser and from MATLAB.

This table describes how to open your MATLAB Drive folder.
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Location Instructions
System file browser In your system file browser, select the  MATLAB Drive folder.

Alternatively, if you have MATLAB Drive Connector installed and
running, click the MATLAB Drive folder button from within the
Connector.

MATLAB In the Current Folder browser, select the  MATLAB Drive folder.
You also can click the MATLAB Drive button  on the Current
Folder toolbar. Clicking the MATLAB Drive button in the Current
Folder toolbar also starts MATLAB Drive Connector if it is installed
but not running.

If the MATLAB Drive button is not on the Current Folder toolbar,
you can add it by right-clicking the toolbar and selecting
Customize. In the MATLAB Toolbar Preferences Controls section,
select Access MATLAB Drive files on this computer and click
OK. MATLAB adds the button to the toolbar.

Sync Files with MATLAB Drive

When you edit a file in the MATLAB Drive folder, you are editing a local copy of the file. MATLAB
Drive updates the files in the cloud with the changes you make locally. Because MATLAB Drive stores
a local copy of files on each computer that has MATLAB Drive Connector installed, you can access
these files when offline or when syncing is paused. File syncing resumes when MATLAB Drive
Connector is running and an internet connection is available, or when syncing is resumed.

See Also

Related Examples
• “Add Files to MATLAB Drive” on page 12-9
• “Share Folders Using MATLAB Drive” on page 12-11
• “Install MATLAB Drive Connector” on page 12-2
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Add Files to MATLAB Drive
You can add files to your MATLAB Drive as you would add files to any other folder. In addition, you
can upload images and videos from mobile devices with the Share button through the device OS or
any mobile application that supports uploading images and videos.

When using MathWorks products:

• You can add files created or updated while you are working in MATLAB by setting the Current
Folder browser to your MATLAB Drive.

• You can add files created or updated while you are working in MATLAB Online or MATLAB Mobile
to your MATLAB Drive.

If you have MATLAB Drive Connector installed, files on your local MATLAB Drive and MATLAB Drive
online are automatically synced when the Connector is running. The Connector displays the files that
have been synced under Activity. Updates of files greater than 250 MB can take longer to update.

If you do not have the MATLAB Drive Connector installed, you can add folders and files to your
MATLAB Drive using MATLAB Drive online with the Upload button (select Files or Folder) or by
dragging and dropping folders and files from the operating system file browser. For either method,
empty folders are not uploaded.

Note

• File sync requires an internet connection.
• Using source control tools with your local MATLAB Drive folder is not recommended and can

cause unexpected behavior.

Sync Exclusions
Some small system files, temporary files, and folders created by applications are excluded from
syncing. This exclusion includes the following files:

• desktop.ini
• thumbs.db
• .DS_Store
• Icon\r

Also excluded from syncing are items named in any of the following ways:

• File name begins with ~$ (a tilde and a dollar sign), .~ (a dot and a tilde), or ._ (a dot and an
underscore)

• File names that end with ~ (a tilde)
• File names starting with ~ (a tilde) and ending with the extension .tmp.
• Files with the extension .asv, .autosave, or .mlx.bak
• Folders called slproj
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See Also

Related Examples
• “Access Files in Your MATLAB Drive” on page 12-6
• “Restore Deleted Files in MATLAB Drive Online” on page 12-21
• “Manage File Conflicts and Update Issues in MATLAB Drive” on page 12-22
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Share Folders Using MATLAB Drive
You can collaborate with others and allow them to view and edit your files by sharing folders from
MATLAB and MATLAB Drive online. You can share a folder by inviting individual members to have
access to the folder or by sharing a link to the folder.

When you send someone a personal invitation to a shared folder, they can preview it and add it to
their files. They can also edit its contents if you grant them permission to do so. When you send
someone a view-only link, they can preview it and add it to their files, but not edit it. Previewing and
adding shared folders to your files can only be done in MATLAB Drive online and requires a
MathWorks Account.

To share a folder from MATLAB, you must be running MATLAB R2019b or later, MATLAB Drive
Connector must be running, and the folder you choose to share must be in your MATLAB Drive. If you
are working in MATLAB Online, you do not need MATLAB Drive Connector to share folders since
sharing is always enabled.

Share Folder By Personal Invitation
You can share a folder from MATLAB and MATLAB Drive online by sending a personal invitation.
Sharing a folder by personal invitation allows you to give others both view and edit permission to
your files. To send an invitation:

1 Right-click the folder and select Share > Invite Members. If you have already shared the folder
by personal invitation, select Manage Members instead. In MATLAB Drive online, you also can
click the Share button and select from the available options.

In MATLAB Online, you also can select the Preview button  to the right of the folder, and in the
Share section, select from the available options.

2 In the Invite section of the invitation, enter the email addresses of the people that you want to
share this folder with. To share the folder with multiple people, enter multiple email addresses
and separate them with semicolons or commas.

3 Select Can View to share the folder as a read-only folder or Can Edit to allow invited members
to edit its contents. If you want to share the folder with multiple people using different
permissions, send each invitation separately.

4 Optionally, enter a message to include with the invitation.
5 Click Send. MATLAB Drive sends an email to the people you have invited.
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Change Member Permission

Once you personally invite someone to share a folder, you can change their folder permissions from
MATLAB and MATLAB Drive online. For example, if you invite someone to share a folder as a read-
only folder, you can change their permissions to allow them to edit its contents.

To change the folder permissions for an invited member, right-click the shared folder and select
Share > Manage Members. In the Shared With section, next to the address of the invited member,
select a different folder permission. Then, click Save to update the permissions.

In MATLAB Drive online, you also can click the Share button and select Manage Members. In
MATLAB Online, you also can select the Preview button  to the right of the folder, and in the Share
section, select Manage Members.
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Revoke Personal Invitations

Once you personally invite someone to share a folder, you can revoke their access.

To revoke access, right-click the shared folder and select Share > Manage Members. Click the X
next to the name of the member to revoke shared access.

In MATLAB Drive online, you also can click the Share button and select Manage Members. In
MATLAB Online, you also can select the Preview button  to the right of the folder, and in the Share
section, select Manage Members.

Share Folder With View-Only Link
You also can share a folder from MATLAB and MATLAB Drive online by creating and distributing a
view-only link to the folder. Sharing a folder using a view-only link gives others view permissions to
your files. To create and distribute a view-only link to a folder:

1 Right-click the folder and select Share > Create Link. Click Create a view-only link to create
the link. If you have already created a view-only link for the folder, select Manage Link instead.
In MATLAB Drive online, you also can click the Share button and select from the available
options.

In MATLAB Online, you also can select the Preview button  to the right of the folder, and in the
Share section, select from the available options.
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2 Click Copy Link to copy the link to the clipboard.
3 Distribute the link to others, for example, by including it in an email.

Remove Shared Link

To remove access to a shared folder from a view-only link, right-click the shared folder and select
Share > Manage Link. Click Delete Link and confirm the deletion by clicking Delete.

In MATLAB Drive online, you also can click the Share button and select Manage Link. In MATLAB
Online, you also can select the Preview button  to the right of the folder, and in the Share section,
select Manage Link.

Members who gained access to the folder using the link will no longer have access to it, and anyone
who tries to use the link in the future gets an error. Deleting the link does not cause any change in
access to those who received a personal invitation to the shared folder. To change their access, see
“Change Member Permission” on page 12-12.

Access Folders Shared with You
You can get access to a shared folder by receiving either a personal invitation or a view-only link.
When you receive an invitation or a link, you can preview the contents of the shared folder. Then, to
view and open the contents of the folder, and to edit them if permitted, add the folder to your files.
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Preview Folder Shared by Personal Invitation

When you are personally invited to a shared folder, you receive an email with a link to the invitation.
Click View Folder in the invitation to open the pending invitation in MATLAB Drive online.

To view all of your pending invitations in MATLAB Drive online, click Shared Content on the left side
of the page.

When the invitation opens, MATLAB Drive online displays a preview of the shared folder. You can
navigate the structure of the shared folder and preview individual files. You must be logged in with
your MathWorks account to preview the folder. To view and open the contents of the folder, and to
edit them if permitted, add the folder to your files.

Preview Folder Shared by View-Only Link

When you receive a view-only link to a shared folder, open the link to preview it in MATLAB Drive
online. When the preview opens, you can navigate the structure of the folder and preview individual
files. Previewing a folder shared by link does not require a MathWorks account. To view and open the
contents of the folder, add it to your files.
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You can also forward the link to others. To get a new copy of the link, click  Share Link. In the
Share by Link dialog box, click Copy Link to copy the link to the clipboard.

Add Shared Folder to Your Files

To view and open the contents of a folder shared with you, and to edit them if permitted, add the
folder to your files. You can add a folder to your files either by creating a shortcut to the shared
folder, or by creating a copy of the shared folder that is only visible and accessible to you.

To create a shortcut to the shared folder, in the MATLAB Drive online folder preview, click the  Add
to my Files button and select Add Shortcut. To create a copy of the shared folder that is only visible
and accessible to you, click the  Add to my Files button and select Copy Folder. MATLAB Drive
adds the folder to your files and opens the Files view. You must be logged in with your MathWorks
account to add a shared folder to your files.

If you have MATLAB Drive Connector installed, the Connector syncs the contents of the added shared
folder to your local drive.

Manage Shared Folder
If you have edit permissions to a shared folder, you can edit its contents, as well as move, rename,
and delete the folder itself.

MATLAB Online and MATLAB Drive online indicate shared folders using the shared folder icon . If
you have MATLAB Drive Connector installed, the Connector indicates shared files in the Activity
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section by displaying SHARED below the file name. If you do not have edit permissions for the
shared file, the Connector displays a padlock icon .

Edit Shared Folder

If you have edit permissions to a shared folder, you can edit the contents of the files and folders
within that folder. You can edit the files in MATLAB Online, or, if you have MATLAB Drive Connector
installed, you can edit the files on your local drive. As you and other members of the folder make
changes, the Connector keeps the shared folder on your local drive up-to-date.

Warning It is possible that other participants with edit permissions are also editing the same files as
you are. If this occurs, the most recently saved copy overwrites any other saved copies.

You cannot edit a shared file if you do not have edit permissions for the shared folder. If you do not
have edit permissions for a shared file, MATLAB Drive Connector displays a padlock icon  below
the file name in the Activity section.

Move or Rename Shared Folder

You can move a shared folder to a new location within your MATLAB Drive. If you have edit
permissions to a shared folder, you also can move or rename its contents. You can move or rename
the folder in MATLAB Drive online and, if you have edit permissions to the folder, from MATLAB.

If you move or rename a shared folder:

• The folder is moved or renamed only for you.
• Others with access to the shared folder do not see the changes. This is true even if you are the

owner of the shared folder.

If you have edit permissions for a shared folder, you can move or rename content inside it. When you
move or rename content inside a shared folder, the moved or renamed content is moved or renamed
for all members of the folder.
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Note If you move one shared folder into another, the one that you move takes on the permissions of
its new parent. For example, if a member can edit the parent folder, they can now edit the folder that
you move into it.

Delete Shared Folder

You can delete a shared folder in your MATLAB Drive. If you have edit permissions to a shared folder,
you can also can delete its contents. You can delete the folder from MATLAB Drive online and, if you
have edit permissions to the folder, from MATLAB.

If you delete a shared folder:

• MATLAB Drive deletes the folder and its contents only from your MATLAB Drive.
• All others with access to the folder, whether by personal invitation or view-only link, continue to

have access to it.
• The folder no longer counts towards your storage quota.

If you have edit permissions for a shared folder, you can delete content inside it. When you delete
content inside a shared folder:

• MATLAB Drive deletes the content from your MATLAB Drive and for all other members of the
folder.

• The content no longer counts towards your storage quota.

Permanently Delete Shared Folder

When you delete a shared folder or its contents, MATLAB Drive moves the deleted items to your
Deleted Files folder. You then can choose to permanently delete those items from your MATLAB
Drive.

Note MATLAB Drive permanently deletes content (including shared folders) in your Deleted Files
folder after 30 days or if your Deleted Files folder is over the deleted files storage quota.

If you permanently delete a shared folder from your Deleted Files folder:

• The folder and its contents are permanently deleted only from your MATLAB Drive.
• All others with access to the folder continue to have access to it.
• If you are the owner of the shared folder, then the folder becomes ownerless. When a folder is

ownerless, no new members can gain access to the folder, whether by personal invitation or view-
only link. In addition, MATLAB Drive deletes all pending invitations to access the folder.

If you permanently delete content from a shared folder:

• The content is permanently deleted from your MATLAB Drive and for all members of the folder.

You cannot permanently delete content from a shared folder that has active members with edit
permissions to the folder.
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Sharing Limitations
There are limits on how many folders you can share, how many people you can share each folder
with, and how much data your MATLAB Drive can hold.

User Sharing Limitations

You can have up to 100 shared folders in your MATLAB Drive. This total includes folders shared by
you (regardless of whether others have accepted your invitation) and folders shared by others that
you have added to your files. Sub-folders in shared folders are not included in this limit.

If you reach the limit of 100 shared folders:

• You cannot share additional folders.
• You cannot add additional shared folders to your files.
• If you receive an invitation to access a shared folder, you can preview the files but you cannot add

a shortcut to the folder to your files. You can, however, create an unshared copy of the folder and
add it to your files. To create an unshared copy of the folder, in MATLAB Drive online, select the
folder, click the  Add to my Files button, and select Copy Folder.

Folder Sharing Limitations

The number of people that you can share a folder with depends on whether you have an eligible
MATLAB license that is current on Software Maintenance Service.

If you have an eligible MATLAB license:

• You can share a folder with 1,000 people using a view-only link and with an additional 100 people
using a personal invitation.

If you do not have an eligible MATLAB license:

• You can share a folder with 10 people using a view-only link and with an additional 10 people
using a personal invitation.

After you have reached your limit for personal invitations you cannot invite others to share that
folder. If a member leaves the shared folder or declines the invitation to access the shared folder,
then you can send additional invitations.

When sharing a folder using a view-only link, when the number of people accessing the link reaches
the folder maximum, others who try to use that link cannot access the folder.

Storage Quota Limitations

When you add a shared folder to your files, the content of that shared folder is included as part of
your total storage allotment, regardless of whether you have edit or read-only permissions to the
folder. If a member of the folder adds or deletes content, your storage allotment updates accordingly.

If you exceed your maximum storage allotment:

• Others with edit permissions can add content to your shared folders, but you cannot.
• You cannot add additional folders to your files or create new invitations or shared links to a folder.
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For more information, see “Storage Quota” on page 12-4.

See Also

Related Examples
• “Access Files in Your MATLAB Drive” on page 12-6
• “Add Files to MATLAB Drive” on page 12-9
• “Restore Deleted Files in MATLAB Drive Online” on page 12-21
• “Manage Files and Folders” on page 6-34
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Restore Deleted Files in MATLAB Drive Online
The Deleted Files folder on MATLAB Drive online holds content that you have deleted from MATLAB
Drive.

To restore content, select the file or folder in Deleted Files, and click Restore.

You can restore content in the Deleted Files folder under the following conditions:

• The file or folder to restore has been in the Deleted Files folder for less than 30 days. (After 30
days or if your Deleted Files has gone over storage quota, content is permanently deleted.)

• You did not permanently delete the content from the Deleted Files folder.
• You have the available storage space in your MATLAB Drive for the restored content.
• You restore an exact item that you deleted. For example, if you deleted an entire folder, you cannot

restore only a single file from that folder — you must restore the entire folder.

Items restored from the Deleted Files folder are returned to their original folder locations.

See Also

Related Examples
• “Add Files to MATLAB Drive” on page 12-9
• “Access Files in Your MATLAB Drive” on page 12-6
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Manage File Conflicts and Update Issues in MATLAB Drive
File conflicts could occur if you access your MATLAB Drive data from either multiple machines or via
a combination of MATLAB Drive Connector and another access method; for example, MATLAB Drive
online, MATLAB Mobile, or MATLAB Online.

When you restart the Connector, MATLAB Drive compares the edited file with the same file in cloud
storage. If the content is different, MATLAB Drive renames the local version of the file. The name of
the copied file has the following text appended to the file name:

conflict_copy_machinename_date

To resolve the conflict, compare the two versions, and decide which one to you want to keep. You can
merge the changes manually, or delete the version of the file you do not want. If you decide to keep
both versions of the file, you can remove the alert icon by clicking Dismiss alert from the file context
menu.

File Update Issues
These conditions can affect file updates:

Issue Description
A file is larger than 5 GB. Updates of smaller files continue.
You exceed your MATLAB Drive
quota.

Updates stop. Remove files from your MATLAB Drive to free up
space.

Connection to MATLAB Drive is
interrupted.

Updates stop until the connection is restored.

File name contains unsupported
characters.

Updates of other files continue. Rename files that have names
with unsupported characters. Follow the requirements for your
operating system when naming files.

You do not have permissions to
access files in the MATLAB Drive
folder.

Updates cannot proceed. You are logged in to the computer as a
user who does not have permissions to access the local
MATLAB Drive folder. Log in as a user who has permissions to
access the folder, or change the permissions on the folder.

See Also

Related Examples
• “Add Files to MATLAB Drive” on page 12-9
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Start and Stop MATLAB Drive Connector
When MATLAB Drive Connector is running, it automatically syncs the files in your MATLAB Drive
folder with files on the cloud. To prevent syncing, pause or stop the Connector.

Start MATLAB Drive Connector
When you start MATLAB Drive Connector, it starts syncing your MATLAB Drive files. You can start the
Connector from within MATLAB or using a separate application.

From within MATLAB, in the Current Folder toolbar, click the MATLAB Drive button . This starts
the Connector.

If you do not see the MATLAB Drive button  in the Current Folder toolbar, right-click the toolbar
and select Customize. Then, in the MATLAB Toolbar Preferences Controls section, select the check
box for the MATLAB Drive control and select OK. MATLAB adds the button to the toolbar.

Alternatively, use a separate application:

• Windows – In the Start menu, select MATLAB Drive Connector. If you see a security alert when
you start MATLAB Drive Connector, select Allow access to continue.

• macOS – Navigate to ~/Applications in Finder, and select MATLAB Drive Connector.
• Linux – Execute ~/bin/MATLABConnector start in a terminal window.

Pause and Resume Syncing
To temporarily stop the syncing of your MATLAB Drive files (for example, if you are on a metered or
slow internet) you can pause syncing. When syncing is paused, you can continue to access and edit
the local copies of your files in the MATLAB Drive folder on your computer. When you resume
syncing, MATLAB Drive automatically syncs your changes.

To pause syncing, open MATLAB Drive Connector. In the top-right corner of the window, click the
Show MATLAB Drive actions button  and select Pause syncing.

To resume syncing, click Resume syncing. You also can click the Show MATLAB Drive actions button
, and select Resume syncing.
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Stop MATLAB Drive Connector
To stop syncing your MATLAB Drive files for an extended period of time, stop MATLAB Drive
Connector. After stopping MATLAB Drive Connector, you can continue to access and edit the local
copies of your files in the MATLAB Drive folder on your computer. When you restart MATLAB Drive
Connector, your files sync automatically.

To stop MATLAB Drive Connector, open the Connector and in the top-right corner of the window, click
the Show MATLAB Drive actions button  and select Quit. On Windows, you also can right-click the
MATLAB Drive Connector icon in the Windows system notification area and select Exit. On Linux, you
also can execute ~/bin/MATLABConnector stop in a terminal window.

See Also

Related Examples
• “Install MATLAB Drive Connector” on page 12-2
• “Access Files in Your MATLAB Drive” on page 12-6
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View MATLAB Drive Connector Status and Notifications
MATLAB Drive Connector shows the status of your MATLAB Drive files and of your network
connection. MATLAB Drive displays the status icon in the Connector window as well as in the
Windows system notification area or the macOS dock.

Status Icon Description
Files are up to date.

File updates completed with a condition that could require action.

File updates failed. Your files are not up to date.

File syncing is paused. Resume syncing to ensure files remain up to date

MATLAB Drive Connector could not connect to the network. File syncing is
paused.

On Windows and macOS systems, if notifications are enabled, MATLAB Drive displays them in the
Windows system notification area or macOS dock.

See Also

Related Examples
• “Manage File Conflicts and Update Issues in MATLAB Drive” on page 12-22
• “Start and Stop MATLAB Drive Connector” on page 12-23
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Configure the MATLAB Startup Accelerator
When you install MathWorks products on your computer, the installation includes a utility program
that can speed up MATLAB startup, called the MATLAB Startup Accelerator. By default, the installer
configures this utility as a scheduled task on your computer that runs several times each day.

While you are not required to modify this configuration, the startup accelerator works best if you
coordinate when it runs with your particular MATLAB usage patterns. For example, by default, the
startup accelerator runs at 8:00 a.m. and again at 1:00 p.m. every day, or whenever you log on to
your computer. To take full advantage of the startup accelerator, schedule it to run at a time just
before you typically start MATLAB.

To modify this configuration, use the Windows Task Scheduler. In the Windows Task Scheduler, these
start times are called triggers. You can modify these triggers to customize when the startup
accelerator runs. You can also add triggers, delete triggers, or delete the startup accelerator task
completely. The following section shows how to change when the startup accelerator runs using the
Windows Task Scheduler. For more information about the Task Scheduler, see Windows
documentation.

Change When the MATLAB Startup Accelerator Runs
To change when the MATLAB Startup Accelerator runs on your computer, use the Windows Task
Scheduler.

1 Start the Windows Task Scheduler.

On the Windows Start menu, search for the phrase “task scheduler” and press Enter.
2 Click Task Scheduler Library in the Console tree to view scheduled tasks and double-click the

name of the startup accelerator to change the configuration.
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3 To change when the task is scheduled to start, click the Trigger tab in the task properties dialog
box. In the list of triggers displayed, select the trigger you want to change, and click Edit.
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4 To change the time the task is scheduled to run, enter a new time and click OK.
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